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CHAPTER 1 - ASSETS CONCEPTS 

ASSETS, PEOPLE AND ORGANIZATIONS/LOCATIONS 

VIZOR is designed around the concepts of People, Assets and Organizations/Locations. 

VIZOR helps you manage your assets and how they are used by people and the organization throughout 

time. 

Organizations and locations are related concepts that are managed separately depending on your needs.  

If you use VIZOR for managing your organization’s internal assets, you may have a single Organization 

with one or many locations.  

Alternatively, if you use VIZOR for managing your customer’s assets, you may have multiple 

organizations each one with one or many locations.  
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ASSET CLASSES, ASSET TYPES AND ASSETS (INSTANCES) 

In VIZOR, 

an asset represents any type of resource assigned to a person or organization. An asset can be an 

instance of an installation of a Software Application, a physical device such as a laptop or desktop, it can 

also be equipment like a projector, or even non-physical assets like a virtual machine or access to a 

Cloud Software Application. 

Assets in VIZOR are often but not exclusively IT Assets. Due to being highly configurable, Organizations 

use VIZOR to track all types of assets that are valuable to them.  

An Asset, also known as an instance of an asset, has a unique life-cycle that can be traced and managed 

with VIZOR. Each asset has a specific life cycle that often looks like the following: 

• start with a request to get the asset 

• follow with the workflows and approvals to purchase the specific asset 

• the purchase process to obtain it 

• the arrival of the asset to the organization 

• the allocation of the asset to a person, location, department or project 

• the provisioning of the asset to the intended user or location 

• the de-provisioning of the asset after used or when reallocated 

• some possible cycles of configuration or repair of the asset  

• and usually finished with the retirement or disposal of the asset 
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ASSET CLASSES 

Assets are first categorized into Asset Classes. Asset Classes define the top-level type of assets and allow 

your organization to manage asset types in a structured way, with general categories such as “software” 

and “computers”.  

Typical examples of Asset Classes are: 

• Software 

• Computer 

• Consumables 

• Document 

• Hardware 

• Network Share 

• Telecom 

 

Can I customize the Asset Classes? 

You can hide asset classes that are not in use by your organization. 

You can rename the existing classes to align to the needs of your organization or industry, and you can 

also create your own asset classes.  

Unlike Asset Types, Asset Classes do not have any specific life-cycle, behaviours or business rules and 

they serve more to categorize or group the Asset Types they contain. 

 

ASSET TYPES AND SERVICE TYPES 

The next level of categorization is the Asset Type or Service Type. An asset or a service is always created 

as an instance of an Asset or Service Type. Every Asset/Service must come from an Asset/Service Type. 

The Asset/Service Type defines the exact kind of asset it is and establishes the main characteristics of the 

asset or service such as: 

• The Life-Cycle of that asset, from procurement to retirement 

• The Actions to execute when provisioning or de-provisioning the asset/service 

• The Approvals and workflows required along the life-cycle of the asset/service 

• Costs and other purchase information  

• Depreciation calculations 
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An Asset Type is similar to a template of an asset/service, and in fact many attributes of an asset 

(instance) are inherited from the Asset Type.  

Typical examples of Asset Types are: 

• Microsoft Office Software 

• Desktop computers 

• Laptops 

• USB Keys  

An Asset/Service Type always belongs to an Asset Class. You cannot have an Asset Type that does 

not belong to an Asset Class. However, you can move an Asset Type from one class to another. 

 

Examples of Asset Class –> Asset/Service Type -> Asset hierarchies: 

Asset Class Asset/Service Type Asset 

Computer Desktop HP Envy 750 SN:4536-45645 

 Laptop Dell Inspiron SN:RT36-43242 

   

Hardware Projector Epson PowerLite SN:JHFY-4578 

 External Drive Seagate Backup Plus SN:48-JHG-7856 

 Monitor Dell 55 E5515H SN: OHH987IH 
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CHANGING THE ASSET TYPE 

In some cases is it necessary to allow changing the asset type of an asset. For example, if you want to 

change a computer from being a “Desktop” to a “Laptop”. 

In general, if you are changing the asset type of an asset you must consider that the old asset type may 

have different settings and life-cycle rules, defined in the record of the asset type.  

 

• In the Web View Editor, select the Web view "Resources / Library". 

 

• select the Fields area on the left and then the General tab. 

 

• Export the field Asset Type Full to the Web view (move to the right). 

 

• Generate the Web view. 

 

• You should be able to edit the asset type in the view using that field. 

 

*Note: We suggest to never delete asset types if they are not being used. Instead, change the visibility of 

the asset type to “Visible = No’ 

AUTOMATICALLY CHANGE ASSET TYPE OF DESKTOP TO LAPTOP  

VIZOR will automatically change asset types of Desktop computers to Laptop based on existing 

computers with asset type set to "Laptop". ALL Desktops will be changed to Asset Type "Laptop" If there 

is at least one Laptop with a combination of Manufacturer and Model Number that Desktops match with. 

 

The model is determined by checking both the manufacturer and the model. For this process, the 

manufacturer can be empty but the model is required. This process runs overnight in the app set up task 

and right after  computers are imported. 

 



  Page 37 

 

In practice, a sample Laptop asset can be created so that subsequent imports are automatically changed 

to the Laptop Asset Type. This sample asset can then be deleted if needed.  

 

ASSET FIELDS 

 

The fields used to manage an asset can be determined by the Asset Class / Type. Webview Editor and 

Workflow tools detailed in this guide can used for this purpose.  

By default Asset Fields are arranged by the following Tabs 

 

Generic Asset  

• Overview 

• Details 

• Actions 

• Allocation 

• Purchase Details 

• Source 

Bulk Asset (Consumerable) 

• Overview 

• Details 

• Bulk Allocation 

• Purchases 

Computer Asset default tabs 

• Overview 

• Details 

• Actions 

• Computer Details (Hardware) 

• Allocation 

• Purchase Details 

• Source 

• Installations (Software Inventory) 
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ATTACHMENTS AND DOCUMENTATION OF ASSETS 

Related documentation such as purchase orders, invoices and leasing documents can uploaded against 

an asset (Overview tab) or against a Purchase (Details tab, as shown above). Files can be uploaded to 

VIZOR directly, or linked to a file storage system such as SharePoint.   

 

Once the file is attached or link, users can search for asset records that contain a specific name 

of file or link. 

This may be used in checking compliance, as it is the case for the Certificate of Destruction. 

CATEGORIZING ATTACHMENTS 

You may also want to categorize specific types of attachment. For example, in the Software 

Licenses view, each License record has the following fields in the Documents tab: 

• Contracts 

• Invoices 

• Instructions 

 

This helps users to file the right documents in an organized manner as well as query, report or 

create notifications for when specific documents are not attached. 

An example of this is the Certificate of Destruction in the Asset Disposal tab, used for a retired 

asset.  

 

ASSET LINKED TO OTHER ASSETS 
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Assets can be linked or allocated to other assets. For example a Monitor and Keyboard could be 

allocated to a desktop computer. 

This is controlled by the Asset field Allocated to Device / Computer. 

ADD NEW ASSETS SETTINGS 

  

A wizard will allow you to define which fields will be available when adding assets to VIZOR. If you don’t 

want to enter that field’s information for the assets you are entering, you can set it to No. You may find 

this wizard by clicking in the link directly at the top of the Add Asset window.  

 

 

Based on the fields selected above, VIZOR will then allow you to define which fields should have unique 

values per asset (Serial Number and Asset Tag are always unique). For the fields that are set to No here, 

VIZOR will allow you to enter the same value for all the assets you are entering at once.  
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These settings will be saved for the next time assets are entered, but you will be able to change them as 

needed.  
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ADDING FIELDS TO THE ADD ASSETS WIZARD 

 

In order to add additional fields to the add new assets: 

  

• Use the Web View Editor to navigate to the Resources / AddGrp Web view. 

• Export the additional fields that you need into the "Overview " tab.  

  

 

 

 

 

 

 

 

 

 

 

 

• Set the Column Span field attribute to 2 and the CSS Class field attribute to 

MemoFieldWidth by clicking on the "Attributes" button. 

 

 

 

 

 

 

• Regenerate the Web view. 
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ADDING A CHECKBOX FIELD 

 

To add a checkbox field to a an asset: 

1. Create a Single Choice Field using the Global choice table "Yes/No". 

a. In the Web Admin, create a new field as a "Single Choice" type, using the global 

“tblYesNo” choice list. 

 

2. Open the Web View editor on your server and export the new field. In the field attributes, insert 

"fld_switch.htmpl" as the Field HTML Template. This will instantly turn your field into a toggle. 

 

3. After generating the web view, you'll notice that the field now displays as intended, the field will 

look like this: 
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ADD NEW ASSETS 

Based on the settings in the previous wizard, the Add New Assets dialog will show the appropriate fields 

to enter.   

For the fields that are not unique per asset that were selected on the first page of the previous wizard, 

but not on the second page, these will show at the top of the dialog.  

For the fields that are unique per asset that were selected on the first page of the previous wizard, as well 

as on the second page, the entry field will show one at a time. Once it has been entered, click on the 

“next” button to move the entry to the box below to easily view and track the information that has 

already been entered, then the next field will appear. These fields can be entered manually or scanned in 

with a USB or Bluethooth bar code scanner.  
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IMPORTING ASSETS FROM AN EXCEL FILE  

 

1. On your Home Page, click on the “Assets” link to access the “Assets” web view:  

 

2. Once in the “Assets” web view, click on the “Import” button in the right tool bar to open 

the Self-Service Import assistant  

 

 

 

 

 

 

 

 

 

 

 

 

 



  Page 46 

 

 

 

3. Once the import assistant opens, follow the instructions below: 

a. Download the template from the link provided and fill in the asset information 

to import. 

 

b. The template contains a series of columns that can be filled in with your asset 

information. The columns in blue are required, all other are optional. Filling as 

much information will help you to better categorize your assets. 

 

 

 

o Asset type: Defines the exact kind of asset it is and establishes the main characteristics of 

the asset or service.  

▪ For example – Computer, Desktop, Tablet, Cellphone 

o Unique ID: This can be your organization’s unique identifier for your asset, be it a 

model number or an arbitrary one you give to each one of them.  

 

c. Click on the Import files button and  upload the asset import template. 

 

4. To update/synchronize assets or add additional information to existing assets in VIZOR, 

fill in the fields that you want to update. You will need to ensure that the following 

columns in the Excel file match the fields in the existing asset in VIZOR that you want to 

update: Asset Type, Serial Number, Unique ID (if it was added previously via an import 

from Excel, this must be the same Unique ID that was used then). 

 

5. Once the import is completed, the assistant will provide with a report of the asset 

import and the totals as follows:  

 

o Processed – Indicates how many assets were read from the file. 

o Added - New assets correctly added. 

o Synchronized - Existing assets that were updated. 
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o Errors - Assets that failed to import errors in the file. 

o A log will provide further details when an error is detected for easy 

troubleshooting 

Note: When importing assets with choice value fields, the value in the Excel file must be an exact match to 

the values in the list in VIZOR. This ensures accurate categorization and data integrity during the import 

process. 
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ADDING A MODEL / MANUFACTURER ENTRY 

VIZOR stores Manufacturer and Model options in choice lists that are accessed by the before mentioned 

fields so you can have a drop down with different selections. To add a new choice to these choice lists, 

follow the steps below: 

1. Go to Chromebooks & Assets 

2. Open any Chromebook or asset record 

 

3. Click on the three dotted button next to the Model or Manufacturer fields: 

  

4. A pop – up window will open, click on “Add New” 

 

5. In the case of adding a model, it will let you create the new choice and also select a 

manufacturer. When adding a new manufacture all you need to do is define the name of the 

manufacturer 
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6. Once added, go back to the field Model or Manufacturer as applicable and find the new choice. 

ASSET CHANGE HISTORY  

VIZOR Tracks all changes which are made to data fields of an asset. This includes 

updates to Status, such as from In-Stock to Assigned. Purchase changes and inventory 

changes from network discovery. Change History of an asset can be seen by clicking 

on the History button in the asset tool bar. 

 

 

Change History reports the date / time of the revision. The user, computer and IP address linked to the 

change. The value affected, the previous value and the current value. 

 

See revision history, enabling/disabling and revision history, synchronizing sections of the document for 

more information on how to configure this functionality.   
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ASSET CONTAINERS 

 

Asset Containers are a special type of assets that contain other assets. Most of the times, a Container 

represents a real, physical item that contains the included assets, like a box, a pallet or a bin. However, a 

container can also be virtual or immaterial, useful to create a set or logical group of the assets. 

For example, you can organize assets of various types into a container, and then allocate the container to 

someone for transportation or for assigning the included assets to others. 

Typical Usage: 

1. Create a type of asset that is a container if needed. There are some default container asset types 

like the Chromebook Container. 

2. Create one or more instances of these containers. You can use the button Add Assets in the 

Assets Web view. 

3. Set the person responsible for the container by setting the person in the Allocate to Person field, 

just like any other asset. 

4. Add assets to the container. 

o You can add one asset at a time by setting the Container field in the Allocation tab. You 

can also add multiple assets by running a query that includes all or more of the assets to 

add, selecting the assets using the last column of the Summary List and then clicking 

Mass Update to set the Container field to all the assets.  

5. The person responsible of the container can view the assets inside by selecting the query “Assets 

in My Containers”. 

Example scenario with Chromebooks. 

 

A school is receiving Chromebooks for the students and the supplier is sending them in containers. A 

Chromebook Container is a type of Asset Container and it has all the Chromebook devices for the 

students of a given class (school class). 

The Containers can be created manually or imported using the pre-created template for importing 

Chromebook Containers. An administrator can log into Assets and select the query “Containers” to see 

all the containers in VIZOR, regardless of who is responsible for each one. If not already done, the 

administrator can assign a Chromebook Container to a teacher.  

 

 

DIGITAL ASSETS 
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Digital Asset are images, photos, patents, creative files, video, audio, presentations, documents, etc. that 

are valuable for the organization.  

Tracking these assets in VIZOR may be important:  

o For Accounting, to know the value of the collective and their existence  

o For Purchasing, to know when licenses or copyrights would expire and be able to renew them.  

o For users, for finding them and knowing where the secure repository is.  

 

VIZOR includes an Asset Class for Digital Assets. You will also find several built-in Asset Types such as: 

• Digital Currency / Cryptocurrency             

• Logo             

• Music             

• Patent             

• Photo             

• Trademark             

• Video 

 

With VIZOR, you can track the purchase and the renewals of a Digital Asset, and configure alerts to 

remind you or stakeholders of the renewals. 

Use the Asset Expires field if the asset cannot be used after a given date. 

Set it to Yes and enter the Expiry Date in the field. 

 

 

 

You may also want to use the following fields for Digital Assets: 

o Confidentiality Level 

Many of them being documents, the content could need to be highly protected, like patents 

 

o Backup Location:   

Where is a backup copy of it? 

 

o Business Justification 
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Why does the business need it? 

 

o Attachments 

Add the link to the actual file or folder. 

If your organization does not have a centralized Document Management system, you may want 

to use VIZOR as the repository, in which case, upload the files. 

If your organization has a centralized Document Management system, just link the document 

into VIZOR. 
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ASSET BASELINES 

VIZOR allows you to compare changes made to an asset record against a baseline. VIZOR will track and 

compare all the changes of the current version of the asset record against the baseline. 

To use the baseline, first set or enable the baseline in the asset record.  

Go to the asset and to the Baseline tab. 

 

It will be clearly indicated if no baseline has been set yet, as above. 

Click on Set Baseline and save (OK or Apply). 

The Baseline tab will show the baseline timestamp as well as the changes of the current record vs the 

baseline. 

If there are no changes, you will see as below: 

 

 

Otherwise changes will be displayed as below: 
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Click on Clear the Baseline to remove the current baseline. 

CLASSIFYING AND PRIORITIZING ASSETS 

You can classify Assets in VIZOR according to  confidentiality, risk and how important is for the business. 

Use the following fields to manage approiately these assets as well as incidents associated to the assets: 

Confidentiality Level: High, Low, Medium. You can modify the possible levels. How much should the 

information inside be protected against unauthorized access and use? 

 

Security Risk: High, Low, Medium. You can modify the possible levels.  
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Priority Business Continuity: from Highly Critical to Standard. How important is this asset for the 

continuity of the business? You can modify the possible levels.  

 

 

 

Risk Priority Number or RPN: this is an integer number, representing numerically the  assessment of 

risk assigned to the asset. Useful when there is a need to further prioritize among assets of the same 

levels in critical situations or DRPs.   

 

 

Environment: it also helps your team to define priorities. If the asset is in Production, it may need 

attention earlier than another one in Test/QA. It also helps identify assets that are specficially for Disaster 

Recovery use, like a mirror server. The criticality of these assets will vary depending on the related 

system.  Default values are: 
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Besides indicating if an asset is for Regulatory & Compliance purposes, an asset may need to comply 

with specific regulations or standard. Use the area for linking Standards and Compliance documents for 

this purpose. 

 

 

STRATEGIC RESERVE 

 

The Strategic Reserve field indicates whether an asset is part of a reserve of items held back from normal 

use. This reserve is maintained to implement specific strategies or to manage unexpected events. It 

serves as a subcategory within assets in storage, separate from day-to-day operational assets. 

 

Organizations often maintain two types of assets in storage: 

 

• Operational Assets: These are used for day-to-day operations. 

 

• Strategic Reserve Assets: These are kept aside and utilized only under specific conditions or 

strategies.   
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PERSONAL INFORMATION AND CONFIDENTIALITY  

VIZOR helps you manage assets that may be delicate for personal information, confidentiality or similar 

regulations and compliance. 

Elements that help you manage this type of assets are: 

Confidentiality Level: High, Low, Medium. You can modify the possible levels. How much should the 

information inside be protected against unauthorized access and use? For example, in hospitals, the 

asset may contain patient information. 

 

 

Query Data Protection Non-Compliance: this built-in query identifies retired asset that have 

Confidentiality Level higher than low and for which the Data Destruction Certified has not be confirmed. 

For example, this could prevent important hard disks from being discarded and not ensuring data is 

wiped correctly.  

Relevant to Data Protection: if yes, regulations such as GDPR applie to the asset and reviews muct be 

executed by the organization. 

Deprovisioning Actions. 

For Assets of confidentiality or privacy level higher than low, for example, you should document and 

preferably automate the actions needed to destroy or wipe out the sensitive data. 

For example, create a HelpDesk ticket or VIZOR action to make someone responsible of the Destruction 

of the Data.  
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PREVENTING UNAUTHORIZED CHANGES TO ASSETS  

Some assets may require additional control so that no changes are made without having a supporting 

Incident record, Problem record, Change record or Release record. 

If you want to enable this control in a specific asset, set the field Changes Require Process Record to 

Yes. 

 

If a user attemps to modify the asset record in VIZOR, the system will prevent her and notify of the need 

to indicate what record is associated to the update. 

 

 

 

VIZOR will only allow saving when the fields Update Required for Record and Update Required for 

Record Type point to a valid, open record that uses the asset in question.  

 

 

 

 

 

CHECKLISTS  
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You may want to standardize and document checklists for assets. For example, when preparing an asset 

for deployment, you may want to ensure certain steps are taken. There are several ways of implementing 

this in VIZOR, one of them by creating a Checklist tab and Custom Single-choice fields.  

In this case, you can follow these steps for adding Checklist fields:  

1. Create a new tab in the Web Admin. You may call it “Checklist”, for example. 

2. Using the Field Editor, add a new field, like “Joined to Domain” for example. Set the tab to be 

“Checklist”. For this case, you often add fields of Data Type Single Choice that use the global 

Choice Table “tblYesNo” with values “Yes” and “No”. 

3. Make other changes as desired and click OK to save. 

4. Create other fields as needed, for example “Named”, to document the computer was given a 

unique name. 

5. In the Web View Editor, select the Web view where the Checklist will be visible, “Resources / 

Library” in this example. 

6. Select Fields on the left and then click on the tab “Checklist”. You will see a list of the new 

custom fields you created on the left. This means the fields are not exported or available in the 

Web view. 

7. Move the fields to the right and position them in the desired order (top to bottom and left to 

right, over 2 columns). 

8. Click on “Generate View“ button. This will apply the changes. 

 

 

 

Removing checklist fields 

If you want to remove a field from your checklist, you can simply remove it from the Web view. 

1. In the Web View Editor, select the Web view where the Checklist will be visible, “Resources / 

Library” in this example. 

2. Select Fields on the left and then click on the tab “Checklist”. You will see a list with the custom 

field to remove on the right. This means the field is exported or available in the Web view. 

3. Move the fields to the left. 

4. Click on “Generate View“ button. This will apply the changes. 

 

We only recommend completely deleting the custom field if you are sure you won’t be using it in the 

future, otherwise it is a good idea to keep it in case you want to use it after. 
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RELATING ASSETS AND SERVICE MANAGEMENT 

 

VIZOR is an integrated tool of IT Asset and Service Management. VIZOR is designed so that these two 

functions can operate together or separate based on the organization needs.  

 

VIZOR integrates IT Asset and Service Management with the following functionality.  

 

View Related Helpdesk Issues 

 

This option provides a quick view from within an asset to see all related issues reported against it. The 

button as shown below is located on the Details tab of each Asset. 

 

 
 

 

View Related Computer / Asset 

 

Within an Helpdesk issue, users can link the Incident or Problem record to a computer or asset. You can 

also view the details of the computer or asset related to the current issue by clickin on the asset icon 

next to the name. 

 

 

 
 

 

 
 

 

For more information on syncing your data, refer to the latest concerned documentation guides. 

Requestable examples: 

VIZOR – Integrating with ECM 

VIZOR – Integrating with AD 
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VIZOR – Integrating with Vector Discovery 

VIZOR – Integrating with Lansweeper 

VIZOR – Integrating with RecoverKeys 

 

Determining problem and defective 

 

VIZOR can be configured to flag problem and defective assets as a Lemon after a threshold of issues 

have been related to it.  

 

Asset requests 

 

VIZOR manages the entire request process of an asset. See Chapter 7, Service Requests. 

 

 

Asset Provisioning Actions 

 

Once an instance of an Asset is specified to fulfill the Service Request, Actions defined in the Provisioning 

Actions area of the Service/Asset Type are executed. You can customize the Actions that VIZOR will 

create, assign and potentially execute for each Service or Asset in the event of Provisioning. See Chapter 

22, Life-cycle & provisioning actions. 
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CHAPTER 2 - SERVICE DESK / 

HELPDESK 

 

Vizor ServiceDesk (also known as Vizor HelpDesk) is a flexible, Web-based system for centrally tracking 

and managing help desk issues and calls. Because it is Web-based, it enables users to access the issue 

database from any browser, anywhere, any time. It also minimizes deployment effort because there is 

nothing to install on the PCs it supports. 

Vizor ServiceDesk works like a Windows application rather than a set of static HTML pages that must be 

constantly updated and reloaded. This enables you to easily customize HelpDesk to suit the way you 

want to work. When you run a query, view an issue, or submit a new issue, HelpDesk dynamically 

updates its interface. It uses pop-up dialogs for tasks like generating reports and attaching files to 

records. 

TERMINOLOGY 

 

Standardization of terminology is of crucial importance for maintaining your teams working at their best. 

From logging, to resolution and closure, your team will find that throughout VIZOR, ITIL 2011 Edition 

process terms are used. Your workflows and processes are thus made clearer and fully consistent to ITIL 

2011’s guidelines and requirements.  

Below are but the central terms you will find to be key. Feel free to contact us for more information or to 

obtain a copy of the English glossary.The following terms are used to refer to HelpDesk components: 

Projects are databases or knowledge bases. All Projects share user accounts, user group privileges, and 

the administration utilities, but each Project has a separate database. 

Web views are customized views of Project databases. Each Web view is designed to meet the needs of a 

class of users. For example, employees who do not belong to the support department only need to see 

the issues they submitted, not all the issues in the Project database or the notes added by the support 

staff. Conversely, support staff need access to all the issue information in the Project database. 

Incidents are unplanned interruptions to or reduction in the quality of a service. 
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THE LIFECYCLE OF THE INCIDENT OR PROBLEM 

 

When an incident or problem is reported using HelpDesk, it is passed on to support staff. The 

investigation of the issue, and any work required, is then performed in accordance with the 

organization’s issue-handling process.  

In VIZOR ServiceDesk, the steps in the issue-handling process are implemented as a Workflow. Each step 

in the process corresponds to a Workflow value shown in the issue’s Progress field or Status. Support 

staff advance an issue through the process by changing this value. Control of the work is maintained by 

assigning different permissions to change the Progress field to different types of user. One can thus set 

security controls to allow only authorized staff to close records based on their role.  For example, in the 

default process included in the standard HelpDesk installation, only group leaders can assign an issue to 

the rest of the support staff. 

 

This diagram summarizes the process required to solve a simple issue using the default HelpDesk 

installation: 
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STATUS AND STATE  

The Status field is a special field that reflects the life-cycle of the incident or problem record. The State 

field is associated, and it is automatically controlled by VIZOR, it is set to Open or Closed.  

To change the mapping of Status values to State values, use the same editor. The choice table for the 

Status list contains an extra column that maps Status choices to State choices. You must complete this 

column when you add or edit the choices in the Status list.  

 

When you edit the State choice table, remember that the Closed choice sets the Closed Date and Time 

fields. So, for example, changing the choice text from Closed may confuse users.  

Notes 

If you edit the Status choice list, check that workflow rules based on the Status field are still correct for 

your needs. 

 

 

 

 

IMPACT, URGENCY AND PRIORITY 

Aligned with ITIL, an Incident, Problem, Change or Service Request may have fields that help track the 

Impact, the Urgency and the Priority of the process in question. These fields’ changes are recorded, 

timestamped and sourced to  either the system agent or the particular userID responsible for the change 

to the benefit of future historical verifications. 
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The Impact measures the business criticality of the record, the extent to which an Incident, a Problem or 

the abscense of a Service or Asset (not provisioned) leads to the distortion of business service levels. 

 

Urgency is a measure of how long it will be until it has significant business impact.  

 

Priority is a category that identifies the relative importance of an incident, Problem, Service Request or 

Change. Priority is normally calculated based on Impact and Urgency but it can be overridden under 

special circumstances. 

 

Priority is set automatically based on the Priority Matrix, which can be modified to your organization 

needs in the Business & Workflow Editor. 

 

 
 

If a user needs to override the priority, and she is authorized to do so, the field Override Priority can be 

used. 

 

When used, the user needs to select the justification for the action.  

 

 
 

By default, VIZOR includes some common justifications, but your organization may want to review and 

define which ones are valid in your environment. 

 

To ensure the field is used only by authorized users, control access to the field Override Priority just like 

with any other field (see controlling access and security of a field). 
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ASSIGNING ISSUES 

 

When an employee submits a new issue through HelpDesk, it is recorded with a progress status of New 

indicating it is awaiting assignment. It can then be viewed by a group leader and assigned to an analyst 

based on the information supplied. 

CLAIMING ISSUES 

 

While an issue is marked Assigned, it is waiting to be claimed by a help desk analyst. An analyst claims an 

issue by marking it In Progress, which indicates that the analyst is working on the problem. 

 

TICKETS RELATED TO ASSETS 

 

Help Desk tickets are often related to assets, especially computers. For example: 

- A repair ticket is opened after a laptop does not start (a failure of the power supply, for example). 

- A ticket is created for adding a hard disk to a computer. 

- A ticket is submitted for installing software in a specific computer. 

In all these cases the ticket refers to a specific asset. Since VIZOR is the primary repository of assets and 

inventory, your organization gets the most benefits when working with tickets associated to assets. 

By default the main fields in HelpDesk for associating the ticket to an asset are: 

1. Computer 

Indicates the primary computer the ticket refers to. It lists computers in VIZOR. 

 

2. Other Asset 

Indicates the main non-computer asset the ticket refers to. It lists assets that are not 

computers. 

 

By default these two fields do not allow all computers or all assets. These lists only show 

computers/assets that meet the following conditions: 

- Assets assigned to the person in the Contact field (Allocated to Person) 
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- Assets in which the field Responsible is the person in the Contact field 

- Assets not assigned. 

- Assets assigned to a location using the special user <Assigned to Location> 

 

This is active by default and helps prevent typos and mistakingly entering a computer that is not 

assigned to the person in question (the Contact). The behavior is controlled by server-side business rules 

that can be turned off if the organization needs to customize the list or see all computers/assets. 

CREATING AND OPENING INCIDENTS OR OTHER ISSUES 

Manually via… 

Service Desk agent: 

Certain submit-only views may be set out-of-the-box for letting contacts and 

other page viewers submit incidents or even access the knowledge base without 

requiring login credentials. 

User authentication: 

Using your user's credentials and navigating to the Submit Helpdesk Ticket or 

the Helpdesk Incidents & Problems views. 

Automated via… 

Inbound Email:   

See integration rules as per the Incoming Email Rules section in chapter 17. 

System alert: 

Choose the given notification alert you want and pair it with a "Create New ticket" integration 

rule. On checking for new alerts, set your integration rule's condition to pick up only on those 

notifications with the use of tags for example to minimize false positives in that rule. 

Rapid capture 
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1. The Copy Issue feature button on the summary list transforms any record displayed into a 

template for faster capture if you already know the seed issue has the information you need. 

The activity log, emails and other details by default do get removed so it really is template 

for a new incident or issue. 

 

2. The Copy as Problem will create a copy of the issue but of the type Problem rather than 

incident. It is helpful to bring already set information while expanding on it. 

 

3. The Copy as Child feature button will create a copy of the issue while at the same time 

setting the new issue as the child of the seed issue which then becomes a parent to the 

former.Working with Issues. 

 

WORKING WITH ISSUES 

 

In its standard configuration Helpdesk gives analyst users direct access to the software and hardware 

information stored in the Vizor Assets database. This provides a quick and easy method of collecting the 

extra information analysts need to investigate an issue, even when the person who reported it is not 

available.  

In addition, with the PC-Duo Remote Control application, analysts can view and take control of the PC 

where the problem occurs, so that they can help even the most inexperienced users.  

 

When setting up the Help Desk categories and ticket customization, almost any configuration is possible 

in VIZOR.  

It is likely that you will want to make changes to the values in the fields Service Type / Category / 

Subcategory. Refer to the section on updating Choice Lists / Choice Tables. 

To distinguish from service requests in Helpdesk, VIZOR has a field called Ticket Type where such 

information is declared for any given record. Just as fundamental and essential to handling issues 

efficiently, VIZOR uses many fields to create a tiered categorization of issues to further differentiate 

issues based on a) the Service Type, b) the Category, c) the Subcategory, d) the Computer, and e) the 

Asset. Together with the fields Department, Location, Source and many more, VIZOR puts front and 
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center a very flexible yet powerful framework to track incidents and issues with a very high or a very low 

amount of resolution at will. In particular, As well, note that the field with the display name is “Source” 

for incident management and other tickets refers to the several ways the submission or the origin of the 

ticket is tied to (eg. Email, Web, Telephone). It is an out-of the box field that can be edited to include 

more choices as per reference in the VIZOR administrator’s guide on the topic of editing ChoiceLists. 

For the authorized support staff, they are by default entitled to the use of several more fields such as a) 

urgency, b) impact, c) priority. To calculate the latter, each of the former can be set to carry a certain 

weight, an associated factor. The default priority matrix can be modified by administrators through the 

Workflow Editor in VIZOR’s Web Admin. It is a crucial tool to enable a more objective, deterministic 

calculation of the importance tied to a particular issue. 

 

CLOSING ISSUES 

 

When a problem is fixed or work on an issue is complete, analysts change its Progress status to 

Resolved to indicate work is closed. On saving any change to these fields, an automatic timestamped 

entry is added to the revision history. The same is true for any save to the incident or issue category 

information fields like the Resolution Code. On closure a Closure Timestamp is produced. 

ABOUT RELATED INCIDENTS 
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To better manage and maintain the relationships between incidents and problems, VIZOR makes us of 

the tab Related Incidents. Link, unlink or edit any of the listed tickets through the buttons on the right. 

RELATED ISSUES AND CHILD ISSUES 

 

Often, a single problem can give rise to several different issues. For example, a server going offline could 

produce issues on problems with e-mail, access to the Internet and users being unable to access their 

files. If you have multiple issues resulting from the same underlying cause, you can link and manage 

them using the Child Issues tab individually. You may also want to take advantage of the summary list’s 

feature buttons (when permissions are granted to oneself) to create a copy of any given issue. For more 

information, refer to the CREATING AND OPENING INCIDENTS OR OTHER ISSUES section above or the 

PARENT-CHILD RELATIONSHIPS BETWEEN ISSUES further down.  

LINKING SERVICE TYPE AND CATEGORY 

 

Service Type and Category in Help Desk can be associated to one another through Workflows. To do 

this: 

  

1. Go to Web Admin following a link like this: "mycompany.vizor.cloud/connectadmin and log in 

with an admin account. 

• Optional if adding a new Category choice: 

I. Navigate to the “Fields” tab and click on choice list button to the left of the 

screen.  

II. Select the Help Desk Project and the “Category” or “ProblemArea” choice list. 

III. Add a new choice, name it and select and ID from the ID drop down. 

IV. make sure the choice list is updated by clicking the "update now" button at the 

right side of the choice list editor 

 

2. Navigate to the "Workflow" tab and select "Help Desk" in the project dropdown. 

  

3. In Business Rules, look for an out of the box "Possible values" rule named "Service Type - Problem 

Area" 

4. Click on the rule and make sure the following values are set like this:  

o Condition Fields: Service Type 

o Action Fields: Category 

o "Enable in all Web views of the project" box: Checked. 
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o Evaluate when users change field values: Checked. 

5. Select or add rows on the business rule and click on each cell to update the values used in the 

conditions and actions according to your project. Here are some examples: 

 

6. Once you are done setting up business rules, click the "Apply" button next to the project 

dropdown. 

 

8. Wait until the message "Changes to workflow were successfully applied" pops up and click ok.   

*Note: Category and Problem Area may be used interchangeably and will show as one or the 

other depending on the level of your VIZOR customization.  

 

 

 

TICKET TASKS 
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Tasks pertaining to a given Incident or Problem record assist in establishing clear procedures or steps 

related to the issue. They help when the incident requires either more than one person to work on it or 

specific steps to be documented or followed. 

Tasks can be edited, assigned, created and set to be performed in sequence or in parallel depending on 

what one needs as per the illustration. In a sequence, the dependencies are created so the next task to 

be marked as completed needs the ones that come before it to be just as so. 

Your organization can also use Tasks for Checklists, to save time and standardize procedures. 

Hint: add Tasks to template issues, so they are copied over and help you when you create a new issue 

based on the template.  
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CONFIGURING THE TASKS GRID 

 

By default the Tasks tab shows a grid of the tasks of the issue: 

 

 
 

To change the columns in this grid, modify the Tasks Summary List Layout in the Admin > Project > 

Layout Editor. The Summary List Layout Tasks doesn't have to be exported to the view, HelpDesk in this 

case, however, the fields for the columns need to be exported to the view.   
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INTEGRATING WITH CMDB’S 

 

 

Visualize HR information, employee status, allocated assets and ongoing tickets and issues related to 

either. It will paint a much clearer picture for your team. 

Bridging the gap by bringing in the information into fileds like “Affected Computer” “Affected Asset” 

along side all the information that can be brought in from AD and many other sources will do the heavy 

lifting for your team when investigating and diagnosticating factors involved in incidents and problems. 

 

For more information on syncing your data, refer to the latest concerned documentation guides. 

Requestable examples: 

VIZOR – Integrating with ECM 

VIZOR – Integrating with AD 

VIZOR – Integrating with Vector Discovery 

VIZOR – Integrating with Lansweeper 

VIZOR – Integrating with RecoverKeys 

RELATED SERVICE REQUESTS 
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The helpdesk uses the tab and fields for Related Service Requests to keep your team informed of any 

pending item, to grant the ability to submit from the very incident or ticket, a related service request as 

well as the ability to edit or even remove such requests. Merging the self-service with your helpdesk area 

this way encourages a sharing of information which will reflect in your team’s ability to monitor the 

progress of any given incident or issue. For more information on Service Requests, see the dedicated 

chapter on Service Requests further below. 

RELATED CHANGE REQUESTS 

To keep 

track of incidents stemming from Related changes, VIZOR makes use of the tab Related Changes. Not 

only does it keep your team aware of any requests but it also allows for keeping tabs on the tickets for 
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issues caused by a given related change. Your team will gain insight from the repercussions of 

implementing such changes and further clarify the picture of known interactions or known errors across 

the board. 
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INTEGRATION WITH THE KNOWLEDGE MANAGEMENT 

Finding a quick diagnostic requires a fast search for information. With the Diagnostics tab, VIZOR will 

help leverage existing information in the ticket, and the knowledge base to quicken your team's ability to 

pin-point relevant articles. To do this, VIZOR picks up on the current values captured in the field 

Category and Subcategory in the overview tab and in the Diagnostics tab's fields Version and Web 

Browser. 

Having captured these fields, click on the Search KB button. This will bring up the results into view which 

were found to contain the matching parameters. Along with the field Subcategory in the KB articles, the 

other fields are also all optional in looking for potential matches. However, just one match is enough. 

MORE ABOUT WORKFLOW 

 

The preceding exercises demonstrated how the workflow controls the steps an issue follows as it 

progresses through the help desk process. They also showed how each step in the process is represented 

by a status value in the Status field.  

At each step in the process, an issue is also considered open or closed. Open issues are still active, or 

awaiting information. Closed issues have been resolved (fixed) or dropped (the problem can’t be fixed or 

reproduced). The read-only State field indicates whether an issue is open or closed. 
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The default workflow implemented in Vizor ServiceDesk is slightly more complicated than the simple 

process shown previously. 
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MONITORING HELPDESK ACTIVITIES 

 

Vizor ServiceDesk automatically tracks the progress of issues through the issue lifecycle. VIZOR 

automatically creates a unique identifier for each incident. It it a fundamental tool for tracking and 

monitoring incidents and your team’s response. It is called the Issue number or Issue ID and is 

automatically generated by the system. This enables users to check on the progress of issues and also 

provides reporting capabilities that allow managers to track and monitor support activities.  

Using the previously mentioned priority overriding, assignment to workteams, automatic escalation  rules, 

the Round-Robin auto-assignment and the closure sequence features – along with manual assignment by 

authorized staff – means VIZOR has all you need to determine or change the order in which incidents or 

issues are acted and by whom. 

 

REVISION HISTORY 

 

VIZOR ServiceDesk maintains a Revision History for each issue. The Revision History is a list of all changes 

made to the issue after it was first submitted. Each time you save an issue, Helpdesk records the changes 

in the Revision History.Each revision comes with a timestamp of the time, date, origin of the change, the 

field changed and a specification of both the previous and new value for the given field automatically. At 

the core, this logging o f incidents and other recrods is protected from alteration after-the fact as it is only 

modifiable by the system so as add entries and never produce any removal of remove entries. 

  

 

DUE DATE 

 

Your organization may want to use the optional Due Date field of a ticket, incident, or problem. The Due 

Date will help the team and the owner of the ticket to prioritize and adjust to specific deadlines and 

commitments. 

 

To use it, simply export the Due Date field to the HelpDesk web view. You can also export this field to the 

Self-Service view if you want to allow users to specify this date. 
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MAXIMUM TICKETS PER DUE DATE 

 

If you are using the Due Date, you may want to set a limit to the maximum number of tickets that are 

commited to the same date. Define the maximum based on the capacity of your team.  

 

 

To configure the Maximum number of HelpDesk tickets per Due Date: 

 

1. Go to the Configuration view. 

 

2. Select Settings on the top right. 

 

 
3. Identify the setting in the list or type “Maximum” in the search box. 

 

 
 

4. Click to open the setting, confirm the project is HelpDesk and update the value to the desired limit. 

 

 
 

5. Click OK. 

 

The setting is active immediately and users will not be able to submit records or tickets for the same Due 

Date if the maximum is reached. 

If a ticket with a given Due Date is resolved, users are allowed to submit again until the maximum is 

reached.   
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BLACKOUT DATES 

 

If you are using the Due Date, you may also want to set blackout dates for the due date. You can use 

these to take into account holidays, special events, vacation periods, etc. 

When users submit requests via VIZOR and a due date is specified, if the user selects a blackout due date 

a message is displayed and the request cannot be submitted until a valid date is selected. 

 

Administrators can define any number of blackout dates 

 

 

To configure the blackout dates for HelpDesk tickets: 

 

ENTER THE BLACKOUT DATES 

 

1. Go to the Web Admin > Fields > Choice Lists. 

 

 

2. Select HelpDesk in the project list and Blackout Dates in the Choice List. 

 

 
 

 

3. Enter the blackout dates or date ranges as choice values in the Blackout Dates choice list.  
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 The dates can be of two types: a single date or a date range. 

 

• date                  

 

single date entered using the format yyyy/mm/dd 

 

 

• start date -- end date 

 

Enter the date range using the syntax: 

        Start date -- End date 

 

Use two dashes to separate the dates and enter each date using yyyy/mm/dd. 

 

 

 

ENABLE BLACKOUT DATES 

 

1. Go to the Configuration view. 

 

2. Select Settings on the top right. 

 

 
 

3. Identify the setting in the list or type “Blackout” in the search box. 

 

 

4. Click to open the setting, confirm the project is HelpDesk and set 1 in the value to enable it. 

 

 

 
 

5. Click OK. 
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The setting is active immediately and users will not be able to submit records or tickets with the Due Date 

being a blackout date. Records or tickets that have a Due Date already set are not affected. 

 

 

 TOTAL ACTIVE TIME USING STATUS REPORT 

The “Total Active Time using Status” report calculates the total duration working hours per ticket by using 

the Status field known also as "Progress" or "Substate"). The process checks all tickets in State "Closed" 

and calculates the total time for each “Active” status change. The duration is set in working time (Hrs) and 

paused time (Hrs) in fields per ticket, after calculating the time the record has been historically in an active 

period or inactive period. 

Whenever the record is in a Status that is considered "Active time", the working time elapsed in that status 

will be added to the field "Duration Working Hrs". If a ticket is closed and reopened or goes through 

cycles of inactive times and then re-enter active times, the time is accumulated for each cycle. 

Whether a given Status is considered "Active time" or not can be defined in the "nActiveTime" in the 

"tblSubstate" table under the Help Desk def database. The values to set are: 1 =  Yes, 2 = No. 

  

 

 

 

 

 

 

 

By default, statuses that map to a State "Open" are active and the statuses mapped to State "Closed" are 

not active. 
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HOW IS THE ACTIVE TIME CALCULATED? 

The active time and the records are related through the predetermined SLA in the following way: 

  

• If the record has an SLA, it uses the associated service level working hours for calculating the total 

time. 

• If the record does not have an SLA, it uses the working hours of the global SLA for the ticket 

service type, or the first available global SLA if there is no global SLA for the service type of the 

ticket. 

The fields “Duration working hours” and “Paused Working Hours” can be used to display the Total Active 

Time information. You can add the fields into the web view so they are visible in your records or access 

the information by selecting the out of box list layout called “Total Active Time”. 

 

RUNNING THE TOTAL ACTIVE TIME REPORT 

The process can automatically generate an Excel report if there is a list layout called "Total Active Time". If 

not setup, this list layout can be created through VIZOR admin.  

To trigger the process, navigate to … \Vector\ConnectTools\VNConfig and run “VNConfigUtils.exe” and 

launch the VNConfig task "Run Duration Working Hours Calculations using Status". 
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The VNConfig task will then take from this list layout to generate the report and save it to 

…\Vector/connectserver/<project name>/reports/Total Active Time.xlsx 
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CHAPTER 3 - ARCHITECTURE  

 

 

ARCHITECTURE DIAGRAM 

 

VIZOR is a Web based product, the architecture is relatively simple. All of the components below could be 

located on one Server. 

 

SINGLE TIER INSTALLATIONS 

 

                    

 

• Vizor Server 

 

• Vizor Admin (workstation or 

server) 

• Vizor Web View Editor 

 

• SQL Database Server 

 

• Exchange Server Integration 

 

• Web Browser (for accessing Vizor and 

Vizor Web Admin) 

 

• Vizor Admin (workstation or server) 

 

Workstations 

Web Server + Database Server 

Mail Server 
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MULTI-SERVER SETUP  

The VIZOR architecture supports the following multi-server architecture.  

To install this configuration several items need to be manually configured on each server. 

 

                    

 

 

 

 

 

 

  

• SQL Database Server 

 

• Vizor Server  

• Vizor Web View Editor   

• Vizor Admin (workstation or 

servers)  

 

• Web Browser (for accessing Vizor 

and Vizor Web Admin) 

 

• Vizor Admin (workstation or 

servers) 

Workstations 

 

Web Server 

 

Database Server 

E-Mail Server 

(Exchange) 

 

• Exchange / Outlook 
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CHAPTER 4 - LOG IN TO VIZOR 

VIZOR supports multiple authentication methods, allowing users to log in with accounts from the 

following sources: 

• VIZOR user accounts (created directly within VIZOR). 

• Active Directory user accounts. 

• Azure/Microsoft user accounts. 

• Windows user accounts. 

• Single Sign-On (SSO) for Seamless Access 

For Active Directory, Azure/Microsoft, and Windows accounts, VIZOR supports Single Sign-On (SSO). 

This means, users do not need to manually log in to VIZOR with their Windows or network credentials. 

Additionally, if the user is already logged into their Web browser or Windows system, they are 

automatically authenticated in VIZOR without needing to re-enter their credentials. 

SSO ensures a better login experience while maintaining secure access to VIZOR. 

 

LOGGING ON 

VIZOR contains multiple views that provide tailored access to different areas of the platform, such as 

HelpDesk, Assets, and Users. Each view focuses on specific functionalities and displays relevant 

information and fields based on user permissions. 

Understanding Views and Permissions 

• Views: Determine the specific data and options available to the user, such as issues in HelpDesk, 

asset details in Assets, or user management in Users. 

• Permissions: Controlled by the VIZOR administrator, permissions define which views and data a 

user can access. 

Example Logon Accounts and Permissions 

VIZOR comes with pre-configured accounts for demonstration purposes. These accounts showcase how 

different permissions impact access to views and data. 

• Administrative-Level Accounts 

These accounts have permissions to access all views and data: 
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o admin (Password = admin) 

o demo (No password required) 

 

• Role-Based Accounts 

Role-based accounts in VIZOR provide users with restricted access to specific views and features, 

tailored to their assigned roles. 

o Role Management: 

User roles in VIZOR are configured and managed via the Roles & Policies view. 

Administrators can create, define, and update roles to align with organizational 

requirements. 

o Configuration: 

Roles determine which views, features, and data users can access.  To configure the 

features and projects available to different user groups or roles, use the Web Admin 

Panel: https://YOURCOMPANY.vizor.cloud/connectadmin 

For more details on managing roles in VIZOR, refer to Chapter 5 – People and Organizations 

(Page 92). 

 

• Submit-Only View for HelpDesk 

The Report Issue view enables users to submit new issues to the help desk without requiring a 

logon account. It is accessed directly via a URL. 

By default, internal information added by administrators or analysts is hidden from non-administrative 

views. The VIZOR administrator can customize roles, permissions, and accessible views based on 

organizational needs. 

LIMITATIONS WHEN LOGGING IN WITH MULTIPLE USER ACCOUNTS 

Due to the architecture of VIZOR, it is not possible to have multiple active sessions using different user 

accounts simultaneously on the same system. 

Why Does This Happen? 

Modern web browsers store user-specific session information (like cookies) across all open tabs and 

windows. As a result, attempting to log in with a different account in a new tab or browser window will 

still use the original session's credentials. 

Simply closing a tab where VIZOR is active does not log off the user, and some session data persists in the 

browser. This behavior is similar to systems like Microsoft Office, where closing an application does not 

necessarily log you out. 

https://yourcompany.vizor.cloud/connectadmin
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Best Practice: 

To ensure that no session information from the previous user is reused, we recommend the following 

steps: 

1. Log off from your current VIZOR session. 

2. Close all browser windows and tabs completely before attempting to log in with a different 

account. 

Thiw way, you can ensure a clean and secure session when switching between user accounts. 
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CHAPTER 5 - PEOPLE AND 

ORGANIZATIONS 

Information about people and their accounts are important in VIZOR for: 

1. Logon accounts, to log in to VIZOR. 

2. Allocating assets to people. 

3. Onboarding new hires. 

4. Deprovisioning employees who leave. 

5. Request approvals for actions, change requests, give assets to employees, etc. 

6. Contacts of people who do not log into VIZOR but will receive email notifications.   

 

In VIZOR, people accounts can be of two main security types: Users and Contacts. People accounts 

typically belong to an organization or company.  

 

USERS 

Users can log into VIZOR and to do so they have a logon account and credentials (user and password). 

The logon account may be native to VIZOR or it may be via a 3rd party such as Active Directory or LDAP. 

Users have a logon account and they can log into VIZOR to use any Self-Service area that has been 

allowed by the administrators of the system. 

 

Employee is a type of user that is commonly used when managing assets internal to an organization. 

Employees are often imported from or synchronized with Active Directory or an HR system.  
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MANAGERS OF EMPLOYEES 

Occasionally, some workflows make use of the concept of the “manager of an employee”. For example, 

requested assets often need to be approved by the manager of the employee requesting the asset, in 

which case it is not practical to add a fixed name in the list of approvers. 

For these scenarios, VIZOR has a special macro is dynamically resolved and that allows you to send the 

approval to the person that happens to be the manager of the employee at the time of the request. 

 

WHO IS MY MANAGER?  

The Manager of an employee is the person that is responsible for the Department, according to 

the employment information. Because the Manager is defined in the Department (Roles & Policies 

area), this means it is easy to make a change when the manager is changed.  

To know the manager of an employee: 

1. In the Employees area, select the person you want to know.  

2. Click on the Employment tab and check what department the employee belongs to. 

3. Go to the Roles & Policies area and select the Departments query. 

4. Click the name of the department the employee belongs to from the list or search for it. 

5. The name of the manager is displayed in the Responsible field. 

 

IMPORTING MANAGERS OF EMPLOYEES 

If you are importing the list of employees from an external source or synchronizing with a Human 

Resources (HR) system, it is possible to also import the manager of each employee. The actual mapping of 

fields depends on the type of source. Please contact support for more details on how to import this 

information. 

 

CONTACTS 



  Page 94 

 

Contacts cannot log into the system but are referred to in processes, assets and tickets. They can receive 

emails and be used in fields of assets, licenses, purchases, tickets, etc. For example, a contact could be a 

person that sells software from a vendor and does not need to log on to VIZOR. 

By default, incidents include a number of fields to capture the submitter of the incident, their contact 

information and also a way for them to declare their preferred method for receiving related notifications. 

 

ORGANIZATIONS OR COMPANIES 

Organizations are also referred to as Companies. You can have one or many Internal Organizations and 

one or many external organizations. Examples of External Organizations are: Customers, Vendors and 

Resellers. 

Customers are Companies or External Organizations in VIZOR. 

Each Company can have one or more associated people. A Company record can have both associated 

Contacts and Users. 

 

USER GROUPS  

User Groups in VIZOR are like roles in the VIZOR system, which allows easier administration of views, 

accesses, permissions and other rules to fit the needs of the organization. 

Each roles is represented by a Security User Group, managed from the Web Admin. 

These roles have a default combination of views and features that are typical for their use of the system. 

The roles are very useful to profile the different functions of users in the VIZOR system depending on their 

function or focus of interest (software licenses, it hardware assets, hr-it, helpdesk, etc.). 

You can create any number of User Groups to fit the requirements of your organization. 

Default User Groups or VIZOR Roles: 

 User Group Demo user Function Views 



  Page 95 

 

 

Software 

Managers 

Daniel Ambler 

Logon=software 

 

Manages Software and 

Software Licenses 

Software Licenses 

Agreements & 

Purchases 

Employees 

My Actions 

 

IT Asset Managers 

 

Donald Nathan 

Logon=assets 

 

Manages IT assets, 

primarily hardware 

assets 

Assets 

Employees 

Locations 

Agreements & 

Purchases 

My Actions 

Roles & Policies 

 

IT Managers Martin West 

Logon=itmanager 

 

Manages general IT 

activities, budgets, 

assets, etc. 

Manages policies for 

asset provisioning. 

Assets 

Software Licenses 

Employees 

Locations 

Agreements & 

Purchases 

My Actions 

Roles & Policies 

Approve Change 
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Requests 

Help Desk Incidents 

 

Employees  Employee User 

Logon=employee 

 

Regular staff that uses 

services from IT and 

HR, such as submitting 

tickets to HelpDesk 

and requesting assets 

 

Request Assets 

Search KB 

Submit a HelpDesk 

Ticket 

Helpdesk Analyst Help Desk Analyst 

Logon=analyst 

Manage helpdesk 

incidents and 

problems. Edit 

knowledge base and 

FAQ articles 

 

Help Desk Incidents & 

Problems 

Change Requests 

Search KB 

 

HR Manager Marianne Rosen 

Logon=mrosen 

 

Monitor employee 

hires, terminations and 

turnover across the 

organization. Initiate 

employee Onboarding 

and termination 

processes.  

 

New Employee 

Onboard 

Batch Onboard 

Terminate Employees 

Employees 

Locations 

Roles & Policies 

Release Manager Chris Hubbard 

Logon=chubbard 

Uses the release 

manager project only. 

For select demos at 

the moment. 

Release Management 
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ORGANIZATIONAL ROLES AND ORGANIZATIONAL UNITS 

In order to manage better your assets and automate the provisioning or de-provisioning, VIZOR allows 

you to define and organize roles within your organization, map users to roles, and map assets to roles. 

For the assignment and organization of roles, VIZOR uses the following types of entities: 

• Organizational Units  

• People/Employees  

• Roles  

• Assets  

 

ADDITIONAL FIELDS 

Organizations may need additional fields for their User, Contact, Customer and Company accounts. 

If you need an additional field, chances are VIZOR already has it as a built-in field but it may not be visible 

in the user interface. 

 

You can view the list of all fields regardless of whether they are published in a Web view or user interface 

by going to the Web Admin > Fields > Fields. 

Some example fields are: 

 

Field Name Notes 

Second Last Name Some countries use a Second Last Name or 

Surname. This is the case for most Spanish-

speaking countries, for example. 

 

 

 



  Page 98 

 

ADDITIONAL FIELDS - EXAMPLE 

In the following example we will walk through the process of adding a new field: Middle name.  

• Open the Web View Editor on the VIZOR server. 

• Select the Web view called “Users&Contacts / Security view” from the list. 

• Once loaded, go to the Fields area on the left. 

• The field Middle Name is in the Info tab. Locate the field in the left or right list to determine if it’s 

already in the Web view (on the right side) or not in the Web view (on the left side). 

 

 

 

Once it is ‘exported’ to the Web view, on the right side, double click on it to see the field attributes. Check 

the field is Visible: Yes. 
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Close and click on the top bottom “Generate View”, right from the “Save” button. 
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INTEGRATION WITH HUMAN RESOURCES - HR SYSTEMS 

 
VIZOR can integrate with a Human Resources (HR) management system via connectors or via 

export/imports. Please contact Vector Networks to know if a connector for your system already exists.    

 

WHAT WILL THE INTEGRATION BETWEEN VIZOR AND THE HR SYSTEM DO?  

1. Import additional employee information.  

Import information that may not available in Active Directory. 

 

2. Synchronize Departments and Job Titles catalogs. 

 

3. Automatically provision assets for a new employee 

VIZOR can be configured to detect new employees and, based on their roles, start the provisioning 

process of all the assets the employee needs. 

 

4. Automatically deprovision assets for en employee leaving the organization 

VIZOR can be configured to detect when employees will be leaving the organization and start 

recovering the assets assigned to the employee (de-provision all the assets of the employee). 

 

5. Automatically provision or deprovision assets for en employee changing job/role 

VIZOR can be configured to detect when an employee changes job and adjust the assets assigned to 

her accordingly. 
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CATALOGS 

VIZOR can import and keep synchronized the following entities either through a connector specific to the 

HR system or via export/import: 

- List of Departments 

- List of Organization Units 

- List of Job Titles 

- List of Job Positions 

 

EMPLOYEE/PERSONAL INFORMATION 

Examples of typical information that can be synchronized between VIZOR and the HR system are:  

- Type of user (Employee, Staff, Volunteer, etc.) 

- Manager of employee 

- Supervisor of employee 

- Department of employee 

- Job Title of employee 

- Job Position of employee 

- Status of Employment 

- Employment Start Date 

- Employment End Date 

- Employee ID 

- Full Name or parts of it, like Middle Name, Second Last Name, etc. 

- Title (different from the Job Title) 

- Nickname 

- Email address (usually also in Active Directory) 

- Organization or Company the person belongs to 

- Address 

- City 

- State / Province 

- Country 

- Phone numbers (multiple) 

- Hours of Availability 

- Location Room or Sub-room  
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MODIFYING THE INTEGRATION 

 

You can modify integration via the VIZOR Import Manager. You can create new rules or modify existing 

ones of the types: People from (source), as in the screenshot below. 

 

You can specify when to synchronize and how to synchronize in the Import Settings step: 
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Use the Global Mappings to set the default values, the order of precedence and the mapping of fields 

between the external source and VIZOR: 

 

 

 

VIZOR has a native connector for a few systems like Infor and SmartStream, however, it uses a common 

interface and can integrate with others. Please contact Vector Networks for more information. 
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IMPORTING USERS FROM AN EXCEL FILE  

 

• On your Home Page, click on the “Users” link to access the “Users” web view:  

 

  

• Once in the “Users” web view, click on the “Import” button to open the Self-Service 

Import assistant  



  Page 105 

 

 

  

  

• The Import assistance will open, follow the instructions:  

a. Download the template from the link provided and fill in the user information to 

import.  

• The template will look like this. Update it with your user’s information  

 

• As seen on the image before, you will be asked to fill in your user’s information in 

the following fields:  

  

1. User’s First and Last name  

2. Unique ID: This is the ID of the person in the external source from 

where they were imported. For example, if the user was imported 

from an HR system, this would be the employee number  

3. Company name: The user’s company of origin  

4. Category: This includes several values as  

 

• Contractor 

• Consultant 

• Employee 

• Intern 

• Etc. 

 

5. Email: The user’s email address.   
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6. Fields highlighted in blue are mandatory, fields in black are 

optional.   

  

  

• Click on Import files and then upload the file you want to import.  

• If the “Enabled” slider is set to No, set it to Yes   

• Once completed, if you aren't planning to import additional users again soon, set 

Enabled to No  

 

• Once the import is completed, the assistant will give you a rundown of the users 

imported.  

In this example, 424 users were processed, 423 were synchronized and 1 of them was a  

brand new addition. 

   

• Your users have now been imported.  

• To update users or add additional information, simply repeat the process and fill in the 

template with the updated information. Upload the template to update the import.  
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CHAPTER 6 - ASSET AND SOFTWARE 

ALLOCATION 

You often need to track the allocation of assets. Assets can be of multiple types and they all share 

common behaviours as assets, whether they are a computer, a hardware graphics card, a projector, a 

router, a Network Account or a Software Asset.  Software Assets are a special type of assets that offer 

more functionality than regular assets. The extended functionality help manage Software Assets more 

efficiently.  

When assets are allocated to a person for use, we call them “assigned”. Assets are typically allocated to a 

person (assigned), like an employee, but they can also be allocated at the same time to other entities like 

departments or locations. In general, assets can be allocated to the following: 

• Person (a user), this is referred to as “Assign” and the Status of the asset becomes “Assigned”. 

• Location (room, building, etc.). The Status of the asset is not changed by this allocation. 

• Department. The Status of the asset is not changed by this allocation. 

• Project. The Status of the asset is not changed by this allocation. 

• Unit or Division. The Status of the asset is not changed by this allocation. 

• Computer (in the case of Software) . The Status of the asset is not changed by this allocation. 

 

VIZOR keeps track of how many assets or software licenses you have and identifies any surplus inventory. 

It decrements your available licenses every time a license is allocated and increases it when the license is 

de-allocated. Hence your inventory stays current and accurate.  

Tracking allocation with VIZOR helps you manage costs and budgets, it helps you know if and when all 

your surplus licenses get redeployed. VIZOR allows you to start the request for purchasing new software 

or stop taking orders depending on your organization’s preference. 
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ASSIGN: WHAT HAPPENS WHEN AN ASSET IS ASSIGNED?  

When an asset is assigned to a person, the Status changes to Assigned and the Assigned Date and 

Assigned Time fields are automatically set to that date and time. The assigned person is also known as the 

Owner of the asset. 

Also, the asset’s Organization, Location, Department and OU can be set automatically to those of the 

assigned person. This is sometimes referred to as the asset follows the user’s context. 

For example: 

Laura is in a student with these fields in VIZOR: 

Location:   USA \ Chicago \ Franklyn Elementary \ Floor 3 \ 301 

OU/Organizational Unit: /Students/3 

For this example, Department and Organization are not relevant in this VIZOR installation, and all 

users share the same. 

 

And there is a computer asset: 

Serial Number: SGF24JJH78009-012 

Asset Tag: LAPT-02-03341 

Location:  USA \ Chicago \ Franklyn Elementary \ Ground Floor \ IT Storage Room \ 

Cabinet01 

OU/Organizational Unit: /UnassignedDevices/Franklyn Elementary 

 

If your VIZOR has the configuration setting “Asset Location and Department follows the assigned person” 

enabled, the asset’s locations, OU etc will be changed to the one of the assigned person. 

You can also turn off this behavior or only enable it for some cases. 

To turn off the behavior in all cases, set the configuration setting to 0. 

To have the behavior enabled only in some cases, modify the built-in query “Follow the User Context” 

(query ID 101) to have the conditions that assets should have to follow the assigned user’s context. 

That is, assets that match the condition are then set the Organization, Location, Department and OU of 

the user they are assigned to. 
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CONFIRM ACCEPTANCE 

After the asset is assigned, you may want the user the asset was allocated to to confirm the acceptance of 

said asset. In order to confirm the receipt of the asset, navigate to the "My Items" web view. In this view, 

you will be able to view all equipment allocated to you and electronically confirm acceptance of 

equipment receipt. 

It is possible for the administrator to configure VIZOR to send an email with a link for the user to accept 

receipt automatically after an asset is assigned. 

 

 

While in the "My Items" view, click on one or more assets to acknowledge reception for and click on the "Confirm 

Acceptance" button in the right tool bar. 
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Clicking on this button will prompt a message of confirmation of acceptance. By 

doing this the user confirms that the selected asset has been received and terms 

and conditions are accepted. You can access the terms and conditions PDF by 

clicking in the link within the message. This link can be modified by the 

organization and will be the same for all assets. 

 

 

 

Administrators have the capability of checking the timestamp of the reception acknowledgment by going 

into the “Details tab” in the Assets view.  
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It is also possible to create a query that shows a specific type of asset that are “assigned” and have not 

been accepted (For which the “User Confirmation On” field is empty). 

 

 

ALLOCATIONS TO DEPARTMENTS, LOCATIONS, PROJECTS AND ASSET CONTAINERS 

In addition to assigning an asset to a person, it is often needed to allocate a number of assets to a 

Department, to a Location, to a Project or to an arbitrary pool of assets for which a person is responsible 

for ( an asset container). 

ALLOCATING EXISTING ASSETS TO DEPARTMENTS, LOCATIONS OR PROJECTS  

To allocate one or more existing assets to a specific department, set the field “Department” in the details 

of the asset. Do the same for Location or Project with the field “Location” and “Project” in the Allocation 

tab of the asset instance. 

If you want to allocate/reserve some assets to a Department, Location or Project: 

1. Go to the Assets area  

2. Use the search or drill down to see the asssets you intend to allocate. 

3. Select all the assets you want to allocate by clicking on the row. 

4. Click on Mass Update 
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5. In the form that opens, go to the Allocation tab and set the field Department, or Location or Project 

as desired. 

 

 
 

6. Click OK to apply the changes. 

 

When an asset is allocated to a department it can still be assigned to a person, at any time. This allows 

departments to receive pools of assets and assign them to people at a time when is needed. 
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ASSET CONTAINERS - POOLS OF ASSETS  

In some cases, the pool of assets is not based on a department, project or division. VIZOR allows you to 

create a type of asset called Container and add arbitrary assets to it. You can then designate a person 

responsible for the pool of assets, regardless of the person’s position, department or location. 

For example, a team leader is given 10 licenses of software ABC, which she will later assign to the team 

members. In a similar way to allocating assets to a department, simply create a pool and add the 10 assets 

using the Mass Updates function (software in this example).  

A person can view what assets she is responsible for by selecting “My Containers” in the query list of the 

Assets view. 

 

IPAD ASSIGNMENT 

iPads may not automatically update to follow the user's location and context when assigned, unlike other 

devices like Chromebooks. This discrepancy may be due to specific limitations or configurations for iPads. 

Suggested Actions 

• Check Asset Type Limits: Ensure the system allows only one iPad per user as per allocation rules. 

• Verify Existing Allocations: Confirm the user does not already have an iPad assigned, which might 

block new assignments. 

• Check for Containers: Ensure the iPad is not part of a cart or container, as this can prevent 

location updates. 

• Enable User Context Query: Confirm the System: Follow the User's Context query is active for 

iPads in system settings. 

If the issue persists, additional investigation may be required to identify system constraints or 

configuration issues. It is advided to contact your support team. 
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ASSET DEALLOCATION  

VIZOR is a great tool to optimize the usage of your Software and other assets as people join the 

organization, leave the organization or change roles, thus having different needs with regards to assets.  

The following are typical scenarios where VIZOR deallocation is used: 

Employee changes position  

Employee terminates job 

Employee requests a new or different asset to replace an existing one 

Employee returns asset from a temporary loan 

One asset needs to be allocated to a different location 

IT person finds an asset that should no longer be allocated  

 

ASSET QUANTITIES 

 

You can easily know the total number of assets of a certain type by opening the Asset Type record and 

going to the Allocation tab. You can also query these fields, which are valid only in a record of type Asset 

Type: 

• Total_Assets 

Total number of Active assets of that type. Retired assets are not counted. 

 

• "Assets_in_Use" 

Total number of assigned assets.  

 

• "Assets_Remaining"  

Total number of assets in Stock or Storage. 

 

 

Please note that the field Total_Allocated is only valid in the context of bulk container assets. 

 

 

 

SOFTWARE ASSET ALLOCATIONS 
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Software is a special case of assets. For each license entitlement entered in the Software License area from 

a purchase, VIZOR automatically creates one Software Asset instance, which can then be allocated to a 

person (user) or a computer (device). 

 

SUMMARY OF ALLOCATIONS 

 

In the Software Licenses area, you can view the overall status of the allocation of software licenses for a 

given Software Asset Type by opening the Software License record. 

Click on the Allocation tab. 

 

 

 
 

 

The Software may be allocated in the following ways: 

• Allocate to people or users 

• Allocate to computers or devices 

• Allocate to a License Server 

 

VIZOR calculates and displays the information in the Allocation tab differently depending on the type of 

allocation. 

 

 

 

ALLOCATION TYPE 

 

The Software may be allocated in the following ways: 
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• Allocate to people or users 

• Allocate to computers or devices 

• Allocate to a License Server 

 

The Allocation Type of a Software License record is displayed in the Compliance tab. The value is 

controlled by the Licensing Calculation field. 

 

 
 

 

An administrator can change the setting in the Web Admin > Workflow > License Manager: 
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LICENSE SERVERS 

A software license server is a centralized computer which provides or allocates the license instances to the 

client computers or users in order to enable licensed software to run on them. Each allocation or instance 

of a license is also known as an access token or a key. 

 

The license server is responsible of controlling the number of running instances of a program based on 

the license entitlements allocated or registered in the license server. 

 

It is up to the License Server to determine how the licenses available are assigned to the client computers 

or users. Many use floating licenses, in which one access token or license is taken by each instance 

running on a client computer. 

However, the final allocation of these licenses can be on reserved named-users or specific computers. 

 

Use the Allocate button in the Allocation tab to allocate tokens to a specific License Server: 
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ALLOCATING ASSETS TO DEPARTMENTS OR LOCATIONS FROM THE PURCHASE  

 

The best way to allocate or reserve the software assets / licenses to a Department, Project or Cost Center 

is directly from the Purchase. 

Each Purchase Line Item contains information that allows VIZOR to automatically create the specified 

number of assets (asset instances) that will be assigned to users afterwards.  

When a Department, Project or Cost Center is specified directly in the Purchase Line Item, all software 

asset instances that are automatically will be reserved or allocated to the specified Department, Project or 

Cost Center. 

 

 
 

 

ALLOCATING EXISTING ASSETS TO DEPARTMENTS, LOCATIONS OR PROJECTS  

To allocate one or more existing assets to a specific department, set the field “Department” in the details 

of the asset. Do the same for Location or Project with the field “Location” and “Project” in the Allocation 

tab of the asset instance. 

If you want to allocate/reserve existing software assets to a Department, Location or Project: 

1. Go to the Software Assets area  

2. Use the search or drill down to see the software asssets you intend to allocate. 

3. Select all the assets you want to allocate by clicking on the row. 
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4. Click on Mass Update 

 
 

5. In the form that opens, go to the Allocation tab and set the field Department, or Location or Project 

as desired. 
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6. Click OK to apply the changes. 

 

When an asset is allocated to a department it can still be assigned to a person, at any time. This allows 

departments to receive pools of assets and assign them to people at a time when is needed. 

 

 

VIEWING ALLOCATION PER DEPARTMENT, LOCATION OR PROJECT 

There are several ways to view how software is allocated per Department, Location or Project. 

• View the summary in the Allocation tab. 
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• View the report Allocated by Department or by Location. 
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• Go to the Locations area, and click on the desired Location. Click on the Assets tab to view assets 

allocated to that location. 

 

 

 

 

 

 

• Create an ad-hoc custom report or summary list directly from the Web view. 
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ACCESS DATA FOR ONE DEPARTMENT OR ONE LOCATION ONLY 

You organization can also limit users to only view the Software Assets allocated to their own Department 

or Location but not any others. This also limits the user to view only Purchases and Software License 

records that are for their own Department or Location. 

To control this: 

1. Go to the Web Admin > Security > Groups 

2. Select the Group from the list where you want to limit the accessible data to users. 

 

3. Click on Features and add or remove the features that control Access to All Departments, Access to 

All Locations and Access to All Organizations. 
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4. Click OK to apply the changes. 
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IMPORTING LOCATIONS FROM AN EXCEL FILE 

 
 To import the list of locations from an Excel file: 

 

1. Access VIZOR with an admin account. 

2. Open the "configurations" web view. 

3. Search for "lists" in the top right search box. 

4. Open the "Import location" link and follow the instructions: 

  

Import Locations from an Excel file. 

1. Download the Locations-ImportTemplate.xlsx file and fill in the data to import. 

2. Click on Import Files and browse to the file you have filled in. 

3. Click On Upload File. Your data will be imported at that time. Close the upload files dialog. 

 

MAPPING CHOICE VALUES DURING IMPORTS (IMPORT ALIASES)  

  
When importing Users, Assets, Tickets and other records, the source may have fields (or columns) to 

import into single-choice fields in VIZOR, like Location, Department, Job Title, and many others. Normally 

the value to import needs to match one of the valid existing choices for that field in VIZOR, otherwise the 

value is automatically created as a valid choice, adding an option to the list. The automatic creation of 

new choices can be turned off.   

  

In some cases, the source data may have a value that does not match a choice in VIZOR but that should 

be mapped to an existing one.  

   

For example, in a user import: 

 

If the Location field has the value "LA" from the source and the corresponding valid location in VIZOR is 

"USA>Los Angeles", it is not desirable or convenient to create a new location named "LA" as this would be 
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redundant. Instead, the administrator can resolve this by giving an alias to the "USA>Los Angeles" 

location.  

  

The alias "LA" can be entered in the "USA > Los Angeles" location in a field called: 

  

     Alias_1 

or 

     Import_Alias_1 

  

Both naming conventions are supported and, as the number “1” suggests, multiple aliases can be set for 

the same choice value (a location in this case). 

  

To enter the value from the user interface, the administrator may need to export the alias field to the 

appropriate Web view. 

  

In this example, the field Alias_1 already exists in the VIZOR project "Roles", where Locations are stored, 

and it would be probably needed to export the Alias_1 field to the Web view "Roles/Manage" using the 

Web View Editor tool. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once exported, you can enter the alias "LA" for the "USA > Los Angeles" location, and any other aliases 

needed.  
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• You can add multiple aliases for the same location / choice value. VIZOR will match the first value 

starting with Alias_1, Alias_2, Alias_3, etc. or Import_Alias_1, Import_Alias_2, Import_Alias_3, etc. 

 

• You do not have to enter an alias for each location if one location has an alias. Aliases are 

optional per location / choice value. 

 

• Avoid duplicate names in the aliases; only the first match will be used. 

 

• Specifically for locations: the value in the alias does not have to follow the location hierarchy. That 

is, "LA" will match the complete "USA > Los Angeles" if the alias is "LA". The alias does not have to 

be "USA > LA".  
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ASSIGNING SOFTWARE ASSETS   

 

Software Assets are assigned to a person or to a computer. This depends on the Allocation Type of the 

Software License record. 

 

Once assigned or allocated to a person, the Status of the asset changes from In Stock to to Assigned. 

 

You can always know the complete status of a Software Asset via the Status and the Provisioning Status.  

As described in the Software Licenses, the Status indicates the life-cycle of the individual software license, 

account or record, while the Provisioning Status indicated the temporary status while it’s being deployed, 

provisioned or deprovisioned to the user. 

 

All the licenses that can be distributed to users or computers are in Status In Stock.  

 

Licenses distributed and consumed have a Status: Assigned and a Provisioning Status of Provisioned.  

 

Licenses that have reached End-of-license and should be removed have a Status: Retired-Expired and a 

Provisioning Status of Provisioned. This should be a temporary situation. 

 

Licenses that were harvested and can be reused have a Status of: In Stock and a Provisioning Status of 

Deprovisioned.  

 

 

Software Assets, where each one may represent a license, can be assigned in the following ways: 

 

1. IT assigns a software asset to a person or computer  

2. IT assigns software assets to multiple people or computers 

3. Auto assign software asset to a person from a Request 

4. Auto assign software asset to a person from Onboarding 

 

 

IT ASSIGNS A SOFTWARE ASSET TO A PERSON OR COMPUTER  

 

In this scenario, an IT person assigns one software asset to a person or to a computer. 

 

To do this:  

 

1. Go to the Software Assets area.  

2. Use the search or drill down to see the software assset you intend to allocate. 

3. Click on the row to open the details of the asset.  
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4. In the form that opens, go to the Allocation tab and set the field Allocated to Person as desired. 

Note you can also set the Computer / Device. 

 
5. Click OK to apply the changes. 

 

When an asset is assigned to a person, the automatic provisioning actions are triggered.  

 

 

 

IT ASSIGNS SOFTWARE ASSETS TO MULTIPLE PEOPLE OR COMPUTERS 

 

In this scenario, an IT person assigns software assets of the same Software Asset Type (e.g. Adobe 

Photoshop) to multiple people or computers at once.  

 

To do this:  

 

1. Go to the Software Licenses area.  

2. Use the search or drill down to see the Software License record you will allocate. 
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3. Click on the row to open the details of the Software License record and go to the Allocation tab.  

4. Click on the Allocate button 

 

 
 

5. Depending on the type of allocation of the software (per user or per computer), a dialog to select the 

users or computer will open. 
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6. Click on the list to select multiple users or computers to allocate the software to. 
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7. Click OK to complete the allocation. 

 

Important considerations: 

 

• VIZOR automatically allocates a software asset to each person if there are available (Status = In 

Stock). 

• VIZOR automatically check if there are software assets in stock and reserved or allocated to the 

Department or Location of the specified person. 

• If there is a software asset available and allocated to both the Department and the Location of the 

specified person, that asset is assigned. 

• If not, VIZOR checks if there is a software asset available and allocated to either the Department 

or the Location of the specified person. If there is one, that asset is assigned. 

• If not, VIZOR checks if there is a software asset available and not allocated to any Department or 

Location, and assigns that asset. 

• Once assigned, the Department and the Location of the Software Asset will be automatically set 

to the Department and the Location of the person it’s allocated to. 
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AUTO ASSIGN SOFTWARE ASSET TO A PERSON FROM A REQUEST  

 

When the process starts from a Request, the software can be automatically assigned after the request is 

approved (if that Software Asset Type requires approval). 

The Request may initiate from the self-service Request Portal or from a manager requesting an asset for 

an employee. In both cases the process is the same. 

To learn more about the Request process, go to Service & Asset Requests and to learn more about the 

automatic assignment or fulfillment of the request go to Fulfilling Requests.  

 

 

AUTO ASSIGN SOFTWARE ASSET TO A PERSON FROM ONBOARDING 

 

The Software Asset may be assigned and then provisioned to a person as the result of the person joining 

the organization (new hire) or starting a new role or job. The process of the automated onboarding and 

user provisioning requires that the organization defines first what software should be automatically given 

to what type of user. 

The rules or policies that control this are defined per Asset Type, in the Software Asset Type area. 

To learn more about the onboarding and automated user provisioning, go to Onboarding and Automated 

User Provisioning.  
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WHAT HAPPENS IF WE NEED MORE LICENSES OF A SOFTWARE ASSET TYPE? 

 

As described in this guide, VIZOR helps you keep track of software allocation, and installations.  

By monitoring the Asset Quantities you can reorder licenses automatically from the vendor or start the 

purchasing process. 

Using the Notification editor, create a notification like: 

 Assets_Remaining   <  Minimum Quantity 

  Asset Type  = MySoftware 

 

Where MySoftware is the software to order more licenses for.  

 

Send the email notification to purchasing or to the Vendor for ordering. 

 

 

AUTOMATIC ALLOCATION 

 

VIZOR can automatically allocate assets to users in several scenarios. You can turn on the specific auto-

allocations that your organization needs in the Configurations area. 

 

AUTO-ALLOCATION OF LINKED ASSETS   

VIZOR automatically allocates all the assets linked to a computer when the computer is allocated to a 

person. For example, if a computer has a linked keyboard, mouse, monitor, printer and computer case, 

when allocating the computer to a person, all the linked assets will automatically be allocated too, and the 

location and department set for these dependent assets in the same manner and under the same rules as 

the parent device. 

Likewise, when that device is returned, all the dependent assets will be automatically returned. 
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AUTO-ALLOCATION OF CONTAINER ASSETS   

VIZOR can automatically allocate all the assets in a container when the container is allocated to a person. 

For example, if a Chromebook Cart has multiple devices, you can allocate all of them at once when 

allocating the container to a person. 

Likewise, when that container asset is returned to storage, the dependent assets should be automatically 

deallocated. 

 

Example: create a Chromebook Cart of type Container and add a few computers to it. In VIZOR, the link is 

indicated via the field  "Container", which points to the container asset. 

 

When allocating the cart to a person, if the auto-allocation of containers is ON, all the contained assets 

will be automatically allocated to this person, and the location and department set for these dependent 

assets in the same manner and under the same rules as the parent device. 

 

AUTOMATIC ASSET ALLOCATION FROM RECENT USERS 

One of the main functions of VIZOR is to keep track of what asset is allocated to what person. For this 

purpose, each asset has the field “Allocated to Person”. This is field is set to either “None” or to a valid 

user/person in VIZOR. 

The auto-allocation from recent users is only available to computers and server computers are always 

excluded (they are never auto-assigned in this way). 

MOST RECENT USER 

How is the most recent user obtained? 

The most recent user is usually found by a discovery tool like Microsoft ECM/SCCM, Vector Discovery 

(VAM) or Google Admin. 

VIZOR checks the values of these fields, in this order, to find the most recent user: 

1. Primary Owner 

2. Top Console User 

3. Recent Users 
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The order of this fields also indicates the order of priority in VIZOR. If VIZOR finds a user in Primary 

Owner, it will not use the other two fields. 

The fields Primary Owner and Top Console User are usually for computers found by Microsoft ECM and 

Vector Discovery (VAM), while Recent Users is typically used by G Suite / Google Admin. 

WHEN? 

How often the validation and auto-allocation happens? Can I trigger it to be executed on demand? 

The validation process occurs after any import or synchronization with a discovery source (Microsoft ECM, 

Google Admin, LanSweeper, Vector Discovery) and daily by default as part of the Application Setup 

Maintenance Task. You can trigger it on demand via the “Run Now” in the corresponding configuration 

item. 

 

CASES IN WHICH THE ASSET IS AUTOMATICALLY ALLOCATED 

In what cases is the asset allocated to the most recent user? 

In the table below, we use ATP for the field Allocated to Person.    

 

If Status is... And... Then  auto-

allocate 

 

Notes 

 

Status Requested 

 

- Yes This is a way for IT to force the automatic 

allocation. This will process the recent user 

and assign to a user regardless of the 

current value of the ATP. 

 

Assigned                 The ATP is None or 

empty                  

 

Yes This scenario is not very common because 

the ATP is enforced to be not empty when 

the status is changed to assigned. It 

happens in some cases after an import. 
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In Stock 

 

The Status has not 

been changed after 

the initial value at 

the creation or first  

import of the asset 

 

Yes The most typical scenario is after an 

import. After the asset is first created from 

the SCCM connector, for example, the 

Status may be set to “In Stock”. If VIZOR 

users do not modify the Status, and a 

Recent User is found, it will automatically 

be allocated to that person and the Status 

changed to “Assigned”. 

 

Retired, In Repair, 

and others 

 

- No  

 

Servers are excluded from auto allocation. 

HOW TO TURN OFF AUTO-ALLOCATION FOR RECENT USERS 

1. Log in as administrator into VIZOR 

 

2. Go to the configuration’s area 
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3.  Search for the setting auto-allocate for discovery recent users and open the record. 

 

4. Ensure the Enable switch is set to no (if set to YES, switch to NO). 
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5. Click OK  

You can log out now the change is complete 
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CHAPTER 7 - LIFE CYCLE OF ASSETS 

AND SERVICES  

 

OVERVIEW  

Assets and Services have a life cycle. VIZOR helps organizations track these life cycles and make the 

associated processes efficient, optimized and collaborative.  

The default life cycle of an asset or service follows this general sequence: 

• Request 

• Approval 

• Fulfillment or Allocation 

• Provisioning 

• Use 

• Deprovisioning 

 

During the Use stage, the asset is assigned, typically to a person, and it is considered active, in production. 

For configuring the Request stage, see the section Service Request Records in this guide. 

 

Automating Actions based on Lifecycle 

See Section “Life-cycle & provisioning actions” for information on how to Automated actions based on an 

Assets lifecycle. 
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ASSET STATUS  

 

VIZOR permits tracking of the complete lifecycle of assets, 

from employee request, through approval, procurement, 

provisioning and eventual retirement. 

VIZOR supports multiple EOF (end-of-life) statuses such as 

Sold, Lost, Donated.  

VIZOR Administrators can configure actions and notifications 

based on each lifecycle status. See notifications and 

provisioning actions sections of this document.  

Asset Statues can created, deleted and updated using the 

Web Admin.  

 

 

ASSET CHECK-IN/OUT  

The Check In / Check Out view is used for assigning or allocating assets rapidly to users, and for returning 

them to storage after use. 

You can click inside the Search bar and use the barcode reader to search for the Asset.  From there, you 

will be able to individually check-in or check-out the asset. 

To select the person to assign the asset to you have two options: 

- Input entering a unique code  

Use the flexible input search that you can use to quickly find the user 

you want by entering the employee number, the student id, the lunch 

number or any other unique identifier like the email address. Use this 

box with a bar code reader to scan the employee or student card to 

check out the equipment fast and simple.  
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- Selecting a person from a list 

This is a regular single choice field with a list of users to select. 

Once a valid person is selected, you will see the details of the person such as email, location, employee 

number, school grade, etc. 

After that you can simply click on Check Out or press the enter key and the asset will be checked out. The 

location and department of the asset will be also set to the location and department of the person it is 

allocated to. 

 

For returning or checkin in equipment, simply scan the bar code of the asset to return while the cursor is 

in the search box, or manually select an asset from the list. 

The asset will automatically offer a different button, this time for check in. You only need to click the 

button and the asset will be returned to storage.  

 

Using Storage Locations 

When checking in asset you may have more than one location for storage. If this is the case, you may 

want to allow your users to select a valid storage location from a list. 

When the user selects one of the options in the Return to Storage Location, the asset new location will be 

set to that location after checking in. 

Valid Storage Locations are created in the Locations area and are always of type sub-room location. That 

is, the only locations shown as possible values for the asset storage locations are of level 6, Sub-room. 

If you do not have yet a Sub-room location create a Sub-room location inside the location you intended, 

the Building/School location, the Floor location, etc, which is usually better since we do not intend to store 

the assets ‘anywhere’ in the school. So, for example: 

If you wanted to store in the location (a School or Building): 

USA \ Chicago \ Franklyn Elementary \  

Then create one similar to: 

USA \ Chicago \ Franklyn Elementary \ Ground Floor \ IT Room \ Main Cabinet 

 

This way you will be able to differentiate between two or more storage locations in the future, for example 

“Main Cabinet” and “Phones Cabinet”. 
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To show the storage location list: 

- In the Web View Editor, open the Check In Out View and export the field “Return 

to Storage Location”. 

- Set the field html template to “fld_NoField.htmpl” 

- If not already enabled, enable the feature “Show Return to Storage Location” to 

the the user groups who will use this option. 

 

If you want to check out more than one asset for an employee, you can do the following.  Click on the 

“Check Out Multiple Assets” button.   

 

In the presented dialog, you can use a barcode scanner to scan multiple items to be checked out.  Please 

note that the barcode must match the Serial Number or Asset Tag of an existing Asset in Vizor.  Click the 

“OK” button once you are done scanning Assets.  Select an Employee to assign the Assets to and then 

click the “OK” button.  Those assets will now be marked as checked-out for that employee. 
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LOST ASSETS 

Assets that are set to Lost, that is the Status becomes “Lost”, are also changed their State to Inactive. 

Because of this, the deprovisioning actions also occur. 

In addition, when the asset is a Chromebook device, the asset is either Disabled or moved to the OU 

defined as the “Lost OU” in the Google Configuration items.  
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REQUEST STATUS OF AN ASSET  

On occasion, you may find that the status of an asset in VIZOR may not be correct.  

For example, let’s say an employee has multiple assets assigned and then one day the employee leaves 

the organization without returning the assets. Someone goes to the work place of the person to verify or 

collect the assets and it results on one of the assets not being found. It is possible the asset was lent or 

taken by someone else and not registered in VIZOR. In this case the status of the asset may be incorrect 

and it is needed to verify whether the asset is lost, moved, discarded or maybe back in stock. 

In these cases, a user can flag the asset in VIZOR in order to request the status is verified.  

The way the asset is “flagged” is via the status “Status Requested”, which is a special value of status similar 

to “Repair”, “Lost”, “Assigned”, etc. 

The usage of this status is for when the value of the existing status may be incorrect or in question. 

Other examples: 

• If the status of a given asset is “In Repair” but then a person finds the asset being used by 

someone, so ostensibly not “In Repair” but “Assigned”.  

• If the status of an asset is “Assigned” but when IT calls the person it was assigned to the person 

says she/he does not have the asset and never received. 

 

The asset manager user can request the status is verified for one or multiple assets at the same time: 

 

This causes the status of the asset to be changed to “Status Requested”. Other fields like “Allocated to 

person”, Location, Department, etc are not changed. When this option is selected, an email is sent to the 

designated person to be verified and ultimately re-set the status.  
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One common good practice is to define a well-known email address specific for this purpose, like 

VerifyAssets@myorg, and it could be used in coordination with Lost and Found. 
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ASSET AQUIRED FROM ANOTHER ORGANIZATION 

In cases of Mergers & Acquisitions or when purchasing assets from another organization, VIZOR helps 

you manage and document the source of the assets. 

Import or Purchase creation. The process should start either when importing the asset or when creating a 

purchase record of the asset in VIZOR. Use the Import Manager to import assets from any external source, 

including an Excel file. Set the Organization field to the name of the source organization. In the Purchase, 

enter the Organization from the UI. 

Once imported, run an ad-hoc query for these asset and click on Mass Update Assets. 

 

 

Then set the organization to the current organization receiving the assets. 

 

After applying, the information will now be recorded in the Historical data for all those assets. Users will 

be able to check and run reports about the source of the assets.   

For some assets, it may be neded to use the Status Merged, where a new record of the asset is created, 

manually or automatically and the old record of the asset from the previous organization is set to 

Merged.  
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RETIRING ASSETS 

When it is time to Retire an asset, VIZOR helps you in multiple ways. 

You can set the Status of the Asset to one of the Retiring statuses. The default values are:  

• Retired - Scrapped / Destroyed  

• Retired - Sold  

• Retired - Donated  

• Retired - Expired  

• Retired - Lost/Stolen  

VIZOR will automatically trigger the deprovisioning actions and change the State to inactive. 

Also, the Disposal tab will appear. 

 

Enter the following fields: 

• Disposal Date 

Date in which the asset was disposed or destroyed. This may be different from Inactive 

from Date field which is automatically set to the time when the status is changed in 

VIZOR. 

 

• Disposal Destruction Method. This field will also be used for comparison against any 

regulation that affects the asset, for compliance. 

Default values are: 
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• Disposal Percentage 

In some cases, if not all the material was recycled, what percentage was. Typically this 

information is optional. 

 

• Disposal Provider 

If a 3rd party, enter the name of the company providing the service. You add the record as 

a Supplier, which can also be managed in the Vendors and Suppliers view. 

 

• Data Destruction Certified 

For some assets, regulation indicates that an explicit certificate of destruction must be 

kept. Click on Yes if this is the case and attach the document to VIZOR. 

 

 

 

• Salvage Value  

Enter the salvage value in the field Salvage Value, Purchase Details tab. It will be used in 

the calculation of the Depreciation. 
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ENVIRONMENTAL DISPOSAL AND COMPLIANCE  

Some assets require a specific disposal. This should be indicated in the field Requires Environmental 

Disposal. 

 

 

You typically set the method in this Requires Environmental Disposal for the asset type, in order for all the 

asset instances to inherit it. The value can be overridden at the asset instance level. 

 

VIZOR has a builtin query and notification called Disposal Waste Non-Compliance .  

This query lists any retired asset for which the method of disposal is different from the one specified by 

regulation. 

You may also want to use a query to find any asset  of specific type that is retired and for which a 

Certificate of Destruction is not attached. 

 

 

 

TO BE SCRAPPED ASSETS 

To be scrapped assets in VIZOR is a special case. Users can only mark assets to be requested for 

scrapping. This status forces VIZOR to not reitre but delete the asset record. This always triggers an email 

to the person with the role of financial director, indicating that the record of the asset will be completely 

destroyed. Only administrators can use this feature but you can remove it from all or enable it to a select 

group.  
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DETECTING AUTHORIZED SOFTWARE AND HARDWARE ASSETS  

 

VIZOR helps you detect unauthorized software and hardware assets installed on the network. 

 

FOR HARDWARE: 

 

 

Run the Unauthorized Hardware query. The query includes and asset of a type that has been flagged as 

unauthorized and it may include specific attributes such as Manufacturer and Model. 

Modify this query for specific cases as needed. 

  

The previous query is also used by the Unauthorized Hardware report and report subscription, which will 

automatically send the list of these devices to the appropriate members of the team and notifiy you when 

one is discovered in the network.   

 

This report should be combined with the Computer Discovery and SNMP Network Discovery for most 

effectiveness.  

 

To control this at the asset type level, set the field Unauthorized in Organization in the Asset Type record. 
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FOR SOFTWARE:   

 

 

Run the Unauthorized Software query in the Software Asset view. The query includes and asset of a type 

that has been flagged as unauthorized. 

 

 
  

Similar to Hardware, use this query in the Unauthorized Software report and report subscription to will 

automatically send the list of this software if discovered in the network.   

 

This report should be combined with the Computer Discovery with Software Installations for most 

effectiveness.  

 

Installations Catalog: VIZOR automatically send you an email New Software Found in Network when a 

new title is found by discovery. You can then decide whether to Authorize it, Import it and map it to a 

Software Asset Type or not. Use the query Found This Week or click on the link from the email notification 

to see the list of new software found. 
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Installations: in a similar way, Installations has an email notification to alert you: New Software 

Installation Found in a Computer. Use this email notification to know if a new software installation has 

been found in a computer, even if the software title is already elsewhere in the network. 

 

To control Unauthorized Software at the asset type level, set the field Unauthorized in Organization in the 

Asset Type record. 

 

 

AUTOMATIC REMOVAL OF SOFTWARE INSTALLATIONS 

 

If you have the Vector Discovery module, you can combine it with VIZOR to automate the removal of 

unauthorized software. 

By default, any software installation found in the Unauthorized Software, will send an instruction to the 

the Vector Discovery module and the computer added to the special group Unauthorized Global.  

 

 

In the Vector Discovery module, create an uninstall package or packages for each software to be 

uninstalled, using the proper command line (like msiexec). The command are executed automatically and 

silently on the computers members of this Unauthorized Global group. 

 

If you do not have the Vector Discovery module, you can still automate this process via a VIZOR Action of 

type Execute Command and control the system that you are using to install or remove software, like ECM. 
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QUERYING CHANGES TO ASSETS IN A PERIOD OF TIME 

 

You can look for changes that occurred to assets in a given period of time by using the report Asset 

Changes. This report allows you to find any assets for which one or more of the following fields changed: 

a. Allocated to Person,  

b. Allocated to computer 

c. Location 

d. Department 

e. Unit 

f. Project 

g. Status 

 

The complete, detailed information of all the changes per asset is available from the asset record in the 

History area.   

 

Example of the report: 
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If there are multiple changes to the asset in the specified time period, you will see a chronology of the 

changes as below: 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

General information and current Status of the asset 

 

Previous and new value of the field 
 

Date when the changed occurred 

 

Vertical visual chronology of the changes 
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You can specify multiple parameters such as time period, the asset Tag or Serial Number, or the person 

the asset was assigned to, or unassigned from. 
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USE OF BARCODE READERS 

Loading up the right user or inventorying resources’ locations at your organization can be a tedious task. 

Fortunately barcode scanning is up and ready to fill the gap. 

The main areas where bar code scanning is used in VIZOR are as follows: 

• Asset checking-in and asset checking-out 

• Asset Inventory (see the topic Asset Inventory Audits). 

• Add Asset 

 

 

ADD ASSETS WITH A BARCODE READER 

Login to the “Assets” view.  Click on the “Add Assets” button.  After selecting the Asset Type, go to the 

“Assets” tab.  Select the “Add assets with the following additional information” option and then select the 

checkbox for “Serial Number” and “Asset Tag” (Vizor focuses on using these fields to search for specific 

Assets in certain areas.  Its recommended that the barcode is entered into either of these fields).  Select 

the text field for either Serial Number or Asset Tag, and then use your barcode reader to enter the value 

into the field.  You can do this multiple times if you’re adding multiples of the same asset type into Vizor.  

Click the “Finish” button to finish adding the Assets into Vizor. 
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ASSET INVENTORY AUDITS 

You can perform inventory audits on a regular basis in order to confirm the existance or the location of 

the assets.  

For physical assets, a typical scenario would involve using a tablet, laptop or mobile device and scan all 

the assets in a physical location.  

To support this scenario, log in to the “Locations” view.  Drill-down to a location that you are performing 

the inventory for and view the Assets (tab) in that location.  Click on the “Inventory Audit” button.  In the 

presented dialog, you can use a barcode scanner to scan multiple items to be audited for this location.  

The barcode scanned must match the Serial Number or Asset Tag of an existing Asset in Vizor.  That Asset 

must also be in the selected Location.   

Tip: 

You can have a barcode per location too. Print the location barcode and place it in a wall or well-known 

location (e.g. next to the door). When you are in the Locations view of VIZOR, set the cursor on the Search 

box on the top right and scan the barcode of the location to directly open the right location. Then use the 

scanner for the barcodes of the assets. 

The “Last Audit” of each asset will be timestamped as you scan them. The column shown in the list of 

Assets in that location will help you better identify the assets that were just scanned and any missing 

assets. 
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AUTOMATICALLY SET THE LAST AUDIT 

This is an automatic process that VIZOR performs for assigned computers. It is particularly useful for 

mobile workers and home works. The process sets a timestamp in the Last Audit field of the asset when 

VIZOR knows that the device exists and that it has been used recently by the person the device is 

assigned to. 

The automatic timestamping of the Last Audit: 

- Is only enabled for computers. 

- Occurs automatically during the Application Setup Task (every night by default) and after imports of 

computer assets. 

- Only happens if the Last Audit has not been set in the last 30 days, per asset.  

- Uses the Primary User. The recent user stored in the Primary User field needs to point to the same 

person as the one the device is assigned. This is now automatically reflected by the field "Assignee Is a 

Recent User". 

- Uses the “Last Active Time”. The time in the "Last Active Time" needs to be not older than 60 days. This is 

the time when the recent user was detected, usually by an external system such as Google, Azure, SCCM. 

The Last Audit is not timestamped if the "recent user" is not that recent data. 
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The Last Active Time is automatically set from the most recent date in the Active Times (originating from a 

source like Google) or in the Source Timestamp, which is the last time the external source collected the 

information VIZOR got for that asset. 
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CHAPTER 8 - SERVICE & ASSET 

REQUESTS 

 

The process Request Fulfillment deals with Service and Asset Requests. In VIZOR, Service Requests are 

part of the Actions VIZOR project and are sometimes referred to as Service and Asset Requests. 

Service Requests are Action records of Action Type = Service Request. 

Designing and preparing your Service Catalog, that is, the menu of services and assets that IT offers, is an 

important step. 

The Service Catalog is located in the main menu, at the bottom. 

 

 

Please note that users using the Service Catalog can open a Service Request directly from it by clickin on 

the Open Service Request button. 
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To designate an asset or service part of your service catalog, go to Manage Service/Asset Types and select 

the asset or service that you want to make part of the Service Catalog. 

 

 

 

By default the list shows the Asset Classes, the first level that groups Asset and Service Types. You can 

create a new Service/Asset Class if you need to. It is a good idea to keep the list of classes short, for easier 

management and navigation. 

You then see the list of Service/Asset Types. Select the Service/Asset Type that you want to add to the 

Service Catalog. If the Service you want to add is not in the list, it may be that it is hidden or that it doesn’t 

exist. Click on Add Service/Asset Type to add a new type.  

 

In the details form, set “Can be Requested” to Yes.  

You can also designate if only users that are members of some groups have access to this asset or service 

by setting the field “Accessible to Groups”. If you do not specify any group, it is accessible to all groups. 

Set any other necessary fields and save. 

 

Once your service can be requested, users will be able to open service requests via the Request Portal. 

The Request Portal lists the Services and Assets that can be requested by users. Besides the name of the 

item to request, you can also add a description, a custom icon and other information you may want users 
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to know. In addition, it is easy to search in the Request Portal by just typing a partial name of the service, 

asset or part of the description. 

Users can request a particular service by clicking on “Request” and filling out some extra information 

about the specific request.  

 

Each user will only see the assets and services that are available to her depending on the groups she 

belongs to and the permissions set in “Accessible to Groups”. 
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SERVICE REQUEST RECORDS 

 

By default, the Self-Service Request Portal creates a Service Request for the Service/Asset type chosen and 

to be allocated to the logged in person. This is designated by the field “Requested For” in the Service 

Request record. 

Each Service Request Record has a unique identifier, the field called ID. This ID is an integer number and it 

is sequential by default.  

ADVANCED 

If you want the next ID to be a higher number, you can set the ‘base’ number in the table tblNextDefect in 

the DAT database of the project. 

You can also add multiple records in this table if you want the ID to follow a specific sequence, or a 

random sequence.   

STATUS AND STATE  

The Status field is a special field that reflects the life-cycle of the Service Request record. The State field is 

associated and it is automatically controlled by VIZOR, it is set to Open or Closed.  

To change the mapping of Status values to State values, use the same editor. The choice table for the 

Status list contains an extra column that maps Status choices to State choices. You must complete this 

column when you add or edit the choices in the Status list.  
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When you edit the State choice table, remember that the Closed choice sets the Closed Date and Time 

fields. So, for example, changing the choice text from Closed may confuse users.  

Notes 

If you edit the Status choice list, check that workflow rules based on the Status field are still correct for 

your needs. 

 

 

AUTOMATED TIMESTAMPS 

Like for other VIZOR records, VIZOR automatically keeps track of important timestamps associated to the 

life-cycle of the Service Request. For example: 

- The Submitted Date and Submitted Time indicate when the Request was created 

or submitted.   

- The Assigned Date and Assigned Time indicate when the Request was assigned 

to an Owner to be attended 

- The Closed Date and Closed Time indicate when the Request is closed, that is, 

when the State becomes Closed.  

- The Last Updated Date and Updated Time indicate the last update to the record. 

- Every change is also automatically timestamped and accessible in the History 

area from the toolbar of a record. 
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ASSIGNMENT TO A PERSON AND ROUTING TO A TEAM 

The person responsible of fulfilling the Service Request record will be the Owner. You can designate the 

default owner of a Service Record depending on the Service/Asset Type in the Service/Asset Type Record, 

in the Life-Cycle > Request > Action Owner field. This can be set to a specific person or to a macro that 

resolves dynamically to a person based on her job title, role, etc. 

In order to automate the routing of Service Requests to a designated support team (Work Team), specify 

the default Assigned Work Team for the Service Request per type in this form. 

You can also specify the Priority. 

If you need the routing rules to a Work Team to be based on other conditions, use the Workflow editor 

and create a business rule that sets the Assigned Work Team based on the conditions you need (see 

Business & Workflow Rules). 

 

CATEGORIZATION OF THE REQUEST 

 

Because a Service Request is created automatically from the Request Portal, it is automatically categorized 

in terms of the Service/Asset Type and Asset Class.  

In addition to this, you can use built-in fields such as Category, Location, Department, Organization, or 

custom fields for further categorization. 

You can let the end user set the categorization by making the field part of the Request, or you can also 

automate it via Business Workflow Rules, of the type Dependent Values or Possible Values (see chapter in 

this guide).    
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In addition to these methods, you can also set Default Values per User/Group (see Setting Default Values 

for a Web View Based on Users or Groups ) or, if the logic is unique or too complex for the editors, you 

can create a macro (see Macros) and call it in the Default Value per field (Field Editor). 

 

 

 

 

IMPACT, URGENCY AND PRIORITY 

Aligned with ITIL, an Incident, Problem, Change or Service Request may have fields that help track the 

Impact, the Urgency and the Priority of the process in question.  

 

The Impact measures the business criticality of the record, the extent to which an Incident, a Problem or 

the abscense of a Service or Asset (not provisioned) leads to the distortion of business service levels. 

 

Urgency is a measure of how long it will be until it has significant business impact.  

 

Priority is a category that identifies the relative importance of an incident, Problem, Service Request or 

Change. Priority is normally calculated based on Impact and Urgency but it can be overridden under 

special circumstances. 

 

Priority is set automatically based on the Priority Matrix, which can be modified to your organization 

needs in the Business & Workflow Editor. 
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ADDITIONAL DETAILS 

 

As for Incidents, Problems and Assets, you can track details of the Service Request record in fields. By 

default, the Service Requests view contains a useful set: 

- Submitter or request initiator  

- Type of service requested  

- Priority, Impact and Urgency 

- Description 

- Activity Log, with timestamp. 

- Resolution description 

Note: The activity log field listed above serves for entering with a timestamp of the date and time for any 

comment, investigation text, diagnosis details etc. It even identifies the submitter for a given text input. 

 

More fields are available in the Field Editor for the Actions VIZOR Project. You can also create your own 

custom fields and export them to specific web views.  

 

Also, like for Incidents and Problems, Service Levels can be specified and monitored for compliance (see 

SLAs and Escalation in this guide). 
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SERVICE REQUEST RECORDS AND REQUEST PORTAL 

The process usually starts with the Request of the asset by someone. Employees and users can request 

assets and services via the Request Portal. 

 

 

 

The Request Portal is accessible to all employees by default. You can change this by modifying the groups 

that can access the Web View “Request Portal” in the Web View Editor.  

 

By default, the Request Portal allows users to request assets and services for themselves. 

It is also possible to allow users to request assets for someone else via the Request Portal. Please contact 

our support team if you need this configuration.  

The administrator of VIZOR can specify what Service or Asset Types are visible or not in the Request 

Portal. This is defined per Services/Asset Type. If you want a specific Services/Asset type to be visible in 

the Request Portal, open the definition of the asset type in question and set the field “Can be Requested” 

to Yes.  
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CUSTOMIZING THE REQUEST 

The request of an asset presents the user with a form used to provide additional information needed to 

provision the asset. For example, VIZOR can ask the user the date when the asset is required for, or the 

number of assets to provide.  

Some asset types may require additional information, for example, if your organization has two types of 

models for computers and you want the requestor to decide, you can add a custom field to the form for 

that particular asset type. 

VIZOR comes with a number of commonly-used fields to choose from and you can decide if the field 

should be requested or not for that particular asset type. 

To define the fields to include in the request, go to Assets > Manage Asset Types and select the asset type 

you want to change the request form for. Click on the Life Cycle tab and click on Request.  

 

Add and remove fields from the list as you need.  

Click OK to apply the changes and include the new fields in new request of that asset type. 

DO YOU NEED A FIELD THAT IS NOT IN THE LIST? 
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If you need a field that is not in the list, you can create your own customized field using the Field Editor. 

Go to Web Admin > Fields and select the Resources project. Click on Add to create a new field.  

In order for this field to be used in the Request Portal, you need to: 

• Create it in the Request Details tab 

• Set Is Visible to No (clear the checkbox). This is so that the field is not visible for all asset types in 

general, but only the ones you explicitly define it to be.  

See Chapter 29 - Fields for more information on customizing fields. 

 

CONTROLLING REPEATED SUBMISSIONS FOR THE SAME REQUEST  

It is possible that users try to submit a Service Request multiple times even though it is for the same need, 

that is for the same Service or Asset they have already requested. 

In order to prevent this, VIZOR automatically tries to determine if there is already a Service Request for 

the same type and for the benefit of the same person already open and in progress.  

 

 

 

This validation happens in the Request Portal just before a new Service Request is about to be submitted. 

By default, a message is displayed and guides the user to check the Pending Service Requests area, but 

still allows the submission. 

It is possible in VIZOR to prevent the submission instead of just offering a warning. This configuration is 

more advanced and needs to be specified in the file CustomCode.bas. Once the CustomCode.bas is 

customized, it needs to be places in the CustomizedFiles folder, as explained later in this guide. 
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PENDING REQUESTS  

 

Users can also check their pending requests inside the Request Portal by clicking on the button Pending 

Service Requests. 

 

 

 

 

From this area, users can also modify an existing request after submission. The user can select the specific 

request and, if configured, change information like the required date or even cancelling the request. 
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As with other Web views, your organization can decide the level of detail the user is allowed to view about 

the Status of the Request record and the rest of the fulfillment process. For example, you can export 

Priority or any additional fields you want the user to see by using the Web View Editor. You can also 

determine if the end user should be able to change it to, or just view it (read-only). 

 

CANCELLING REQUESTS  

Allowing users to cancel a submitted request is useful in the following situations: 

• The user realizes shortly after that the submission was a mistake or that the service/asset type 

was incorrect.  

• The user realizes the submission is unnecessary for reasons like business changes, cancelled 

projects, etc. 

• The user realizes there is an existing submission for the same need. 
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To handle these cases, by default in VIZOR, user can go to Pending Service Requests area and Cancel the 

request by changing the Status. 

Note that the request can be cancelled only if it is in certain statuses that are cancellable, such as when it’s 

“Awaiting Approvals”. After these, the Request is in a status where there is no return. 

Since your organization can change the Status of the life-cycle of the Service Request, you can also 

determine which Status are cancellable. You can remove the ability to cancel in WebAdmin > Workflow > 

Actions > Status Life-Cycle. 

Once cancelled, An email notification is sent to the owner of the SRR, which you can customize via the 

Email Templates and the Notifications Editor.  

 

RE-OPENING REQUESTS  

In some cases, you may want to allow re-opening service requests. There are usually two approaches: 

• [Default] The special Status “Re-opened” is available for Service Requests Users may reopen a 

request if it’s less than 3 days old.  The way this works is via the flag “Can be re-opened” is Yes. 

By default this flag is set to 3 days and it can be modified.  

Administrators can always re-open a Service Request. You can modify this behavior or add more 

user groups to have this privilege by configuring the Business Rules in WebAdmin > Workflow > 

Actions > Status Life-Cycle. 

• Designate a status by which the support team indicates completion but it is still open and to be 

validated by the person receiving the service. VIZOR includes the builtin status To be Verified for 

this case. If you implement this approach, you may want to have Requests automatically closed 

after X time of being in To be Verified.   

End users can re-open the Request by going to “Pending Service Requests” and selecting the query “My 

Closed Requests”. The Status can then be changed to Re-opened and a text field “Reason for Re-opening” 

is displayed to explain the change. 



  Page 177 

 

 

Once re-opened, the request will then be displayed in the query “Re-opened Service Requests” of the 

support team and an email notification will be sent to the owner of the SRR. As usual, you can customize 

via the Email Templates and the Notifications Editor.  

 

 

 

 

APPROVING REQUESTS 

Once a Request for an asset is submitted, you may want to have it approved before fulfilling it. 
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To define if a particular asset type requires an approval and to configure the type of approval, go to 

Assets > Manage Asset Types and select the asset type you want to configure the approvals for. Click on 

the Life Cycle tab and click on Approval.  

In this area you can define up to 3 levels of approvals, exceptions to the approvals and the minimum 

number of approvers.  

 

VIZOR supports an unlimited number of levels of approval. Please contact 

support if you need more than the default 3 levels. 

 

 

MINIMUM REQUIRED APPROVERS 

When defining approvals, either for asset requests, change requests or any approvals in helpdesk tickets, you can 

define a minimum number of approvers.  

Normally, an approval moves to the next status only when all the approvers have accepted. If there are five people 

in the approvers list, and only four have approved, the request stays until all five approvers approve or reject the 

request. 
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By using the Minimum Approvers field, the administrator can allow requests or tickets to continue to 
the next status as soon as a given threshold is met. If the “Minimum Approvers” field is set to 3, as soon 
as 3 approvers “approve”, the request will continue to the next status, whichever has been defined. 

 
For asset requests, the minimum number of approvers is defined per asset type, and it applies to each 
one of the approvals. That is, if the minimum approvers is 3, approval level 1 will pass when 3 approve 
and then move to level 2, which will pass when 3 approve and move to approval level 3, which will again 
pass when 3 approvers pass it.  

 

To modify the minimum approvers number, go to the “Asset type” view and follow the instructions as 

shown below: 

1. Go to “Assets” in the quick links panel in your home page. 

 

 

 

 

 

 

 

 

 

 

2. In the “Assets” view, click on the “Manage Asset Types” button in the right side tool bar to access 

the Asset Types view. Once in, click on the asset type that is going to be modified. 
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3. Once the asset type is selected, we can access the approval configurations by clicking on the “Life 

Cycle” tab and by clicking “approval” after in the life cycle graph. 

 

4. The “Minimum Approvers required” field is located in the bottom part of the “Approval” window. 

This field will allow to set up a minimum of required approvers as well as specific approvers for 

each level for the asset type. 

 

 

If you need the minimum number of approvers to be different per request, based on custom rules, this 
can be configured for asset requests, Change Management and Helpdesk tickets too. If you need this 
configuration, please feel free to consult with our technical support for more information. 
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In case the existing number of approvers for a request is less than the required number of approvers, 
the approval of all the current approvers will be needed for a status change. 
 
For example, if there are only 2 approvers for a specific request and the number of minimum required 
approvers is 3, all the current approvers (in this case, 2) will need to approve to go into the next status, 
as if there was no minimum number of approvers. 
 

 

FULFILLING REQUESTS 

Once a Request for an asset is approved, or if no approval is required, the request goes to Fulfillment. 

During the fulfillment stage an action to fulfill the request is created and assigned to a person or to a 

team. 

The assigned person will get an email notification with a link to view the request. 

Once the assigned person logs into VIZOR, she will be able to see the request for asset fulfillment action 

inside My Actions area.  

 

You can control how the fulfillment of the asset occurs in the Life Cycle tab of an asset type definition. 
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Configure the fulfillment by selecting how VIZOR should choose the asset to assign to the person 

requesting the asset: 

• Take one from stock 

VIZOR will take a random asset instance of the requested type from the pool of available 

assets in stock (storage) and assign it to the person the request is for.  

Typical examples are software licenses, in which all instances in stock are essentially the 

same.  

This method does not require a person to fulfill the asset and therefore the process 

moves directly to the provisioning stage. 

 

• Create a new asset 

VIZOR will create a new asset instance of the requested type and assign it to the person 

the request is for.  

Typical examples are Active Directory accounts, access to network shares, unlimited 

enterprise agreement licenses, etc.  

This method does not require a person to fulfill the asset and therefore the process 

moves directly to the provisioning stage. 

 

• Wait for manual allocation  

VIZOR will wait for a person to select what asset instance of the requested type to assign 

to the person the request is for.  

Typical examples are computers and special hardware for which it is desirable to decide 

the specific item.  

With this method, VIZOR puts the request action in the status “Approved – Pending 

Fulfillment”. It then requires the person assigned with the fulfillment action to go to My 

Actions, click on Fulfill an Asset and select the asset from the list before moving to the 

next provisioning stage. 

 

When the fulfilling is manual, fulfilling the Asset from the request action is more efficient than allocating it 

in a different way because:  

• You do not need to assign it to a person, it is automatically set to the person indicated in 

the request. 

• You do not have to specify the return date if there is one, it is automatically set from the 

request. 

• It automatically copies other requirements of the asset from the request into the actual 

provisioned asset. 

• It automatically set the status of the selected asset to "Assigned". 
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• It only displays assets that are available and of the requested asset type. 

• It changes the status of the request action to "Completed". 

 

 

ADVANCED NOTES ON THE REQUEST-FULFILLMENT PROCESS 

 

Requesting an Asset or Service from the Request Portal creates: 

1. An Asset/Service Request Specification (Asset with UsageType = "Request Specification"  

a. Submiited Date & Time are set to the request time. 

b. The Contact (originator) and Submitter fields default to the logged in user, unless 

requesting for someone else, in which case Contact (originator) will be different. 

c. State=Open 

d. Asset_Status is set to Requested 

e. Asset_Sub_status is set to Requested 

f. The Request Specification is an instance copied from the asset type template, e.g. 

Laptop. 

 

2. An Action for requesting, approving and fulfilling the asset 

a. Submiited Date & Time are set to the request time. 

b. Contact (originator) and Submitter default to the logged in user 

c. “Requested By” defaults to the logged in user 

d. State=Open 

e. Substate is set to Awaiting Approval 1 

f. Action Type= Request Asset  

g. Event Type= Request  

h. UsageType= Employee  

The action is used for the process of requesting, approving and fulfilling the asset. 

The Asset/Service Request Specification contains the needs of the requester, which if approved will 

eventually be fulfilled with an asset instance. 

Once Approved, the Action is passed to the Action Owner for fulfillment. 

The owner of the action sees the fulfillment action in “My Actions” and the Fulfillment tab is visible. 

After the fulfiller selects an available asset: 
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- The following fields are copied from the Request Specification to the selected Asset/Service 

Instance: 

o Owner  

o All the fields from the Visible Request Fields list for that asset type  

- The following fields are set on the allocated asset instance  

o The status is set to “Assigned” 

o The Allocated to Person (Owner) is set with the value of Reuested For or Contact  
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BILLING AND CHARGE BACKS 

 

Your organization may want to keep track of all or some charges incurred by servicing the Service 

Requests for internal costs calculations or for actual billing and charge backs to other departments.  

VIZOR includes builtin functionality to facilitate this. Use the Amount field, a currency field, to keep track 

of the actual charges per Service Request record. 

 

If the Amount field is entered, once the Request is Complete, two email notifications are sent: 

 

1. Email sent to the contact indicating the charge  

 

 
 

 

2. Email sent to Accounting in order to record the charge in the books. 
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You can modify these using the Email templates editor and the Notifications Editor.  

 

You can also have the financial team subscribe to the monthly report with all the charges. 

 

 
 

 

ADVANCED 

Many accounting systems can integrate with external systems via email. A specified email address and 

format needs to be created to match the parsed fields required on the accounting system. 
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In VIZOR, you can create the email template using wild cards like <F: (name of field)>. You can also create  

a custom macro if you need additional integration capabilities. 

 

 

REPORTING COSTS 

 

In addition to creating your custom reports, VIZOR includes a built report that facilitates the reporting of 

costs, whether you use it for billing or for internal analysis. 

The Ongoing Costs report allows you to specify the period of time and whether to report the costs or 

charges by Cost Center, by Department or by Location. 

 

 
 

The top area displays the Total Costs for the specified Period and the lower the costs broken down per 

Cost Center, Department or Location, e.g. per Cost Center in this example: 
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MEASURING RESULTS 

Measuring the success of the operations providing the IT services is very important. Three techniques can 

help you in this process: 
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- Resolution Codes 

Categorize how the Service Request was completed or resolved. This will identify how close to 

satisfying the original request you were. Run a report on the different Resolution Code after and 

follow those over time. 

 

- Service Levels, time to resolution 

As described in the SLA chapter, monitor real closure times against target times. 

 

- End User Surveys 

Collect feedback from end users using surveys.  

 

ABOUT SURVEYS 

VIZOR includes default surveys that can be easily sent for end users to fill in after the request is 

closed. You can  

customize the questions you ask, any number, any type. 

customize who gets the survey: Everybody? One in every 3? Only requestors of a new service or 

provider? Only for a special project, like upgrades of Windows?  

CREATING A NEW SURVEY VIEW 

Survey views are similar in functionality to a Submit-Only view.  Access to the Survey view is usually done 

through a custom URL instead of through a Quicklink and no credentials are required on the user side in 

order to view it.   

In order to create a new Survey view, open up the Web View Editor.  Click the “New View” button  , enter a 

View name to be used for the Survey, and then select the project the Survey will belong to.  Click OK to 

create the view. 

With the view created and selected in the Web View Editor, go to the “Web View” section from the list on 

the left side.  Change the “View Type” to be “Survey View”. 
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Click on the “Attributes” button and find the attribute called “Web View Text”.  Update the value here if 

you wish to show a message at the top of the Survey view.  Click OK to close the Attributes dialog and 

then generate the web view.  A message will show up asking for valid user credentials.  This user will be 

used when submitting the surveys.  Enter user credentials and continue with generating the view.  You 

now have the base for your new Survey view.  You can now start adding fields to it. 

ADD/REMOVE FIELDS FROM A SURVEY 

In order to add or remove fields from a Survey, open up the Web View Editor and load the Survey view 

(example: HelpDesk / Survey).   

Select the "Fields" section from the list on the left side.  In the "Tab" list, select the "Survey" tab.  Its 

recommended that any new fields added specifically for surveys be added to this tab. 

In order to make the fields available in the Survey view, make sure to move them from the “Available” list 

to the “Export To View” list.  If you don’t want a field in the Survey view anymore, move it to the 

“Available” list. 
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ENABLING RATINGS UI FOR CHOICE LIST FIELDS 

------------------------------------------------------ 

If you would like a choice list field to visually use a ratings UI instead of a dropdown list, this can be set in 

the Web View Editor.  Make sure the field is in the “Export To View” list and then double-click on it (or 

select it and then click the “Attributes” button).  Find the attribute called “Rating Field” and set it to “Yes”. 

 

  Once the view is regenerated, the choice list should now be using a ratings UI.  Please note that the look 

of the ratings UI changes depending on the number of choices in your choice list.  If there are only 2 

options, then it will show an X and a checkmark as the options.  

If you have more than 2 options in the choice list, then it will automatically switch to displaying stars for 

all the options. 
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MEASURING DEMAND FOR SERVICES AND ASSETS 

As you manage your resources to provide the services in your catalog, it is very useful to identify what are 

the services and assets that are in most demand. 

To do this, you can use the builtin reports Volume per Day, Requests per Type and Trendy Requests. 

These reports can be given periods of time depending on your needs. 

Volume per Day 

 

This report allows you to know the volume that you are servicing, identify trends over time and days or 

weeks in which there are more requests.  

 

 

Requests per Type 
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This report helps you identify the top types of services or assets being requested in the specified period of 

time. 

 

 

 

 

  



  Page 195 

 

 

Trendy Requests. 

This report identifies trends in the number of requests for a specific type. Based on the rolling average 

number of requests per month for each asset or service type, it then calculates the growth of that 

particular service or asset in the last month. The top 10 growing or trending types are displayed first, 

followed by the comparison of averages and last month requests. 
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In addition, you can also use ad-hoc queries and create new reports with virtually any field and condition 

to help in the analysis. 
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CHAPTER 9 - APPROVALS 

Approvals can be used during various processes in VIZOR. You can approve a Request for an Asset or a 

Service, you use approvals before a Change Request. You can also approve the request for onboarding a 

new employee or a new account in your organization. 

You can set an approval workflow for each individual type of asset, and you can also have different 

approvers depending on the requestor. 

You can also set multiple levels of approval. Multiple levels of approvals are used when you only want 

certain users to approve a request after specific users have already approved it. For example, you may 

want a Director to approve a request but only after is has been previously validated and approved by a 

Manager. 

VIZOR comes with three levels out of the box, but you can add any number of levels of approval to a 

given process. 

 

DYNAMIC APPROVERS 

There are some built-in macros that can be used for implementing dynamic approvers. 

<EMPLOYEE MANAGER> 

This person is the manager of the user for which the request is submitted for. 

 

<EMPLOYEE SUPERVISOR> 

This person is the supervisor of the user for which the request is submitted for. 
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<ASSET RESPONSIBLE> 

This person is the person responsible of the asset type being requested. The name of the person with this 

role is indicated by the field Responsible in the details of the specific asset type. 

 

 

These macros can make approvers be conditional by department or by the work team. For example, you 

may only want HR Manager of Department A to approve assets assigned to Department A employees, 

and may only want HR Manager of Department B to approve assets assigned to Department B employees. 

 

APPROVAL EXCEPTIONS 

 

You can add exceptions to specific levels of approvals for certain users. For instance, if all requests require 

a manager to approve, you may want managers to not require that level of approval. 

To define these exceptions, set the list of user groups where no approval is needed.  

 

 

DELEGATES 

 

VIZOR has the ability to grant another employee (or delegate) the ability to make approvals on your 

behalf.   

You can do so by logging into the Employees web view and editing the employee you want to give 

approval rights to.  In the Overview tab, find the “Delegate For” field and click the “Make XX My Delegate” 

button.  This should add your name to the field.  The employee will now be able to see any requests 

awaiting your approval. 
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NOTE: 

We currently don't have a way to change delegation for users other than the one you're currently logged 

in as.  So, in order to change the delegations for anyone that may have left the organization, you will need 

to do the following: 

    - Login to ConnectAdmin 

    - Click on Security tab -> Users button 

    - Find the user you want to change delegation for and click on them 

    - Update the "Authenticate With" field to use "VIZOR Authentication" 

    - Update the Password for the user (may need to save changes first before the fields will show up) 

    - Save the user 

    - Login to the Connect views and make the necessary changes to delegation 
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CHAPTER 10 - ASSET LIFE-CYCLE 

AUTOMATED ACTIONS  

 

A Service Request is used to provision a Service or Asset of a specified types. 

Once an instance of an Asset or Service is specified to fulfill the Service Request, the Actions defined in 

the Provisioning Actions area of the Service/Asset Type are executed. 

You can customize the Actions that VIZOR will create, assign and potentially execute for each Service or 

Asset in the event of Provisioning. 

 

 

 

EVENTS IN THE LIFE-CYCLE OF AN ASSET 
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At the moment, VIZOR supports the following events in the life-cycle of a service or asset instance: 

• Provisioning 

• De-provisioning  

• On Repair 

 

CREATE TICKETS IN PARALLEL… OR NOT  

One of the main advantages of VIZOR Actions is that you can create multiple Actions in parallel so your 

team can work in a more efficient way.  

Since an Actions can create a HelpDesk ticket (Incident or Problem), a Change Management record, a 

Service Request Record, etc., it means you can design the provisioning of your services and assets to 

include multiple tickets in parallel. This allows multiple people, including external providers, to work in 

parallel when possible. 

In some cases the sequence of the actions is important. For example, installing software in a computer 

needs to be done only after the hardware has been prepared. For these cases, set the order  

 

 

A typical example of this is for onboarding new employees. Use automated provisioning rules based on 

the roles of the new employee to start the several processes that are required to provision all the 

necessary assets and services. The actions will be coordinated and orchestrated by VIZOR, whether they 

are automated (like scripts) or not (a manual process documented in the VIZOR Action). 

Using these techniques is the best way to also manage efficiently the automated deprovisioning of these 

assets or services when the person no longer requires them. 

The deprovisioning actions are triggered automatically when the person leaves the organization or even 

when the person changes jobs that require different resources. 
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CAN I CREATE MORE TYPES OF ACTIONS? 

 Yes, the VIZOR Actions framework can be extended to have more adapters. Please contact Vector 

Networks for more information. 

   

ENABLING AUTO_PROVISIONING 

In order for the background services to attend provisioning and deprovisioning actions, you need to turn 

on the feature in the Configurations area. 

Search for the setting “Execute Actions Interval” and set the interval to the frequency in minutes to check 

and run the automated actions. 

 

APPROVAL ACTION 
  

This action triggers a multi-level approval process where multiple approvers can take part. Required 

approvers are notified of the pending approval within the VIZOR system and via email, and they can 

approve or reject from the Web UI or directly from the email. 

   

ACTIVE DIRECTORY ACTIONS 
  

The following actions are built-in, via the VIZOR native AD adapter. 

• Add user to Security Group 

• Assign user to OU 

• Change user password 

• Create user account 

• Delete user account 
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• Disable user account 

• Enable user account 

• Remove user from Security Group 

• Reset user password 

  

SET UP THE CONNECTOR FOR ACTIVE DIRECTORY ACTIONS 

To set up the Connector for Active Directory Actions, you need to have an import rule with the intended 

Active Directory. Create this import rule in the VIZOR Import Manager. See the chapter on Integration 

with Active Directory for details on how to create and configure this rule (Integration with Active Directory 

). 
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CREATE HELPDESK TICKET ACTION 
  

This action creates a helpdesk ticket, assigns it to a person or team, and monitors its status until 

completion. At the moment, out-of-the box, only the VIZOR HelpDesk is supported. 

  

EXECUTE COMMAND ACTION 
  

This action runs an executable and passes dynamic information from Connect via macros. For example, 

you can execute a Powershell or a 3rd party tool. 

  

CREATE CHANGE RECORD ACTION (CHANGE MANAGEMENT TICKET) 
  

This action creates a Change Request in the VIZOR Change Management system. The change request is 

started and its Status monitored until completion. 

  

SEND EMAIL ACTION 
  

This action simply sends an email to one or multiple recipients based on a configurable template. 

 

VIZOR ACTION 
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This action creates and monitors a Connect Action, which is essentially a generic task/issue inside Connect 

and assigned to a Connect user. It is only accessible inside the Connect system and it is useful for 

following up activities that are not tracked by other systems. 

 

EXAMPLE TESTING LIFE-CYCLE AUTOMATED ACTIONS 

1. Go to VIZOR Admin and in Options, set the "Execute Actions Mode" to 2, which will not execute the 

actions but only log that they would be executed, which is useful to testing. 

2. Add a custom action to the Network Account Active Directory asset type on deprovisioning. 

Go to Manage Asset Types and select Network Account Active Directory. 

In the Actions tab and add one for an Execute Command. 

3. Allocate an asset of type Network Account Active Directory to a user 

4. To test the deprovisioning action, remove the asset from the user 

Select the asset assigned to the user in Assets, set the Allocated to Person to <None> and Save. 

You should see the new action created in My Actions view > Asset Actions. 
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CHAPTER 11 - ONBOARDING AND 

AUTOMATED USER PROVISIONING 

 

VIZOR helps streamline the process of onboarding new personnel so they are consistently productive 

from day one.  VIZOR coordinates and monitors the provisioning of the necessary resources, assets or 

access to services. 

 

From the perspective of the employee or person, there are three types of events where Automated User 

Provisioning is used: 

 

• The person joins the organization 

• The person changes job/role 

• The person leaves the organization 

 

ONBOARDING: PERSON JOINS THE ORGANIZATION 

  

The high-level cycle is as follows: 

 

1. A person will be starting a new job/role in a few days. A manager uses the New Employee 

Onboard to notify this.  

 

2. The account is automatically created in Active Directory. 
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3. Based on the role, VIZOR generates internally the equivalent of a list of Service & Asset Requests 

(see) to be given to the new employee. 

 

4. VIZOR monitors the request for each asset using the Asset Life-Cycle Automated Actions. 

 

5. The new hire gets all the equipment and access to systems needed. 

 

 

START THE ONBOARDING OF A NEW EMPLOYEE/ACCOUNT 

 

A manager, HR person or any person given that role may start the onboarding of a new 

employee/account. The process is available from the Employees view, but a shortcut from the homepage 

is also possible. 
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The manager or person submitting the new employee/account can see the Asset & Service the person 

will receive in the Assets tab. 

 

 

 

Administrators of VIZOR can configure this form to not show the list of assets to the user as well as 

add/remove fields in the form. 

You can use any of the existing fields of a User account, as listed in the Web Admin > Field Editor > 

Users & Contacts, and you can create your own custom fields (see also Fields ). 
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HOW VIZOR KNOWS WHAT ASSETS AND SERVICES TO GIVE TO THE PERSON?  

 

VIZOR automatically starts the process of allocating and provisioning the assets needed by the person (by 

assets we also include any access to systems and services). 

The list of assets is based on the role or multiple roles of the person, as defined in VIZOR.  

The typical Automatic Provisioning rule is based on the Job Title but these rules can be also based on: 

- Job Title 

- Job Position 

- Department 

- Unit / Division 

- Project 

Authorized users can configure this by going to the Roles & Policies web view and then selecting the type 

of item to create the rule for: 
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As an example, select Job Titles and open the details of Administrative Assistant. Then click on the 

Automated Provisioning tab. 
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The list shows the assets and services currently defined to be given to users with this job title. 

Click on Add Asset Types to give more to this type of users. 

Apply your changes. 

Note that only users that are given the role from now on will be getting the new assets or services. 

Adding new assets to the list does not affect existing users with that role. 

 

You can add assets to be automatically provisioned in the same way for different roles, like for a Project 

and a Department, and all the assets will be added to the list if the roles apply . 

 

HOW VIZOR PROVISIONS THESE ASSETS AND SERVICES? 

Once VIZOR knows the list of assets and services to give to the person, it will create internal requests for 

each one. How each asset is given to the user depends on the rules for that asset type. 

APPROVALS 

Define if the asset still needs an approval or not when the process started from an Automated 

Provisioning rule in the Asset Type Life-Cycle, in the Approval stage. See more in Approvals.  
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Note the Request stage does not apply to Automated Provisioning. 

 

Fulfillment or Allocation 

What specific asset is allocated to the user is defined in the same way as if the request had started from 

an ad-hoc request from the Request Portal. You define this in the Asset Type Life-Cycle, in the Fulfillment 

stage. See more in Fulfilling Requests.  

 

Provisioning 

The rest of the provisioning for an Automated Provisioning also works in the same way as when the 

request start in the Request Portal. See how you define the Asset Provisioning actions in Asset Life-Cycle 

Automated Actions . 
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CHAPTER 12 - SOFTWARE ASSETS 

 

SOFTWARE ASSETS 

VIZOR Software focuses on managing your assets of class Software. Software Assets behave in general 

like any other asset, but they also have unique, extended characteristics and workflows that are exclusive 

to Software. For example, Software Assets have the following additional functionality: 

• Software Licenses records 

• Software Installations  

• License Compliance 

• Special Allocation/Deallocation 

 

For more information: 

Software Licenses 

Software Installations 

Software Asset Allocations 
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THE DEFINITIVE MEDIA LIBRARY 

Making your software assets part or not of the Definitive Media Library will make your operations run 

more smoothly when it comes to fetching installers and other digital items more consistently. If an item is 

part of the DML it means your organization has a definitive source, seed, shared volume location or path 

from which the digital media can be disseminated from. 

VIZOR helps you track the software that is part of the DML. By making a Software Asset Type be in the 

Definitive Media Library, the Software License record inherits the property and help you manage the DML. 

 

A valid Software License Record would look like the screenshot below: 
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Check the DML catalog by running the query “In Definitive Media Library”, as shown below. 
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CHAPTER 13 - SOFTWARE LICENSES 

VIZOR helps you manage Software Licenses associated to Software Assets. 

Each Software Licenses must be associated to a Software Assets, such as Microsoft Office. 

If you plan to include multiple versions in the same license, do not add the version to the name your 

Software Asset, e.g. “Microsoft Office”. However, in some cases, the license is restricted to a specific 

version, in which case is appropriate to name the Software Asset with the version, e.g. “Microsoft Office 

2016”.  

In either case, you can further specify the Version, Edition and Language of the software covered by the 

Software License record. 

 

EXPIRATIONS AND RENEWALS 

You can get reminders via email when software licenses or subscriptions are about to expire or to be 

renewed. 

By default, email notifications are sent 31 days before the End Date of a Purchase associated to a Software 

License. Emails are sent to the Contact and the Business Owner of the Software License in question, as 

designated in the Contact and Business Owner fields. The Software License must be active and the 

Purchase not Permanent (the duration) for the notification to be sent.  

You can change the default time interval (31 days) and the recipients (Contact and the Business Owner) in 

the Notification Editor. 

You can also create additional email notifications to meet the needs of your organization. 

 

LICENSE COMPLIANCE STATE 
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License compliance is performed automatically by VIZOR on a regular basis (configurable). 

Each Software License can have a Compliance State, which can be one of the following:  

 

Compliant – Optimal Less licenses are used than entitlements, within a 

configurable threshold (%) that accommodates for 

near future growth 

 

Non-Compliant 

 

More licenses used than entitlements 

Compliant - Over 

Licensed 

 

Less licenses are used than entitlements, but there 

are many unused licenses, more than the expected 

near future growth 

 

N/A For the cases where either our calculations cannot 

set the compliance or the concept does not apply 

 

 

A software license can be Compliant but exceeding a threshold (%). The threshold is  

▪ Defined per software license 

▪ The suggested action would be to sell licenses or renew fewer in the next contract 

with the vendor 

▪ You can also define the threshold based on employee hires/terminations/job changes 
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LICENSING CALCULATIONS 

The license calculation will: 

- Calculate the total number of licenses used, according to the specified method 

- It will take into account matching entitlements for: 

 

For each allocated User or 

Computer, the field…   

Needs to Match the field in SW License 

record… 

 

Allocated to Organization Entitled to Organization 

 Entitled to Location 

 Entitled to Department 

 Entitled to Project 

 

The default Licensing Calculations included with VIZOR are the following:  

Calculation Types:  

One License = One Computer installation  

One License = One Named User  

One License = One Computer CPU  

One License = X Computer CPU Cores  
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One License = One Operating System  

 

 

LICENSE COMPLIANCE OF OPERATING SYSTEMS   

Tracking license compliance of Operating Systems is similar to tracking compliance of regular software 

installations, with some differences: 

• Most software discovery tools do not report the Operating System as a “Software Installed” 

therefore they are not in the VIZOR Software Installations area. 

• Because of the above, you will not see these entries in the various installations lists such as in the 

Software Asset, License Record or Computer Asset. 

The calculation is based on the Operating System reported by the discovery tool as displayed in 

the Computer Details tab. 

 

 

 

To track license compliance: 

• Create a Software Asset Type for the operating system to track, for example "Microsoft Windows 

10". 

o While on the software licenses web view, click the “Software Asset Types” button in the 

right tool bar.  

o Click on “Add Asset type” and create the desired software asset type 
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• In the Installations tab, set the option to “Automatically import future installations that match the 

following patterns and associate them to this asset type” to Yes. Then enter the name of the 

Operating System that you want to match, as it is displayed in the field OS Name in the Computer 

Details tab. Save. 

 

 

 

• Create a Software License for that Software Asset Type. 

o Back in the “Software Licenses” web view, click on “Add new license” in the right tool bar.  

o Look for the software you are creting the license for in the “Software” field and fill all 

other fields as needed 
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• In the “Compliance” tab, change the Licensing Calculation to be One License = One Operating 

System 

 

• You may also enter the Version in the Software License record if you only want to match a specific 

version for this record. 

 

As for other compliance calculations, the calculations happen on a regular basis via a background process 

controlled by the configuration item “Assets Verification”. You can run it on demand by clicking on the 

button “Run Now” or regularly via the Interval. The Interval is in hours. 
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One report that could be useful when tracking Operating Systems is the report “Computers by Operating 

System”, in the Assets view. 
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DOCUMENTATION 

 

Documentation related to a software license such as license certificates, purchase orders, invoices and can 

be uploaded against a license on the Documents tab.  

Files can be uploaded to VIZOR directly, or linked to a file storage system such as SharePoint.   
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LICENSE PURCHASE CALCULATIONS  

VIZOR allows you to track your licenses purchases, renewals, upgrades and other agreements and 

automatically keep your licenses calculations up to date.  

VIZOR calculates these whenever a purchase is added, updated or removed in the Purchases tab. 

- Number of Licenses are calculated using only the Active purchases. 

- Costs over time (total cost, licenses costs, maintenance costs, and services costs) are calculated 

using the total of all the purchases, active or not. 

- Average costs per unit (avg total cost, avg license cost, and avg maintenance cost) are calculated 

using just the active purchases. 

 

RECOVERING LICENSES 

For licenses based on Installations, one computer per license, for example, VIZOR will automatically 

recover the license and recalculate compliance accordingly. 

For others, where there is a license file or key that must be removed from the device, use Deprovisioning 

Actions.  

Deprovisioning Actions. 

If the process cannot be automated, you should at least create the VIZOR action to document the process 

and ensure someone execute the procedure.  

Create a HelpDesk ticket or a VIZOR action to make someone responsible of the recovery of the license.  

 



  Page 225 

 

Automated Recovery through a script: it is possible for some software to execute a script in order to 

remove the allocation of the license from a device. For example, VIZOR includes some power shells for 

removing a cloud SalesForce license or an Microsoft Office 365. Create a Execute Command Action to 

execute these scripts when deprovisioning the asset. The action will execute automatically when: 

- The person leaves the organization 

- The person changes job title and the new one no longer needs that asset 

- The device is retired 

- The device is assigned to someone else 
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RELEVANT FIELDS 

Some important fields of the Software License record are: 

Field Name Data Type Choice List Notes 

    

Entitled Licenses / Number 

of Licenses 

 

Single-

Choice 

  

Licensing Model Single-

Choice 

 

  

Licensing Calculation Single- 

choice  

 

  

Licenses/Seats Installed or in 

Use 

 

  Set by the licensing calculation 

Last Licensing Calculation 

 

  Timestamp of last time the 

licensing calculation process 

executed 

 

License Calculation    
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Parameter 

 

Over-Licensed Threshold 

 

   

Allocated to Organization Single-

Choice 

Companies 

(USERS.tblUser 

WHERE …) 

 

 

    

Allocated to Location Single-

Choice 

Locations 

(Roles.tblDts 

WHERE …) 

 

 

Allocated to Department Single-

Choice 

Departments 

(Roles.tblDts 

WHERE …) 

 

 

Allocated to Project Single-

Choice 

Projects 

(Roles.tblDts 

WHERE …) 
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Licensing Model: the licensing model indicates how the software is licensed. Is it open source? Is it 

licensed per named user? The licening model is important for categorization of the license records and it 

used for the calculation of compliance. It also determines the Licensing Calculation for some cases. The 

possible values are: 

- Concurrent / Per Session  

- Enterprise Agreement  

- Freeware  

- License Server - Floating 

- Named User  

- Network  

- OEM  

- Open Source  

- Packaged - Single  

- Per Computer/Device  

- Per Server CPU  

- Per Server CPU Cores  

- Shareware  

- Trial  

- Utility-based (pay-per-use) 

 

There are also other fields that belong to different entities and are used in the context of Software 

Licenses. For example, the following are fields of an Asset, a Computer Asset specififally, and are used for 

licensing calculations: 

o CPU Count 

o CPU Cores Count 

o Virtual Machine 
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CHAPTER 14 - SOFTWARE 

INSTALLATIONS 

VIZOR helps you manage the installations of software across your computers, for the software assets that 

are important to you.  

A Software Asset is typically associated to multiple installations, so you can see where and how that 

software has been deployed. You can also join installations of different software titles or packages as one 

Software Asset Type. In many cases, there are many software installations of different versions, editions 

and minor builds found by the Discovery layer that represent the same Software Asset type. 

In order to do this, VIZOR synchronizes with your Microsoft Endpoint Configuration manager ECM (a.k.a. 

SCCM), or Vector’s own Inventory and Discovery component, and it automatically brings the relevant 

software inventory information discovered by them.  

 

VIZOR allows you to focus on the software that is important to you by: 

• Viewing only the Software Installations that you need to manage.  

You may need to manage specific software because of costs, size of deployment, license 

compliance, etc. About 80% of the installations found by discovery tools are not useful to 

be managed by organizations. 

• Normalizing the Software Installations into Software Assets 

Normalizing or grouping all the multiple different installations and flavours of a software 

title as one helps you be more efficient and optimize its use.   

 

 

ALLOCATIONS VS INSTALLATIONS 
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Allocations are normally managed by VIZOR using approval workflows and the App/Asset Request Portal. 

They represent the “should be”. 

Installations are found by a discovery layer, such as Vector’s own or Microsoft ECM, and represent what “it 

is found to be”.  

Part of the optimization process is to ensure the Software “found to be” is closest to the “should be”. 

 

There are some reasons why the allocations may not be the same as the installations for a given software 

license: 

1. The allocation has not been defined yet for that software.  

This is especially true at the beginning of using VIZOR. As new requests and approvals for 

software are processed, VIZOR automatically handles them as allocations (the “should be”), but at 

the beginning allocations would be empty. 

 

Note: You can also import the allocations if you have the allocations or policies 

already defined elsewhere. 

 

2. The provisioning is not complete.  

Maybe VIZOR has just allocated the license to the user or computer, and therefore it is reserved, 

but it is not installed yet. The actual installation can be automated via VIZOR and Microsoft ECM, 

AD GPOs or other software distribution tools. 

 

3. There has been installations performed outside VIZOR. 

You want to know if it happens. Ensure you use VIZOR email notifications to alert you of this 

situation. 

 

4. The de-provisioning is not complete.  

Similar to deploying software, it is possible that VIZOR has just removed the license from the user 

or computer, as when an employee leaves, but the uninstallation is in progress. 

 

5. The Discovery of Installed Software is not up-to-date.  

The discovery tool may not be fully updated yet. This may or may not be a problem to attend. For 

example, if the discovery tool is configured to update the software inventory every 2 days, then it 

is expected to have up to a 2 day delay. This situation should be temporary. 
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RECONCILIATION AND IDENTIFICATION OF ALLOCATION VS INSTALLATIONS  

VIZOR will automatically try to match the Software Asset instance that may be associated to a Software 

Installation found in your network by Vector Discovery, ECM, LanSweeper, etc. 

For each installation CI record, VIZOR matches the title in the Software Asset Types library and a valid 

available Software Asset instance, based on the Allocated Computer or on the computer being used by 

the Allocated to Person. 

 

Useful builtin queries: 

IN SOFTWARE ASSETS: 

o “Software Asset NOT Linked to an Installation” 

o “Software Asset Linked to an Installation” 
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IN INSTALLATIONS: 

o “Installations NOT linked to a Software Asset” 

o “Installations linked to a Software Asset” 

 

 

 

 

 

SOFTWARE LICENSE KEYS DISCOVERY 

 

VIZOR integrates with third party tools such as Recover Keys that discover software keys installed 

in computers. You can view the discovered keys in VIZOR in the Software Installations area.  

Each discovered key is automatically assigned to the computer installation of the software title, 

which may have version and edition information. 
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Discovered keys are ‘found’ keys, and are different from ‘should be’ keys. That is, the keys used to 

install software in your network may not be the same keys you have as part of your entitlements. 

Entitlement keys are stored in the Keys tab in the Software License record (Software Licenses). 

 

You can easily check what software titles you have discovered keys for by running the query 

License Key Discovered (set the Summary List Layout to Key) or any of the reports Discovered 

License Keys by Application and Discovered License Keys by Computer. 

You can also view the discovered keys in the Installations tab of the Software License record and 

the definition of the Software Asset type.  

 

INTEGRATION WITH RECOVERKEYS 

What types of keys are integrated into VIZOR? 

All the keys, serial numbers and license keys found by the tool RecoverKeys are imported into 

VIZOR and associated to a Software Installation.  

 

RECOVERKEYS DISCOVERY 

The tool RecoverKeys is installed in one or more computers in your LAN. You don’t need a server 

for RecoverKeys.  

When executed, RecoverKeys scans the network and discovers the license keys of the computers 

included in the target IP address range. In order to discover these keys, the Windows user running 

RecoverKeys must have administrator permissions in the target computers.  
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CHAPTER 15 - WARRANTIES 

 

 

VIZOR helps your organization track the warranties of your assets efficiently. 

Each asset has warranty information such as  

• Warranty Description: optional free text that may be useful to understand the warranty 

type, scope, etc. 

• Warranty Status: to easily identify if the warranty has expired 

• Warranty Start Date 

• Warranty End Date 

• Warranty ID: the identifier or name of the warranty as per the vendor 

 

VIZOR also includes the following fields that may be useful when managing warranties: 

• Support End Date: some devices have an end date of support for the device, after which 

time the device will not receive updates from the vendor or the operating system. For 

example, this is an important information for Chromebook devices because the Chrome 

OS will not receive updates after this date. 

• Assignee Insurance: if not blank, this indicates the person to which the device has been 

allocated has an insurance to cover the device repairs or lost incidents. In the case of 

schools, the insurance is often tracked per student. 

• Number of Repairs: a counter of the number of repairs the device has gone through, 

which can be useful when managing its warranty.  

• Is Lemon: if Yes, it indicates the number of repairs has exceeded a maximum threshold. 

This is often reflected in a decision to not repair the particular device again but retire it or 

return to the manufacturer instead. 

 

 

AUTOMATICALLY OBTAINING THE WARRANTY INFORMATION  

 

VIZOR can automatically get the exact warranty information for each device by communicating directly 

with the vendor. This is an excellent way to keep the records up-to-date in an efficient manner. 

The current vendors that support this functionality are: 

• Dell 

• Lenovo 
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*  VIZOR has a connector for HP Warranties developed according the HP API. However, at this 

time HP has stopped the service. VIZOR and other software vendors are waiting on guidance from 

HP on when the service will be resumed. 

 

To use this feature, the vendor requires you to get a client ID and a secret key that is unique to your 

organization. Please contact your vendor to get the necessary account information to get the warranty 

information from them using VIZOR. 

 

Once you get your client ID and a secret key, log in to VIZOR as an administrator and go to Configuration. 

Search for “warranties” web view and open the configuration item specific for the vendor.  

Enter the client ID and a secret key, and save. 

VIZOR has an automatic process in the background that will regularly synchronize the warranties over 

time. The process updates a few warranties at a time, due to vendor constraints, and typically a few 

hundreds will be synchronized during a day. 

 

You can easily monitor progress by using one of the built-in queries per vendor, like “Devices from Dell” 

and sorting by “Most Recently Updated”.  

 

VENDOR URLS USED 

VIZOR needs to communicate with the vendors to obtain the warranty information. You may need to 

open/allow communication through your firewalls for the following URLs: 

 

• For Dell 

https://apigtwb2c.us.dell.com 

 

• For HP 

https://api-csc-sgw.external.hp.com 

 

• For Lenovo 

https://SupportAPI.lenovo.com 

 

 

 

  

https://apigtwb2c.us.dell.com/
https://api-csc-sgw.external.hp.com/
https://supportapi.lenovo.com/
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CHAPTER 16 - FINANCIAL 

INFORMATION & PURCHASES 

 

 

ASSET TYPES COSTS 

VIZOR allows you to manage the standard or estimated cost of an asset or service type.  

These costs can be displayed to the end users in the Request Portal to give an idea of the internal costs, 

whether they are actually charged or not. 

 

To enter it, go to Manage Asset/Service Types and select the asset type you want to enter the cost for. 

Enter Yes in “Has An Associated Cost?” and enter the “Associated Cost”. 

 

 

IMPORT COSTS FROM EXTERNAL SYSTEMS 

You can import the standard cost of assets and similar information by using the VIZOR Import Manager.  

Use the import of Asset Type information. For example, select the option in the screenshot for importing 

from an excel file generated by the system that has the costs. 
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In the mappings, ensure the Associated Cost and the Asset Type fields are mapped. 

You can map additional information that may be relevant. 
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COSTS OF ASSET INSTANCES  

VIZOR allows you to manage the cost of each specific instance of an asset throughout its Life-Cycle. This 

is recorded in the Purchases tab of the asset instance. 

 

 

Your associated costs are recorded with related purchases, which can be of different Sub Types: 
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See Asset Purchases in this guide for more information. 

 

CATEGORIZING ASSET COSTS  

 

In VIZOR, you can categorize the costs via the related Purchases and Purchase Line Items. 

Typical field to use for categorizing the costs are: 

Purchase Line Item Sub Type: main sub type are New Purchase, Maintenance, Services, Upgrade, 

Subscription, Facilities. The possible values were described in the previous section. 

 

 

Department: allocate the cost to a department. This also sets the software asset instance as reserved for 

that department. Modify the list of Departments in Roles & Policies. 

Location: allocate the cost to a specific Location. This also sets the software asset instance as reserved for 

that Location. Modify the list of Locations in the Locations view. 

GL Account: allocate the cost to a specific entry in the General Ledger of the company.  

Cost Center: allocate the cost to a specific cost center of the company. Modify the list of Cost Centers in 

the Choices Editor (Webadmin > Fields > Choices).  

Capex-Opex: to categorize in Capital Expenditures vs Operational Expenditures. 

Fixed-Variable: to categorize in fixed, having the same cost for the term period, vs variable, being 

variable depending on consumption or other variables. 

Direct-Indirect: to categorize in direct to production or consumtion vs indirect. 
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CONFIGURATION AND COST CALCULATIONS FOR HELPDESK REPAIR TICKETS  

To configure and optimize this feature in your VIZOR system, please follow these steps: 

1. Edit the Cost column in the choice list associated with the Cost Units within the HelpDesk project. 

This allows you to define different cost units that align with your organizational requirements. 

 

2. Customize the Set Service Cost Business Rule in the HelpDesk module. This rule ensures that the 

appropriate Service Cost is automatically assigned based on the Category assigned to the ticket. 

By tailoring this rule, you can fine-tune the cost allocation process to your specific needs, 

however, please note that this rule will be disabled if you have a non-out-of-the-box Category list 

configured on your server. 

 

3. To include specific Asset Types in the Parts Repaired list, ensure that the Is Part? field is set to Yes 

for those Asset Types. Additionally, provide the relevant Service Cost (and optionally, the 

Associated Cost) for each Asset Type, enabling you to select the appropriate parts during ticket 

creation, ensuring accurate cost calculation. 

If you prefer to disable the automatic cost calculations and opt for manual entry only, please follow 

these steps: 

1. In the Field Editor, set the default value of the Manually Enter Cost field to 1. This change will 

prompt you to manually enter the cost for each ticket, bypassing the automatic calculation. 

 

2. In the Web View Editor, remove the Manually Enter Cost field from the HelpDesk/HelpDesk view. 

This step removes any confusion and aligns the view with your chosen manual entry approach.  
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ASSET PURCHASE INFORMATION 

The Purchase information for an Asset can be viewed and edited by clicking in the Purchase Details tab for 

that Asset. This information can be edited for multiple assets in a single transaction using the Mass 

Update functionality.  

 By default the following purchase information can be tracked per Asset. 

 

• Purchase Reference  

• Supplier/Seller  

• Unit Price  

• Purchased Date  

• Delivery Date  

• Service Contractor  

• Warranty Description  

• Expected Life  

• Warranty Start Date  

• Warranty End Date  

• Warranty Status  

• Warranty ID  

• Depreciation Scheme  

• Recurring Costs  

• Salvage Value  

• Book Value 

Purchase information can be manually entered in to VIZOR or come via an integration with a purchasing 

system. 
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DEPRECIATION SCHEMES 

Depreciation is an accounting method of allocating the cost of a tangible or physical asset over its useful 

life or life expectancy. Depreciation represents how much of an asset's value has been used up and helps 

to tie the cost of an asset with the benefit of its use over time. In other words, the asset is put to use each 

year and generates revenue—the incremental expense associated with using up the asset is also recorded. 

Vizor lets you calculate the current value of an asset based on built-in or custom depreciation schemes 

like: 

• Degressive 10% 

• Degressive 40% 

• Degressive Duration of Contract 

• Linear 

Depreciation can be triggered from the “Depreciation” configuration item. To access this item: 

• Log in and access find the “Configuration” quick link in the quick links widget in your home page 

and click on it. 

 

 

 

 

 

 

 

 

 

• Once in the “Configuration” web view, use the search box at the top of the screen to find the 

“Depreciation” item. 
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• In the configuration screen below, follow the instructions: “Click on Run Now to process the 

depreciation of the assets specified in the query ‘To Depreciate’ 

 

• Depreciation Date 

o You can configure “Depreciation Date” and “Start of Fiscal Year” as needed in your 

organization.  

o This is the date up to which the depreciation will be calculated for assets. This is the 'cut' 

date, in many cases the current day when running the depreciation. If left empty, the 

current date will be used.  

o Only the day and month will be taken into account for the start of the fiscal year. The 

“Run Now” button will trigger the depreciation calculation for the assets in the “To 

Depreciate” view. 

o Having the ability to set this date allows you to calculate depreciation up to a period that 

passed, for example, set the depreciation book value for the assets to be on 01-January 

every year, but run it a few days later 
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• In order to be in the to be in the “To Depreciate” view, assets need to meet the conditions below: 

 

 

o Be an active asset. 

o Price must be declared. 

o The following fields must be filled out: 

o Depreciation scheme 

o Expected life (in years) 

o Book value. 

o Salvage value. 

 

• Go back to the “Purchases” tab to see the updated depreciation values  

 

HOW OFTEN IS DEPRECIATION TRIGGERED? 

The Depreciation calculation does not run automatically. Use the Run Now button when you need to 

calculate it. Contact our technical support if you want the process to run on a regular basis. 
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ASSET AGREEMENTS AND PURCHASES 

VIZOR tracks all agreements purchases, these can be searched and filtered showing recent purchases and 

agreement expiring.  

 

Agreement and Purchase view shows all line items on the purchase and associated purchasing 

information such Cost Center, PO Number and Contact details.  

 

PURCHASE AUTO-RENEWAL 

In VIZOR, you have the option to enable auto-renewal for each purchase, allowing the system to 

automatically create the next iteration of the purchase when it's due for renewal. To enable this feature, 

set the "Auto Renew Purchase" to "Yes" on th  e ticket and specify the renewal interval and date.  

The available auto-renewal intervals are: 

• Monthly 

• Quarterly 

• Bi-Annually 

• Annually 

When utilizing the auto-renewal feature in VIZOR, several actions are triggered. Firstly, as the designated 

renewal period approaches, VIZOR generates a new purchase that mirrors the original purchase, with all 

line items preserved, these line items are adjusted by offsetting the date fields according to the selected 
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renewal interval. Furthermore, any alerts associated with the line items persist and seamlessly carry over to 

the new iteration.  

For line items where the "Auto Create Assets" option is enabled, no new batch of items will be generated, 

instead, the existing items tied to the previous line item will be reconnected to the new line item. This 

process involves redirecting the items and updating their end dates with the appropriate interval offset. 

 

CASES WHEN IT'S RECOMMENDED NOT TO USE AUTO-RENEWALS 

• If you're renewing for a higher or lesser quantity, it's best not to enable auto-renewal, this way, 

you can manually handle any surplus items or avoid creating additional resources. 

• If the only change on renewal is pricing, using the auto-renewal mechanism and adjusting the 

pricing later can save time. 

• If the only change is the PO or Invoice Number, auto-renewal can be used, and the necessary 

adjustments can be made afterward. 

In case you choose not to auto-renew, the old purchases will retain their status and will not be 

automatically deactivated or made inactive. 
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SETTING UP ALERTS FOR LINE ITEMS AND PURCHASES  

 

VIZOR can alert you when a line item or purchase is about to expire. You can set this alerts in the 

Purchases & Agreements web view inside a purchase record by selecting the line item and clicking on 

"Edit Alerts". 

  

 
  
 

By default, these alerts are sent using the macro "<Purchase Stakeholders>" that sends to the 

Stakeholders of the Purchase Line Item, as well as the Contact, Stakeholders and Business Owner of the 

Line Item’s related License.  

  

Stakeholders and the end date can be setup by clicking on the "Edit the Alert" button.  
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CHAPTER 17 - AUDITS 

 

VIZOR helps you manage internal or external audits. 

 

You can track if a specific asset is under Audit or if the complete Asset Type is under Audit. 

 

The Audit tab contains information relevant to tracking these. 

 

Under Audit: set it to yes when your organization is auditing this asset instance or asset type. 

 

Under Dispute: there may not be an audit, but a contract dispute with the vendor or supplier. Set it to 

Yes when this is the situation. 

 

Last Audit: date when the last audit concluded. This is useful especially if there is a new audit, to know 

when the last audit was. You can create queries like 

 Last Audit < <Days ago: 365> 

that helps you identify regularity and vendor practices. 

 

Audit Actions: keep track of all the activities related to the audit. Logged, timestamped and searchable. 
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PREVENTING CHANGES DURING AUDITS 

 

In VIZOR, you can prevent any updates to asset records during an audit, as needed by some regulations 

and requirements.  

To enable the modification audit lock, simply go to the Asset Type and set: 

Under Audit    = Yes 

Prevent Updates During Audit  = Yes 

 

Save. 

 

 

 
 

 

 

If any user tries to added new assets of this type, update existing asset records or delete one, VIZOR will 

prevent this and show the warning below until the completion of the audit (Under Audit = No). 
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CHAPTER 18 - INTEGRATION 

BETWEEN PROCESSES 

VIZOR helps you manage the relationships between different ITIL process records. For example, an 

Incident may have an associated Change Management record. A Problem may have a few Incidents, etc.  

 

FROM ASSETS 

 

INCIDENTS 

You can view all incidents related to an asset by clicking on the Asset instance and then going to the 

Related Items tab. 

Click on View Related HelpDesk issues and a new window opens with all the Incidents and Problems 

associated to this asset. 

 
 

 

 

CHANGE RECORDS 
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You can view all Change Records related to an asset by clicking on the Asset instance and then going to 

the Related Items tab. 

Click on View Related Change Requests and a new window opens with all the Change Management 

Records associated to this asset. 

 

 
 

 

RELEASE RECORDS 

You can view all Relase Records related to an asset by clicking on the Asset instance and then going to 

the Related Items tab. 

Click on View Related Release and a new window opens with all the Release Management Records 

associated to this asset. 

 

 
 

 

 

ALERTS IN INCIDENT MANAGEMENT 

If users are creating an Incident associated to a high priority asset, a message will alert them of the high 

importance of the asset to the business. The user may then consider this information when assessing the 

Impact, Urgency and Priority of the ticket. 
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FROM SERVICE REQUESTS  

 

INCIDENTS 

You can create a new one with Add, or link to an existing one with Link to Existing. 
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CHANGE RECORDS 

You can create a new one with Add, or link to an existing one with Link to Existing. 

 

 
 

 

 

RELEASE RECORDS 

You can create a new one with Add, or link to an existing one with Link to Existing. 
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ASSET AND CONFIGURATION RECORDS 

Service Requests are linked to the Asset CMDB and configuration system in several ways: 

 

• The Service Request is associated to the “Asset/Service Request Specification”, as 

described before. This “Request Specification” is a full asset or CI record in Assets that 

represents what is requested, the type, the characteristics, how it should be, etc. It may 

not be the exact way it was provisioned. 

 

• The Service Request is associated to an Asset or CI Record in Assets for the fulfilled assets 

or services. Each record is an Asset or Service Instance, which is allocated, has life-cycle, 

access controls, etc. This can be an actual computer, a software installation in a computer, 

access to a Cloud system, etc. 

 

• The Service Request may have triggered an action with an external Configuration 

Management System or CMDB via Provisioning Actions. The relationship and change with 

that external system is recorded in the action and, depending on the external system, it 

may have bidirectional information coming from the external system.  

For example, ECM may or an external CMDB may report back the completion of the 

deployment, or additional information about the installation. 

Another example would be with a system that generates electronic keys. VIZOR has 

integration with some providers in which the request for the change of code for the 

electronic key is made directly to the external system, which in turns returns the new 

serial number to VIZOR, or other documented Configuration records of the asset. 

 

• The Service Request may had spawned a Change Record, which is itself related to a CI 

record. 
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CHAPTER 19 - ADMINISTERING VIZOR 

 

CREATING PROJECTS AND GENERATING WEB VIEWS 

A VIZOR project includes: 

 A database of records of the main data your are tracking in that project (and their revision 

histories). For example, Incident and Problem records are in the HelpDesk VIZOR Project, Asset 

instance records are in the Asset/Resources VIZOR Project and Software License records are in the 

LicenseManager VIZOR Project. 

 A database of definitions, which includes the queries, sorts, layouts, reports, notifications, 

fields, and tabs available in the project.  

Each project can have multiple Web-based views.  

Each Web view is customized to meet the needs of a class of users. For example, in HelpDesk, employees 

only need to see the issues they submitted not all the issues in the project database. On the other hand, 

support staff need access to all the issue information in the project database. Likewise, a person managing 

Software Licenses for only a specific department should only see the Software License records of that 

department, while the general Software Asset Manager person would be able to see the Software License 

records of all departments. 

With VIZOR, you can provide separate views for different teams based on the VIZOR User Groups. Each 

view is accessed through the same Web-based interface.  

Views are easy to define using the Web view Editor. Just choose the queries and fields that you want users 

to see:  

 Queries determine which issues users can retrieve from the project database.  

 Fields determine what information users can view and modify for each issue.  
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HOW TO KNOW WHAT WEB VIEW IT IS? 

Sometimes it is needed to know what Web view a particular user interface belongs to. Most UIs in 

VIZOR are part of a Web view. For example, if you want to change the name of a field in the UI or if 

you want to add or remove queries to the list, you need to know the name of the Web view, and the 

VIZOR project it belongs to. 

How to know?  

For simple, standard views, the URL visible in the Web browser often tells us the name of the Web 

view in the format: 

 …/connect../ProjectName_ViewName/… 

So, for instance, the name of the main “Assets” Web view is “Resources_Library”. Resources is the 

VIZOR project or database it is in, and “Library” is the name of the Web view inside “Resources”. In 

this case, your URL at the top of the browser would be similar to: 

http://demo6.vizor.cloud/connect03/Resources_Library/HTML/censusmain.asp?View=Resou

rces%2FLibrary&State=2&t= 

 

However, in some cases it is not that simple if you are in a nested Web view. A nested Web view is a 

view inside another view. For example, in the Assets view (Resources_Library), open the details of any 

asset and go to the Details tab. You will see a button to view the tickets related to the current asset as 

below. 
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If you click on this button, you will see  a new list: 

 

 This is an embedded Web view of the project HelpDesk inside the Resources_Library view. How can 

we know the name of this Web view? These are steps for Chrome and Edge browsers; 
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- Right click on any column of the summary list and click on Inspect. 

- This opens the Developer tools dialog. On the right, click on the tab Properties: 

-  

- Note the property called baseURI. This URL will indicate the name of the Web view, 

HelpDesk_RelatedIssues in this case.. 

 

 

 

 

To create projects and edit definitions (of fields, queries, reports, sorts, layouts, and notifications), use 

VIZOR Admin, a Windows program. VIZOR Web Admin is a Web-based tool that allows you to remotely 

edit some of the project definitions (such as tabs and choice lists).  
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ADMINISTERING PROJECTS AND WEB VIEWS  

 

  

 

EMAIL INTEGRATION  

 

EMAIL INTEGRATION 

VIZOR email integration can be set for both incoming and outgoing emails.  

Outgoing Emails are used for sending emails from VIZOR, usually automatically via the email notifications. 

Incoming Emails are used for receiving emails into VIZOR and processing business rules around them. For 

example, they can be used to store email communication related to a HelpDesk ticket or to a Software 

Purchase. Incoming Emails are also used for converting emails to tickets in HelpDesk. 
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INCOMING SETTINGS 

Access VIZOR Web Admin via a link such as: https://mycompany.VIZOR.cloud/connectadmin/. 

If a subdomain is not yet set up for your VIZOR server, the link will be an IP address such as 

http://10.2.123.45/connectadmin/ 

 

Login using an account that has access to admin features. In most cases, the user will be: 

Username: admin 

Password: admin 

 

This account is the default one available during initial configuration, but you may use any other 

administrator account. It is suggested to change the password of the admin user once all the 

configuration is completed. 

Click the Email tab (Figure 1.1). 

 

Figure 1.1 

From the dropdown list, select the HelpDesk project (Figure 1.2). 
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Figure 1.2 

On the far right, click Add a new Integration. A window will appear with multiple fields to fill out (Figure 

1.3). 

 

Figure 1.3 

E-Mail Address: The e-mail address of this monitored account, such as support@company.com. It will 

appear by default as the “From” address of automated and manual replies to process e-mails. 
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Hostname: The hostname or IP address of the IMAP  or POP server. 

Port: The port through which the IMAP or POP server communicates. If the IMAP server requires SSL, 

enable this by checking the box. 

Logon: The logon of the account used to access the IMAP server. 

Password: The password of the account used to access the IMAP server. 

Once all the information is entered, click on Test (Next to the logon and password fields). If the settings 

are correct, you will get a confirmation message as a browser alert. Otherwise, you will be alerted of an 

error, meaning one of the fields in the settings are incorrect. 

 

The Mail Handling and Issue Completion sections of this window are typically done by the main contact 

of your VIZOR implementation project and are to be discussed, so you may skip these parts and click OK 

in the bottom right. The Integration will be disabled by default, and it is turned on once configuration is 

complete, and you are ready to go live with your new VIZOR system. 

OUTGOING SETTINGS 

Click on Mail Settings (Figure 1.2). The SMTP settings are usually the same the incoming settings. You 

can test these outgoing settings by clicking the Test button (Under the password field) and entering an 

email address to which a test email will be sent to verify the connection (Figure 2.1). Like the incoming 

settings, you will see a success or error message depending on the validity of your settings. 

 

Figure 2.1 

 

In the next section under the SMTP settings, add the email addresses that will be used (Figure 2.2). 
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Figure 2.2 

The first email address, just like the incoming settings, is used in the “From” of emails being sent. Also, 

emails can be sent at specific intervals. In this example, it would be every hour. The second email address 

is used for failed outgoing emails. Typically, an administrator would receive the notification. A maximum 

number of retries can be set, meaning the amount of tries before the failing email sends an error 

notification to the administrator. Once all the settings are filled out, click Apply in the bottom right. Your 

VIZOR email integration is now complete. 

VIZOR ADMIN  

VIZOR Admin is an application for administering VIZOR projects. For example, you can use it to:  

 Create projects 

 Customize fields 

 Define queries, sorts, and layouts 

 Define reports 

 Define and set up e-mail notifications 

To start VIZOR Admin:  

On the Start menu, select Programs, Vector, VIZOR, Vizor Admin. 

On the Start menu, point to Programs, click VIZOR, and then click Vizor Admin. 
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 Web View Editor  

Web View Editor is a Microsoft Windows application that creates Web views for your VIZOR projects. Web 

views are Web-based applications that provide access to projects through a Web browser.  

To start the Web View Editor from VIZOR Admin:  

On the Tools menu, click Web and then click Web View Editor. 

The Tools > Web > Web View Editor command is available only when the Web View editor is installed 

on the computer running VIZOR Admin.  

To start the Web View Editor from the Start menu:  

On the Start menu, select Programs, Vector, VIZOR, Web View Editor. 

On the Start menu, point to Programs, click VIZOR, and then click Web View Editor. 

Notes 

 VIZOR Admin and Web View Editor are installed on the Web server, by 

default. You can install additional copies of these tools on other computers, so 

you can perform administration tasks locally. However, to create new Web views, 

you must use the editor on the Web server. 

  

VIZOR WEB ADMIN 

VIZOR Web Admin is a Web-based administration tool. It allows you to perform the following 

administrative tasks over the Web:  

 Manager users and user groups, and define group privileges (access to 

features and projects) 

 Add and edit contacts 

 Define workflow rules 

 Create new tabs 
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 Set up choice fields 

 Enable e-mail notifications 

 Migrate projects to SQL Server and move projects to different SQL Server 

computers 

 Move attachments to a different computer 

To logon to VIZOR Web Admin, choose one of the following methods: 

 In your Web browser, go to //server/vitadmin, where server is the name of 

your Web server. 

 In VIZOR Admin, click Tools > Web > Web Admin. 

 At the Web server, click Start > Programs > Vector > VIZOR > Web 

AdminStart > Programs > Vector > VIZOR > Vizor Web Admin. 

 

If users cannot successfully relocate databases or perform other tasks with VIZOR Web Admin, check that 

there is a global group named YOURDOMAIN\CensusAdminsGroup, and that the user (especially if the 

user is a domain user, not a domain administrator) is a member of this group.  

VIZOR Web Admin uses your Windows credentials to run tasks if you are a member of the 

CensusAdminsGroup group or the local Administrators group on the VIZOR Server computer. Otherwise, 

VIZOR Web Admin runs tasks as CensusUser.  

Members of the CensusAdminsGroup group (or of the local Administrators group on the VIZOR Server 

computer) have the required permissions to perform any task with VIZOR Web Admin. The CensusUser 

account, on the other hand, cannot perform IIS-related tasks such as unloading virtual directories (when 

logging off users), and may not be able to relocate databases to other computers.  

During installation, the Setup program creates the CensusAdminsGroup group and adds all members of 

the domain Administrators group to the CensusAdminsGroup group. Setup also adds the 

CensusAdminsGroup to the local Administrators group on the VIZOR Server computer. The purpose of the 

CensusAdminsGroup is to control access to Web Admin.  

If Setup was unable to create the CensusAdminsGroup, you can create it manually.  
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For example, if you want to allow a domain user that is not a domain administrator (because domain 

administrators already belong to the local Admins group by default) to use the Relocation tab, you can 

create the CensusAdminsGroup and add the domain user to the group. This allows the domain user to 

perform tasks that are typically only available to local admins:  

 Managing SQL Server databases and physical files. 

 Logging off VIZOR users (which requires permissions to control IIS). 

TO MANUALLY CREATE THE CENSUSADMINSGROUP AFTER VIZOR IS INSTALLED:  

1   Create a global group named CensusAdminsGroup in the domain. 

2   Add CensusAdminsGroup as a member of the local Administrators group of the Web server. 

3   On the Start menu, click All Programs > Vector > VIZOR > Vizor Tools > Set Up Global Group.All 

Programs > Vector > VIZOR > Vizor Tools > Set Up Global Group. 

 

GLOBAL CONFIGURATION OPTIONS OR SETTINGS 

VIZOR offers multiple global additional configuration options or settings to further tailor VIZOR to your 

needs. In VIZOR Admin you can find the following options: 

Option Description Default Value 

Disable remembering last 

Summary List 

If No, the last Summary List of 

the user will be used in the next 

session. If Yes, the default 

Summary List will be used 

No 
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APPLICATION SETUP AND MAINTENANCE TASK 

 

From time to time, we want to make sure VIZOR is up and running the best way possible. As with any 
other system, maintenance is needed to smooth up operations.  This task checks several VIZOR 
processes that are critical, for example, it ensures some database tables are 'in good shape'. It also 
triggers some automatic allocation of assets, etcetera. 
  
This task is usually run over night. To run it on demand, go to the "Configurations" web view and search 
for "Application" or "Setup". Select the "Application setup and maintenance tasks'. Click on "Run now" 
to run the task on demand.  
  

 
  
  
If you would like to run it in a set interval instead, set it up in the "Interval" field. This indicates the 
interval in hours. You can also check out the next run and last run in their respective fields.  
  
The next run can also be setup to an arbitrary date if needed: 
  

1. Setup the desired date in the "Next Run" field.  
2. Consider that after this run, the following time will be determine by the date you set up plus the 

interval set in the "Interval" field. 
3. If the intention is to change this temporarily, change the settings back to the desired run time.  
4. It is recommended that this task is run overnight as some tasks may be CPU or Memory intensive 

and could cause your VIZOR to run slow.  
 



  Page 271 

 

CHAPTER 20 - INTEGRATION WITH 

ACTIVE DIRECTORY 

 

OVERVIEW 

VIZOR integrates with your Active Directory in multiple ways: 

1. Log in to VIZOR using your AD user. 

o Single-Sign-On (SSO) 

Allows your users to skip entering their user logon name and password if they are already 

logged in with their AD user in Windows or the browser.  

o Log in with AD credentials 

Your users enter their user and password in the VIZOR logon page, which is authenticated 

by AD. This mechanism is also used for Windows programs. 

 

2. Import and synchronize user accounts automatically 

o Import and keep always synchronized user AD accounts as VIZOR Users  

▪ Users can log on to VIZOR 

o Import and keep always synchronized user AD accounts as VIZOR Contacts 

▪ Contacts cannot log into VIZOR but are contacts of tickets, stakeholders and 

people relevant to the processes in VIZOR. Emails can be sent to contacts. 

 

3. Create user accounts in AD 

VIZOR can create user accounts in Active Directory automatically after certain events that 

can be configured. These are usually executed as part of onboarding users or on events 

of the life-cycle of an asset. 

 

4. Modify membership of users to OUs and Security Groups 

Similar to the creation of accounts, but for adding and removing a user from OUs and 

security groups. 
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5. Reset Passwords of user AD accounts  

Similar to the creation of accounts, but for resetting the password of a user. 

 

INTEGRATING IF VIZOR IS IN THE CLOUD  

How can VIZOR integrate with your Active Directory if it’s in the Cloud? Are there any limitations? 

When VIZOR is in the Cloud, it can integrate in two ways: 

• Using the standard connection LDAP/LDAPS 

The process is the same as when the VIZOR server is on the same network as the AD domain 

controller. You need to allow LDAPS communication to happen through your firewall. We 

recommend that this channel is limited to the VIZOR server only (by IP, for example).  

In addition, secured and encrypted user credentials is used.  

For LDAPS communication, the VIZOR server needs to trust the SSL certificate used by your Active 

Directory domain.   

Vector technical experts will help you with installing the certificate and configuring the 

communication between the systems. 

 

• Using Microsoft Azure 

If you have migrated totally or partially to Azure AD or if you have an interface to your internal AD 

from Azure, VIZOR can easily integrate directly without the need of an LDAP connection. 
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IMPORTING USERS AND AUTHENTICATION 

The Active Directory integration will require using the VIZOR Import Manager, which is a Windows 

application running on the server. If the VIZOR server is in the cloud, you may need a remote desktop 

connection to the server. You may do so by using the Windows desktop app (Figure 3.1).  

 

HOW ARE USER ACCOUNTS IDENTIFIED AND SYNCHRONIZED? 

VIZOR follows the following process in order to identify user accounts and determine if it’s an import or a 

synchronization. Importing will create a new user in VIZOR based on the Active Directory account and 

Synchronize will update an existing account in VIZOR with the respective account in Active Directory. 

1. Match the SID  

If the VIZOR user account has stored an SID, it first tries to match it with the AD SID.  

If there is a match, no further search occurs and the account is synchronized. Under normal circumstances, 

all users are synchronized via the SID. 

 

2. Match alternative unique fields 

If there is no match for the SID, VIZOR will try to match based on a series of unique fields. The unique 

fields can be configured per VIZOR server and the default sequence is: 

2.1 Match the primary E-mail address 

Try to find a user account in VIZOR with a primary email address matching the primary email 

address of the AD user account. 

If there is a match on the email address, no further search occurs and the account is synchronized. 

The AD SID is also stored in the VIZOR user account so future synchronizations are based on the 

SID. 
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2.2 Match the formula-based Full Name   

If there is no match on the primary email address, VIZOR resolves the Full Name (in VIZOR) based 

on a configurable formula that uses VIZOR fields (usually retrieved from AD properties). The Full 

Name is the displayed name of users in lists and fields. 

 

If the resulting Full Name of the formula matches a VIZOR account, no further search occurs and 

the account is synchronized. The AD SID is also stored in the VIZOR user account so future 

synchronizations are based on the SID. 

 For example, if the Full Name formula is: 

”First Name Last Name (Username)” 

 

 And the formula is applied to an AD user that results in: 

”Jane Rosen (jane.rosen)” 

 

 Then a search will try to find a user account in in VIZOR that matches exactly: 

”Jane Rosen (jane.rosen)” 

 

3. Create a new account 

If there was no match using the previous approaches, a new user account is created in VIZOR and the SID 

stored for future synchronizations. 
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FIELDS AUTOMATICALLY SYNCHRONIZED 

What user fields are automatically synchronized between Active Directory and VIZOR? 

The following is the default mapping when using the default import rule:  

VIZOR Field Active Directory Information  

Accessible_To company 

AD_User_Status_Disabled userAccountControl 

Comments description 

Department department 

DN distinguishedName 

First_Name givenName 

Last_Name sn 

LastLogonDate lastLogon 

Middle_Name middleName 

nCompanyName company 

Org_Level NULL 

tEmailName mail 

tName displayName 
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tUID objectSid 

tUserName sAMAccountName 

tWorkPhone telephoneNumber 

Phone_3 mobile 

Phone_2 homePhone 

tFax facsimileTelephoneNumber 

Supervisor manager 

Location physicalDeliveryOfficeName 

tUserNameAlt userPrincipalName 

Address_1 streetAddress 

City l 

State_Province st 

Zip postalCode 

Country co 
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HOW TO CONFIGURE THE INTEGRATION WITH AD (WHEN IT IS NOT IN AZURE) 

Enter the IP address of the server along with a username and password. These should be provided to you 

by your main contact for the implementation project. 

 

Figure 3.1  

Once you have access to the server, click Start, then select VIZOR Import Manager (Figure 3.2). You will 

be prompted to enter credentials. Enter the credentials of an administrator such as the default admin 

account. 

 

 

Figure 3.2 

A list of imports will be shown. Select Import Users from AD, then click Edit (Figure 3.3). Click Edit again in 

the next window. 
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Figure 3.3 

Clicking Edit the second time will display a window with fields to fill in (Figure 3.4). Sample values have 

been provided in the figure. 
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Figure 3.4 

 

After filling in these fields, click Test to verify your settings. If your settings are correct or incorrect, you will 

get an appropriate alert. If your settings are correct but you still receive an error, it is possibly a firewall 

issue. In that case, you may need to contact your network administrator to solve the issue. 

 

 

If the test was successful, click OK to close the settings window. You will be able to control when the 

integration happens (scheduled or immediate) by clicking on the edit button and changing the settings 

on import configuration section.  
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Click OK again to go back to the list of imports (Figure 1.3). To run the AD rule that was just edited, click 

Run Rule on the left side under the Edit button. Your users from AD will now be imported into VIZOR. 

 

TO IMPORT USER ACCOUNTS FROM AN ACTIVE DIRECTORY OR WINDOWS DOMAIN:  

1   Log on to the User Account Import Manager, and click Next in the Welcome dialog. 

2  In the Import Rules dialog, click an import rule to specify the users you want to import. 

3   In the Active Directory Servers and Windows Domains dialog, select an Active Directory LDAP server or 

a Windows domain. 

To add an Active Directory server, click Add LDAP. To add a Windows domain, click Add Domain. 

4   In the Active Directory Servers and Windows Domains dialog, click the Active Directory server or 

Windows domain from which you want to import users. 

5   In the Import Users dialog, choose one of the following options: 

 To import all users listed in the dialog, click Next. 

 To filter the list based on Active Directory groups, click Add Filter and select the groups to filter, then click Append to add the 

group filter to the current search filter, or click Replace to replace the current filter with the group filter. Click Refresh to apply 

the search filter.  

You can also type additional LDAP search filter conditions directly in the Filter box. For example, 

"(cn=e*)" selects all users with user names starting with "e", and "(&(!cn=IUSR*) (!cn=CensusUser))" 

filters out all IUSR_<computername> accounts and the CensusUser account.  

 To filter the list based on Windows Domains groups, select the groups you want to import from the list. 

 To import some of the users, click Selected Users, then click the users you want to import. 

6   In the Import Settings dialog, select the Import as Contacts check box if you want to import contacts 

instead of users. 
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7   To add the imported users to a specified user group, such as Employees, click the group to which you 

want to add the new users in the Import to Group list. (Note that imported users are always added to the 

Users group.) 

8   To schedule imports, select the When Scheduled check box, then click Configure. 
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UPDATING ACTIVE DIRECTORY FROM VIZOR (VIA ACTIONS) 

The following actions are built-in, via the VIZOR native AD adapter. 

• Add user to Security Group 

• Assign user to OU 

• Change user password 

• Create user account 

• Delete user account 

• Disable user account 

• Enable user account 

• Remove user from Security Group 

• Reset user password 

 

One important aspect to consider is that for VIZOR to be able to make changes in Active Directory, the 

user used by the AD connector in VIZOR will need different permissions in Active Directory.  

What user VIZOR uses for the AD connector? 

VIZOR uses the username you enter in the Active Directory connection settings dialog. 

 

For being able to log in to VIZOR using your AD user and for import and syncrhonizing user accounts, the 

user only needs read-only permissions, and access to all the OUs and directories that you intend to 

synchronize.   

For the VIZOR to create user accounts in AD or modify the membership of users to Security Groups, we 

suggest using the Delegation Model of AD in order to give the exact and minimum permissions needed. 

The idea is that this account should only have the ability to perform the tasks your organization requires 

VIZOR to do. Delegation of rights involves basic operations on objects, such as the ability to view an 

object, create a child object of a specified class, or read attribute and security information on objects of a 

specified class.  

 

See Microsoft’s documentation on how to do this. We suggest you use the Delegation of Control Wizard 

to grant the "AD Operators" security group the allow "write members" permission or, guided by the 

wizard, select the "Modify the membership of a group" common task. 

Please note that delegation is done at the Container/OU level. Permissions on Directory objects normally 

are inherited down in the tree. 
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AUTOMATIC PROVISIONING OF SOFTWARE VIA AD ACTIONS 

To support the automation of installation of software already regulated by GPO or ECM package 

distribution, VIZOR facilitates the best practices in that it has built-in actions that add or remove  users in 

the Active Directory to what should be software-specific access-granting Active Directory security groups.  

In a similar way, for software deployed virtually without installation, such as via Citrix, VIZOR automatically 

adds the user that will “receive” the software to the AD Security Group that is used for that software title. 

In a typical example, a Security Group called “SageUsers” would exists to control users who have access to 

Sage (the accounting software). If VIZOR receives an approved request for provisioning “Sage” to “Mike 

Morin”, then VIZOR adds Mike Morin to the group SageUsers. 

Note that if the connector is set up to authenticate with AD with a windows account that has only AD read 

permissions, the connector may still import data but it will not support the GPO-ECM installation 

automation. 

 

CHAPTER 21 - INTEGRATION WITH 

AZURE 

 

OVERVIEW 

VIZOR integrates with Azure to bring similar benefits to the integration with Active Directory: 

1. Log in to VIZOR using your Azure user. 

o Single-Sign-On (SSO) 
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Allows your users to skip entering their user logon name and password once they have 

logged in to Azure  

 

2. Import and synchronize user accounts automatically 

o Import and keep synchronized: user Azure accounts as VIZOR Users  

▪ Users can log on to VIZOR 

o Import and keep synchronized: Azure accounts as VIZOR Contacts 

▪ Contacts cannot log into VIZOR but are contacts of tickets, stakeholders and 

people relevant to the processes in VIZOR. Emails can be sent to contacts. 

 

FOR IMPORTING USERS AND AUTHENTICATION 

 

FIELDS AUTOMATICALLY SYNCHRONIZED 

What user fields are automatically synchronized between Azure and VIZOR? 

The following fields are automatically: 

 

  

VIZOR Field Azure Information  

Address 1 streetAddress 

City city 

Country country 

Department department 
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E-mail 1 Mail 

First Name GivenName 

Full Name DisplayName 

Job Title jobTitle 

Last Name Surname 

Location officeLocation 

Logon Name UserPrincipalName 

Mobile Phone MobilePhone 

Mobile Phone mobilePhone 

Mobile Phone MobilePhone 

Phone 1 businessPhones 

State/Province state 

Supervisor Manager 

UID Id 

Zip postalCode 
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TROUBLESHOOTING SYNCHRONIZATION  

 

When doing a synchronization with Microsoft Azure, you want to make sure the process is completed 

correcty. To troubleshoot the import or synchronization of your Microsoft Azure AD users, follow the next 

steps:  

 

1. Go to the item "Import Users from Azure AD" in the “Configurations” web view and click on "Run 

Now". 

 
 

 
 

Please consider that for ad-hoc imports it’s better to use the "Run Now" button instead of setting the "Next 

Run". The time of the next run remains at midnight or at the desired time always. When "Next Run" doesn't 

have any time, it means it is 00:00 hrs, so it starts at midnight. 

  

2. Verify the synchronization occurred. You can check this in "Last Run" and in “Revision History” 

 
Importing users from AD “Last Run” 
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 “Revision History” 

3. Verify users got synchronized. Go to the Security web view. Select the query All and sort by Most 

Recently Updated. 

  

4. O

p

e

n

 

t

h

e

 

d

e

tails of one or more users and verify the Last Imported Time is consistent with the last run. 

 

 

 

 

 

 

 

 

5. If you are 

troubleshooting a specific account, view the details of that accounts and analyze the timestamps 

and history.  
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MAPPING MICROSOFT AZURE AD USER GROUPS TO VIZOR USER GROUPS  

 

VIZOR allows mapping of user groups from external sources like Microsoft Azure AD.  By doing so, you 

will be able to easily translate your Azure AD groups when importing users and have a better 

administration of views, accesses, permissions and other rules within of your organization. 

In order to map user groups, follow the instructions below: 

1. Login with an administrator account. 

2. Go to the “Configurations” web view 

 

 

 

 

3. Go to the item "Import Users from Azure AD" 

 

4. Scroll down and find the “Group mappings” configuration in the window that opens up 

 

5. Click on the “Add” button   

 

     

6. Match the Azure AD group with the VIZOR group you want to map it with in the window that 

pops up 
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When clicking on “VIZOR Group”, a drop down list with all the groups that are defined up to that 

moment in VIZOR will show up. You can create any number of User Groups to fit the 

requirements of your organization and are managed from the VIZOR web admin. 

 

Here are some examples of group mappings from Azure AD to VIZOR: 

 

7. Click “Ok” to add the individual mapping you just created to the list. The buttons below can be 

used to add another mapping, edit current mappings or remove them. 

 

 

 

 

 

8. Click “Ok” in the “Import users from AD” window to save changes. The next time an import is 

made from AD, these mappings will be taken into account.  
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USER ATTRIBUTE TABLE 

 

The table below outlines various properties associated with user objects in Microsoft Entra ID. These 

properties are crucial for managing and organizing user accounts within an organization. Each property 

has specific characteristics and usage scenarios, aiding in user identification, authentication, and 

management processes. The table also indicates whether a property is returned by default, if it supports 

filtering, and if it requires the $select query option to be included in API responses. 

 

Field Type Comment 319 320 

aboutMe String A freeform text entry field for the user to 

describe themselves.  

Returned only on $select. 

Yes 

 

accountEnabled Boolean True if the account is enabled; otherwise, 

false. This property is required when a user 

is created.  

Returned only on $select. Supports $filter 

(eq, ne, not, and in). 

Yes 

 

ageGroup ageGroup Sets the age group of the user. Allowed 

values: null, Minor, NotAdult, and Adult. 

For more information, see legal age group 

property definitions.  

Returned only on $select. Supports $filter 

(eq, ne, not, and in). 

Yes 

 



  Page 291 

 

assignedLicenses Assigned 

License 

collection 

The licenses that are assigned to the user, 

including inherited (group-based) licenses. 

This property doesn't differentiate 

between directly assigned and inherited 

licenses. Not nullable.  

Returned only on $select. Supports $filter 

(eq, not, /$count eq 0, /$count ne 0). 

Yes 

 

assignedPlans assignedPlan 

collection 

The plans that are assigned to the user. 

Read-only. Not nullable. 

Returned only on $select. Supports $filter 

(eq and not). 

Yes 

 

birthday DateTime 

Offset 

The birthday of the user. The Timestamp 

type represents date and time information 

using ISO 8601 format and is always in 

UTC. For example, midnight UTC on Jan 1, 

2014, is 2014-01-01T00:00:00Z.  

Returned only on $select. 

Yes 

 

businessPhones String 

collection 

The telephone numbers for the user. Note: 

Although it is a string collection, only one 

number can be set for this property. Read-

only for users synced from the on-

premises directory.  

Returned by default. Supports $filter (eq, 

not, ge, le, startsWith). 

Phone_1 Phone_1 

city String The city where the user is located. 

Maximum length is 128 characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith, and eq 

on null values). 

city city 
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companyName String The name of the company that the user is 

associated with. This property can be 

useful for describing the company that an 

external user comes from. Maximum 

length is 64 characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith, and eq 

on null values). 

Yes 

 

consentProvided

ForMinor 

consent 

ProvidedFor 

Minor 

Sets whether consent was obtained for 

minors. Allowed values: null, Granted, 

Denied and NotRequired. Refer to the 

legal age group property definitions for 

further information.  

Returned only on $select. Supports $filter 

(eq, ne, not, and in). 

Yes 

 

country String The country or region where the user is 

located; for example, US or UK. Maximum 

length is 128 characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith, and eq 

on null values). 

country country 

createdDateTime DateTime 

Offset 

The date and time the user was created, in 

ISO 8601 format and UTC. The value 

cannot be modified and is automatically 

populated when the entity is created. 

Nullable. Read-only.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

creationType String Indicates whether the user account was 

created through one of the following 

Yes 
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methods:  

• As a regular school or work account 

(null).  

• As a local account for an Azure Active 

Directory B2C tenant (LocalAccount).  

• Through self-service sign-up by an 

internal user using email verification 

(EmailVerified). 

• Through self-service sign 

• Up by an external user signing up 

through a link that is part of a user 

flow (SelfServiceSignUp). Read-only.  

Returned only on $select. Supports $filter 

(eq, ne, not, in). 

customSecurity 

Attributes 

customSecurit

y 

AttributeValue 

An open complex type that holds the value 

of a custom security attribute that is 

assigned to a directory object. Nullable.  

Returned only on $select. Supports $filter 

(eq, ne, not, startsWith). The filter value is 

case-sensitive. 

Yes 

 

deletedDateTime DateTime 

Offset 

The date and time the user was deleted.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

department String The name of the department in which the 

user works. Maximum length is 64 

characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, and eq on null 

values). 

departme

nt 

departm

ent 

displayName String The name displayed in the address book 
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for the user. This is usually the 

combination of the user's first name, 

middle initial, and last name. This property 

is required when a user is created and it 

cannot be cleared during updates. 

Maximum length is 256 characters.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith, and eq on 

null values), $orderby, and $search. 

employeeHire  

Date 

DateTime 

Offset 

The date and time when the user was hired 

or will start work in a future hire.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

employeeLeave

DateTime 

DateTime 

Offset 

The date and time when the user left or 

will leave the organization. To read this 

property, the calling app must be assigned 

the User-LifeCycleInfo.Read.All permission. 

To write this property, the calling app must 

be assigned the User.Read.All and User-

LifeCycleInfo.ReadWrite.All permissions. To 

read this property in delegated scenarios, 

the admin needs at least one of the 

following Microsoft Entra roles: Lifecycle 

Workflows Administrator, Global Reader. 

To write this property in delegated 

scenarios, the admin needs the Global 

Administrator role. Supports $filter (eq, ne, 

not, ge, le, in). 

  

employeeId String The employee identifier assigned to the 

user by the organization. The maximum 

length is 16 characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith, and eq 

employeeI

D 

employe

eID 
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on null values). 

employeeOrg 

Data 

employeeOrg 

Data 

Represents organization data (for example, 

division and costCenter) associated with a 

user.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

employeeType String Captures enterprise worker type. For 

example, Employee, Contractor, 

Consultant, or Vendor.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

externalUserState String For an external user invited to the tenant 

using the invitation API, this property 

represents the invited user's invitation 

status. For invited users, the state can be 

Pending Acceptance or Accepted, or null 

for all other users.  

Returned only on $select. Supports $filter 

(eq, ne, not, in). 

Yes 

 

externalUserState

ChangeDateTime 

DateTimeOffse

t 

Shows the timestamp for the latest change 

to the externalUserState property.  

Returned only on $select. Supports $filter 

(eq, ne, not, in). 

Yes 

 

faxNumber String The fax number of the user.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith, and eq 

on null values). 

Yes 
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givenName String The given name (first name) of the user. 

Maximum length is 64 characters.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith, and eq on 

null values). 

First_Nam

e 

First_Na

me 

hireDate DateTimeOffse

t 

The hire date of the user. The Timestamp 

type represents date and time information 

using ISO 8601 format and is always in 

UTC. For example, midnight UTC on Jan 1, 

2014, is 2014-01-01T00:00:00Z. Returned 

only on $select.  

Note: This property is specific to 

SharePoint Online. We recommend using 

the employeeHireDate property to set and 

access hire date values for users. 

Yes 

 

identites objectIdentity 

collection 

Represents the identities that can be used 

to sign in to this user account. An identity 

can be provided by Microsoft Entra ID 

(also known as a local account), by 

Microsoft account (MSA), or by a 

federated identity provider.  

Returned by default. For more information, 

see User sign-in types. Supports $filter (eq) 

only on the signInType property. 

Yes 

 

imAddresses String 

collection 

The instant message (IM) addresses of the 

user.  

Returned only on $select. 

IM_1 IM_1 

interests String 

collection 

A list for the user to describe their 

interests.  

Yes 
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Returned only on $select. 

isResource  

Account 

Boolean Do not use – reserved for future use. Yes 

 

jobTitle String The user's job title. Maximum length is 128 

characters.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith, and eq on 

null values). 

title title 

legalAgeGroup 

Classification 

String Used by enterprise applications to 

determine the legal age group of the user. 

Allowed values: null, 

minorWithOutParentalConsent, 

minorWithParentalConsent, notAdult, and 

adult. For more information, see legal age 

group property definitions. Read-only.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

License 

Assignment 

States 

license 

Assignment 

State 

collection 

State of license assignments for this user. 

Read-only.  

Returned only on $select. 

Yes 

 

mail String The SMTP address for the user, for 

example, 

"name@contoso.onmicrosoft.com".  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith, and eq on 

null values), $orderby, and $search. 

email_1 email_1 

mailNickname String The mail alias for the user. This property 

must be specified when a user is created. 

Yes 
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Maximum length is 64 characters.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith). 

mailingAddress physicalAddres

s 

The mailing address for the user.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

manager manager The user or contact that is this user's 

manager.  

Returned only on $expand. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

memberOf directoryObjec

t 

The groups and directory roles that the 

user is a member of. Nullable.  

Returned only on $expand. 

Yes 

 

messages message The messages in a mailbox or folder. 

Nullable.  

Returned only on $expand. 

Yes 

 

mobilePhone String The primary cellular telephone number for 

the user.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith). 

Phone_2 Phone_2 

mySite String The URL for the user's personal site.  

Returned only on $select. 

Yes 

 

officeLocation String The office location in the user's place of 

business.  

Returned by default. Supports $filter (eq, 

Yes 
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ne, not, ge, le, in, startsWith). 

onPremises 

Distinguished 

Name 

String Contains the on-premises Active Directory 

distinguished name or DN. The property is 

only populated for customers who are 

synchronizing their on-premises directory 

to Azure Active Directory via Azure AD 

Connect. Read-only.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

onPremises 

DomainName 

String Contains the on-premises domain FQDN, 

also called dnsDomainName, synchronized 

from the on-premises directory. The 

property is only populated for customers 

who are synchronizing their on-premises 

directory to Azure Active Directory via 

Azure AD Connect. Read-only. 

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

 

Yes 

 

onPremises 

Extension 

Attributes 

onPremises 

Extension 

Attributes 

Contains extension attributes 1-15 for the 

user.  

Returned only on $select. Supports $filter 

(eq, ne, not). 

Yes 

 

onPremises 

ImmutableId 

String This property is used to associate an on-

premises Active Directory user account 

with their Azure AD user object. This 

property must be specified when creating 

a new user account in the Graph if you are 

using a federated domain for the user's 

userPrincipalName (UPN) property.  

Important: The $ and _ characters cannot 

Yes 
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be used when specifying this property.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

onPremisesLast 

SyncDateTime 

DateTimeOffse

t 

Indicates the last time at which the object 

was synchronized with the on-premises 

directory.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in). 

Yes 

 

onPremisesProvi

sioningErrors 

onPremises 

ProvisioningErr

or collection 

Details of the synchronization provisioning 

errors for the user.  

Returned only on $select. 

Yes 

 

onPremisesSam

AccountName 

String Contains the on-premises SAM account 

name synchronized from the on-premises 

directory.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

onPremises 

Security 

Identifier 

String Contains the on-premises security 

identifier (SID) for the user that was 

synchronized from the on-premises 

directory.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

onPremisesSync

Enabled 

Boolean True if this user object is currently being 

synchronized from an on-premises 

directory; false if this object was originally 

synced from an on-premises directory but 

is no longer being synchronized; null if this 

object has never been synced from an on-

Yes 
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premises directory (default).  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, and eq on null 

values). 

onPremisesUser

PrincipalName 

String Contains the on-premises 

userPrincipalName synchronized from the 

on-premises directory.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

otherMails String 

collection 

A list of additional email addresses for the 

user.  

Returned only on $select. 

email_2 email_2 

password 

Policies 

String Specifies password policies for the user. 

This value is an enumeration with one 

possible value being 

DisableStrongPassword, which allows 

weaker passwords than the default policy 

to be specified for the user. 

DisablePasswordExpiration can also be 

specified. The two can be specified 

together; for example: 

DisablePasswordExpiration, 

DisableStrongPassword. Returned only on 

$select. 

Yes 

 

passwordProfile passwordProf

ile 

Specifies the password profile for the user. 

The profile contains the user's password. 

This property is required when a user is 

created.  

Returned only on $select. 

Yes 
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pastProjects String 

collection 

A list for the user to enumerate their past 

projects.  

Returned only on $select. 

Yes 

 

postalCode String The postal code for the user's postal 

address. Maximum length is 40 characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith, and eq 

on null values). 

zip zip 

preferredData 

Location 

String The preferred data location for the user. 

For more information, see OneDrive Online 

Multi-Geo. 

Yes 

 

preferredLangua

ge 

String The preferred language for the user. 

Should follow ISO 639-1 Code; for 

example "en-US".  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith). 

Yes 

 

Provisioned 

Plans 

provisionedPl

an collection 

The plans that are provisioned for the user. 

Read-only. Not nullable.  

Returned only on $select. Supports $filter 

(eq and not). 

Yes 

 

proxyAddresses String 

collection 

For example: ["SMTP: bob@contoso.com", 

"smtp: bob@sales.contoso.com"]. For 

Azure AD B2C accounts, this property has 

a limit of ten unique addresses. Read-only.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith). 

Yes 
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refreshTokensVa

lidFromDate 

Time 

DateTimeOffs

et 

The date and time when the user's refresh 

tokens valid from. 

Yes 

 

responsibilities String 

collection 

A list for the user to enumerate their 

responsibilities.  

Returned only on $select. 

Yes 

 

schools String 

collection 

A list for the user to enumerate the 

schools they have attended. Returned only 

on $select. 

Yes 

 

showInAddress 

List 

Boolean true if the Outlook Global Address List 

should contain this user; otherwise false.  

Returned only on $select. 

Yes 

 

signInSessions 

ValidFromDate 

Time 

DateTimeOffs

et 

Any refresh tokens or sessions tokens 

(session cookies) issued before this time 

are invalid, and applications will get an 

error when using an invalid refresh token 

to acquire a new access token.  

Returned only on $select. 

Yes 

 

skills String 

collection 

A list for the user to enumerate their skills.  

Returned only on $select. 

Yes 

 

state String The state or province in the user's address. 

Maximum length is 128 characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

state state 

streetAddress String The street address of the user's place of 

business. Maximum length is 1024 

street street 
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characters.  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

surname String The user's surname (family name or last 

name). Maximum length is 64 characters. 

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith). 

last last 

transitive 

MemberOf 

directoryObjec

t 

The groups, including nested groups, and 

directory roles that a user is a member of. 

Nullable.  

Returned only on $expand. 

Yes 

 

usageLocation String A two-letter country code (ISO standard 

3166). Required for users that will be 

assigned licenses due to legal 

requirements; for example, "US" or "UK".  

Returned only on $select. Supports $filter 

(eq, ne, not, ge, le, in, startsWith). 

Yes 

 

usageRights usageRight 

collection 

Represents the usage rights a user has 

been granted. Read-only.  

Returned only on $select. 

Yes 

 

userIdentities objectIdentity 

collection 

Represents the identities that can be used 

to sign in to this user account. An identity 

can be provided by Microsoft Entra ID 

(also known as a local account), by 

Microsoft account (MSA), or by a 

federated identity provider.  

Returned by default. For more information, 

see User sign-in types. Supports $filter (eq) 

Yes 
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only on the signInType property. 

userPrincipal 

Name 

String The user principal name (UPN) is the 

Internet-style sign-in name for the user 

based on the Internet standard RFC 822. 

By convention, this should map to the 

user's email name. The general format is 

alias@domain, where domain must be 

present in the tenant’s collection of 

verified domains. This property is required 

when a user is created.  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith), $orderby, 

and $search. 

user_1 user_1 

userType String A String value that can be used to classify 

user types in your directory, such as 

"Member" and "Guest".  

Returned by default. Supports $filter (eq, 

ne, not, ge, le, in, startsWith). 

type type 

websites String 

collection 

A list for the user to enumerate the URIs 

relevant for them.  

Returned only on $select. 

Yes 
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CHAPTER 22 - INTEGRATION WITH 

GOOGLE  

VIZOR integrates with Google (Google Admin, Google Workspace or Google G Suite) in the following 

ways: 

1. Chromebook Devices in Google are added as assets and regularly synchronized. 

2. Users can log into VIZOR using their Google credentials. 

3. User accounts in Google are imported and regularly synchronized. 

4. Through Email addresses to synchronize accounts. 

IMPORT CHROMEBOOKS FROM GOOGLE 

SYNCHRONIZATION SETTINGS 

The integration with Google Admin/Google Workspace allows Chromebooks to be imported and 

synchronized as VIZOR Assets and Google Users as VIZOR User Accounts. 

 

Important Notes on Synchronization: 

• Source Type Must Be Google: 

Assets or users will only synchronize if they were originally created in VIZOR through the Google Import 

process. These assets or users will have their Source Type set to Google. If an asset is created manually or 

through an Excel Import (even if the information matches an asset in Google), it will not synchronize with 

Google, this is because the Source Type of the asset is not set to Google. 

To Verify the Source Type: 

o Open the asset's details in VIZOR. 
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o Navigate to the Source tab and check the Source Type. If it is set to Google, the asset is 

eligible for synchronization. 

This setting is designed for security and to prevent accidental misconfiguration of assets not intended to 

synchronize with Google. If you would like this restriction to be modified or removed, please contact the 

support team for assistance. 

Configuration Instructions: 

To configure the integration with Google: 

 

1. Navigate to Configuration > Integration with Google. 

2. Ensure the Public URL configuration setting is set before proceeding. 

3. Adjust the Interval setting to define the synchronization frequency (in hours) for assets and users. 

 

IMPORT CUSTOM OR ANNOTATED FIELDS:  

The Annotated or Custom fields per device in Google Admin are the following Google fields: 

• Annotated User 

• Annotated Location 

• Annotated Asset ID 

• Notes 

If you decide to Import these fields from Google, VIZOR will synchronize these fields in both directions in 

the following way: 

1. Whenever a Google device is first imported into VIZOR, the values of these fields from Google will be 

imported into VIZOR. This will happen only once, the first time the computer is added to VIZOR.   

Google  VIZOR 

Annotated User Allocated to Person (Assignee) 

But only if the value in Google 

Admin can be converted to a valid 

user in VIZOR.  

Annotated Location Location 

But only if the value in Google 
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Admin can be converted to a valid 

user in VIZOR. 

Annotated Asset ID Asset Tag 

The value is directly passed from 

Google to VIZOR during the first 

import. 

Notes Notes 

The value is directly passed from 

Google to VIZOR during the first 

import 

 

2. After, the Annotated or Custom fields are automatically updated in Google Admin by VIZOR whenever 

the value changes in VIZOR.  

That is, when the Allocated to Person, the Location, the Asset Tag or the Notes field is changed in the 

VIZOR asset, VIZOR will automatically update the mapped fields in Google. 

It is important to note that any values stored in these Annotated or Custom fields in the Google Admin 

will be overwritten by VIZOR when the device is changed in VIZOR if the “Import Annotated or Custom 

fields” is set to Yes. 

VIZOR Google 

Allocated to Person (Assignee) Annotated User 

By default the email of the user is 

saved in the Google device. This 

can be configured by defining the 

field to save to Google in the 

Configuration settings.  

Location Annotated Location 

The full Location name, as 

displayed in VIZOR. 
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Asset Tag  Annotated Asset ID 

The value is directly passed from 

VIZOR to Google. 

Notes Notes 

The value is directly passed from 

VIZOR to Google. 

 

What happens if you do not import or synchronize the annotated or custom device fields from Google 

Admin? The fields will not be imported into VIZOR when the asset is first created in VIZOR and the values 

in Google will not stay synchronized with the equivalent values in VIZOR. So, unless you use these custom 

fields in Google for something else, it is a good idea to synchronize them and ensure the integrity of the 

data is maintained and centralized by VIZOR. This way, in the future you can view or export the list in 

Google Admin knowing the user is the correct person, the asset tag is the right one and that the location 

is accurate. 

What happens if we were not initially importing the Annotated or Custom fields but we decide to 

synchronize them after? 

There is no problem, and we suggest your organization keeps the fields synchronized. The only aspect to 

keep in mind is that existing assets already in VIZOR will NOT import the values from Google, while new 

devices added to VIZOR will import these fields the first time they are imported, from that point in time, 

and as described earlier.  

If you need to import the Annotated or Custom fields from Google after the assets have been already 

created in VIZOR, please contact support and we will be happy to help you with the request.  

 

Customizing the information to write back in the Google Device.  

In the integration with Google, if "Sync Custom/Annotated Fields" is enabled, VIZOR writes back some 

information to the device in Google. Specifically, the values of the following custom fields are updated by 

VIZOR: User, Location, Asset ID and Notes.  

For the Custom User field, the email of the user in VIZOR is saved in the Google device by default.  

This can be customized by defining the "User Field To Map" in the Configuration settings. To change it, 

enter the Caption of the user field that you want to be saved in Google. 
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For example, if you set it to "Full Name", the user in Google will be something like: 

 "Peter Parker (peter.parker@spider.com)". 

If you enter "ID Within Organization", the student id or the employee id of the person in your 

organization will be saved in Google. 

By default (if you leave it blank), the E-mail (E-mail 1) of the person will be written back in the Google 

device, e.g. peter.parker@spider.com. 

 

 

ORGANIZATIONAL UNIT FOR LOST ASSETS 

You can also specify the “Lost OU”. The Lost OU must already exist in Google Admin. Devices for which 

the Status in VIZOR is changed to Lost, will be automatically moved by VIZOR to this OU in Google 

Admin.  

If you leave the Lost OU empty, the device will be disabled via VIZOR and the Google Admin. 

 

ANNOTATED USER VS RECENT USERS 

Annotated User is normally empty in Google Admin unless someone updates it. It is not updated by 

Google. 

When the option to synchronize annotated fields in Google is enabled in VIZOR, the Allocated to Person 

in the device will be initially set from the value of the Annotated User during the full synchronization (daily 

by default). Likewise, when this option is enabled, changing the Allocated to Person in VIZOR will 

automatically update the value of the Annotated User in the Google Admin. This happens moments after 

the change is made in VIZOR and not during the full synchronization. 

 Recent Users is read-only both in Google Admin and in VIZOR, and it is controlled by Google. It is always 

mapped and synchronized from Google Admin to VIZOR.  

Regardless of the option to synchronize annotated fields in VIZOR, the Allocated to Person may be set to 

the most recent user in some cases , like when the Allocated to Person is initially empty, or when the 

device is changed to “Request Status” in VIZOR. For more details and the other cases see the topic of 

Auto-Allocation on Recent Users. 
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DEVICE FIELDS MAPPED FROM GOOGLE 

 

The following is the default mapping when using the default import rule:  

VIZOR Field Google G Suite Information  

Domain_Name Org Unit Path  

MqAssetOwnerLookup  

(Owner) - Optional 

Annotated User  

(only imported initially and if 

“Import Annotated or Custom 

Fields “ is Yes) 

Location - Optional Annotated Location 

(only imported initially and if 

“Import Annotated or Custom 

Fields “ is Yes) 

Asset Tag Annotated Asset Id  

(only imported initially and if 

“Import Annotated or Custom 

Fields “ is Yes) 

Notes Notes 

(only imported initially and if 

“Import Annotated or Custom 

Fields “ is Yes) 

OS_Version OS Version 
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OS Name OS Name 

Serial_Number Serial Number  

MAC_Address Mac Address  

ComputerName Device Id  

Model Model 

Firmware Version Firmware Version 

Source Timestamp  Last Sync 

This is the last time the device was 

synchronized with Google. 

This field always has a value for 

devices from Google. 

tBriefDescription Serial Number  

tSID Device Id 

Recent Users Recent Users 

This section shows the list of recent 

Chromebook users, in descending 

order, by last login time: the Email 

column displays the user's e-mail 

address and the Managed column 

displays the user's type. When the 

type is Yes, the user is managed by 

the domain. 

Active Times Active Times   

A list of the last 10 logons 

indicating the date and the time of 
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each session. This information 

comes from Google and it may not 

always present. Certain settings 

need to be enabled on the Google 

side for the Active Times to be 

collected and be available for 

VIZOR. 

System Version  Platform Version 

IMEI / MEID MEID 

Ext System Enrollment Time Last Enrollment Time 

Support End Date Support End Date 

Google Status Status 

OrderNumber OrderNumber 

When available if the device was 

purchased with Google.  

 

Default Values set in VIZOR: 

VIZOR Field Default Value 

Asset Type Chromebook 

OS_Name Chrome OS 

Item_Level 3 

nUsageType 1 
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FILTERS  

Filters can be used to import or synchronize only a subset of all the assets or computers from Google. 

You can define special conditions that Google devices need to meet for being imported or synchronized 

with VIZOR.  

These conditions are based on properties of the device in Google, like devices that : 

- are not deprovisioned in Google 

- were registered in Google after a certain date 

- match a specific serial numbers or part of the serial number (partial match) 

- are in a given location 

- have a specific text in the Notes  

 

To use this Google-side filter, enter a filter in the field “Source Filter 2”, part of the Configuration record of 

the Google Integration in question. 

The filter is applied when getting the chromebook devices from Google and before they are imported into 

VIZOR. 

The filter can be used temporarily too. For example, a filter can be added to quickly synchronize only 

certain devices and then remove the filter to allow normal synchronization in subsequent imports. 

The filter needs to follow the syntax defined by Google. For filtering a Serial Number, use the keyword 

"id": 

For example  

    id: 12345abcdefg 

will only synchronize computers with the serial number “12345abcdefg”. 

Partial serial number matches are supported, as long as you enter at least three characters in the serial 

number. 

For the complete information on the syntax and valid operators: 

https://developers.google.com/admin-sdk/directory/v1/list-query-operators 

https://developers.google.com/admin-sdk/directory/v1/list-query-operators
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TROUBLESHOOTING GOOGLE AUTHENTICATION 

 

Having a way to authenticate when integrating Google. The authentication has to be set up with the 

relevant administrative Google account. An important property of said account is it's permission level. To 

properly setup the authentication, this account has to have the correct permissions to access the data we 

need.  

  

If the account used doesn't have the correct permission level, the account won't have access when VIZOR 

tries to get the data from Google. To setup the correct authentication: 

  

1. Clear the existing cached credentials 

•  Go to the Configuration item for the Google integration and change the tenant id. You can 

simply add TEST to the existing one to rename it back easily.  

  

2. Enter new credentials: 

• Log in with a VIZOR account (not a Google account). Once the first synchronization attempt 

happens you will be prompted for Google credentials. 

 

Or 

  

• Log in to VIZOR with a valid Google account that has administrator permissions. This time 

you won't be prompted for credentials, as clicking on the "Run now" button will take in 

your credentials automatically.  

IMPORT USERS FROM GOOGLE 

Go to Configuration > Import Rules > Integration with Google. The same connection parameters used for 

the devices is used for the users. 

By default, all users from Google become users in VIZOR, belonging to the group “Users”. Since everyone 

belongs to this group, only grant the minimum permissions and access to this group. 



  Page 316 

 

For proper permissions and categorizing users as Staff, Students, Teachers, etc, use the groups mapping. 

By default there are three mapping rules, one for Staff, one for Students and one for Teachers. Edit the 

external names to match the names of the OU in Google or of a Google Group. 

VIZOR supports mapping automatically from either OUs or Google groups or a combination. 

If the external group name starts with a "/" it is assumed to be an OU, otherwise it is a Google group. 

 

USER FIELDS MAPPED FROM GOOGLE 

The following is the default mapping when using the default import rule:  

 

 

 

VIZOR Field Google 

First_Name Name 

Last_Name Name 

Organization (from parent organization) 

Comments Notes 

Department Department 

Email 1 PrimaryEmail 

External ID Id 

Logon Name PrimaryEmail 
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Phone 1 Phone 1 

Phone_2 Phone 2 

Phone_3 Phone 3 

Location Combination of building, room, floor, etc. 

Address_1 First /main Address 

City First /main Address 

State_Province First /main Address 

Zip/Postal Code First /main Address 

Country Parent Organization 

Job Title Job Title 

Employee ID 

ID in Organization 

Employee ID 

Organization Unit OrgUnitPath 

Last Logon Time LastLoginTime 

ACTIVE TIMES AND LAST ACTIVE TIME IN GOOGLE 

The Active Times information displayed in VIZOR is directly imported from Google and is not configured 

within VIZOR. The Last Active Time is automatically determined based on the most recent date recorded 

in either the Active Times data or the Source Timestamp. The Source Timestamp reflects the last time 

Google collected activity information for the corresponding asset, which VIZOR then retrieves. 
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In Google G Suite, a device is considered "active" when it engages in certain activities. These 

activities can include: 

• User logins, 

• Internet connections, 

• Application usage, 

• System operations such as updates, or 

• Synchronization with G Suite services. 

 

Google G Suite collects this activity data, and it is subsequently imported into VIZOR. Because this data 

comes from Google, individual activities may not be visible in VIZOR’s Revision History. 
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POWERWASH AND DEVICE DEPROVISIONING 

When managing Chromebooks, understanding the implications of a powerwash and device 

deprovisioning is crucial. A powerwash can remove all access and control over a device, including the 

ability to connect to WiFi or add a valid email if not handled properly. Here are the key points to consider: 

 

Powerwash Reminders 

Before resetting a Chromebook, remember the following: 

 

• All Local Data Will Be Deleted: 

o Confirm with users that no important files are saved locally on the device. All local files 

will be permanently deleted. 

o Files saved in Google Drive or other cloud services are safe. 

• Turn on Automatic Re-enrollment: 

o Ensure that automatic re-enrollment is enabled for the devices you plan to reset (it is 

enabled by default). 

o If this feature is disabled, you will need to manually re-enroll devices back into your 

domain. 

 

Understanding the Reset Options 

There are two different reset options for managed Chromebooks: 

 

• Clear User Profile: 

 

This can be considered a "powerwash light." It removes personal information without completely resetting 

the operating system and system settings. This method is ideal for re-assigning devices to new users 

without experiencing any device issues. 

 

• Factory Reset (Full Powerwash): 

 

This is a full reset that removes all personal data and resets the operating system. It reverts the device 

back to its factory state with no enrollment. If the device is subject to forced or auto enrollment, it 

will be re-enrolled as during the initial setup.  

 

The Factory Reset, is the most common reset type, it completely resets the device to its factory settings. 

On the other hand, the Clear User Profile, also known as Wipe Users, deletes user data while retaining 

device policy and enrollment. 
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KEY POINTS ABOUT POWERWASH 

 

Factory Reset (Full Powerwash): 

A Factory Reset, also known as a Full Powerwash, removes all data including user policies, device policies, 

and enrollment policies, this process reverts the device back to a factory state. If the device is subject to 

forced or auto enrollment, it will be re-enrolled as it was during the initial setup. 

 

Wipe User Data (Clear User Profile): 

The Wipe User Data option, also known as Clear User Profile, removes all user profile data while keeping 

the device policy and enrollment intact. This is useful for reassigning devices to new users without losing 

important system settings. 

 

Current UI Limitations and Future Updates: 

Currently, the VIZOR interface includes only the "Powerwash" button, which performs a Factory Reset. 

There is no button available for "Wipe Users." However, we plan to add the "Wipe Users" action in version 

320. This action can be implemented immediately for customers needing it urgently. 

 

Terminology in GAC: 

In the Google Admin Console (GAC), the term "Powerwash" is referred to as "reset." When you select a 

device and choose 'reset,' GAC presents options for either "Clear User Profile" or "Factory Reset." 
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CHAPTER 23 -  INTEGRATION WITH 

POWERSCHOOL  

VIZOR integrates with in the following ways: 

1. Students in PowerSchool are imported as Users and regularly synchronized. 

2. Active Staff in PowerSchool are imported as Users and regularly synchronized. 

3. Schools in PowerSchool are imported as Buildings. 

4. Through Email addresses to synchronize accounts. 

USER FIELDS MAPPED FROM POWERSCHOOL (STUDENTS)  

The following is the default mapping when using the default import rule:  

VIZOR Field PowerSchool 

First_Name First Name 

Middle_Name Middle Name 

Last_Name Last Name 

Email 1 Student Email > Email Address 

External ID (PowerSchool Internal ID) 

Logon Name Access Accounts > Student Username 
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Parent_Name Parents > Mother’s Name 

Parent_2_Name Parents > Father’s Name 

Parent_Email Parents > Guardian’s Email 

Parent_2_Email Parents > Guardian’s Email 

Organization District Name 

Location Combination of school, grade, teacher, etc. 

Grade_Level Grade Level 

Homeroom_Teacher Modify Info > Home Room 

Lunch_ID Modify Info > Lunch ID 

Employee ID 

ID in Organization 

Student Number 

 

Default Values set in VIZOR: 

VIZOR Field Default Value 

Can Log In Yes 

State Active 

Security Type User 

Category Student 
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USER FIELDS MAPPED FROM POWERSCHOOL (STAFF)  

The following is the default mapping when using the default import rule:  

VIZOR Field PowerSchool 

First_Name First Name 

Middle_Name Middle Name 

Last_Name Last Name 

Email 1 Email Address 

Organization District Name 

Location School Name 

Logon Name Teacher Username 

Lunch_ID Lunch ID 

Category Staff Type (if not Teacher, then defaults to Staff) 

Employee ID 

ID in Organization 

ID 
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Default Values set in VIZOR: 

VIZOR Field Default Value 

Can Log In Yes 

State Active 

Security Type User 

 

INCREASING GRADE LEVEL FOR ALL STUDENTS IN VIZOR  

 

The VNConfig application can be used to increase the Grade Level for all students in VIZOR.  

VNConfig will get the current Grade Level for all users with Category = Student and with a value in the 

Grade Level field and increase it by 1.  

Exception - If the Grade Level value is K, the value wil be set to 1. 
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CHAPTER 24 - SEARCHING AND 

QUERYING  

SUMMARY LIST QUERY 

Users can further refine the queried information by adding filters and using the simple search box.  

SUMMARY LIST FILTERS 

Filters are a feature that enable you to modify your existing query in order to make the results of searches 

more specific. They can be added and modified using a Web view’s summary list settings. This is done by 

clicking on the Modify the summary list button. This is the middle button found usually amongst a series 

of three buttons located in the tool bar above a Web view’s summary list. 

 

 

Once inside of the summary list settings, filters are applied by defining search parameters with conditions 

(equals, not equals, contains, etc.) in relation to fields available in the current Web view. To emphasize, 

filters can make use of any fields that exist in a Web view. That is to say that if a field has been exported 

into a Web view, it will be available to be used in applying a filter. 

 

The screenshot below shows a field being selected. Once a condition and comparison value (the third 

field) has also been specified, you can now click the ‘OK’ button to apply the filter 
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(Clicking the ‘X’ button will remove a fitler) 

 

Note: If you would like to use a field in a filter, but would not like to actually see the filter in any of the 

record data, that field can be hidden by setting the value of the field’s Visible attribute to “Never” when 

using the Web View Editor.   

 

As an additional caveat: multiple filters can be applied at the same time and removed at any point during 

the use of the Web view. It's also worth noting that filters are considered ad-hoc, in other words, they are 

not persistent and will not remain when re-loading the current Web view or loading a different Web view. 

 

SIMPLE SEARCH 

 

Simple Search is the box on the right of the top of the summary list where users can quickly search by 

using text and without having to specify what fields to search that text in. VIZOR will search in multiple 

fields by the text entered. What fields are searched depends on each project. VIZOR will search in all the 

fields included in the query “Simple Search for Web views”. 

Every project has a query called Simple Search for Web views, accessible in the Query Editor. If the query 

does not have any fields, VIZOR searches in many fields, which may slow down the search. 

Administrators can add or remove fields by using the query editor. Only the field name is used in this 

query, not the operator or the value. 
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When inside of the VIZOR Admin application: 

 

1) Refer to the list of projects found on the left side of the VIZOR Admin window and click on the desired 

project. 

 

2) Once a project has been selected, click on the Project tab near the top left corner of the VIZOR Admin 

window and then select Query Editor located inside. 

 

 

 

3) You should then see a field containing the name of a query as well as table displaying field names, test 

conditions, values and operators for a given field as well as a code view and several buttons. In this area, 

select “Simple Search Fields for Web Views” in the Name field. The values in this table determine what the 

Simple Search will look for when performing a search. 
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4) From here, you can modify any of the values for existing rows in the aforementioned table as well as 

add rows and delete existing rows. Using the buttons to the right of this table will help with certain tasks. 

 

5) When you have completed your changes to the table, you will need to click the Apply button that is 

located below the Code View. 

 

 

By the default, the query is initialized with the following fields depending on the project. 

 

For the assets Resources project: 

ID 
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Name 

SN 

Asset Tag 

Model 

Allocated to Person 

 

For the Users project: 

Full Name     

First Name 

Middle Name:  

Last Name 

Logon Name 

E-mail 

ID Within Organization 

Lunch ID 

Nickname 

Phone1 

Parent Email  

Parent Name 

Parent 2 Email 

Parent 2 Name  

 

For the Helpdesk project: 

 

ID 

Summary 
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Description 

Owner 

Contact 

Computer 

Other_Asset 

Resolution 

ActivityLog 

 

Note: Make sure to regenerate web views in the web view editor once finished so changes are 

applied to VIZOR. 

For more information on regenerating web views you can refer to “When do you have to regenerate” in 

Chapter 40 – Planning and Developing a custom project 

SEARCHING WITHIN A QUERY 

While Simple Search defines what fields can be located through the search function, this will depend on 

the query the search is being performed in. The Simple Search will be applied to the selected query once a 

search is performed adding an internal “AND” to the conditions of the query. Let’s take the example 

below:  

Searching for a computer that has been assigned to specific person under the “Unassigned” query will not 

return any results due to the conditions being in conflict since Simple search is not looking for the 

“Assigned” field. 

 

 

Taking into account the default Simple Search conditions for the “Resources” project described previously 

and the “Unassigned” query for the same project, the search will look something like this: 

(Status <> Assigned) 

AND 

(ID = 0 AND 
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Name = any AND 

Serial Number = any AND 

Asset Tag = any AND 

Model = any AND 

Allocated to Person = any) 

On the contrary, searchin on top of the “All Assets” query will return search results since there is no 

specific condition that is in conflict with the Simple Search’s conditions. 

ABOUT QUERIES  

To build queries in VIZOR Admin, select the Project you want to create a query for on the left. Click Query 

Editor on the Project menu. In the Query editor, use And and Or operators to combine multiple search 

conditions. You can control the order in which search conditions are evaluated using parentheses.  

The standard format of a condition is: 

 Field  Test Value 

For example: 

  

NOTES 

 To base a new query on an existing query, choose an entry in the Query 

Name list, click Copy, and name the new query. 

THE BASE QUERY 

 

Hidden in the web view is the base query. This query is always applied on top of any other query 

or search and is always appended to any other query selected from the list of queries located in 

the top toolbar to the left. 
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In example, we can create a query called "Assets I am responsible for" and export it to the 

"Assets" web view. It is possible to select this query along with another query from the list which 

shows all computers (Query: "Computers") or a query that shows all Dell Devices (Query = "Dell 

Devices") regardless of who the owner is.  

  

If we apply the base query "Assets I am responsible for" to the "Assets web view" and the user 

runs the "Comptuers" query we can expect the following behavior:   

  

The base query "Assets I am responsible for" will be acting underneath the "Computers" query 

and it will show something like this:  

  

Responsible = <User> AND 

Asset Class = Computers  

  

  

In practice, the combination fo the "Computers" query and the "Assets I am responsble for" will 

show All the computers that the logged in user is responsible for. Putting base queries into use 

will allow for a more personalized and adaptable experience for managers and users alike 

 

 

 

 

 

 

 

 

SET UP A BASE QUERY 

 

To setup a base query, the desired query must be created first. Log in to VIZOR admin and access the 

query editor (Project menu > query editor) in the project the base query will act upon. 
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1. Once the query is created, export the query using web view editor. 

 

2. Head up to your VIZOR environment in your browser and access the web view where the query was 

generated to. Right click on the query option and click on inspect.  
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In the displayed code, look out for the numeric query ID value: 

 

 

3. Back in Web View Editor, select the “Web View” option located in the left bar under the web view 

where the base query will be applied to. 

 

 

 

4. Click on the three dotted button next to attributes and enter the numeric query ID of the base query.  
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5. Regenerate the web view. Once this is completed, the base query will work in the background along 

with any other query selected.  
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EDITING EXISTING QUERIES 

 

In this section, we'll guide you through the process of editing existing queries. Whether you need to fine-

tune filters, adjust sorting, or modify visibility settings, these steps will help you manage your queries to 

meet your specific needs. 

 

1. Once logged in your VIZOR system, navigate to the quick links menu and choose the view 

containing the query you wish to edit. 

 

2. Locate the "Options" button at the top left corner of the page and click on it. In the options 

menu, switch on "Administrators Mode" by setting it to yes and then click OK to confirm. 

 

 

 

3. With "Administrators Mode" activated, find the "Edit the current query" button (represented as an 

engine icon) next to the query's name in the top blue bar. 

 

4. Select the query you want to modify from the query list, then click the "Edit the current query" 

button to access the customization options. Here, you can adjust filters, sorting, column layout, 

visibility settings, and more according to your preferences. Customize these settings as needed, 

add or remove filters, and make any other desired changes. 
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5. Once done, save your changes by clicking the Save button at the bottom right corner of the 

customization menu. You can now select the edited query from the Query List as you would with 

other queries.  
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CREATE A NEW QUERY  

 

Custom queries allow you to tailor your view and filter information according to your specific needs. 

Follow these steps to create queries within your system: 

 

4. Once logged in your VIZOR system, go to the quick links menu and select the view where you 

want to create the new query. 

5. In the selected view, click on the "Modify the summary list" button located in the top blue line of 

the page (middle button). 

6. Once clicked, a pop-up menu will appear. In this "Settings" menu, set your viewing and sorting 

preferences for the summary list. Additionally, you can add custom filters to narrow down the 

data for your new query. 

 

7. Once you've configured all the settings and filters to your liking, proceed to save the new query 

by clicking on the "Save as New Query" button at the bottom left of the pop-up menu. 

8. You will be prompted to enter the necessary information for the new query, such as its name and 

visibility settings (available to all users or only to you).  
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9. Click "OK" to save the changes and create your new query. Your new query will be available in the 

Query List along with others. 

 

SEARCHING BY DATES 

Use the <Today> value to match the current date. For example, you can search for all issues submitted or 

updated today.  

To search against specific dates, double-click the Value box, then double-click a date in the calendar.  

 

SEARCHING FOR UNASSIGNED ASSETS OR ISSUES  

By default, the Owner field is set to <None>. You can use the value <None> in queries to find 

unassigned issues.  

 

 

FINDING ASSETS OR ISSUES OWNED BY THE CURRENT USER  

Use the value <User> to match the current user. With <User>, you can build generic queries that work 

for any user. For example, the My Assigned Issues query finds all issues assigned to the current user.  

 

FINDING NEW ASSETS OR ISSUES  

To find all issues that have not been updated since they were first submitted, search against the revision 

number: Revision Number = 1.  
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FINDING PARENT ISSUES  

You can find the parent issues of a child issue by searching against the Child Issues field. For example, to 

find the parent issues of the issue 22, use the Advanced Query editor to search for Child Issues = 22.  

To find all parent issues, use the Advanced query editor to search for Child Issues <> 0.  

 

SEARCHING CHOICES LISTS WITH RELATIONAL OPERATORS  

The relational operators are <, <=, >=, and >. When you search choice lists with a relational operator, the 

search is based on the order of the choices in the list.  

For example, if the choices in the Problem Area list are ordered:  

Apps - Goldmine 

Apps - MS Excel 

Apps - MS Outlook 

Apps - MS Word 

Apps - Other 

HW - Disk 

...  

the query Problem Area < HW - Disk returns all the application-related issues.  

When a choice list uses a non-alphabetical sort order, the sense of the relational operators is reversed. For 

example, if the Priority list is ordered:  

Highest 

High 

Medium 

Low 
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Lowest 

the query Priority > Medium returns issues marked High or Highest, and the query Priority < Medium 

returns issues marked Low or Lowest.  

  



  Page 342 

 

 

SAVING QUERIES  

To save changes and continue editing, click Apply. 

To save changes and exit the Query editor, click Close. 

 

INSERTING PARENTHESES AROUND SEARCH CONDITIONS  

When you combine search conditions with the And and Or operators, you may not always get the results 

you expect. For example, suppose you want to find all new issues with priorities ASAP or Today.  

Status = New And 

Priority = ASAP Or  

Priority = Today  

And has a higher precedence than Or, so this query finds all new issues with priority ASAP, plus all issues 

(not just the new ones) with priority Today.  

To find only new issues with priorities ASAP and Today, click the Priority = Today search condition, then 

click  to place parentheses around the conditions joined by Or. For example: 

Status = New And  

(Priority = ASAP Or  

Priority = Today)  

 

SEARCHING FOR STRINGS  

The Contains operator performs a case-insensitive search for a string of text anywhere in a field. You can 

use Contains to search for keywords in the Summary or Description fields. This allows you to package 

common keyword searches such as predefined queries. For example:  

Summary Contains printer  
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You can also use Contains to find all choices in a list that contain the same string of characters. For 

example, the choices in the default Problem Area list start with “HW -“ “, “Apps - “, or “System - “. So 

Contains “HW -” finds all hardware problems.  

 

SEARCHING FOR NULL VALUES 

It is possible to perform a search to determine whether or not a value has been set for a field. When a 

field has no value, it is considered to be <Null>; on the other hand, when a field has a value, it is <Not 

Null>.  

The following steps describe how these macros can be used in queries: 

 

1   Open the Query Editor for the desired project. 

2   Create the query using <Null> and <Not Null> as desired (use Like for the Test column). 

   Example:  

    Priority Like <Null> AND Severity Like <Not Null> 

NOTE: Searching for null values in Date, Time, and Number fields will require a few additional steps. 

Please contact support for more information. 

 

3   Export the query to the Web view(s) and regenerate the view(s). 

 

NOTE: Saved queries with <Null> and <Not Null> can only be used from the Web views, not from the 

Preview in the Admin editors. 

 

It is also possible to use the <Null> and <Not Null> using the Ad-hoc Query editor of any given Web 

view. Simply select a Field, choose Like for the Test option, and type either <Null> or <Not Null> in the 

Value textbox. 
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SEARCHING WITH WILDCARDS  

To provide flexibility in the specification of search patterns, the Like and Not Like operators support 

wildcard characters. Using wildcards, you can search for inexact patterns of text in any field. 

Wildcard Matches 

_  Any single character. For example:  

run_time matches run time or run-time  

% Zero or more characters. For example:  

Contains run%time matches any string that contains runtime, 

run time, or run-time.  

Like Install% matches any string that starts with Install.  

Like %run%time% matches the same strings as Contains 

run%time.   

[charlist] Any single character in charlist. Can include spaces, but not the 

right bracket (]) character. For example:  

SP[56] matches SP5 or SP6   

Use a hyphen to specify a range of characters. For example:  

[1-36-9] matches the digits 1, 2, 3, 6, 7, 8, or 9   

To match the hyphen character, the hyphen must be either the first 

or last character in charlist. For example:  

[-0-9] or [0-9-] match any digit or a minus sign   

[!charlist] Any single character not in charlist. For example:  

[!tb]rash matches crash but not trash or brash   

To search for the wildcard characters _ and %, you must enclose them in brackets. For example, to search 

for a percent sign, use the pattern [%].  
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USING MACROS IN QUERIES 

A Macro in a query is part of a condition expression that is resolved at runtime, that is, its value is 

evaluated dynamically when executing the query. 

 

For example, in a typical query condition expression: 

Field Operator Value 

Owner = Peter Parker 

the value is fixed to the user Peter Parker. However, using a macro <User> in the value: 

Field Operator Value 

Owner = <User> 

will cause the value to be the name of the person currently logged in to VIZOR. 

Most of the macros used in queries are used in the Value part of the condition but custom macros can be 

created for the Field or Operator parts as well. 

 

<IS ACCESSIBLE DEPARTMENT> 

This macro is used to filter items (assets, records, etc) based on the department of the current logged-in 

user. The macro is used in queries where the field part is a single choice with Choice values coming from 

Departments. For example: 

 Allocated to Department = <Is Accessible Department>  
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In the condition above, the query will return all records where the Allocated to Department is set to the 

same department as the one of the logged-in user, or any department if the user has the feature “Access 

all Departments” enabled. 

The typical use of this macro is in named queries that are designated as the “base query” of a Web View.  

For example, adding the condition expression 

Allocated to Department = <Is Accessible Department> 

 to the base query of the Asset Library (Resources _ Library) Web view will ensure users can only see the 

assets allocated to the department they belong to, or any asset if they have enabled the feature “Access 

all Departments”. 

 

The macro <Is Accessible Department> distinguishes between two types of users: 

1. Users who can view or manage items (assets, records, etc) of their own department only. 

2. Users who can view or manage items (assets, records, etc) of any department, or no explicit 

department. 

 

<IS ACCESSIBLE LOCATION> 

This macro is used to filter items (assets, records, etc) based on the location of the currently logged-in 

user. The macro is used in queries where the field part is a single choice with Choice values coming from 

Locations. For example: 

 Allocated to Location = <Is Accessible Location>  

In the condition above, the query will return all records where the Allocated to Location is set to the same 

location of the logged-in user or any location inside. That is, if the user location is “San Francisco”, then 

items in locations “San Francisco \ Lombard St.” and “San Francisco \ Bay St.” will also be included. 

Similar to <Is Accessible Department>, items in any location will be included in the results if the user has 

the feature “Access all Locations” enabled. 

The typical use of this macro is in named queries that are designated as the “base query” of a Web View.  

For example, adding the condition expression 

Allocated to Location = <Is Accessible Location> 
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 to the base query of the Asset Library (Resources _ Library) Web view will ensure users can only see the 

assets allocated to the Location they belong to, or any asset if they have enabled the feature “Access all 

Location”. 

 

The macro <Is Accessible Location> distinguishes between two types of users: 

1. Users who can view or manage items (assets, records, etc) of their own Location only. 

2. Users who can view or manage items (assets, records, etc) of any Location, or no explicit Location. 

 

TIMEOUT DATABASE QUERIES 

It may occur that certain database queries time out and do not complete successfully. This may affect 

certain data and functionality of VIZOR. When this occurs, the Windows Application Event log shows 

errors indicating the query failed because of a timeout from SQL Server.  

This situation is normally caused by a SQL Server database being very busy at the time of the query. If this 

situation happens regularly, the best approach is to increase the capacity/performance of the SQL Server. 

 

However, if this cannot be resolved in the short term, one alternative is to increase the time VIZOR waits 

for a query to be responded from SQL Server. 

By default, Microsoft uses 30 s as the default timeout. If you need to increase it, you can do it by entering 

the new timeout in the following registry value: 

 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\MetaQuest\CensusWeb\Server\1.0\TimeoutCommand 

 

If the value does not exist, you can create the entry as a 32 or 64 bit DWORD. The value is in seconds. 

 

If the value is changed from the default, the following entry in the Windows Application Event log will be 

added when the related *.exe process starts: 

 

VNDataStore.GetCommandTimeout: Using custom timeout command: 60 
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THE AUTO – STATUS QUERIES 

The Auto-status feature in VIZOR will allow you to easily manage your assets in the "Lost", "Retired", "In 

Repair" and "In Stock" status automatically. Auto-status is based on specific queries that are found in the 

query editor. The conditions must be set in each query, all the assets that match those conditions will be 

set to "Status = <x>". 

  

When accessing the query editor, an invalid condition will be found. This is in order to avoid unwanted 

automatic status changes. This condition will need to be changed to the desired one so assets are set to 

the target status.  

  

The auto-status is triggered on the following events: 

 

• After any import of computer assets (Whether they are from Google, MS SCCM, Excel, etc). 

• When the Application Setup Task runs (Usually every night) 

• On demand through vnconfig.exe 

  

The conditions in these queries can be link to any of the fields in the resources projects depending on the 

user’s needs and can be changed at any time making this a very efficient and time saving feature for IT 

asset managers.  
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AUTO SET STATUS ON CUSTOM CONDITIONS 

  

You can automatically set the status of assets to Lost, In Repair, In Stock, Retired based on your own 

conditions. This is useful for organizations to automate their processes and establish internal policies. 

 Here are a few example scenarios where this feature can be used: 

1. You have an external system that you are phasing out where you keep track of equipment in 

Repair. You import from the external system on a regular basis via Excel. You can create a rule to 

ensure all assets imported from that external system are In Repair in VIZOR.  

In the Query Editor, open the query “Auto-Status: In Repair” and set the conditions to: 

Import source = Assets from an Excel file 

  

2. You have a specific Organizational Unit (OU) named “/devices/Lost/” in Google where all Lost 

computers go. You want to ensure the status in VIZOR is always lost for devices found in that OU. 

 

In the Query Editor, open the query “Auto-Status: Lost” and set the conditions to: 

 

                         Organizational Unit  =  /devices/Lost 

 

If you have more OUs inside the /devices/Lost that you also want to be automatically set to Lost, 

you may need to add something like this: 

                         Organizational Unit  =  /devices/Lost  OR 

                         Organizational Unit  Like  /devices/Lost/ 

 

   

 

1.   You have retired all Iomega Drives and Compaq servers and you want to make sure any asset 

that meets these conditions is set to Retired in VIZOR: 
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In the Query Editor, open the query “In the Auto-Status: Retired” and set the conditions to: 

  

( Manufacturer = Iomega And  

Asset Type = CD Drive ) Or  

( Manufacturer = Compaq And  

Asset Type = Server )  

  

 

When are these automatic rules that set the asset status applied? These rules are executed at these times: 

1. Every night, during the regular Application Setup Task 

2. Every time an import of computers is completed. 

If you need to run it immediately, there is a task in the VNConfig tool for running them on demand. 
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CHAPTER 25 - THE SUMMARY LIST 

ABOUT SORTS  

You can sort the Summary List by almost any valid record field, such as Asset Type, Location, Priority, 

State, Status, Owner, or any other field or combination of fields.  

Users can also sort the list by clicking on one of the columns. 

VIZOR allows you to define sorts, which are named sets of sort criteria. Sorts appear in the Sort list on the 

Summary toolbar.  

To define a custom sort in VIZOR Admin:  

1   Click Sort Editor on the Project menu to open the Sort editor.  

2   In the Sort editor, choose the fields you want to use as sort keys. The first field is the primary sort key, 

the second field is the secondary key, and so on.  

For example, if you sort by Owner and Priority, all issues belonging to the same person are grouped together, 

and the issues for each owner are sorted by priority.  

To base a new sort on an existing sort, choose a sort from the Name list, click Copy, and name the new sort. 
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SORT ORDERS  

Choice Order Ascending and Choice Order Descending sort the issues based on the order of the 

choices in the choice list, not on alphabetical order.  

For example, a choice list may contain the values High, Medium, Low in that order. An alphabetical order 

for the sort list would be High, Low, Medium or Medium, Low, High, which doesn't make as much 

sense.  
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SAVING SORTS  

To save changes and continue editing, click Apply. 

To save changes and exit the Sort editor, click Close. 

RELATED TOPICS 

Defining Sorts 
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ABOUT SUMMARY LIST LAYOUTS  

Different queries can list different information in the Summary List. For example, a query that lists only 

the issues assigned to the user does not need to display the Owner column, unlike a query that lists all 

issues assigned to a group.  

VIZOR allows you to define layout styles that specify the column layout and contents of the Summary 

List. Layout styles appear in the Layout list on the Summary Toolbar.  

To define a layout in VIZOR Admin, click Layout Editor on the Project menu to open the Layout Editor.  

Each column in the Summary List corresponds to a field. Choose the fields you want to list, and set the 

column widths and alignments. By default, field names are used as column headings, but you can change 

this by entering a new heading in the Title cell.  

 

To base a new layout on an existing layout, choose the layout from the Name list, click Copy, and name 

the new layout. 

 

SAVING LAYOUTS  

To save changes and continue editing, click Apply. 

To save changes and exit the Layout editor, click Close. 
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SUMMARY LIST LAYOUTS AND DRILL-DOWN 

In order for drill-down to function in certain views (e.g. Asset Library), any layout that will be used with 

drill down must have the following fields in it (the width can be set to 0 so they are not visible in the UI): 

- Usage Type 

- Item Level  
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CHAPTER 26 - REPORTING 

ABOUT REPORTS  

Reports help you understand and assess the state of your project. A system like VIZOR contains a lot of 

valuable information. Reports allow you to access this information, break it down, analyze it, and present 

it.  

VIZOR is thus delivered from the get-go with a vast variety of reports. One can choose at will 

what report to produce be it one whose parameters are already constrained for you and ready 

to go, or one from the large selection that give your team the flexibility to generate reports ad 

hoc, tailored to your information needs. Use these to produce your management reports going 

back to any historical record for any continuous period in time of your choosing by using the 

prompt for setting your ad hoc parameters. Specifically on the latter, see the sections below on 

Embedded Query Reports or on Creating New Custom Reports for more information on the 

Report Editor tool. 

In addition to viewing the default reports included with VIZOR, you can create new reports in VIZOR 

Admin. To design reports in VIZOR Admin, click Reports on the Project menu, and then click Report 

Editor.  

VIEWING REPORTS  

You can view reports inside Web views. After you click on a Web view, you can access the list of reports 

available to you in that Web view by clicking on the Reports menu item on the top toolbar.  

By default, Web views use HTML to format and display Listing reports, and Crystal Reports for custom 

reports (VIZOR includes the Crystal Reports Runtime Software).  

VIZOR has two types of reports: HTML reports and Crystal Reports.   

HTML reports are fully generated by VIZOR at runtime based on the fields and query specified in the 

Report Editor. Crystal Reports, on the other hand, are based on pre-created reports stored in *.rpt files. 
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Crystal reports have an additional option for viewing: The Interactive Report Viewer, which allows the user 

to zoom in/out, page and export to other formats. 

VIZOR includes the Crystal Reports Runtime Software which is installed automatically on the server and 

allows this type of reports to be viewed from the web browser. You do not need to purchase Crystal 

Reports. 

Another advantage of this type of report is that you can create more advanced reports. Using Crystal 

Reports, you can add features such as parameters, charts, formulas, field highlighting, and running totals 

to a listing report. You can also import graphics (such as company logos) and completely reformat the 

report.  

To build new Crystal reports, you need a version of the Crystal Reports Editor in one computer in your 

organization (bought separately). The Crystal Reports Editor does not need to be installed on the VIZOR 

server. You use it only for modifying the *.rpt files used by VIZOR. This can be done from any workstation 

with Crystal Reports Editor installed, and once the *.rpt file is changed, it is uploaded to the VIZOR server. 

Some reports have parameters that allow to customize the report at runtime. Depending on how the 

report is viewed, parameters can be accessible from the Report Viewer top menu, when using the 

Interactive Crystal Reports viewer, or prompted before viewing the report, as it is the case for PDF reports.   

You can also view Summary, Time, and Listing reports in VIZOR Admin, within the Report Editor.   

TYPES OF REPORTS 

In general, VIZOR reports can be categorized as follows: 

• Web or Listing Reports 

o Standard 

▪ Tabular 

▪ Multi-column 

o Custom 

▪ VIZOR Query Report 

▪ Embedded Query Report 

▪ Standalone Report 

• Summary and Time Reports 

These reports are deprecated and can only be viewed in the Report Editor (VIZOR 

Admin). 

STANDARD REPORTS 
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Listing reports are listings of information entered in records, such as tickets, issues, assets, people, etc. Use 

Listing reports to extract specific information from records.  

For example, you can use a Listing report to print a summary of the resolution details for each resolved 

issue, or to print only the issue number, owner, and summary for each issue. With Listing reports, you 

choose a set of issue fields, and only those fields are included in the report.  

Standard reports are generated by VIZOR without the use of a third party reporting engine. Standard 

reports are viewed in the Web UI as HTML reports. 

 

QUERY  

In the Query list, choose a query to extract the records from the database and include them in the report. 

For example, if you want a report that breaks down the open issue count, then use the Open Issues query.  

 

SORT  

Sorts the records.  

PAGE  

Header, footer, and title to apply to the report.  

TABULAR  

Tabular listings list records in the columns of a table. A tabular report is like the Summary List, except that 

you can use a report template to add things like a report title or page numbering.  

 

MULTICOLUMN  

Multicolumn listings arrange record information into blocks; these are repeated down the page for each 

record.  
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Files 

Standard reports do not have an associated file, they are generated at runtime based on the definition of 

the report, using the VIZOR Admin > Report Editor  (the definition of reports are stored in the DEF 

database). 

 

 

CUSTOM REPORTS  

Custom reports use Crystal Reports and can have features that are not available with Standard HTML 

reports. Using Crystal Reports, you can add features such as parameters, charts, formulas, field 

highlighting, and running totals to a listing report. You can also import graphics (such as company logos) 

and completely reformat a listing report. To build custom reports, you need a version of Crystal Reports 

that is version 8.5 or beyond. 

Custom listing reports appear in the same list together with Standard reports in the VIZOR Web Report 

Viewer. After you customize a listing report, you cannot edit it in the Report Editor. You must use Crystal 

Reports.  

Custom reports also have an additional option for viewing: The Interactive Report Viewer, which allows 

the user to zoom in/out, page and export to other formats. 

 

Files 
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All custom reports have an associated rpt file that is not generated at runtime, it must be created in 

advance.  

 

CREATING NEW CUSTOM REPORTS 

While VIZOR comes with numerous custom reports out of the box, it may be desirable to create additional 

custom reports. The process of creating such a report is as follows: 

 

1   Open the Report Editor for the desired project. 

2   Select the Listing tab. 

3   Locate a report that has the Custom Report checkbox checked. If checked, this indicates that the 

report will appear in the Custom tab of Reports section of the Web views. 

4   Click the Copy Report button. Choose a name for the new report, type it in, and press OK. 

5   Press Apply to save your changes. 

Note: After doing this, VIZOR will have already saved two .rpt files in the CustomizedFiles folder 

allocated to this project. In order to view the reports in the Web views, they must be moved to the 

Web view folder. This can be achieved by regenerating the Web views that are related to the 

project. 

 Example: 

  CUSTOMIZEDFILES\#Project#HelpDesk\#AllWebViews#\ 

 

Please note that even though your customized reports will and should be placed in the 

CUSTOMIZEDFILES folder, reports part of the installation and developed by Vector are located in 

the SPTemplates folder.  

6   Regenerate the Web views that are related to the project.  

7   Navigate to the Web view's Reports folder and locate the two .rpt files. From here you can use Crystal 

Reports to edit the .rpt files. If you wish to add, change, or remove fields, create cross tabs, or add new 

charts, you will need advanced knowledge of Crystal Reports. Please contact support for more 

information. 
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If the report name is "Open Issues - Age by Priority" then the filenames will be: 

 Open$Issue$-$Age$by$Prioritylandscape.rpt and  

Open$Issue$-$Age$by$Priorityportrait.rpt 

or  

rptListingGOpen$Issue$-$Age$by$Prioritylandscape.rpt 

 rptListingGOpen$Issue$-$Age$by$Priorityportrait.rpt 

Once the modifications have been made to both files, they must now be copied to the CustomizedFiles 

folder to ensure they will be included the next time the Web views are generated.  

See Customizing Web View Files for more information on the CustomizedFiles folder.  
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LARGE REPORTS WITH LARGE DATA  

 

Depending on your organization, you may have some reports that display or process a high number of 

records. For example, if you have many thousands of assets, running certain reports in real time may take 

minutes. An area where you may experience this is in Software Installations, because it contains all the 

designated software installed in each computer. This way, you may have 5,000 computers, each one with 

100 software installations, resulting in 500,000 records analyzed by the report. 

 

One way to improve the performance of these reports is to generate the report overnight, and only open 

the generated static report during the day. In most cases these reports will be equally useful even if the 

data is not retrieved in real time.  

 

To pre-generate the report: 

- Go to the Web Admin > Report Subscriptions. 

- Select the desired project that contains the report. 

- Create a new Subscription. 

- Select the report and the format to generate it in. Excel is a good option for non-custom reports while 

PDF is a good option for custom reports. 

- In the Type, choose “Save as file” and enter the destination file name. The destination should include 

both the full path and file name and be a path as seen from the VIZOR server, like: 
 C:\Program Files (x86)\Vector\ConnectServer\CensusWeb\Views\CensusWebVD\Resources_Library\Reports\AllAssets.xlsx 

 

- Choose an existing schedule or create a new one. 

- Click Apply. 

 

It is often useful to make that report available in the usual reports User Interface in the Web in VIZOR. See 

the topic Viewing a Pre-generated Report in the VIZOR reports area. for more details. 

VIEWING A PRE-GENERATED REPORT IN THE VIZOR REPORTS AREA 

You can make available to users a pre-generated report in the standard VIZOR reports area. This is 

particularly useful for viewing reports that are slow to generate on demand. 

 

First, create a Report Page for the project in question and call it “SkipGenerate”. The only thing important 

is the name. This will tell VIZOR to not generate the report but open one from the existing file. 

 

Then, you need to create a copy of the report that is pre-generated, for example, if the original report is 

“All Software Installations”, go to the Report Editor and create a copy of the report and call it “All Software 
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Installations - Daily”. Set the Report Page to “SkipGenerate”. This report will be the one users access via 

the Web. Save. 

Once created, export it to the desired Web views as usual using the Web View Editor. 

 

Now we need to ensure the file is generated and it exists in the folder used for runtime reports. For this, 

we need the scheduled generation of the original report to save the file to the /CensusWebVD/Reports 

folder. 

Go to the Report Subscriptions area and locate or create one for generating the original report to a file. In 

the full path of the file to save change the folder to be the “Reports” folder of the CensusWebVD of your 

Web views. By default it will be something like: 

 C:\Program Files (x86)\Vector\ConnectServer\CensusWeb\Views\CensusWebVD\Reports 

 

Set the file name to the name of the report with each space replaced by a “$”. You can also take the name 

from the DEF database in the table tblSystemCustomReports, from the column tReportName of the 

record that represents the report in question. 

Add the proper file extension, like “.pdf” or “.xlsx”. So, the path will be something like: 

 C:\Program Files (x86)\Vector\ConnectServer\CensusWeb\Views\CensusWebVD\ Reports\SWInst.pdf 

   

You can now view the report in PDF from the Web view. 

TYPES OF CRYSTAL REPORTS IN VIZOR 

Depending on how the data is retrieved, there are three types of crystal reports in VIZOR: 

1. Dynamic Query 

2. Dynamic Connection 

3. Stand-alone 

 

 Query can be modified 

in VIZOR 

Report works automatically 

for new VIZOR projects and 

relocated databases 
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Dynamic Query  Y Y 

Dynamic Connection N Y 

Stand-alone N N 

 

 

 Report knows about 

the Database 

Connections? 

Report knows about the Query 

and SQL Statements? 

Dynamic Query  N N 

Dynamic Connection N Y 

Stand-alone Y Y 

 

HOW IS THE TYPE OF REPORT INDICATED? 

The type of report is indicated by a formula field called DSType. 

If the report does not have a formula field with this name, you can create it. 

If the value of DSType tells VIZOR how to treat the report. The following are the possible values: 

 DSType Field 

Dynamic Query  4 

Dynamic Connection 1 
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Stand-alone 5 

 

Note: Two variants of the Dynamic Connection type are also available, although deprecated now: 

    Dynamic Connection using a DSN = 2 

    Dynamic Connection using a UDL = 3 

 

1. DYNAMIC QUERY REPORT 

For this type of report, VIZOR uses the rpt Crystal Report and injects the data from a query executed by 

VIZOR, not inside the Crystal Report. The data is controlled by the query defined in the Report Editor just 

as it would be for Standard reports.  

The actual SQL statement is not known to the report and the VIZOR engine passes the actual data to the 

crystal report inside a virtual table called 'ado'.  

 

 

Selecting the data to include in a report  

In the Query list, choose a query to extract the records from the database and include them in the report. 

For example, if you want a report that breaks down the open issue count, then use the Open Issues query.  

 

Selecting the fields to include in a report  

In the Fields list, choose any of the fields available for that VIZOR project or database. Adding or 

removing fields from the list cause VIZOR to pass these fields as the data input provided to the Crystal 

Reports. How the field is used or displayed is controlled by the Crystal Report and can be changed in the 

usual way as for standard Crystal Reports. 

From within Crystal Reports, fields passed to this type of report appear in Database Fields as a virtual 

single table called “ado”, regardless of where they actually exist in a database. 
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ADDING FIELDS TO A DYNAMIC QUERY REPORT 

1 In VIZOR Admin, select a project and open the Report Editor. On the Listing tab, add one or more fields to a 

custom report. You can insert the new fields anywhere (for example, in between two existing report fields). 

2 Log on to a Web view of the project and view the custom report. 

VIZOR dynamically adds the field when you view the report BUT VIZOR does not save the changed report. 

You have to do that yourself (see step 3). 

3 From the report viewer, save the report in the Reports folder. Do this for both the Portrait and Landscape 

versions of the custom report. 

The Reports folder is located in the ConnectServer folder. For example: 

C:\Program Files (x86)\Vector 

\ConnectServer\CensusWeb\Views\CensusWebVD\HelpDesk_HelpDesk\Reports 

4 In Crystal Reports, open one of the .rpt file you just saved. The report includes the new field (to check: in 

the Field Explorer, expand Database Fields and then expand ado). 

Note that if you insert the new field into the report and then try to preview the report, Crystal Reports will 

display an OLE DB Provider dialog box and prompt you to select a data source. 

When this happens, just click Cancel. VIZOR sets the data source at runtime.  

If you want to be able to preview changes in Crystal Reports: 

▪ Save the report. If you get a "Unable to Save Data With Report" message box, click No. 

▪ In the Web view, view the report and save it again (this time the saved report will include the data 

required by Crystal Reports for previewing). 

▪ Open the report in Crystal Reports: now you can preview the report without being prompted for a 

data source. 

5 Copy the modified .rpt files to the CUSTOMIZEDFILES folder. If you don’t, your modified custom reports will 

be overwritten the next time you generate the Web view. 

Note: In general, any time Crystal Reports asks you to either use saved data or refresh 

data, use the saved data. Refreshing the data requires that you select a data source, and 

the data source should be set only by VIZOR at run time (when a user views the reports). 
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REMOVING FIELDS FROM A DYNAMIC QUERY REPORT 

6 In VIZOR Admin, select a project and open the Report Editor. On the Listing tab, remove a field from a 

custom report. 

7 Log on to a Web view of the project and view the custom report. 

When you view the report, VIZOR dynamically updates the list of fields included in the report BUT VIZOR 

does not save the changed report. You have to do that yourself (see step 3). 

If you get a “This field name is not known” message, then the field is used in a formula somewhere in 

the report. If this happens, you must open the .rpt file in Crystal Reports, find the formulas that use the 

field, and remove all references to the field.  

If the field was displayed in the report, or used to define a chart, you’ll see a blank space in the report 

where the field or chart were supposed to be. 

8 From the report viewer, save the report in the Reports folder. Do this for both the Portrait and Landscape 

versions of the custom report. 

The Reports folder is located in the ConnectServer folder. For example: 

C:\Program Files (x86)\Vector 

\ConnectServer\CensusWeb\Views\CensusWebVD\HelpDesk_HelpDesk\Reports 

9 In Crystal Reports, open one of the .rpt file you just saved. The report no longer includes the field you 

removed (to check: in the Field Explorer, expand Database Fields and then expand ado). 

10 Update the custom report as required. For example, if the removed field was used to define a chart, you’ll 

have to create a new chart. 

11 Copy the modified .rpt files to the CUSTOMIZEDFILES folder. If you don’t, your modified custom reports will 

be overwritten the next time you generate the Web view. 

Note: In general, any time Crystal Reports asks you to either use saved data or refresh 

data, use the saved data. Refreshing the data requires that you select a data source, and 

the data source should be set only by VIZOR at run time (when a user views the reports). 

 

 

 

 

2. DYNAMIC CONNECTION REPORT 

For this type of report, VIZOR uses the rpt Crystal Report and dynamically provides the necessary 

connection information for the Crystal Report to execute a query. VIZOR provides the database 

parameters including user credentials. The data is retrieved inside the Crystal Report from the query 

stored in the rpt file.  
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Selecting the data to include in a report  

The data is not controlled by the query defined in the Report Editor, so you need to query directly the 

tables and create the necessary joins within Crystal Reports. This type of report requires that the author of 

the report understands the structure of the database underneath but other conditions or filters that may 

not be supported by the VIZOR query editor may be used.  

 

Selecting the fields to include in a report  

The Fields list is not used in this type of report. Adding or removing fields from the list in the Report 

Editor will not change anything in the report since the fields are completely controlled by the Crystal 

Report. How the field is used or displayed is also controlled by the Crystal Report and can be changed in 

the usual ways. This type of report requires that the author of the report understands the structure of the 

database underneath but fields that are not VIZOR fields can be used.  

From within Crystal Reports, fields appear in Database Fields with the real table and field names and they 

point to a specific database (e.g. HelpDesk01_DAT). 

To add fields to a report of this type, you need to use the Database Expert in Crystal Reports and connect 

to a valid database, select the table where the field is and add it. Depending on your report, you may 

need to create a JOIN as well. 

3. STAND-ALONE REPORT 

This type of report is loaded by VIZOR from the rpt Crystal Report file but it does not change it in any way 

or pass any information to it. VIZOR assumes all the necessary connection information, query and data are 

stored within the Crystal Report. A report of this type can be a report where the database connection 

information and credentials are stored inside the Crystal Report or it can be a static report that does not 

query any database (it already has the data inside). 
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CUSTOMIZING THE REPORT USED BY THE PRINT BUTTON 

The report used to print record is named Current Issue - Detailed. If you edit this report in the Report 

Editor (of VIZOR Admin), the changes apply to all Web views of the project.  

By default the report is a Standard Report and the field can be defined directly in the Report Editor. 

However, you can choose to make it a Custom Report, in which case you need to click on the checkbox 

Custom and provide the two required rpt files. 

Each view has two versions this report:  

rptListingGCurrent$Record$-$DetailedPortrait.rpt 

rptListingGCurrent$Record$-$DetailedLandscape.rpt  

You can find examples of these files in the  

CensusWebVD\<project>_<view>\Reports   

folder, where <project> is the name of the project and <view> is the name of the Web view. The portrait 

version of the report is used to print records.  

To customize the report:  

1   View the portrait version of the report in a Web view. You can either print an record or view the report 

with the Report Viewer. 

Viewing the report creates the .rpt file.  

2   In the Report Editor (VIZOR Admin), mark the report as a custom report (select the Custom check box). 

      This prevents VIZOR from overwriting the customized report if the report definition changes.  

3   Using Crystal Reports, customize the report (add graphics, change fonts, rearrange and align fields). 

4   Put a copy of the customized report in: 

CUSTOMIZEDFILES 

 \#Project#<project> 

  \#WebView#<view> 

   \Reports  

When you regenerate the Web view, the customized version of the report is copied to the Web view folder. 
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EXPORTING TO CSV  

 

Custom reports can be exported to CSV from the Web.  

By default the separator is the comma “,”. If you need the CSV separator to be different, for example “;” , 

you can do it by adding a custom field inside the report. 

This is defined per report and inside the Crystal Report. 

Inside the Crystal Reports Editor, create a Formula Field called “CSV-CharFieldDelimiter”. 

In the formula editor, simply add the character to be used as the delimiter or separator, like “;”, but not 

surrounded by quotes. 

If not present or empty, the default will be used.  

Internally, the format of this type is CharSV=7. You can also make a specific report open by default in CSV 

by customizing the Reports.js file.  

  

Advanced Setting for the Report Engines: USING CRYSTAL REPORTS FOR ALL 

LISTING REPORTS 

It is also possible to use the Crystal Reports engine for all the Listing reports, rather than the HTML report 

engine. In this case, a Creation API for Crystal Reports would need to be purchased from a third party. 

Once purchased, this Creation API, after having been installed on the web server, will enable VIZOR to 

display all existing and future Listing reports using the Crystal Reports Engine. This is done automatically 

without the need to use the Crystal Reports Editor. Since this involves the automatic generation of .rpt 

files, Crystal Reports requires that the Creation API be present.  

 

Options control which report viewers are used by the Web views:  

 Standard Report Engine specifies the report viewer used for Listing reports. 

 Custom Report Engine specifies the report viewer used for Custom reports. 
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To set these options, log on to VIZOR Admin, and on the Tools menu, click Options.  

Note: If you have a version of Crystal Reports that is newer than version 9, you must still select Crystal 

Reports 9 as the report viewer. 

By default, VIZOR uses the included Crystal Reports Runtime Software to display custom reports, and a 

built-in HTML report engine to display listing reports, print records from the Web Views, and format 

notification contents such as attachments. 

 

 

DEFINING REPORT PAGES  

Report pages define formatting elements common to every page of a report, such as headers, footers, 

titles, and column layout. Report pages also define report titles. Pages can be shared by many reports, 

allowing you to define a standard look for all reports generated by VIZOR. Report Pages are only used in 

Standrad HTML Reports. 

VIZOR comes with a set of predefined pages. You can adapt these templates to your specific 

requirements, or define entirely new pages.  

TO OPEN THE PAGE EDITOR:  

On the Tools menu, click Report, then click Page Editor.  

 Choose a page from the Name list. You can then edit, delete, or rename the 

page. 

 To use one page as a starting point for a new page, choose a page from the 

Name list, click Copy, and give the new page a name. 

 To create a page from scratch, click New. 

You can use the Page editor to define headers, footers, and titles for your reports. In addition to typing 

and formatting plain text, you can insert placeholders for the current date, time, and page number. When 

you generate your report, these placeholders are replaced with values. 
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To do this Click 

Insert the current date  

Insert the current time  

Insert the current page number  

Left-align text  

Center text  

Right-align text   

Format text by changing fonts and point sizes, and 

applying bold, italic, or underline styles. 
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CHAPTER 27 - COMPUTERS AND 

DISCOVERY TOOLS  

DISCOVERY OF COMPUTERS - BRINGING COMPUTERS INTO VIZOR 

Computers are special types of assets managed in VIZOR. Computers have special attributes or fields such 

as CPU, CPU Speed, Memory, Operating System, etc. 

Before you can manage your computer assets in VIZOR, you can import them from one or several of these 

sources: 

• Vector Discovery 

• Microsoft Endpoint Configuration Manager ECM (a.k.a. SCCM) 

• LANSweeper 

• Solarwinds 

• Excel 

• In-house / custom discovery 

 

VECTOR DISCOVERY 

VIZOR can discover the computers in your network via our own Vector Discovery tool. If you use our 

discovery tool, computers are automatically imported into VIZOR. 

WHAT INFORMATION IS SYNCHRONIZED/IMPORTED FROM VECTOR DISCOVERY?  

For computers: 
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• Base_Board_Manufacturer 

• Base_Board_Product 

• Base_Board_Version 

• Bios_Major_Release 

• Bios_Minor_Release 

• Bios_Release_Date 

• Bios_Vendor 

• Bios_Version 

• ComputerName 

• CPU 

• CPU_Cores_Count 

• CPU_Count 

• CPU_Speed 

• Domain_Name 

• EC_Firmware_Major_Release 

• EC_Firmware_Minor_Release 

• Image_Version 

• IP_Address 

• Key_Name 

• MAC_Address 

• Manufacturer 

• Memory 

• Model 

• Network_Card 

• OS_Name 

• OS_Version 
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• PC_Model 

• Primary_Owner 

• Serial_Number / SN 

• Source_Timestamp 

• Subnet_Mask 

• System_Family 

• System_Manufacturer 

• System_Product_Name 

• System_SKU 

• System_Version 

• Name 

• Unique ID in Vector Discovery 

  

Note: The IP Address and MAC Address that are imported are the first ones found, not necessarily the 

primary ones. 

HOW TO DETERMINE THE ORIGIN OF AN ENTRY: DISCOVERY AGENT OR MANUAL 

 

The following methods offer different approaches to discerning whether an entry originated from a 

discovery agent or was manually created in VIZOR. 

• Method 1: Using the Field "Source Name" 

This field denotes the latest external source of information. 

o If the source has never changed (check asset history), the Source Name is the original 

origin. 

o If the source has changed (refer to asset history), the first entry in the Source Name field 

indicates the initial origin. 
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• Method 2: Using the Field "Submitter" 

Records might be linked to a user or appear as "<None>". 

o If the record is generated by Vector discovery, it will be labeled as "<None>". 

 

• Method 3: Using Record History 

Using the record history to locate entries for revision 1, which signifies the creation of the record. 

o The revision 1 signifies the initial creation of the record. 

o If entries show "issueagent" the record is generated by VIZOR itself. 

 

The displayed username is associated with the user at the time of saving the revision. Note that if the 

user's profile has since changed names, it might be historically accurate but not presently accurate.  
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INTEGRATION WITH MICROSOFT ENDPOINT CONFIGURATION MANAGER - ECM 

(AKA SCCM) 

If you have deployed Microsoft’s ECM (a.k.a. SCCM) across your network, VIZOR’s ECM Connector imports 

and synchronizes the computers information collected by ECM. The ECM Connector also imports the 

software installations per computer as discovered by ECM. 

The integration between VIZOR and Microsoft ECM allows organizations to manage the life cycle of assets 

discovered by ECM and it extends the asset information to include usage, allocation and financial details. 

 

UNDERSTANDING HOW THE INTEGRATION WORKS  

The integration has two main components: 

1) ECM / SCCM Connector 

2) VIZOR Importer 

 

ECM/SCCM CONNECTOR 

The ECM/SCCM Connector reads data from ECM and sends it to the VIZOR Server on a regular basis. 

The connector makes multiple queries to the ECM views of the SQL Server database using read-only 

access. The data is converted to a common format that is sent over to the VIZOR Server for the 

synchronization. 

The ECM Connector must be installed in a computer located in the same LAN as ECM. 

If Vizor is in the cloud, the connector may be installed directly on the ECM server or in any computer that 

can query the ECM SQL Server database. 

If VIZOR is on premises, the connector is automatically installed on the VIZOR Server and no separate 

installation is required. 
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The default installation path is: 

C:\Program Files (x86)\Vector\ConnectTools\DataExport\SCCM 

In both cases, credentials for a SQL Server user with read-only access to the ECM views is required. 

 

VIZOR IMPORTER 

The data queried and prepared by the ECM Connector is sent over to the VIZOR Server. The data is 

received and serialized into a temporary cache until it is fully processed and imported. 

The default import cache paths are: 

C:\Program Files (x86)\Vector\ConnectServer\Import\ExternalData\ 

Assets - SCCM Desktops 

Assets - SCCM Laptops 

Assets - SCCM Printers 

Assets - SCCM Servers 

Asset – SCCM Monitors 

Scheduled tasks regularly synchronize the assets based on the configuration preferences depending on 

their types. The default frequency is daily, at midnight. 

Some parameters of the synchronization can be configured from the VIZOR Import Manager, after 

selecting the appropriate import rule. There is one rule for each type of asset. 

 

 

 

WHAT INFORMATION IS SYNCHRONIZED/IMPORTED FROM ECM/SCCM? 

 

For computers: 
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• Base_Board_Manufacturer 

• Base_Board_Product 

• Base_Board_Version 

• Bios_Major_Release 

• Bios_Minor_Release 

• Bios_Release_Date 

• Bios_Vendor 

• Bios_Version 

• ComputerName 

• CPU 

• CPU_Cores_Count 

• CPU_Count 

• CPU_Speed 

• Domain_Name 

• EC_Firmware_Major_Release 

• EC_Firmware_Minor_Release 

• Image_Version 

• IP_Address 

• Key_Name 

• MAC_Address 

• Manufacturer 

•Manufacturer_ID 

• Memory 

• Model 

• Network_Card 

• OS_Name 
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• OS_Version 

• PC_Model 

• Primary_Owner 

• Serial_Number / SN 

• Source_Timestamp 

• Subnet_Mask 

• System_Family 

• System_Manufacturer 

• System_Product_Name 

• System_SKU 

• System_Version 

• Name 

• Top_Console_User 

• Unique ID in ECM/SCCM 

  

Note: The IP Address and MAC Address that are imported are the first ones found, not necessarily the 

primary ones. 

 

Software Installations: 

• Application_Name 

• Application_Platform 

• Device_Name 

• Installed_Date 

• Source_Timestamp 

• Unique ID in ECM/SCCM 

• Vendor 
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• Version 

 

Monitors: 

• Asset Type 

• Src_Last_Updated 

• Name,Computer 

• Manufacturer 

• Description 

• ScreenWidth,ScreenHeight 

• Computer 

• PixelsX,PixelsY 

• Type 

• SerialNumber 

• Unique ID in ECM/SCCM 

 

Printers: 

• Asset Type 

• Name 

• Src_Last_Updated 

• Name 

• Unique ID in ECM/SCCM 
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CONFIGURING THE INTEGRATION WITH ECM 

The integration brings automatic import and synchronization of computers and other assets 

from ECM into VIZOR. With the integration enabled, computers discovered by ECM will be 

also displayed in VIZOR, in the Assets > Computers area. Once the computers are in 

VIZOR, they can be managed just as other assets, including their life-cycle, requests, 

approvals and workflows. 

 

INSTALLATION OF THE ECM CONNECTOR WITH VIZOR IN THE CLOUD 

Run the setup program of the VIZOR ECM Data Connector in a computer in the LAN. It can 

be installed in any computer that can read data from the ECM database, including the ECM 

Server. This connector is needed to bridge the integration between the ECM server and the 

VIZOR server in the Cloud. 

This step is only necessary if your VIZOR server is in the cloud, otherwise your VIZOR 

application server already has the ECM connector installed, which is used to connect to your 

local ECM server. 

 

Enter Parameters to Connect to ECM 

In this step, we will configure the connection parameters to the ECM SQL Server database. 

It is suggested to have a service account with database read permissions. 

Go to: 

C:\Program Files (x86)\Vector\ConnectTools\DataExport\SCCM 

Run MqExporterSettings 

Enter the parameters:  

Database name 

  Usually: CM_xxx 

SQL Server Name: 

Sql server login (user/pwd) 

  Or windows authentication (checkbox) 
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Upload URL: 

If the VIZOR Server is on premises, leave the default value. 

If the VIZOR Server is being Cloud Hosted, enter the proper URL: E.g.: 

https://vector.vizor.cloud/connect/webapi/xferfls.asp or 

https://company.vizor.cloud/connect/webapi/xferfls.asp 

 

 

Save and close. 

 

Set The Frequency  

Go to VIZOR > Configuration > Settings and search for Integration with Microsoft ECM.  

In the field Value, enter how often the synchronization should occur. 

https://vector.vizor.cloud/connect/webapi/xferfls.asp
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Then, on the computer that has the Connector, local to your LAN network, go to: 

C:\Program Files (x86)\Vector\ConnectTools\DataExport\SCCM 

Run CreateScheduledTask.bat 

This batch file creates Windows scheduled tasks for exporting all data from ECM.  

You can set the frequency of the import/synchronization by setting the frequency of the 

Windows Scheduled Task. 

When “Use Windows Authentication” is selected, the schedule task needs to run under a 

Windows account that has logon permissions on the SQL Server hosting the ECM database 

and read permissions on the ECM database. 

 

 

INSTALLATION OF THE ECM CONNECTOR WITH VIZOR ON PREMISES 

When ECM/SCCM is in the same network as the VIZOR application server, use the local 

VIZOR ECM Data Connector already installed in the VIZOR server. 

Go to VIZOR > Configuration > All and search for Integration with Microsoft ECM.  

 

Set Use Local Connector to Yes. 

 

Enter Connection Parameters  

VIZOR needs the connection parameters to connect to the ECM SQL Server database.  

Enter the parameters:  

Database name 

  Usually: CM_xxx 

SQL Server Name: 

Sql server login (user/pwd) 

  Or windows authentication (checkbox) 

Save. 
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Set The Frequency  

When using the local connector (the SCCM database is in the same network as VIZOR), the 

interval indicates the frequency in days for synchronizing the assets and software. The 

default is 1 day. 

Using Windows Authentication for SQL Server  

When using Windows authentication for connecting to the SCCM database, you need to give 

read permissions to the Windows user running the Windows Service called: Vector 

Integrations Service. The user running this process will be authorized by SQL Server to 

retrieve the necessary data. 

 

INSTALLATION OF THE CONNECTOR FOR MULTIPLE ECM / SCCM SOURCES 

VIZOR can integrate with multiple ECM / SCCM sources at the same time. For example, if 

your organization has several distributed SCCM systems, they can all be centralized and the 

assets managed in VIZOR. 

This type of deployment requires the installation of multiple connectors, each one installed 

in a computer that is close to each SCCM or directly in the SCCM server. 

Each separate connector is installed in a similar way to when installing one connector and 

VIZOR is in the cloud.  

For each one of the SCCM sources: 

1. Determine what Location in VIZOR should be linked to the given SCCM source. 

For example, for SCCM-A, the organization determined the location is “USA \ New York”. 

Go to the Locations area in VIZOR and drill-down to USA \ New York, then open the details 

of the location and note the numeric ID.  
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2. Install the connector in the SCCM-A server, or in a near computer. 

Follow the instructions in Installation of the ECM Connector with VIZOR in the cloud . 

 

3. Enter the Location in MqExportSettings.xml 

Open the file MqExportSettings.xml with a text editor. 

The file is located by default in: 

C:\Program Files (x86)\Vector\ConnectTools\DataExport\SCCM 

Towards the bottom of the file, locate the <rs:data> section. The row for nID=’3’ is for 

entering the Location ID (2 is for the Organization ID, in case you have multiple 

organizations). 

 

Enter the numeric ID of the location from step 1 into the tValue and save. 
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This will tell the connector that every asset will belong to the location “USA \ New York”.  

You can now run the connector as usual directly or via Scheduled Tasks. 
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HOW DO I KNOW IT WORKS? 

For the computer asset information: go to Assets > Computer, your desktops, laptops and 

servers should be listed in each one of the asset type groups.  

Click on any of those computers to load the details. The Computer Details tab should have 

the hardware information as collected by ECM. You can also find the network address of the 

computer as well as the primary logon user of that computer. 

 

For the software installations: go to Software Installations > Software Installations Catalog. 

All the software titles discovered by ECM will be listed. 

You can now specify what software titles to import into VIZOR and normalize them into 

Software Asset Types. 

 

 

WHAT HAPPENS AFTER IMPORTING SOFTWARE INSTALLATIONS? 

 

 

The next time the scheduled tasks run, the software installations flagged to be imported will 

be moved to the Software Installations area and each installation mapped to one Software 

Asset Type. 

You can view any current and past installations in the Software Installations area, query for 

new installations this month, this year, this week, as well as uninstalled software (Removed 

Installations).   

Click on an installation record to view more details such as the version and the license key, 

if discovered. 

You can also check the last time this information was refreshed with ECM in the Source tab. 

 

Imported installations will also be displayed in the following areas: 

- Installations of a computer 

Assets > Computer then Details > Installations tab 

 

- Installations of a Software Asset Type 
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Assets then Asset Types > click on a particular Software Asset Type (e.g. 

Microsoft Office 2016). Then Details > Installations tab. 

  

- Installations of a Software License 

Software Licenses then click on a particular Software License, then Details > 

Installations tab. 

The difference between the software installations catalog and the software installations is 

that the catalog is just a list of all the different software titles found in ECM with the number 

of how many computers each software is installed in. The catalog does not have the name 

of the computer where the software is installed or any other details. The detailed list of 

installations per computer is in the software installations file. The catalog is much smaller 

and it serves as a directory of the full list of software installations. 

 

Software Installations Catalog    

Adobe 10.1.2 20 

Microsoft Office 2016 100 

 

 

Software Installations 

Adobe 10.1.2 Computer01 (Additional 

information per 

computer 

installation) 

Microsoft Office 2016 Computer01  

Adobe 10.1.2 Computer02  

Microsoft Office 2016 Computer02  

Adobe 10.1.2 Computer03  

Microsoft Office 2016 Computer03  
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Adobe 10.1.2 Computer04  

Microsoft Office 2016 Computer04  

… …  

 

SQL VIEWS USED BY VIZOR 

The following ECM SQL views are queried: 

• v_GS_COMPUTER_SYSTEM 

• v_GS_PC_BIOS 

• v_GS_PROCESSOR 

• v_GS_X86_PC_MEMORY 

• v_R_System 

• v_GS_OPERATING_SYSTEM 

• v_GS_SYSTEM_ENCLOSURE 

• v_RA_System_IPAddresses 

• v_RA_System_MACAddresses 

• v_GS_NETWORK_ADAPTER_CONFIGURATION 

• v_GS_SYSTEM_CONSOLE_USAGE_MAXGROUP 

• v_UsersPrimaryMachines 

• v_GS_PROCESSOR 

• v_GS_PRINTER_DEVICE 

• v_R_User 

• v_GS_INSTALLED_SOFTWARE 
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SOLARWINDS 

With VIZOR’s SolarWinds Connector, import and keep synchronized the list of servers managed by 

SolarWinds, including computer details.  

 

 

 

LANSWEEPER 

Similar to the connector for ECM, you can import and synchronize the list of computers discovered by 

LanSweeper.  

 

 

EXCEL / WORKSHEET 

Some times the best source for the import is an Excel file. Maybe it was created manually or maybe a 3rd 

party system can easily export the inventory to Excel. VIZOR’s native adapter easily imports and 

synchronizes from a list of computers in Excel.  

 

 

IN-HOUSE INVENTORY 

If your organization has deployed a custom computer discovery or inventory system, you can still use 

VIZOR’s flexible adapter technology to import and synchronize the list of computers.  
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NEEDS ATTENTION - NOT SEEN RECENTLY 

VIZOR automatically sets the field flag Needs Attention – Not Seen Recently to Yes if an asset that was 

imported from discovery (ECM/SCCM, Vector Discovery, etc.) has not been seen recently.  

For example, if a computer is decommissioned outside VIZOR or deleted in ECM//Vector Discovery, it will 

not be updated in VIZOR. Computers are updated daily by default.  

 

How much time passes before the flag needs attention is raised?  

The time is configurable in the Admin > Options. 

Look for the option Days before asset marked as Not Seen Recently 

 The default value is 60 (days) 

 

 

 

 

INFORMATION SPECIFIC TO MOBILE DEVICES AND PHONES 

VIZOR includes information that is specific for Mobile Devices and Phones. This information is found in 

the Phone Details tab.  

For example: 

• Phone Number 

• IMEI. This is a 15- or 17-digit code that uniquely identifies mobile phone sets, set by the 

manufacturer.  

• SIM Card Number. When using one, the ID of the card. 

• ICCID. This is the unique iodentifier of the circuit, if present. 
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By default, this tab is only enabled for assets of class Telecom. If you need to modify this, go to the 

Business Rule “Hide Tabs By Asset Class” in the Worfklow Editor. 
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IDENTIFYING THE SOURCE OF AN ASSET RECORD AND DOCUMENTING THE 

DISCOVERY PROCESS 

As we saw, discovery processes, internal or external, are fed into VIZOR via the import rules in the Import 

Manager. It is often important for users to know how recent is the data obtained by discovery and how it 

was retrieved. In the import rule, besides the name of the source, enter the details of the Discovery in the 

Documentation field and describe the Update Procedures. 

 

When viewing an asset or CI record in VIZOR, users will be able to see the following information in the 

Source tab: 

Source Type: Computers from X (as selected when creating the import rule) 

Source Name: any name chose by you that helps relate to this source 
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Last Imported date and time. 

The timestamp of the source, for example, if the computer information comes from ECM, what is 

the last timestamp as per ECM. 

Discovery Documentation: the documentation entered by you on the Documentation field of the 

import rule. 

Update Procedures: the update procedures as entered by you on the the import rule. 

 

 

 

 

IDENTIFYING DISCREPANCIES VS DISCOVERY 

VIZOR allows you to identify discrepancies between the information in VIZOR and the information 

obtained from Discovery. 

For example: 

• Query Computers with Discrepancies vs Discovery 

This builtin query finds discrepancies such as 

o Allocated to Person vs Primary_Owner from Discovery 

o Allocated to Person vs Top_Console_User from Discovery 
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o Manufacturer vs Manufacturer from Discovery 

o Model vs Model from Discovery 

o Location vs Discovery Location 

 

 

 

• Installations vs Allocated Software 

VIZOR will automatically try to match the Software Asset instance that may be associated to a 

Software Installation found in your network by Vector Discovery, ECM, LanSweeper, etc. 

 

For each installation CI record, VIZOR matches the title in the Software Asset Types library and a 

valid available Software Asset instance, based on the Allocated Computer or on the computer 

being used by the Allocated to Person. 

See Software Installations Reconciliation for more information. 
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CHAPTER 28 - MANAGING 

CONTACTS, USERS AND GROUPS 

ABOUT USERS AND CONTACTS  

In VIZOR, you work with four types of accounts:  

 Users, who have logon names and passwords and can log on to Web views, 

VIZOR Web Admin, VIZOR Admin, or the Web View Editor. 

 Contacts, who cannot log on. Contacts are people who, for example, report 

issues by telephone, e-mail, fax, or through submit-only views. 

 Companies, who cannot log on. Companies are related to either a Contact, or 

User of the VIZOR system. 

 Value-Added Resellers (VARs), who cannot log on. Like Companies, VARs are 

related to either a Contact, or User of the VIZOR system. 

Users are not specific to projects. For example, a user can use the same logon name and password to log 

on to any Web view of any project. However, each project can store different information for users. When 

you add a field to the Contact tab of a project, that field is a project-specific user information field.  

Companies and VARs can be used to better organize Users and Contacts. For example, when multiple 

Contacts are associated to the same Company, it becomes easier to search for all records related to the 

Company - the same is true for VARs. However, there are specific features in VIZOR that only work with 

Companies, for example: 

 Service level agreements can be created to apply to all users of one specific 

company. For more information, see Companies. 
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 When Contacts are created through E-mail Integration, VIZOR will attempt to 

automatically associate a Company. For more information, see Setting Default 

Values for Issues Submitted by E-mail. 

 

USERS  

All users must have a VIZOR user account, which consists of a user name and an optional password. Use 

Vizor Web Admin to create and manage user accounts.  

GROUPS  

By assigning users to groups, you can control:  

 Access to features in VIZOR Admin, VIZOR Web Admin, and Web views. 

 Access to projects.  

 Access to Web views. 

 Workflow permissions. 

Use VIZOR Web Admin to create groups, edit group privileges, and assign users to groups.  

CONTACTS 

A contact is a person who reports an issue. For example, a guest from another company may report an 

issue with a computer while they are working on-site. In this case, the guest is the contact, and the help 

desk analyst who enters the report is the submitter.  

To create and manage a list of contacts, use VIZOR Web Admin. Web views can also include a Contact 

button that opens the Users and Contacts dialog. Access to this dialog from a Web view is controlled by 

the group permissions defined in VIZOR Web Admin.  
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VIZOR provides a set of tools for administering projects and Web views:  

 VIZOR Admin for administering projects. 

 Web View Editor for defining and generating Web views for projects. 

 VIZOR Web Admin for administering projects and users through the Web.  

 

IMPORTING USERS AND CONTACTS FROM WINDOWS  

You can import user accounts from Active Directory (or from a Windows domain), so users can log on to 

VIZOR with their Windows user names and passwords. Use the User Account Import Manager to import 

user accounts and keep VIZOR synchronized with Active Directory/Windows (see Integration with Active 

Directory).  

 

 

ADMINISTERING USERS AND CONTACTS  

To create and manage users and contacts in VIZOR, use Vizor Web Admin. For example, you can use Web 

Admin to disable users, create contacts, and to create user accounts.  

Users with the required permissions can also create contacts in Web views. 

 

USER SECURITY  

VIZOR security enables you to manage user access to record data and features. In VIZOR, security is based 

on the users and groups.  
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When you install VIZOR, the Setup program creates sample users, such as Admin, and demo, along with a 

number of role-based user accounts.  

To secure your projects, you must import or create user accounts for users. You then assign the users to 

groups, and use group privileges to control their access to tools, such as VIZOR Admin and VIZOR Web 

Admin and for individual features such as the Report editor.  

 

USER GROUPS  

Each user is a member of one or more groups. Access to VIZOR features and projects is based on group 

membership. You can enable and disable features and projects on a group-by-group basis. A user can 

only access a feature or project if the user is a member of a group where the feature or project is enabled.  

VIZOR has several default groups.  

 The Admins group has all features enabled 

 The Users group enables features that you want to make available to all users. 

All users are members of this group 

 The Analysts and Group Leaders groups have access to all Web View 

features controlled by security permissions 

 The Employees group cannot access any of the Web view features controlled 

by security permissions 

To control access to VIZOR features, you assign users to the groups based on their roles and 

responsibilities in the issue tracking process. For example, a help desk group leader or analyst who is also 

responsible for administering VIZOR must be a member of the Admins group. For example, a member of 

the QA staff who is also responsible for administering VIZOR would be a member of both the QA and the 

Admins group. 

NOTES 

 Use the Web View Editor to set the group access permissions that control who 
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can log on to the Web views of a project.  

 Use VIZOR Admin to control access to projects. 
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IMPORTING USER ACCOUNTS 

You can import user accounts from an Active Directory domain, an LDAP repository, from Microsoft 

Dynamics or from other sources (see Integration with Active Directory for more details). 

INTEGRATION WITH MICROSOFT DYNAMICS 

 

 

VIZOR integrates with Microsoft Dynamics in three main areas of functionality: 

 

• With Microsoft Dynamics CRM, for synchronizing users, contacts and customers. 

• With Microsoft Dynamics GP, for linking helpdesk tickets to the items that customers have 

purchased. 

• With Microsoft Dynamics GP, for the RMA tickets, to track returns and warranties provided to 

customers. 

 

Additional features: 

- View details of sales invoiced to customers, including invoice dates and the serial numbers and items 

included 

- Automatically create sales transactions in GP from VIZOR 

- Automatically create RMA transactions in GP from VIZOR tickets 

- Track the status of items sent to customers as part of RMAs.VIZOR discovers them in Dynamics GP and 

brings the Tracking Number and Serial Number. 

- Show reconciliation of parts sent vs parts received. 

- Track available parts in internal inventory that can be sent to customers. 
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Internally, VIZOR uses multiple tables such as Invoices, Line Items, Serials for Line Items, Sales Transactions 

and RMA Transactions. 

 

 

(only on-premises editions of Microsoft Dynamics are supported at the moment). 

NEEDS ATTENTION - NOT SEEN RECENTLY 

VIZOR automatically sets the field flag Needs Attention – Not Seen Recently to Yes if a user account that 

was imported has not been seen recently in the last synchronizations with the source.  

For example, if a user account is is deleted in Active Direcory and it was imported into VIZOR, it will not be 

updated in VIZOR on the daily synchronization.  

 

How much time passes before the flag needs attention is raised?  

The time is configurable in the Admin > Options. 

Look for the option Days before user marked as Not Seen Recently 

 The default value is 7 (days) 

 

DEFINING IMPORT RULES  

An import rule remembers the settings from the last time you used the rule.  

To define an import rule:  

1   In the Import Rules dialog, click Add and type a name for the import rule. 

2   Click Next and continue through the remaining steps of the User Account Import Manager.  

All your subsequent choices and settings are saved in the import rule. For example, suppose you select an 

Active Directory server, specify an LDAP search filter, and change the default import settings. The next 
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time you run the User Account Import Manager, you can select the import rule to use the same choices 

and settings.  

 

INTEGRATING WITH ACTIVE DIRECTORY  

Before you can import user accounts, you must add a connection to an Active Directory server or 

Windows domain.  

To add an Active Directory server:  

1   In the Active Directory Servers and Windows Domains dialog, click Manage. 

2   In the Manage Active Directory Servers and Windows Domains dialog, click Add LDAP. 

3   In the Display Name box, type a name for the LDAP server. VIZOR uses this name to identify the 

server. 

4   In the Host, Port, and Base DN boxes, enter the connection information for the LDAP server: 

Host is the IP address of the LDAP server. 

Port is the port the LDAP server is running on. By default, LDAP servers run on port 389. LDAP over SSL uses 

port 636 by default.  

Base DN is the top level of the LDAP directory tree. For example, if your organization’s DNS domain name is 

mycompany.local, the Base DN is dc=mycompany,dc=local. 

5   If you want to use anonymous authentication for the connection, select the Anonymous Bind check 

box.  

Alternatively, clear the Anonymous Bind check box and enter the information for authenticating a user when 

connected to the server, where: 

User DN is the user to authenticate For example: CN=Administrator,CN=Users,DC=mycompany,DC=local 

Password is the user's password 

6   In the LDAP Logon Name Field box, type the name of the LDAP property that stores the user account 

name. VIZOR uses this name to log on. 

7   Click Test to test the connection. 
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WHEN VIZOR IS IN THE CLOUD 

VIZOR can integrate with your Active Directory for synchronizing user accounts and allowing users to log 

in using the same user credentials. 

REAL-TIME INTEGRATION 

If you want the VIZOR cloud server to communicate with your Active Directory in real time, an open IP 

channel needs to be allowed across your firewall.  

Typically, the TCP and UDP 389 ports are needed, but depending on the configuration there may be more. 

You will need to consult with your firewall configuration expert. 

VIZOR uses the LDAP protocol on this port.  

You can also use the LDAPS protocol. 

 

IMPORT 

 

As an alternative, you can export the users list from your AD and then import them into VIZOR. This 

solution, however, does not bring the user passwords and therefore users would need to set the 

passwords in VIZOR.  

 

FILTERING USERS  

You can use LDAP search filters to filter the list of users imported from Active Directory.  
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If you want to filter users based on Active Directory groups, click Add Filter and select the groups you 

want to filter. Then click Append to append the group filter to the search filter in the Filter box, or click 

Replace to replace any existing search filter.  

If you want to filter on other conditions, you can also write your own LDAP search filters, and combine 

them with the group filters created with Add Filter. For example, you could type in filters such as:  

 (sn=Mark) 

selects users with a surname of Mark. 

 (!cn=IUSR_*) 

filters out all user names that start with IUSR_*. 

 (&(!cn=IUSR_*) (!cn=IWAM_*)) 

filters out all IUSR_<computername> and IWAM_<computername> users. 

For more information on the LDAP search filter syntax, see: 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/adsi/adsi/search_filter_syntax.asp.  
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IMPORT SETTINGS  

Import as Contacts 

 

If you want to import the users as contacts, select the Import as Contacts check box.  

Import to Groups 

 

By default, imported users are added the Users group in VIZOR. If you want to add the imported users to 

a different group (for example, Admins), click the group in the Import to Groups list.  

Get E-mail Addresses From  

Specifies where to get the e-mail addresses of imported users.  

Scheduling Imports  

Specifies when to import users. Select the When Scheduled check box and then click Configure if you 

want to use Window's Scheduled Tasks to schedule regular imports. Scheduling imports keeps VIZOR 

synchronized with Active Directory and Windows domains.  

Select the Now check box if you want to import users as soon as you finish with the User Account Import 

Manager.  

Import Settings 

These check boxes control whether the User Account Manager:  

 Adds new user accounts for any new users found in the Active Directory or 

Windows domain. 

 Updates existing user accounts with any changes (for example, to the user 

name or e-mail address) found the Active Directory or Windows domain. 
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CREATING USER ACCOUNTS  

Most of the times user or employee accounts are created when synchronizing with an external system, like 

Microsoft Azure, Google G Suite, Active Directory, SugarCRM, etc. Other times, they are imported from an 

xls or csv file. However, you can create manually a new user or employee account. 

To create a user account:  

1. In VIZOR Web Admin, select the Security tab and click the Users button.  

2. Click the appropriate button for Add New User, Employee, Contact, etc. 

3. In the Type field, select User or Employee. 

4. In the Authenticate With list, click VIZOR Authentication if the user will be native to VIZOR, and 

so the password and authentication will be managed by VIZOR. 

5. If the account is of type User, type a new user name in the Logon Name. If the account is of type 

Employee, and you want the employee to be able to log on to VIZOR, select YES in the field Can 

Log In, and type a new user name in the Logon Name. 

6. In the Password and Confirm Password boxes, type the user’s password. 

7. Enter the rest of the user information and click OK or Save. 

8. After creating the account, you can set the User Groups the new account belongs to. New users 

automatically belong to the Users group; however, administrators can assign the User to 

additional groups, if desired. 

USER ACCOUNT LOGON AND EMAIL  

When creating a new user or employee account, VIZOR can automatically generate the logon name and 

the email address following your organization’s naming convention. 

The logon name can be used to create the user in Active Directory automatically via an asset Action, when 

provisioning the user. 

 

The default logon and email are generated using formulas that can be changed in VIZOR Admin > Tools 

> Options 
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Match pattern for email format The regular expression pattern 

to be used to format the email 

address. 

 

([a-zA-Z]{1})(.+)( )(.+) 

 

 

Replace pattern for email format 

 

The expression to use as 

formula in combination with 

the match pattern for 

generating automatically email 

addresses. 

 

$1 is the value in the first 

parentheses in the regular 

expression formula 

 

$2 is the value in the second 

parentheses in the regular 

expression formula 

 

$3 is the value in the third 

parentheses in the regular 

expression formula 

 

$4 is the value in the fourth 

parentheses in the regular 

expression formula 

 

$1$4@acme.com 

Fields to be used in the email 

formula 

 

Comma separated fields to be 

used in the email formula.  

The are written in the same 

order as they are considered in 

the formula. 

 

<F.ID:First Name>,<F.ID:Middle 

Name>,<F.ID:Last Name> 

Match pattern for logon format The regular expression pattern 

to be used to format the logon 

name. 

 

([a-zA-Z]{1})(.+)( )(.+) 

 

 

Replace pattern for logon format 

 

The expression to use as 

formula in combination with 

the match pattern for 

generating automatically logon 

names. 

 

$1 is the value in the first 

parentheses in the regular 

expression formula 

 

$2 is the value in the second 

$1$4 



  Page 410 

 

parentheses in the regular 

expression formula 

 

$3 is the value in the third 

parentheses in the regular 

expression formula 

 

$4 is the value in the fourth 

parentheses in the regular 

expression formula 

 

Fields to be used in the logon 

formula 

 

Comma separated fields to be 

used in the logon name 

formula.  

The are written in the same 

order as they are considered in 

the formula. 

 

<F.ID:First Name>,<F.ID:Middle 

Name>,<F.ID:Last Name> 

 

 

 

 

EXAMPLE OF EMAIL PATTERNS 

 

([a-zA-Z]{1})(.+)( )(.+) 

 

Results in:  

 

anewman@acme.com 

 

([a-zA-Z]+)(.+)( )(.+) 

 

Results in:  

 

alfred.newman@acme.com 

 

 

 

LOGON NAME ALTERNATIVES 

mailto:alfred.newman@acme.com
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The Logon Name Alternative serves as an additional identifier for users within VIZOR, facilitating matching 

with various logon formats, especially when the primary logon name doesn't align. Example: 

 

• Primary logon name, often associated with Google accounts: peter.johnson@myschool.org. 

 

• Secondary logon name, typically for Windows domain users: peter.johnson@myschool.local. 

 

In general, Logon Name Alt can have either of these 2 types of values: 

 

• Complete Alternative Logon Name. For instance: "peter.johnson@myschool.local". 

 

• Partial Logon Name. Used in combination with parent organization domains, like: "peter.johnson". 

 

By default, Logon Name Alt extracts the name part from the email address, therefore, for this example 

"peter.johnson". 

 

VIZOR often requires matching users using keys beyond its standard user ID, especially during user 

imports or identification from Recent Users entries. User keys can be provided in formats like 

"peter.johnson@myschool.local" or "MYSCHOOL\peter.johnson".  

When exact matches aren't available, Logon Name Alt is utilized. 

VIZOR will then check for possible matches using the Email Domain of the parent organization (first 

example) or the Network Domain (second case). 

 

NOTES:  

1. Imports from Azure set the Logon Name Alt with the mailNickname attribute. 

2. Imports from Active Directory set Logon Name Alt with the AD userPrincipalName attribute.  
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ENABLING AND DISABLING PROJECTS  

When you disable a project for a group, members of that group cannot:  

 Log on to Web views of the project. 

 Edit the project in VIZOR Admin. 

 Edit views of that project in Web View editor, or generate new views of that 

project. 

You can disable specific Web views for members of a group. 

To enable or disable a project for a group:  

1   In VIZOR Web Admin, click the Security tab, then click the large Groups button on the left of the tab. 

2   In the Groups list, click a group. 

3   Click Projects  

4   If you want to enable a project: 

a   In the Disabled list, click the projects you want to disable. Use the Shift and Control keys to select more than one project. 

b   Click . 

5   If you want to disable a project: 

c   In the Enabled list, click the projects you want to disable. Use the Shift and Control keys to select more than one project. 

d   Click . 

You can also enable or disable projects from the Groups Allowed to Open list in the Project Properties 

dialog.  
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WORK TEAMS  

You can use VIZOR to help manage and coordinate work teams. Setting up work team support involves 

the following tasks:  

• Building a list of work teams. Manage Work Teams as Departments. 

• Assigning users to work teams. 

• Adding the Assigned Work Team field to Web views. This field is used to assign issues to specific 

work teams, either manually by users or automatically by workflow rules. 

Define queries for finding work team issues. VIZOR includes a My Work Team’s Issues query that gets all 

the issues assigned to a user’s work team, but you may want to define additional queries for work teams 

(for example, a query that finds all open issues assigned to the user’s work team).  

Defining Work Teams  

The list of available work teams is stored in a global choice list named Work Team. The HelpDesk project 

has an Assigned Work Team field that uses this global choice list.  

You use VIZOR Web Admin to edit the list of work teams.  

To edit the list of Work Teams:  

1   In VIZOR, go to the Roles and Policies area. 

2   Click on the queries and select Work Teams in order to see the current list. 

3   The list is also a Global Choice List, accessible for Single-Choice and Multi-Choice fields in all projects. 

4   Edit the Work Teams: 

Click on the appropriate button on the right to create a new Work Team. 

To delete a Work Team, click on the Delete red icon on the row in the Summary List. 

To rename a Work Team and edit other properties, click the Work Team on the Summary List. Make changes in the form that 

opens and save as usual. 

 

ASSIGNING USERS TO WORK TEAMS  

You can assign both users and contacts to work teams. No user or contact can belong to more than one 

work team.  
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To assign a user or contact to a work team:  

1. In VIZOR Web Admin, select the Security tab and click the Users button.  

2. Select the Users query.  

3. In the query results, click the user or contact you wish to edit. 

4. In the Work Team list, click the work team to which the user belongs. 

ADDING WORK TEAM SUPPORT TO WEB VIEWS  

To allow users and workflow rules to assign issues to work teams, export the Assigned Work Team field 

(Overview tab) to the Web views.  

 

BUILDING WORK TEAM QUERIES  

You can query for issues assigned to a specific work team, for example, all issues assigned to the QA 

Team:  

Assigned Work Team = QA Team  

You can also use the <My Work Team> macro to query for issues assigned to the work team of the 

current user. For example, this query finds all open issues assigned to the user’s work team:  

Assigned Work Team = <My Work Team> AND  

State = Open   
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USER CATEGORIES  

You can control which users and contacts are visible in a project. Each user (and each contact) can be 

assigned to a user category. For example, some users can be assigned to the Internal User  category, and 

others to the External User category.  

The list of available user categories is a global choice list, so you can use VIZOR Web Admin to build the 

list of user categories you want to use.  

To edit the list of user categories:  

1   In VIZOR Web Admin, click the Choices tab. 

2   In the Project list, click < Global Choice Lists >. 

3   In the Choice List list, click User Category. 

4   In the Choices section: 

 To add a new user category, click  and then type the category name. 

 To rename a user category, click the category and then click  . 

 To delete a user category, click the category and then click  . 

 

 

ASSIGNING USERS TO CATEGORIES  

Assigning users and contacts to categories allows you to control whether they are visible in a project.  

To assign users and contacts to categories:  

5. In VIZOR Web Admin, select the Security tab and click the Users button.  

   Alternatively, in VIZOR Admin, click Tools > Security > Users.  

6. Select the All Users & Contacts query.  

 For more information about using queries, see About Queries. 
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7. In the query results, click the user or contact you wish to edit. 

8. In the User Category list, click the category to which the user belongs. 

9. Click Save. 

 

HIDING USERS IN PROJECTS  

To control which users, contacts, and companies are visible in a project:  

10. In VIZOR Web Admin, click the Options tab. 

11. In the Project list, click a project. 

12. Click Organize users per project.  

13. Check the In this project, only display users, contacts, and companies in the following categories 

box. 

14. Select the categories of users and contacts you want to be visible in the project. 

15. Click OK. 
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CREATING VIZOR-ONLY USERS 

VIZOR-Only users can log in to VIZOR but they do not have an active role in the organization. For 

example, they are not Employees or Customers. By default, assets are not allocated to VIZOR-Only 

users, VIZOR-Only users are not assigned HelpDesk tickets and Purchases are not created for VIZOR-

Only users. 

This is specially usefull when its important for a user not to show in asset allocation lists or automatic 

provisioning of asset rules. One good example is the built in “Admin” account. 

1. In VIZOR, log in with an administrator account and select the “Security” link 

 

 

 

 

 

 

 

 

 

 

 

2. In the right toolbar, click on “Add new VIZOR-only User” 
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3. In the “Add New VIZOR-only User” window, all the information needed. Shown in the image 

below are some of the usual fields used, the more detail for your accounts the better.  

 

• First and Last Name – Your user’s first and last name. 

• Full Name – Concatenated version of first and last name. This will show in user fields such 

as “Allocated to Person”, “Owner”, “Contact”, etc 

• E-mail  

• Logon Name – This will be the user name used to log in by your user. 

• Organization name – Your company’s name. 

• Authenticate with – Preferred method of authentication such as  

o VIZOR Authentication 

o Google  

o Azure Active Directory. 

• Password & Confirm Password – Used to setup the initial password for the user to log in, 

can later be changed by the user if enabled by the administrator. 

• Category – Defines what kind of user you are creating. Some of the options are:  

o Consultant 

o Employee 

o Contractor 

o Intern 

o Etc. 

 

4. Click “OK” to save the initial information and navigate to the “Groups” tab to setup the user 

groups your user will belong to.  

• Click on “edit” to open the user groups window 
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• Select the user groups for your new user, click “OK” to save 

 

 

 

 

 

 

 

 

 

 

 

 

5. While not required, you can navigate to tabs “Contact Details” and “Employment” to further 

provide details to your new user.  
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DISABLING USER OR EMPLOYEE ACCOUNTS  

Disabled accounts cannot log on to VIZOR but the names still appear in the user fields such as Allocated 

to Person, Owner and Contact.  

Disabling a contact, company, or VAR has no effect. 

To disable a user account:  

1. In VIZOR, log in with an administrator account and select the “Security” link 

 

 

 

 

 

 

 

 

 

2. Search for the account that is going to be disabled. The search box at the top right corner can be 

used for this. 

 

3. Click on the user account and locate the field “Is Disabled” in the “Info” tab. Click on the square 

checkbox to mark it. 

 

 

4. Click “Ok” to save. The user contact will now be disabled.   
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DELETING USER OR EMPLOYEE ACCOUNTS  

Disabled users are not deleted from the database by default because existing assets, HelpDesk tickets,  

Actions or Licenses may refer to those users.  

If you don’t want to see certain users in fields like Contact, Owner, Allocated to Person or Submitter, 

you can modify the WHERE condition of the choice list of the field in question to exclude disabled 

accounts (Field Editor) (see Removing Disabled Users from Choice Lists).   

If you want to remove disabled users from the choice lists but only for new selections or under certains 

conditions, use the Workflow Editor and create a business rule of type Possible Values. You can select and 

filter the individual users to be displayed in a particular list of a field. 

 

Deleting the user from the users database directly is possible but it may leave any related helpdesk 

tickets, assets, actions, licenses, etc. with a broken reference to the user. This may cause the value of the 

field with the reference to be shown empty or with a numeric ID that represents the user ID of the deleted 

user account.  

 

 

REMOVING DISABLED USERS FROM CHOICE LISTS  

Instead of deleting users from the users database, you can prevent the Owner and Contact lists from 

showing disabled users. However, if an existing record (assets, ticket, action, etc.) references the user in its 

Owner or Contact field, the field will be empty or show a numeric ID.  

To remove disabled users from choice lists:  

1   Open the project definitions database. 

2   Open tblDtsFields and find the owner (nID = 11) and contact (nID = 13) records. 

3   In the tWhere field, add And fDeleted = 0 to the Where clause. For example: 

Where (([nID] >= 0 And [tName] <> '') Or [tName] = '<User>') And fOriginator = 0 And 

fDeleted = 0  
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ADDING A CHOICE LIST OF USERS OR CONTACTS  

To add a choice list of users:  

1   In the Field Editor, create a new field. 

2   In the Type list, click Multi-Choice List or Single Choice List. 

3   In the Table Containing Choices list, click tblUser. 

tblUser cannot be edited in the Choices Editor.  

4   In the tWhere field, type: 

Where (([nID] >= 0 And  [tName]  <> '') Or  

 [tName]  = '<User>') And fOriginator = 0  

The [nID] >= 0 condition removes the macros defined in tblUser (the users database): 

User ID User Name 

-4 <Contact> 

-3 <User> 

-2 <Previous Owner> 

-1  <Owner> 

 

The user with nID = 0 is the <None> macro.  

The fOriginator = 0 condition removes contacts, so that the list contains users only.  

5. Apply the changes. 
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EDITING USER INFORMATION  

You can edit user information for Users, Contacts, Companies, and VARs with VIZOR Web Admin.  

To edit user information:  

1. In VIZOR Web Admin, select the Security tab and click the Users button.  

1. Alternatively, in VIZOR Admin, click Tools > Security > Users.  

2. Select the All Users, Contacts, Companies & VARs query.  

a.  For more information about using queries, see About Queries. 

b.  To quickly find a user, use of the search feature is 

recommended. To make the search box appear, press the  button. 

3. In the query results, click the user you wish to edit. 

4. Make the modifications you desire. 

5. Click Save. 

 

 

 

 

PASSWORDS  

You can change passwords for VIZOR native user accounts. You cannot change passwords for user 

accounts imported from Active Directory or Windows.  

To change a user’s password:  

1. In VIZOR Web Admin, select the Security tab and click the Users button.  

1. Alternatively, in VIZOR Admin, click Tools > Security > Users.  

2. Select the All Users, Contacts, Companies & VARs query.  

a.  For more information about using queries, see About Queries. 

b.  To quickly find a user, use of the search feature is 

recommended. To make the search box appear, press the  button. 
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3. In the query results, click the user you wish to edit. 

4. Change the value in the Password and Confirm Password fields. 

5. Click Save. 

 

CHANGING PASSWORD FOR A VIZOR-NATIVE ACCOUNT 

 

1. Login to VIZOR and click on any link to go to any view from your homepage. 
2. Click on the "Password" link at the top right by the Log Off link. 

 
 

3. Enter the new password and confirm it, and then  click "OK". 

 
4. Log off. 
5. Test your new password. 

 

CHANGING THE AUTHENTICATION METHOD  

1   In the Authenticate With list: 

 Click VIZOR Authentication to authenticate against the VIZOR user database. 

 Click an Active Directory server to authenticate against Active Directory. 

 Click a Windows server to authenticate against a Windows domain. 

2   If you authenticate with VIZOR, you may need to enter the logon name and password. 
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DEFINING USER GROUPS  

Groups allow you to assign privileges to users. By enabling and disabling features for a group, you control 

the features (privileges) available to the members of that group.  

Group membership determines which features are available to a user. Each group enables and disables 

different features. Users that belong to more than one group have access to any feature enabled in at 

least one of the groups.  

Group membership also controls access to projects and Web views. To assign users to groups, use VIZOR 

Admin .  

In the Users view of the Security tab, you can select a user and then edit the list of groups to which the 

user belongs. In the Groups view, you can select a group and edit the list of users that belong to the 

group.  

To add a group:  

1   In VIZOR Web Admin, click the Security tab.  

If you are in VIZOR Admin, click Tools > Security > Groups.  

2   On the Security tab, click the large Groups button on the left side of the tab. 

3   Click Add  and type a new for the group. 

To delete a group:  

1   In VIZOR Web Admin, click the Security tab.  

If you are in VIZOR Admin, click Tools > Security > Groups.  

2   On the Security tab, click the large Groups button on the left side of the tab. 

3   In the Groups list, click the group you want to delete. 

4   Click Delete . 

  



  Page 426 

 

 

GROUPS: ADDING AND REMOVING USERS  

On the Security tab, the Groups view allows you to add or remove multiple users at the same time.  

To add users to a group:  

1   In VIZOR Web Admin, click the Security tab.  

2   On the Security tab, click the large Groups button on the left side of the tab. 

3   In the Groups list, click a group. 

4   Click Users  

5   To add users: 

a   In the Non-Members list, click the users you want to add to the group. Use the Shift and Control keys to select more than one 

user. 

b   Click . 

6   To remove users: 

c   In the Members list, click the users you want to remove from the group. Use the Shift and Control keys to select more than one 

user. 

d   Click . 
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USERS: CHANGING GROUP MEMBERSHIP  

To add a user to a group (in the Users view):  

1. In VIZOR Web Admin, select the Security tab and click the Users button.  

2. Select the All Users query.  

 For more information about using queries, see About Queries. 

 To quickly find a user, use of the search feature is recommended. To 

make the search box appear, press the  button. 

3. In the query results, click the user you wish to edit. 

4. Select the Groups tab. 

5. Click the Edit button. 

6. In the Select Groups dialog, select the check boxes for the groups to which you want to add the 

user. 

 To filter the list of groups, click Advanced  and type part of a group 

name. Click Filter to list only the groups that contain the text you typed.  

 To find all groups with names that start with a certain string of 

characters, click Options and in the Search Type list, click Starting With.  

7. Click OK. 

8. Click Save. 
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ORGANIZATIONS & COMPANIES  

VIZOR maintains a list of companies. By assigning users to companies, you can create a service level 

agreement that applies to all users at a specific company.  

To create a company:  

9. In VIZOR Web Admin, select the Security tab and click the Users button.  

10. Click New  . 

11. In the Type field, select Company. 

12. Provide all required information. 

13. Press Save. 
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DEPARTMENTS  

By assigning users to departments, you can create a service level agreement that applies to all users in a 

specific department.  

To edit the list of departments:  

1   In VIZOR, go to the Roles and Policies area. 

2   Click on the queries and select Departments in order to see the current list. 

3   The Departments list is also a Global Choice List, accessible for Single-Choice and Multi-Choice fields in 

all projects. 

4   Edit the departments: 

Click on the appropriate button on the right to create a new department. 

To delete a department, click on the Delete red icon on the row in the Summary List. 

To rename a department and edit other properties, click the department on the Summary List. Make changes in the form that 

opens and save as usual. 

 

  

VIZOR FEATURES  

VIZOR includes features that can be enabled and disabled. Most VIZOR Features correspond directly to 

buttons or menu options in the user interface (UI), such as Security or Report Editor. When a user does 

not have permission to use a feature, the feature is not displayed in the UI.  

To enable or disable a feature for a group:  

1   In VIZOR Web Admin, click the Security tab.  

2   On the Security tab, click the large Groups button on the left of the tab. 

3   In the Groups list, click a group. 
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4   Click Features. 
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5   To enable a feature: 

a   In the Disabled list, click the feature you want to disable. Use the Shift and Control keys to select more than one feature. 

b   Click . 

6   To disable a feature: 

c   In the Enabled list, click the features you want to disable. Use the Shift and Control keys to select more than one feature. 

d   Click . 

 

WEB VIEW FEATURES  

 

Feature Permits the user to 

Ad hoc Queries Access the Ad-hoc Query Editor 

Add Contact Editor Open the Users and Contacts dialog in a Web 

view by clicking the Contacts button 

Add Contact  Create contacts 

Add & Save Issues Create new isues and save them 

Copy & Save Issues Create a new issue based on the current one in 

the Web view and save it  

Delete Contact Disable contacts 

Update Contact Edit contacts 

Default Value Editor Set default values for new issues 
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Email Conversation View and manage the e-mails linked to the 

current issue in the Web view 

E-mail Current Issue Send an e-mail with a summary of the current 

issue from the Web views 

Email Queue View and manage the e-mails that are not 

linked to issues  

Manage E-mail 

Templates 

Create, update and delete e-mail templates that 

are used when composing new e-mails or in 

automated e-mail responses 

My Queries Run personal queries only available to the user 

from the Web views 

Password Editor Change password 

Queries -  View Source View the SQL WHERE clause behind the named 

query 

Report Viewer View VIZOR reports 

Report Viewer - 

Hardware Inventory 

View Hardware Inventory reports 

Report Viewer - 

Software Inventory 

View Software Inventory reports 

Revision History  View the change history for an issue 

Save & Remove User 

Queries 

Create new personal queries and be able to 

delete them 

Save Issues Update and save issues from the Web views 

Update Submit Only Update the contact information from a Submit-
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View Contact Only View 

Use E-mail Templates Apply saved e-mail templates when composing 

new e-mails  

Example  

The staff responsible for logging issues received from customers need to be able to add new contacts 

(each customer is a contact). To allow users to add new contacts in Web views, enable these features:  

Add Contact Editor 

Add Contact  

 

 

VIZOR WEB ADMIN FEATURES  

The following features enable and disable the different tabs in VIZOR Web Admin. 

  

Feature Permits the user to 

Web Admin - Banner Create and edit banners. 

Web Admin - Choices Create and edit choices lists 

Web Admin - Email Integration Manage and configure integrations of VIZOR and e-

mail accounts for submitting issues by e-mail, linking 

e-mails to issues, automatic status by e-mail and more 

Web Admin - Inventory Editor Connect projects to Vector Asset Management or PC-

Duo Enterprise site databases for linking computers 

and other assets to the issues as well as viewing 

hardware and software reports 
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Web Admin - Notifications Set the user account used for notifications 

Web Admin - Relocation Relocate databases and attachments 

Web Admin - Security Edit users, contacts, and groups. Add, edit, and delete 

groups. Enable and disable features for groups 

Web Admin -  

SLA - Manage Agreements & 

Levels 

Manage Service Level Agreements and Service Levels, 

including working hours, target times and escalation 

rules 

Web Admin - SLA - Report 

Viewer 

View reports with summary and metrics of Service 

Level Agreements performance 

Web Admin - SLA - View View only the Service Level Agreement Information 

Web Admin - Tabs Create new tabs 

Web Admin -  

Users - Add 

Create new users 

Web Admin -  

Users - Disable 

Disable users therefore preventing them from logging 

into the system 

Web Admin -  

Users - Update 

Update user information such as e-mail addres, postal 

address and telephone 

Web Admin -  

Users - View 

View only users and user information 

Web Admin - Workflow Edit workflow rules 
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ADMIN  

To enable Admin features, you must enable Admin Utility. Otherwise, users cannot log on.  

Feature Permits the user to 

Admin Utility  Log on to VIZOR Admin 

Delete Project Delete a project 

Delete Issues Delete issues from a project 

Import Issues Import issues into a project 

Integrity Editor Open the Integrity Editor 

Layout Editor Open the Layout Editor and define custom layout styles for 

the Summary List 

Licenses Open the Licenses dialog  

New Project Create a new project 

Notification 

Editor 

Set up automatic e-mail notifications 

Page Editor Create and edit report pages 

Project Properties  Edit project properties, such as which groups are allowed to 

open a project 

Query Editor Open the Query Editor and define custom queries 

Report Editor Define new reports, and edit existing reports 
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Sort Editor Open the Sort Editor and define custom sorts 

Field Editor Add new fields, change labels and modify the values that 

appear in choice lists 

Web Tools Menu Start the Web View Editor and VIZOR Web Admin from the 

Tools > Web menu 

When Editor Edit the when conditions for notifications 

Windows Account 

Editor 

Edit the Windows user account used for anonymous access 

to virtual directories and for running the notification service. 

Example  

To allow users to create new reports, enable, at a minimum, the Admin Utility and Report editor features. 

This allows users to log on to VIZOR Admin and create new reports using existing queries, sorts, and 

report pages. The new reports are automatically made available in existing Web views.  

Enabling the Query editor, Sort editor, and Page editor features allows users to create new queries, sorts, 

and report pages and use them in report definitions. New queries aren’t available in Web views unless you 

export the queries and regenerate the views. All new sorts, however, are automatically made available in 

Web views.  

 

WEB VIEW EDITOR FEATURES  

You can prevent users from logging on to the Web View editor by disabling the Web View Editor feature.  
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CHAPTER 29 - FIELDS 

THE FIELD EDITOR  

Before you start tracking assets and issues, you may need to customize some of the fields used to collect 

and display information. For example, the Type and Priority fields should list choices that correspond to 

your organization's terminology and environment.  

You may want to delete unused custom fields, add new fields to track additional information, or add new 

tabs. For example, you may want to add a tab for hardware configuration details. We do not recommend 

deleting default fields, simply remove them from the Web View where you no longer want to have it. 

VIZOR Web Admin provides a Field Editor for editing fields. To open this editor, click on the Fields tab 

and then click on Fields on the left side menu. The Field Editor allows you to edit field definitions, but to 

export fields to Web views use the Web View Editor.  

EDITING FIELDS  

Click a field in the Field list to edit, copy, rename, or delete the field. The Field list contains all the fields 

defined in the project.  

The buttons beside the Field list allow you to create new fields or copy, delete, or edit the selected field.  

DESTINATION TAB  

Tabs allow you to group sets of related fields in the User Interface.  

CAPTION AND LABEL  
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The Caption is the actual field name as it appears in choice lists such as the Field list in any of the VIZOR 

Admin editors. The label is the caption that appears beside the field in a Web view User Interface. Most of 

the times both are the same, but some times it is useful to have a different Label Caption. For example, 

you may create a field called “Audit Ready”, with possible choices “Yes” and “No”, and have a label in the 

form that is “Is this asset ready for audit?”. 

DATA  

Under Data, you specify what type of input the field accepts: text, dates, times, numbers, yes/no values, or 

choices from a list.  

The choices displayed in a choice list field are defined in a choice table. To edit and create choice tables, 

click the browse  button adjacent to the Table Containing Choices list.  

FIELD IS  

The Field Is check boxes give you control over how the field behaves in a Web view. Required fields 

cannot be left blank. Visible fields appear in a Web view, instead of being hidden. Enabled fields accept 

user input, while disabled fields are read-only (they display data but do not accept user input).  

The Read-Only For list specifies which user groups cannot edit the field.  
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DEFAULT VALUES 

 

You can use default values of fields to pre-fill the value of a field in order to save time, define standards or 

categorize items/records automatically.  

Default field values automatically insert the value of the field when a new record, Asset, Software License, 

Ticket, etc. is created.  

Types of Default Values: 

• Literal 

• Formula 

• Table or SQL View  

 

1. LITERAL VALUE 

Exact values can be: 

• A number:  45 

• Text:   Enter the description here 

 

For literal values, simply enter it directly in the text box for the default value.  

 

2. FORMULA 

 

Formulas can use wildcards to replace at runtime the value of another field, macros, or other calculations. 

 

Value of another field 

You can use the value of another field in the same record: 
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 <F.ID:Owner> 

 

 This macro will set the field to the value of the Owner field 

 

 <F.ID:Asset Tag> 

 

 This macro will set the field to the value of the Asset Tag field 

 

A Macro 

You can use a general macro like the ones available in queries, notifications, etc. For example, the macro 

that resolves to the current date: 

 

 <Today> 

Or the date of the first day of the current quarter: 

<First Day of Quarter> 

 

A combination 

You can also use any combination of general macros, field values and literals. E.g. 

 

 <Asset Purchased Date><Asset Type Abbrev><Asset Type Count> 

 

This will set the field to a concatenation of the 3 macros resulting in something like this: 

  

  21-11-2018LAPTOP1844 
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3. TABLE OR SQL VIEW 

The default value can come from a table or SQL view. In this case, the data in the table is not controlled by 

VIZOR and it must have specific columns. The table or sql view must exist in the DAT database of the 

project. 

VIZOR provides tables and SQL views for specific cases like Round-Robin automatic assignment, but you 

can use this mechanism for your own needs.  

The table or SQL view must be named 

FldDefVal_< field ID> 

 

So, for example, for the Owner field in HelpDesk, ID 11, the table or SQL view must be named: 

FldDefVal_11 

 

And it must have at least these two columns (it can have more): 

Value 

OrderBy 

VIZOR will take the first available value in the field or column Value, when sorted by the field OrderBy. 

This mechanism is only enabled by default for the field Owner but it can be enabled for others. 

 

Round Robin Assignment of Tickets 

Round Robin automatic assignment is a good example of the default values using a SQL view. You can 

use the Round-Robin assignment for automatically setting the owner of a HelpDesk ticket when created. 

Most of the times this is useful for tickets created from an email or another process and not usually for 

tickets created from the User Interface because the user creating the ticket sets the owner directly.  

By default, the Round Robin assignment will set the owner of the new ticket to the next available person 

in the pool. By default the pool is composed of the members of the HelpDesk Analysts group. VIZOR will 

simply go in a cyclical sequence assigning one ticket to one person. 

For example if the HelpDesk Analysts members are: 

 John 
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 Elisa 

 Andrew 

 Patricia 

Then VIZOR will assign a ticket to John, then Elisa, then Andrew, then Patricia and then John again. 

SHOW IN CHOICE LISTS  

This check box controls whether you can use the field to build queries, reports, and other styles.  

MAINTAIN REVISION HISTORY  

This check box controls whether VIZOR tracks revisions to the field, and whether you can use the field for 

update notifications (update notifications are generated when the value of a field changes).  

 

ABOUT ADDING FIELDS  

You can add fields to any of the tabs. New fields are automatically available in all VIZOR editors, such as 

the Query Editor and Report Editor.  

New fields are not automatically exported to Web views. You must use the Web View Editor to export the 

fields and regenerate the Web views.  

To use a field as a starting point for a new field, click an entry in the Field list and click Making Fields 

Required. 

By default, users can leave the Web view fields blank when they submit an issue. To force users to 

complete a field before saving an issue, click the Required check box. The field label is highlighted in Web 

views to show that it is mandatory.  
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MAKING FIELDS READ-ONLY 

 

To make a field read-only for all users, clear the Enabled check box.  

To make a field read-only for a specific user group, click the Enabled check box, and then click the group 

in the Read-Only For list.  

 

USING FIELDS TO DEFINE STYLES 

 

If you don't need to use a field to build queries, sorts, layouts, reports, or notifications, clear the Show in 

Choice Lists check box. This removes the field from the Field lists of editors, such as the Query Editor and 

the Ad-hoc Query Editor of a Web view.  

For example, the Attachments field is not needed for queries, sorts, layouts, reports, or notifications. How 

often would you expect users to search for or sort issues based on the files attached to an issue?  
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TRACKING CHANGES  

If you don't want to track changes to a field, clear the Maintain Revision History check box. VIZOR 

doesn’t update the revision history when a user changes the field.  

For a memo field, VIZOR doesn’t track the changes to the field value. Instead, it marks the field as 

modified.  

Notes 

 To send notifications when a field is updated, select the field's Maintain 

Revision History check box. 
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The Destination Tab specifies the tab to which the new field is added.  

Fields added to the Contact tab are treated in a slightly different manner. Depending on how the Web 

view is configured, the fields could appear in two locations: 

 Contact tab 

 The Contact tab shows information about the current contact, while 

preventing the viewer from making modifications. It is functionally 

equivalent to a regular tab - the only difference is that all fields are 

automatically read-only. 

 View Contacts Details dialog 

 For more information, see Viewing Contact Details. 

By default, fields assigned to the Contact tab will appear in the View Contacts dialog. To control 

whether or not they should also appear in a physical contact tab, modify the Contact Tab in Record 

Details Web View Attribute. For more information, see Setting Web View Attributes. 

 

SETTING FIELD LABELS  

Field Caption is the label displayed by the field in a Web view. You can override this label in the Web 

View Editor by setting the Caption attribute.  

Choice Lists is the label that appears in any choice list that allows a user to choose a field (for example, in 

the Field list of the Ad-hoc Query editor of a Web view). To change this label, click  to rename the field.  
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CHOOSING A FIELD TYPE  

CURRENCY, DATE, NUMBER, TEXT, AND TIME  

These are text entry fields. VIZOR validates the text entered in these field types, and displays a warning if 

users enter invalid characters or uses the wrong format.  

For example, Number fields accept only numeric values, and Currency, Date, and Time fields require the 

input values to follow the Windows Regional Settings.  

MEMO  

A Memo field is a text field that allows a large amount of characters to be input.  

SINGLE CHOICE AND MULTI CHOICE  

These fields are drop-down choice lists. Choice lists present fixed lists of choices to the user. Multi Choice 

fields allow a user to select one or more choices.  

YES/NO  

This is a check box.  

 

Advanced 

 

Internally, the Data Types are defined using the following IDs (for example, in tblDtsFields). 

Data Type ID Notes 

    Boolean  1  

    Currency  5  

    Date  8  
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    Text  10  

    Memo  12  

    Time  101  

    Number  102 Sub type (size): 

Byte   2 

Integer   3 

Long Integer 4 (default) 

Single   6 

Double   7 

    SingleChoice  103  

    MultiChoice  104  

    SCC  105  

    RelatedRecord  106  

    DateTime  109  

    SubRecordLink  110 The main field that links to a 

subrecords table 

    Password  115  

    HTML  120  

    SQLRowVersion  121 Binary, timestamp type in SQL 

Server 
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SETTING THE FIELD SIZE  

For Text fields, the field size is the maximum number of characters that a user can type in the field. For 

Number fields, however, the size is determined by the selected data size: 

Size Description 

Byte Stores numbers from 0 to 255 (no fractions).  

Decimal precision: None  

Storage size: 1 bytes   

Integer Stores numbers from –32,768 to 32,767 (no fractions). 

Decimal precision: None  

Storage size: 2 bytes 

Long Integer  Stores numbers from -2,147,483,648 to 2,147,483,647 (no fractions). 

Decimal precision: None  

Storage size: 4 bytes   

Single Stores numbers from 

–3.402823E38 to 

–1.401298E–45 for negative values and from 

1.401298E–45 to 3.402823E38 for positive values.  

Decimal precision: 7  

Storage size: 4 bytes   

Double Stores numbers from 

–1.79769313486231E308 to 

–4.94065645841247E–324 for negative values and from 

1.79769313486231E308 to 4.94065645841247E–324 for positive 

values.  

Decimal precision: 15  

Storage size: 8 bytes   
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ABOUT REMOVING FIELDS  

To remove a field, you can either delete it or hide it. Alternatively, you can choose not export the field 

when you generate your Web views.  

You can also disable fields by making them read-only.  

 

DELETING FIELDS  

Deleting a field removes it and all stored data from the issue database. If you don't want to lose the data, 

you can disable the field, hide it, or remove it from the Web views.  

You can delete a field only if it is not used in any query, sort, layout, report, or notification.  

HIDING FIELDS IN ALL WEB VIEWS 

Because you can remove a field from a Web view by not exporting the field, the ability to hide fields is not 

often required. However, you may want to hide a field if some of the queries you export use the field, but 

you don’t want users to see it.  

To hide a field in all Web views of a project, clear the Visible check box in the Field Editor. To hide a field 

in specific Web views, use the Visible attribute of the field in the Web View Editor.  

NOTES 

 Hidden fields are still available in editors unless you clear the Show in Choice 

Lists check box.  

 Queries do not work if fields used in the query definition are not in the Web 

view.  
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REMOVING FIELDS FROM WEB VIEWS  

Using the Web View Editor, you can remove fields from some Web views and leave the fields in other 

views.  

 

CONTROLLING ACCESS AND SECURITY OF A FIELD 

 

VIZOR has multiple ways to control access to your data. Since data is mostly stored in fields, controlling 

access and security of a field is paramount. 

 

Methods to control access and security of a field: 

• Visible or Hidden, in the Field Editor 

• Disabled or Read-only, in the Field Editor 

• Read-only for specific user groups, in the Field Editor 

• Visible or Hidden per Web View, in the Web View Editor 

• Read-only per Web View, in the Web View Editor 

• Visible or Hidden under custom conditions, using the Business Rule Worfklow Editor 

• Read-only under custom conditions, using the Business Rule Worfklow Editor 

• Create custom macros using scripting programming language to reflect unique or complex 

conditions. 

• Because access to Web views can be controlled per user group, and you can create any number of 

Web views, you can combine all these to defined eseentially any possible security, access or 

authorization situation. 

 

 

 

 

CHOICE LISTS  

A choice list is a list of choices displayed in a selection list on a form, in particular, they are used to select 

the choices for single choice fields and multi choice fields. The choices are defined in a choice table.  
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EDITING CHOICE TABLES  

You can edit the choices in the list from VIZOR Web Admin.  

1. Go to http://<server>/connectadmin/ 

2. Click on the Fields tab. 

3. Click on "Choice Lists" on the left. 

4. In Project, select either the name of the project where your choice table or associated field is, or 

"Global Choice Lists" if it’s a global choice list.  

5. The Choice Lists editor allows you to add new choices, delete choices, change choice text, and 

reorder choices.  

After your changes, we also recommend clicking on the button "Update Now" located on the bottom 

right. This will refresh the choice list in the views where it’s being used right away. 

• Use VIZOR Admin when you want to create new  

• Using the Field Editor, you can associate a choice table with a field.  

• Typical examples of choice lists are Status or Status in HelpDesk.  

You can also delete complete choice lists when they are not referenced by a field.  

 

MANAGING CHOICE LISTS 

To add or remove options from a choice list (e.g., the Manufacturer field), follow these instructions: 

Adding a New Option 

1. Click the three dots next to the field in the interface. 

2. In the pop-up menu, click Add New in the top-right corner. 

3. Enter the desired value (e.g., a new manufacturer) and click OK to save it. 

 

Removing or Editing Options 

1. Access the Web Admin interface at https://YOURDOMAIN.vizor.cloud/connectadmin. 

2. Navigate to the Fields tab. 

3. On the left-hand column, select Choice List. 
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4. From the dropdown, select Project Global Choice List, then locate and select Manufacturer or the 

relevant list. 

5. To remove an entry, find the option in the list and click the red X next to it. 

6. To add a new option, click the blank page icon in the same column and enter the desired value. 

 

After making any modifications, ensure you click the Update Now button located at the bottom of the 

yellow box on the right-hand side of the tab to save your changes. 

 

EDITING CHOICE TEXT  

When you change the text of a choice, you must update any queries that test the choice value. For 

example, consider this query:  

Status = Assigned  

If you change the choice text from Assigned to InProgress in the choice table, the query will not find any 

issues. Issues store the index of the choice, but queries store the text.  
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RENAMING CHOICE LIST TABLES  

VIZOR Web Admin (in the Choice List list on the Choices tab) displays a name associated with the choice 

table, not the name of the choice list field.  

A choice table has two names: the name of the choice table (for example, tblState) and a friendly name 

(for example, State). VIZOR Web Admin displays the friendly name. You can change the friendly name by 

renaming the choice table in VIZOR Web Admin.  

 

SORTING CHOICE LISTS  

Web Views can list choices in any order. For example, a non-alphabetic choice order such as Highest, 

High, Medium, Low, Lowest is more appropriate for a list of relative values than the alphabetic order.  

When you create a new choice list, you choose how you want to order the list. Non Alphabetical Choice 

Order check box controls whether a choice list supports non-alphabetic choice orders and sorts. 

 

 

 

 

 

 

By default, VIZOR lists choices in alphabetic order. However, when you allow non alphabetial sorts, you 

can define the sort order by assigning a numeric ID to each choice. This ID controls the position of the 

choice in the list (1st, 2nd, and so on). 
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 STATUS AND STATE  

The Status choice list is a special type of choice list. When a user selects a choice from the Status list, the 

State field is set to Open or Closed.  

To change the mapping of Status values to State values, use the same editor. The choice table for the 

Status list contains an extra column that maps Status choices to State choices. You must complete this 

column when you add or edit the choices in the Status list.  
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When you edit the State choice table, remember that the Closed choice sets the Closed Date and Time 

fields. So, for example, changing the choice text from Closed may confuse users.  

Notes 

If you edit the Status choice list, check that workflow rules based on the Status field are still correct for 

your needs. 

 

GLOBAL CHOICE LISTS  

Global choice lists are shared by all projects.  

TO DEFINE A GLOBAL CHOICE LIST  

1   In VIZOR Web Admin, click the Choices tab. 

2   In the Project list, click Global Choice Lists. 

3   Click  to create a new choice list. 

Alternatively, to base the new list on an existing list, select an entry in Choice List and click .  

4   In the Add Choice List dialog: 

a   In the Choice List Name box, type a name for the database table in which you want to store the list choices. 

b   In Choice List Caption, type a display name for the choice list (this is the name displayed in in VIZOR Web Admin). 
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c   Select the Non-Alphabetical Choice Order check box if you want to define a non-alphabetical order for the choices in the list 

(for example, Applications, System, Hardware).  

d   In the Choices section, click  to add a new choice to the list. 

To associate the new choice list with a field, use the Field Editor in VIZOR Admin, then regenerate the Web 

views that use the field.  

 

  



  Page 457 

 

 

DIFFERENT WAYS OF DEFINING DEFAULT VALUES 

Stopdev 

Default Values for Fields 

- Field Editor 

only when created 

- Using Workflow Business Rules 

for single-choice fields only 

-per web view per person 

- Per web view, per user group. 

(advanced) via defaultValues js files. 

- For records created from an email 

- For imported records. 

 

+ add a message in the form (tab header) 

+Alert per Status 

+Change the color of the status in the summary list 

 

Use Ticket Templates to Populate Tasks 

Although at the moment it is not possible to create a Business or Workflow Rule to automatically add 

Tasks to a ticket based on the Service Type or Category, there is a type of record in HelpDesk that may be 

used for this purpose: Templates. 

Templates are found in the query Templates and users can create new tickets based on the template by 

clicking on the Copy button (shown in a red square below). When copying from a Template, the new 

ticket inherits all the Tasks. 
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2. A user cannot belong to more than one Work Team but maybe we can find a way to implement 

something equivalent if you can describe to us the use case or the way you wanted to use it. 

 

 

HD Template for Repairs tickets: 

add a macro <Asset Summary> to a text/memo/htm field in the template and it will be replaced with the 

equivalent previous default content: Type + Name + Asset Tag + SN . 

 

 

 

SETTING THE LOCATION OF AN ASSET FROM THE OU – ORGANIZATIONAL UNIT 

 

You can now automatically set the Location of assets or devices depending on their Organizational Unit 

(OU). 

 

The OU of the device may be imported from an external system, like the Google Admin, or be set from 

the user when the asset is assigned to the user. 

The OU of the user itself may also come from an external system, like Google for example. 

 

The Location will be set  from the OU following these cases but ONLY if the asset is included in the system 

query System: Set Location from OU: 

 

 

 

-------------------- 

The mapping of the Location is resolved in the following way, and in descending order (if the first rule 

does not match, the next one is tried): 

 

1. If the OU has an explicit Location mapped. If there is an explicit mapping, it can be viewed in the global 

choice table "tblAD_OU" in the Web Admin.  

The Location is the dependent field and it can be imported from an Excel file containing the mappings 

(contact Technical Support) 

   e.g. 
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              OU="/Chicago/School A/"          =>     "USA \ City \ Building" 

 

 

You can add any number of OUs mapping to one Location, but one OU can only point to one Location. 

 

2. If there is no exact mapping of a Location for the given OU but there is one mapping for a parent OU. 

That is, if the OU is contained by an OU for which there is a direct mapping of a location.  

              OU="/Chicago/School A/Grade 4/2030"   

 

    and there's a VZ location mapping in the choice table "tblAD_OU" in the Web Admin for a parent OU  

e.g. 

              OU="/Chicago/School A/"          =>     "USA \ City \ Building" 

 

   Then that location ("USA \ City \ Building") will be the location set. 

 

 

2. If the OU is almost the same as the long name of a location, but just with the delimiters being different. 

   e.g. 

              OU="/Chicago/School A/"           

 

   this VZ location matches automatically: 

              "Chicago \ School A" 

         

3. If the OU is contained 'inside' a location using the long name and converting the delimiters. 

              OU="/Chicago/School A/Grade 3/3-B"   

    and there's a VZ location (best match) 

              "/Chicago/School A/" 

 

4. If the OU matches exactly one of the aliases of a location  

              OU="/Chicago/School A/"   

 

    and there's a VZ location with an alias 

              "/Chicago/School A/" 

 

 

5. If the OU is contained by the OU of one of the aliases of a location  

              OU="/Chicago/School A/Grade 4/2030"   

 

    and there's a VZ location with an alias 

              "/Chicago/School A/" 

 

   That location will be matched, this after having checked the cases above in which there are no exact 

matches for the OU being checked. 

 

 

1. Should the Location of the user from SIS be ignored during the import and instead set the Location of 

the user based on the OU from Google ? (via the mapping rules). Right now, the mappings of OUs to 

Location is only enabled for Assets that are In Stock/Storage. 
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2. Should we keep the OUs and Locations as they are for the user, but when assigning the asset only set 

the OU of  the asset to the OU of the user? And then apply the auto mapping rules to set the Location of 

the asset according to the mappings. 

This effectively means to enforce the UO->Location mappings to all assets but not to Users. This could be 

also useful for you in the future possible to help identify inconsistencies between SIS and Google. 

  

3. Leave the rules unchanged, moving the assets to the OU and Location of the user when assigned. 

When they are back to storage, set the Location of the asset according to the auto mapping rules. 

 

               

 

 

When is this rule applied? 

---------------------------------- 

 

1. Automatically when the OU is updated. 

 

2. After imports of assets. 

 

2. On Demand 

For setting the Location of user from the OU of the user account on demand: 

- Run the task "Set Asset Location From OU" in the tool VNConfigUtils 
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WORKING WITH TABS  

VIZOR Web Admin allows you to add new tabs to a project. After you add a new tab, use the Field Editor 

to add new fields to the tab.  

You can also reorder the tabs, change the tab names, and delete tabs. To delete tabs you must delete all 

the fields on the tab or move the fields to another tab.  
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Stopdev endof 

 

CHAPTER 30 - E-MAIL INTEGRATION 

E-MAIL INTEGRATION 

In addition to enabling users to submit issues through Web views, you can configure VIZOR to directly 

accept issues submitted by e-mail, as well as keep track of all e-mail conversations associated to the issue.  

This provides an easy-to-use interface with which most users are already familiar, and enables support 

staff to manage e-mail exchanges with users without having to spend time entering the details of 

conversations. 

 

To configure your system to accept e-mail issues: 

Open Web Admin using one of the following methods: 

In your Web browser, enter //server/Connectadmin, where server is the name of your Web server. 

In VIZOR Admin, click Tools > Web > Web Admin. 

At the Web server, click Start > All Programs > Vector > VIZOR > Vizor Web Admin. 

Log on as a user that belongs to the VIZOR Administrators group. 

In Web Admin, click the E-mail tab and click Incoming Mail. 

Select the Project for which you want to enable e-mail integration. 

 

INCOMING E-MAIL INTEGRATION PROCESS  

Configuring VIZOR to accept issues submitted by e-mail is a multi-stage process: 
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Click Add a new Integration to enter the details of an e-mail address you want to use to submit issues to 

the project and keep the e-mail exchanges. The Add E-mail Integration Account window is displayed. 

For each e-mail address, you want VIZOR to monitor, you must specify:  

The information that will enable VIZOR to access the account. (See “ Specifying the E-mail Integration 

Account”.) 

The rules that govern how incoming e-mails are handled. (See “ Mail Handling”.) 

The information you want to copy from the e-mail to the associated issue, and default values for non-

mapped fields. (See “ Mapping E-mail Fields to Issue Fields”.) 

When you have completed entering the details of the E-mail Integration Account, select Enable this 

integration , and click OK to save your changes. 

 

SPECIFIYING THE E-MAIL INTEGRATION PARAMETERS 

Before VIZOR can convert e-mails to issues, you must specify the addresses that you want to use for 

submitting issues. 

To specify the details of the e-mail account you want to integrate with VIZOR: 

1    In the Hostname field, enter the name or IP address of the IMAP e-mail server that handles 

incoming e-mail. 

2    In the Port field, enter the port through which the e-mail server communicates..  

  If the IMAP server requires an encrypted connection, check the SSL box, and change the port 

accordingly.  

3    Enter a Logon and a Password for the account that VIZOR will use to access the e-mail server. 
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RECEIVE EMAILS VIA AN HTTP PROXY   

If your are running VIZOR on premises, and the security configuration in your network blocks IMAP 

communication except via an HTTP proxy, you need to configure this settings so VIZOR can receive emails 

using this type of proxy. 

Go to the Configurations area and search for “HTTP Proxy”. 

 

Set the necessary parameters to match the proxy used in your organization: 

 

Authentication Method  

Enter the text "Basic" or "NTLM". 

 

Domain  

Enter the name of the NTLM authentication domain (optional), if NTLM authentication is used. 

 

Hostname  
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hostname or IPv4 address 

 

Port  

Commonly used HTTP proxy ports are 8080 and 3128. 

 

 

Save. The “Mq Mail Integration Agent” service will use these parameters next time it fetches incoming 

email. 

 

 

INCOMING E-MAIL RULES 

E-mail-handling rules determine how e-mails sent to the address specified in the Incoming E-mail Server 

section are processed.  

When an e-mail is received, VIZOR compares the e-mail fields with the conditions specified in the first 

entry of the rules list. If the e-mail matches all conditions specified in the rule, VIZOR executes the 

specified actions, and then processes the next e-mail. If any of the conditions in the rule are not met, 

VIZOR tests the e-mail against the conditions specified in the next rule, until it reaches the end of the rule 

list. 

It is recommended to place a rule that has an Action Type of Queue as the last rule in the list to cover 

the possibility that the e-mail does not meet the conditions of any rule in the list, in which case, the e-mail 

will be automatically added to the E-mail Queue for manual processing.  
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To create an e-mail rule: 

In the Mail Handling section, click the Add button. The Add Rule window is displayed. 

Enter a Rule Name. 

Enter the conditions you want the rule to test for. For example, to test the Body of the e-mail for 

the word problem:  

1    Enable the first empty condition by selecting its check box. 

2    Click <Field> and select Body. 

3    Click Is Equal to and select Contains. 

4    Type problem in the entry field. 

5    Next, enter the actions you want the system to perform when all the conditions are met.  
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For example, to configure the system to create an issue and send a reply to the person who sent the e-

mail: 

a    Select the Integrate e-mail with VIZOR check box. 

b    Select Create New Issue using these values. 

     By default, VIZOR completes the issue using the field mappings defined in the Issue Completion section 

of the Edit E-mail Integration Account window. To override these mappings for this rule only, click these 

values. For more information, see “ Mapping E-mail Fields to Issue Fields” . 

c    Select Send an e-mail to <Reply to Sender> to send an acknowledgement to the submitter. (For 

more information, see “ Defining E-mails”) . 

6    Click OK to save the rule. The rule is added to the bottom of the mail-handling list. 

7    Select the rule and click the Up and Down arrows to specify the processing order for the rule. 

In most systems, the first rule checks whether an e-mail refers to an existing issue to avoid the possibility 

of creating duplicate issues. The easiest way to create this rule is to specify a condition that checks 

whether the e-mail contains a reference to an existing issue. If there is no match, only then should the 

system go on to check whether the e-mail contains details of a new issue. 

 

USING REGULAR EXPRESSIONS IN THE EMAIL RULE CONDITIONS 

You can use Regular Expressions in the Email Rule Conditions. For example, you may want to have a rule 

that matches a subject with the word “hello” in multiple languages. The condition will be something like:  

subject   contains  hello|hola|bonjour 

 

where the character “|” is used as a regular expression OR. 

Another example could be: 

subject   contains [nN]ew ticket 

where the rule will match both “New ticket” and “new ticket” in the subject. 
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Regular Expressions are only enabled automatically in email rule conditions that use the operator 

contains , which then causes the value that follows to be processed like a regular expression. 

 

  



  Page 469 

 

 

OUTGOING E-MAIL SETTINGS 

In order for the VIZOR E-mail Integration to process incoming and outgoing e-mails, several Mail Settings 

must be configured in VIZOR. 
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TO CONFIGURE THE MAIL SETTINGS: 
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Log on to VIZOR Web Admin. Click the E-mail tab and the Mail Settings section. 

Fill in the Outgoing E-mail Settings. These settings are used when sending e-mails. 

Click Test to ensure VIZOR is able to connect to the SMTP server using the settings you provided. 

 

Option Description 

Hostname The hostname or IP address of the SMTP server. For example: smtp.mycompany.com 

Port The port through which the SMTP server communicates.  The default SMTP server 

port is 25. 

SSL VIZOR supports SSL, enabling you to use secure connections to your email server.  

Selecting Yes from the drop down list will ensure that VIZOR communicates 

uttilising the SSL protocol. 

Logon The logon account used to gain access to the SMTP server. Use this only if your 

SMTP server requires authentication. 

Password The password for logging into the SMTP server. Use this only if your SMTP server 

requires authentication. 

Request Read 

Receipt 

Read receipts will appear in the conversation, confirming that the recipient has read 

the message. Note, however, that some recipients may choose to never send read 

receipts. 

Send Automatic E-

mail Notifications 

From 

Name of the sender for SMTP e-mail. Some SMTP mail servers require the sender to 

be a valid e-mail address.Supported Formats: "Notification Service" 

<notificationservice@yourcompany.com> notificationservice@yourcompany.com 

Send Automatic E-

mail Notifications 

Every 

Send e-mail notifications at the specified interval (in minutes). 

Maximum Retries The maximum number of retries for e-mail notifications. Once surpassed, the e-mail 
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will be sent to the address specified in the Send Failed Outgoing E-mails To. 

Send Failed 

Outgoing E-mails 

To 

If the Maximum Retries is surpassed, the e-mail will be sent to this address. If there 

is no address specified, the e-mail service will continue trying to send to the original 

recipient. 

 

 

Fill in the Incoming E-mail Settings. These settings are used when receiving e-mails, together with the 

Account, Server and Logon Information specified in the defined Mail Integrations. For more 

information, see Setting Up E-mail Integration. 

 

Option Description 

Check Server For New Mail Every Check for new incoming e-mails at the specified interval (in minutes).  
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MAPPING MESSAGE FIELDS TO ISSUE FIELDS 

When an e-mail is sent to a monitored address, VIZOR generates an issue and copies information from 

the e-mail to specified issue fields. VIZOR automatically creates a default mapping between the e-mail 

fields and specified issue fields when you integrate an account. For example, the body of the e-mail is 

copied to the issue’s Description field. However, you can change the fields that the e-mail information is 

copied to using the Edit Mapping button.  

To view the field mappings for the specified account: 

Click the Edit Mapping button. The Edit Mapping window lists the fields in your selected project, with 

mandatory fields shown in red. 
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To map an e-mail field to a project field: 

Double-click the row of the project field you wish to map. The Edit Mapping Field window is displayed. 

In the Edit Mapping Field window, select the E-mail Field you want to map to the selected project field, 

and click the OK button.  

To undo a field mapping: 

In the Edit Mapping window, double-click the mapping you want to cancel. 

In the Edit Mapping Field window, deselect the Assign value to this field check box and click the OK 

button.  

Click the OK button to save your changes, and close the Edit Mapping window. 

In addition to the usual E-mail Fields, a special field called Lookup user from e-mail’s sender is included. 

If a project field is mapped to this field, the system will use the incoming e-mail’s From address in an 

attempt to find an existing VIZOR user or contact who matches the credentials. When looking for a match, 

the system will consider all e-mail addresses associated with the user - not only the primary address. (See 

Associating Multiple E-mail Addresses to a Single Contact) 

If a user is found, that user will be associated with the e-mail. Otherwise, a contact may be created 

automatically if the option Create a contact based on the “from” address in the Default Values is set 

(See Setting Default Values for Issues Submitted by E-mail).  

 

For example, a typical mapping could be like this:  

E-mail 

Field 

VIZOR Field 

Subject Summary 

Body Description Log 

From Instead of mapping From to a VIZOR field, you can use the <Look up User from sender’s e-

mail> macro to fill in the field with VIZOR user ID. 

To Contact (this would allow you to search for issues submitted by e-mail)  
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SETTING DEFAULT VALUES FOR RECORDS SUBMITTED BY E-MAIL 

While the Edit Mapping window will allow associating e-mail fields to VIZOR project fields, it is possible to 

define a separate set of values that will be applied along with the imported e-mail fields. When VIZOR 

fields are not mapped to e-mail fields, or when those mapped values are empty, the default values are 

considered. There are two different types of Default Values: 

Global Default Values are set in the Issue Completion section of the E-mail Integration Account 

window.  

Rule Default Values can be set within any specific Rule that has Create as an Action Type, and if 

specified, they can override the Global Default Values. 

For example, you could have a Global Default Value that sets the VIZOR field Priority to Medium. This 

may be acceptable in the majority of cases, but for the sake of this example, let’s say a Rule is created to 

treat e-mails sent from the CEO to the VIZOR system. In this case, you may want the issue Priority to be 

set to High, instead of Medium, but still use all other existing Global Default Values.  By using the Rule 

Default Values, special cases like the one just described are possible. 
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If you mapped Lookup user from e-mail’s sender to any VIZOR field in the Edit Mapping window, 

selecting the Create a contact based on the “from” address if one doesn't already exist checkbox will 

enable the auto-creation of contacts when no match is found in the system. (See Mapping Message Fields 

to Issue Fields) 

When a contact is created, VIZOR will analyze the "from" address, and attempt to automatically associate 

the contact with a company. To achieve this, VIZOR looks at the e-mail domain (ex: 

bob@mycompany.com), and looks for a company that has a similar e-mail address. It knows to ignore 

common e-mail domains like Gmail, Hotmail, Yahoo, etc. To make modifications to the invalid e-mail 

domain list, see Ignoring Specific E-mail Domains When Creating Companies. 

 



  Page 477 

 

SENDING AUTOMATIC E-MAILS 

From both the E-mail Integration Rules and the SLA Escalation Rules, you can send an e-mail message 

automatically as an action. 

TO SEND AN AUTOMATIC E-MAIL AS AN SLA ESCALATION RULE ACTION:  

Log on to Web Admin. 

Click the SLA tab and the Service Levels section. Select a Project and a Service Level and click the 

Escalation Rules tab. Load an Escalation Rule, and click Send an e-mail as an Action. 

Enter the e-mail information and click OK. This e-mail will be sent when the conditions of the SLA 

Escalation Rule are met.  

Tip:  Automatic SLA Escalation Rule E-mail Actions are useful for informing the Owner of when they need 

to resolve an issue by. 

 

TO SEND AN AUTOMATIC E-MAIL AS AN E-MAIL INTEGRATION RULE ACTION:  

Log on to Web Admin. 

Click the E-mail tab and the Incoming Mail section. Select a Project load an E-mail Integration. Load a 

Mail Handling Rule, and click Send an e-mail as an Action. 

Enter the e-mail information and click OK. This e-mail will be sent when the conditions of the Mail 

Handling Rule are met. 

Tip:  Automatic E-mail Integration Rule E-mail Actions are useful for replying to the person who sent the 

e-mail to tell them the number of the issue that the e-mail created so they can follow up on it at a later 

time. 
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SENDING E-MAILS FROM THE WEB VIEWS 

TO SEND AN E-MAIL CONTAINING INFORMATION ABOUT AN ISSUE: 

Log on to a Web view. 

Load an issue and click on the   button.  

The E-mail Editor will open, with the default Current Issue Template. You can add the value of additional 

fields using the Field Value Macro. 

Click the Send button. 

This e-mail will be added to the issue’s Conversation if the Save to Conversation checkbox is selected. 

SERVICE LEVEL AGREEMENTS (SLA) AND E-MAILS: 

If the issue has an SLA agreement associated with it, the first time you send an e-mail from VIZOR to the 

Contact of the issue, the Actual Initial Response Date and Actual Initial Response Time fields in the 

issue will automatically be set to the date and time when the e-mail is sent (if they aren’t set already). 
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USING THE E-MAIL EDITOR 

The E-mail Editor in VIZOR allows you and your users to create and send e-mail messages from the Web 

view. You can also configure e-mail to be sent automatically from SLA or E-mail Integration (for example, 

when VIZOR creates a new issue from an incoming e-mail, or when an SLA rule changes the Owner of an 

issue). 

  

 

SENDING E-MAILS  

EDITING THE TO, CC, AND FROM FIELDS 
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You can specify users by either looking up users and contacts in VIZOR, using macros or typing in the e-

mail address directly. 

To lookup users and contacts in VIZOR, beside the To, CC, or From box, click  . 

In the Select Users and Contacts dialog box, double-click the users and contacts you want to add. 

The list of selected users and contacts is displayed under Selected Users and Contacts. You can edit this 

string of text, for example, to remove a user, or to add the e-mail address of a person who is not a user or 

contact. 

 

NOTES 

 The text box beside the Find button allows you to display all users and contacts whose names start with the same letters. In 

the text box, type the first few letters of the name and then click Find. 

 To display the complete list of users and contacts again, delete all text from the box and then click Find.  

 Click Advanced to search for all users and contacts whose names contain the same string, or to search based on e-mail 

addresses. 

 If you would like to send separate e-mails to several recipients, select the Send e-mail to each recipient individually checkbox. 

If you have recipients entered in the CC field, you will not be able to send individual e-mails. 

 

EDITING E-MAIL CONTENT 

You can type in any text you want, and you can use macros to insert the issue number, the name of the 

project, and the values of different fields (such as the Summary and Description Log). 

 

If you prefer your e-mail body to be in HTML format, click the HTML in Body checkbox. 
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ATTACHING FILES 

Beside the Attachments box, click  . 

 

In the E-mail Content Attachments dialog, click Browse and locate the file you want to attach. Click 

Upload or Link. 

 

This adds the file to the list of files attached to this e-mail message. Every time the e-mail message is sent, 

the files are attached to the message. 

 

E-MAIL CONVERSATION AND QUEUE 

E-mail integration brings the ability to view support-related and other e-mails directly from the Web views. The E-mail 

Conversation and Queue are where you can view and manipulate these integrated e-mails. 

THE E-MAIL CONVERSATION 

The E-mail Conversation is where you can access all the e-mails related to a specific issue. 

To access an issue’s E-mail Conversation: 

Log on to the Web view where the issue can be found. 

Find the issue using the search feature. 

Select the issue from the summary list. 

Click  in the toolbar. 
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THE E-MAIL QUEUE 

The E-mail Queue is where you can access and process all the e-mails pending assessment from a help desk analyst. These e-

mails have not been associated to any existing issue. 

To access the E-mail Queue: 

Log on to a Web view of the desired Project. (Each Project has its own E-mail Queue.) 

Click  in the toolbar. 

WORKING WITH E-MAILS IN THE UI (WEB VIEW)  

The E-mail Conversation and Queue are where integrated e-mails can be processed, in the Web view. There, you can: 

Send a new e-mail. 

Reply to an e-mail. 

Forward an e-mail. 

Link an e-mail to an existing issue. 

Create a new issue from an e-mail. 

 

Emails are automatically linked to the ticket record when they contain a specific token in the subject or 

the body of the email. 

The default tag is: 

Issue ID: # 

But you can change it in the settings area. 

SENDING NEW E-MAILS 

E-mails are created and sent using the e-mail editor (see Using the E-mail Editor). 
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You might be interested, for example, in sending an e-mail and keep a copy in an issue’s E-mail 

Conversation and Activity Log. 

New e-mails' fields will be completely blank with the exception of the From address which is determined 

by your E-mail Options, and the Subject which, for the Conversation only, is pre-filled with the respective 

issue number. 

To send a new e-mail from an E-mail Conversation or the E-mail Queue, click . 

REPLYING TO E-MAILS 

E-mail replies are created and sent using the e-mail editor  (see Using the E-mail Editor). 

You might be interested, for example, in requesting more information from a customer after receiving a 

support e-mail. 

E-mail replies are pre-filled with the original e-mail’s content, and the From address is determined either 

by the original e-mail’s Integration Account’s (see Setting up E-mail Integration) e-mail address, or by 

your E-mail Options if the original e-mail didn’t come from E-mail Integration. 

To reply to an e-mail from an E-mail Conversation or the E-mail Queue, click  or 

, depending whether you want to reply only to the sender or to all the original recipients as 

well. 

Note: see Sending E-mails From Web views to see how an E-mail Conversation reply can automatically 

update the respective issue’s Actual Initial Response Date and Time. 

FORWARDING E-MAILS 

Forwarded e-mails are created and sent using the E-mail Editor. 

You might be interested, for example, in sending a copy of a customer e-mail to a colleague for second-

line support. 

Forwarded e-mails are pre-filled with the original e-mail’s content with the exception of the To recipient 

which is left blank. The From address is determined by your E-mail Options. 

To forward an e-mail from an E-mail Conversation or the E-mail Queue, click . 
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LINKING AN E-MAIL TO AN EXISTING ISSUE 

Whether an e-mail is already in an issue’s E-mail Conversation or still in the E-mail Queue, you might find out it is related to 

some (other) existing issue. 

To link an e-mail to an issue, from an E-mail Conversation or the E-mail Queue, click . 

After the e-mail is linked to this new issue, it can be found in this issue’s E-mail Conversation. 

CREATING A NEW ISSUE FROM AN E-MAIL 

Whether an e-mail is already in an issue’s E-mail Conversation or still in the E-mail Queue, you might decide a new issue 

needs to be created with regards to the information found in it. 

To create a new issue from an e-mail in an E-mail Conversation or the E-mail Queue, click . 

After the issue is created, you will receive a message stating the new issue’s number, and the e-mail will 

now be in this issue’s E-mail Conversation. 
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E-MAIL MACROS 

Macros are available when you use the E-mail Editor in the Web views and Web Admin.  

Macros resolve values for information related to the issue so you don’t have to look it up manually. 

Examples of email macros: 

Macro Available In 

Fields 

Description 

<Contact> To, CC, From The person who is entered in the Contact field in the 

issue. This is usually the person who reported the issue. 

<Owner> To, CC, From The person who is entered in the Owner field in the 

issue. 

<Previous Owner> To, CC, From The person who was entered in the Owner field in the 

issue before it was reassigned to a new VIZOR user. 

<Submitter> To, CC, From The person who is entered in the Submitter field in the 

issue. This is the person who entered the issue in VIZOR. 

<Work Team Members> To, CC The people who belong to the work group that is 

entered in the Assigned Work Team field in the issue. 

<Reply To Sender> To The person who sent the e-mail. This only applies when 

replying to an e-mail through the Conversation or Queue 

or from the E-mail Integration Actions.  

<Reply To CC> CC The people who were CCed on the e-mail that was sent. 

This only applies when replying to an e-mail through the 

Conversation or Queue or from the E-mail Integration 

Actions. 

<Integration E-mail> From The e-mail address specified for the E-mail Integration 

Account. 
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<Server Mail Sender From Admin 

Options> 

From The e-mail address specified in the Mail Settings for who 

to Send Automatic E-mails Notifications From. 

<Value of Field:> Subject, Body The value of a field in the issue. 

<Issue Number> Subject, Body The number of the issue. 

<Project Name> Subject, Body The name of the project the issue is in. 

<Link To Issue> Body Generates a URL that you can include in the e-mail to 

allow people who have access to the Web views to log in 

to a specific view and automatically load the issue you 

specified. 

<Attribute of Person in Field:>  Very flexible macro for resolving the value of a user 

indicated by a field of the dts record. 

You can use custom user fields. 

For example, if you want to add the email of the person 

that is the owner of a HelpDesk ticket, you would specify 

this: 

 

<Attribute of Person in Field:{Owner}.{E-mail 1}> 

 

Format: 

<Attribute of Person in Field:{Caption of field which 

value is a person/user}.{Caption of the field of the 

person/user to return}> 

 

 

<Group Members:Admins> 

 

To, Cc, Bcc Return the users/persons that are members of the 

specified group. 

E.g. <Group Members:Admins> 
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<Supervisor of:Caption of person field> 

 

Any Return the supervisor of the user/person that is in the 

specified field, for the current record. 

E.g. <Supervisor of:Contact> 

 

<Job Title:Name of a job title> 

 

Any Return the first user/person that has the job title 

specified. 

E.g. <Job Title:CEO> 

 

<Teacher of:Caption of field that points 

a student> 

 

Any Return the teacher of the student that is in the field 

specified, in the context of the current record. 

E.g. <Teacher of:Allocated to Person> 

 

<Parent Email of:Caption of field that 

points a student> 

 

Any Return the email of the parent of the student that is in 

the field specified, in the context of the current record. 

E.g. <Parent Email of:Allocated to Person> 

 

<Parent Name of:Caption of field that 

points a student> 

 

Body Return the name of the parent of the student that is in 

the field specified, in the context of the current record. 

E.g. <Parent Name of:Allocated to Person> 

 

<Days from now:days> 

 

Body Returns a date a number of days in the future from 

today. 

<Days ago:days> 

 

Body Returns a date a number of days ago from today. 

<Asset Instance of this Action:Caption 

of field of the asset> 

Body Return information, the value of a field, of the asset 

being affected by an action, in the context of an action. 
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 <Asset Instance of this Action:Serial Number> 

 

<Connect as> 

 

Body Returns the credentials to use in a connection. Used for 

actions that connect remotely to an asset.  

<Base URL:> 

 

Body Returns the Public URL of the VIZOR system. Usually this 

is as defined by the configuration item Public URL. 

 

<Value of Field:Caption of field> 

 

Any Value of any field of the current record. 

<Value of Field:Owner> 

 

<Asset Type Abbreviation> 

 

Any The abbreviation of the asset type of the asset instance 

on context. 

<Next Asset Type Number> 

 

Any The next automatically generated unique number 

(sequencial) of the asset type of the asset instance on 

context. 

<Formatted Purchase Date:yymmdd> 

 

Any Returns the purchase date of the asset instance, 

formatted using the argument. 

<Approvers per cost level> 

 

Any Returns the list of people that are defined to be 

approvers depending on the cost of the asset type in 

context, the asset instance in context or the purchase in 

context. 

<Line Item Purchase Field:Caption of 

field> 

Any Value of any field in the line item's related purchase 

record. 

 

Example  

<Line Item Purchase Field:Supplier> 

<Line Item License Field: Caption of Any Value of any field in the line item's related license record. 
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field > Example                                                                          

<Line Item License Field:Software Asset Type> 

 

USING MACROS INSIDE EMAILS  

Position your cursor in the e-mail where you would like the resolved macro to be inserted. 

Click on the Macros tab.  

Click on the macro you would like to insert. In the Web views, the macro will be resolved to the current 

value. In templates and in Web Admin, the macro will remain unresolved so that it can be resolved when 

the automatic e-mail is sent or when the template is applied to an e-mail. 

 

E-MAIL TEMPLATES 

Templates are available when you use the E-mail Editor in the Web views. 

Use templates to store reusable e-mail content so that your users can quickly create e-mails when 

standard responses are required. A template can contain Subject, Body and Attachment information. 

TO CREATE AN EMAIL TEMPLATE  

All users who have access to the Web View – Manage E-mail Templates can create and edit templates. 

To create a template, open the E-mail Editor to create a new e-mail. Click the Templates tab and click 

Add a new template.  

By default, the new template is filled in with any subject, attachment and body text that was entered in the 

e-mail you added the template from. 

Enter a Name for the template, as well as any subject, attachment or body text that you want in the 

template. 
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Click OK, and your new template will be available in the Templates list for all users who have the feature 

Web View – Manage E-mail Templates. 

 

 

 

LINKS WITHIN NOTIFICATION TEMPLATE 

It is possible to create a link within an email template. This is most useful for email notifications that use 

an email template. For example, most notifications have a link at the top right that brings the user to the 

issue when clicked on. Additionally, notifications can link to a survey a user can fill out once an issue is 

closed (See Issue Closed Notification in the templates tab). 

 

To create a link to an issue, first go to the templates tab and either create a new template or edit an 

existing one. Enter the text you want the link to have, for example View the ticket online, and click on 

the Link button in the top toolbar (Make sure HTML in Body is checked in the bottom right to view the 

toolbar). 

 

Within the Link Info tab, URL should be selected as the Link Type by default. For the protocol, select 

http:// or https:// depending on whether or not you have SSL enabled. Next, for the URL, enter something 

similar to this: 

 

customer.VIZOR.cloud/connect?View=HelpDesk%2FEmployee&nId=<Issue Number>&Qry=22 

 

Note that the <Issue Number> in the URL is a macro used to get the ID of the issue related to the 

notification being sent. If you prefer having this value encrypted, use eId=<Encrypted Issue Number> 

instead. 

 

To link to a survey for the related issue, the steps will be the same as mentioned above, except the link will 

be like this: 

customer.VIZOR.cloud/connect?View=HelpDesk%2FSurvey&eId=<Encrypted Issue Number> 

 

You can copy the link from the View the ticket online link, but make sure View=HelpDesk%2FEmployee 

is replaced with View=HelpDesk%2FSurvey, and remove “&Qry=22” from the URL. 
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TO USE AN EMAIL TEMPLATE 

All users who have access to the Web View – Manage E-mail Templates can use templates. 

To use a template, open the E-mail Editor to create a new e-mail. Click the Templates tab and select the 

template you want to use. Click Apply the selected template.  

 

 

 

PERSONAL  E-MAIL OPTIONS 

The Web view E-mail Options affect all e-mails created from the Web views, be it from the E-mail toolbar 

button, an issue’s E-mail Conversation or the E-mail Queue. 

Two options are available to Web view users regarding e-mails: 

The From address to be used when composing e-mails. 

The requesting of read receipts. 

By default, every user’s E-mail Options are: 

From Address: their own e-mail address. 

Read Receipts: requested. 

To change your E-mail Options: 

Log on to a Web view. 
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Click  in the toolbar. 

Click the E-mail tab to open it. 

Perform the desired changes and click OK. 

 

THE "FROM ADDRESS" E-MAIL OPTION 

You have the option to use the e-mail address of your VIZOR user account or any other e-mail address, 

when sending e-mails from Web views. 

No matter what this option is set to, replies to e-mails coming from an E-mail Integration Account will 

always have the respective account’s e-mail address as their From address. 
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THE "READ RECEIPTS" E-MAIL OPTION 

You have the option to request a read receipt for all the e-mails you send from any Web view. 

Depending on the From address of your e-mails and the E-mail Integration configuration, these read 

receipts can be processed automatically by the E-mail Integration feature. 

Note that read receipts can be recognized by their subjects starting with “Read:”. 
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CHAPTER 31 - BUSINESS & 

WORKFLOW RULES 

ABOUT BUSINESS & WORKFLOW RULES  

Business & Workflow rules allow you to define and enforce an issue handling process. Together with e-

mail notifications, Business & Workflow rules help you automate the tracking and management of issues.  

 

WHAT CAN YOU DO WITH BUSINESS & WORKFLOW RULES? 

When a user selects a choice from a choice list, you can:  

 Select choices in other choice lists. 

 Change the possible choices in other choice lists. 

 Hide fields. 

 Disable fields. 

 Make fields required. 

 Hide tabs. 

These are the basics of Business & Workflow rules. However, this explanation leaves out some important 

details: 
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 By default, rules are applied when a user creates, saves, or loads an issue. You 

can also force rules to be evaluated when a user selects a choice.  

 Business & Workflow rules can also be based on more complicated 

conditions. For example, a rule may require that certain choices are selected from 

a number of different choice lists, or that the user is a member of a specific 

group, or both.  

AUTOMATE BUSINESS & WORKFLOW  

By controlling the possible values of the Status field, you can define and enforce a process.  

Simple Business & Workflow controlled by Status values 
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EXAMPLES 

EXAMPLE 1: 

After an analyst starts work on an issue and marks it In Progress, you can enforce a process where only 

the analyst can mark the issue as Dropped, Resolved, or To be Verified.  

When: 

<User in Group> = Help Desk Analyst AND 

Status = In Progress  

The possible values are:  
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Status = Dropped 

Status = Resolved 

Status = To be Verified  

Note that Status = In Progress is an implied possible value. A choice list can always be set back to its 

current value. For example, if a user is not a help desk analyst and an issue is marked In Progress, the 

Status list contains only one choice: In Progress.  

This rule is an example of a possible values rule.  

EXAMPLE 2:  

You can prevent anyone except a group leader from assigning new issues.  

When: 

<User in Group> = Help Desk Group Leader AND 

Status = New  

The possible values are:  

Status = Assigned  

This prevents new issues from being resolved or dropped without first being assigned to an analyst by the 

group leader. If a user is not a group leader, the only possible choice is New.   

EXAMPLE 3: 

You can enforce a process where developers must forward issues to QA: 

When: 

<User in Group> = Developers AND 

Status = Assigned 

The possible values are:  

Status = To be Verified 

And where only QA can close issues (or assign them back to developers): 
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When: 

<User in Group> = QA AND 

Status = To be Verified 

The possible values are:  

Status = Fixed 

Status = Assigned 

Note that a choice list can always be set back to its current value. For example, if a user is not part of QA 

and an issue is marked To be Verified, the Progress list contains only To be Verified. 

EXAMPLE 4: 

You can prevent anyone except a manager from assigning new issues. 

When: 

<User in Group> = Managers AND 

Substate = New 

The possible values are:  

Substate = Assigned 

This prevents new issues from being resolved or dropped without first being assigned to a developer by 

the manager. 

CREATE RELATED CHOICE LISTS  

You can define rules to create a relationship between two choice lists.  

EXAMPLES 

If Problem Type can be Hardware, Software, or System, Problem Area can be a type-specific list that 

displays a list of hardware components, software applications, or system components.  

When: 
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Problem Type = Hardware  

The possible values are:  

Problem Area = Disk 

Problem Area = Monitor 

Problem Area = Keyboard 

Problem Area = Memory  

You need to create similar rules for software and system problems.  

By default, Business & Workflow rules are evaluated when an issue is saved. For related choice lists like the 

ones in this example, you probably want to evaluate the rule whenever the Problem Type changes. 

Otherwise, users would have to select a Problem Type, save the issue, and then select the Problem Area.  

DEPENDING ON THE TYPE (SOFTWARE DEFECT, HARDWARE DEFECT, OR 

DOCUMENTATION DEFECT) YOU CAN UPDATE THE FUNCTIONAL AREA LIST.  

When: 

Type = Documentation Defect 

The possible values are:  

Functional Area = Online Help 

Functional Area = User Guide 

Functional Area = Tutorials 

Functional Area = Readme 

You need similar rules for software and hardware defects. 

By default, Business & Workflow rules are evaluated when an issue is saved. For related choice lists like the 

ones in this example, you probably want to evaluate the rule whenever the Type changes. Otherwise, 

users would have to set the Type, save the issue, and then select the Functional Area. 

SET FIELD VALUES  
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Instead of setting the possible values of a choice list, you can define rules that select choices from other 

lists. These type of rules are called a dependent values rules, because they make the value of one field 

depend on the value of another field.  

EXAMPLES 

This rule that assigns a default owner based on the Problem Area.  

When: 

Owner = <None> AND 

Problem Area = SW - Outlook  

The values to set are:  

Owner = Erick Yanez  

This rule assigns a default owner for new issues, but allows the issue to be reassigned. Without <New 

Issue> = yes, users could not change the owner of the issue. This rule assigns a default owner based on 

the Functional Area. 

When: 

<New Issue> = yes AND 

Functional Area = Security 

The values to set are:  

Owner = Erick Yanez 

 

 

WHAT YOU SHOULD KNOW ABOUT BUSINESS & WORKFLOW RULES  

 Rules work with single-choice list fields  

You cannot define rules that apply to any other type of field, including multiple-choice list fields.  
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 Rules are defined per project  

All Web views of a project share the same Business & Workflow rules. You cannot disable the Business & 

Workflow rules for specific Web views. The rules are either enabled for all views or disabled for all 

views.  

 Rules can impact performance  

Defining a large number of rules may impact the performance of Web views.  

Using Business & Workflow rules to set default values is a good choice if you have a small number of 

rules and are not limited by resources (server, network, end-user computers).  

 Rules are evaluated when issues are loaded and created  

By default, Business & Workflow rules are evaluated when an issue is loaded or created (note that when 

you save an issue it is immediately re-loaded, triggering the Business & Workflow rules). You can force 

rules to be evaluated when a user changes the value of one of the fields specified in the condition. 

Evaluating rules on field changes has a potentially higher performance cost. However, if you want to 

implement dependent fields, you should evaluate the Business & Workflow rule on field changes.  

 Changes to choice lists can break Business & Workflow rules  

If you remove choices from a choice list, or change the meaning of a choice, rules that use the choice list 

may stop working or result in unexpected behavior.  

 By default, rules apply to all users  

To build group-specific rules, use the macro <User in Group> in your conditions.  

 The order of rules is important  

Rules are evaluated in the order they are listed in the Business & Workflow Editor. For example, in the 

default  Workflow, the rule Admins-<Any> is the first rule in the list. This ensures that any member of 

the Admin group can make any change to the Status field.  

If the Admins-<Any> rule is last, then an analyst who is also a member of Admins does not have full 

administrator permissions for changing the Status field. The stricter rules are evaluated first, limiting the 

changes the analyst can make. If the Admins-<Any> rule is last, a developer who is also a member of Admins 

does not have full administrator permissions for changing the Status field. The stricter Developer rules are 

evaluated first, limiting the changes the developer can make. 
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WHAT IS A BUSINESS & WORKFLOW RULE?  

A Business & Workflow rule has this simple format:  

if ( condition ) then  

 action  

The condition can test:  

 If a user belongs to a specific group 

 If a specific choice was selected from a choice list. 

Multiple conditions can be joined with a logical AND. The only test operator available is the equal to 

operator (=).  

If the rule is a possible values rule, the action can specify the possible values for one or more choice lists. 

If the rule is a dependent values rule, the action can select choices from one or more choice lists.  

They make possible the establishment and application of incident models alternatives. These can be 

generic with th use of macros or given specific values to specify for very specific sets of situations where 

combinations of values from different fields need to trigger a corresponding action rule . 
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CREATING RULE TEMPLATES  

Before you can define any rules, you must create a template. Templates define the fields used in rules, and 

rules provide the values. For example, a template might look like this:  

When: 

<User in Group> = _ _ _ _ AND 

Status = _ _ _ _   

The possible values are:  

Status = _ _ _ _   

A template defines what the rules look like, while a rule fills in the _ _ _ _ parts with specific values.  

To create a rule template:  

1   Log on to VIZOR Web Admin. Click the Workflow tab. In the Project list, click a project. 

Business & Workflow rules based on this template apply to all Web views of this project.  

2   Click Template and click Add. 

3   In the Add New Template dialog: 

 In the Template Name box, type a name for the template.  

 In the Template Description box, type a short description of the template.  

 Select the type of rules you want to define: 

A Dependent Values rule makes the value of one field depend on the value of another field.  

 For example, if How Found = Reported by Customer then Priority = Highest.  

A Possible Values rule makes the possible values of one field depend on the value of another 

field.  

 For example, if Type = Doc Defect then the possible values for Functional Area = Help, Readme, or 

Manual.  

A Hidden Fields rule makes the visibility of one or more fields depend on the value of of another 

field. 

 For example, if Substate = Cannot be Fixed then the Estimated Fix Time field will disappear. 
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A Required Fields rule makes the required state of one or more fields depend on the value of 

another field. 

 For example, if Substate = Duplicate then Duplicate Issue will become a required field.  

A Disabled Fields rule makes the functional availability of one or more fields depend on the value 

of another field.  

 For example, if Substate = Cannot be Fixed then Fixed by will be disabled, preventing user input. 

A Hidden Tabs rule makes the visibility of one or more tabs depend on the value of a field.  

 For example, if Substate = Cannot be Fixed then the Fix tab will disappear. 

4   Click OK.  

5   In the list of templates and rules, click the new template. 

6   Under Conditions, click . Then click the Field box three times and click a field whose value you want 

to test. Repeat for each additional field you want to test. 

Conditions determine when a rule is applied. If all the field tests evaluate to True, the rule is applied.  

Note that the Field list contains single-choice fields only.  

7   If you created a Dependent Values template, click  under Dependent Values, then click the Field 

box three times and click the field whose value you want to set. Repeat for each field whose value you 

want to set.  

    Note that the Field list contains single-choice fields only.  

If you created a Possible Values template, click  under Possible Values, then click the Field box three times 

and click the field whose possible values you want to specify. Repeat for each field whose possible values 

you want to specify.  

 Note that the Field list contains single-choice fields only.  

If you created a Hidden Fields template, click  under Hidden Fields. Once an empty field row has appeared, 

no further action is necessary. Multiple fields will be available for selection when 

Defining_Rulesdefining rules. 

If you created a Required Fields template, click  under Required Fields. Once an empty field row has 

appeared, no further action is necessary. Multiple fields will be available for selection when defining rules. 

If you created a Disabled Fields template, click  under Disabled Fields. Once an empty field row has 

appeared, no further action is necessary. Multiple fields will be available for selection when defining rules. 

If you created a Hidden Tabs template, click  under Hidden Tabs. Once an empty tab row has appeared, no 

further action is necessary. Multiple tabs will be available for selection when defining rules. 
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DEFINING CONDITIONS  

DEFINING CONDITIONS BASED ON USER GROUPS  

By default, a rule applies to all users. To build group-specific rules, use the macro <User in Group> in 

your conditions.  

If a user belongs to a group for which there is no rule, then for possible values, the fields displays all 

possible values.  

Rules that apply to the Users group apply to all users, because all users are members of the Users group. 

Rules for specific groups can override the base rule defined for the Users group. 

Using user group conditions in a business rule of the type Disable fields described below to limit access to 

an incident’s information given a user’s membership to any given group is quite useful (e.g. a disabling 

rule for all fields triggered on condition that the incident ID=X will specifically limit access to that specific 

incident). 

DEFINING CONDITIONS FOR NEW ISSUES  

To define rules that apply only to new issues, use the macro <New Issue> in the condition. <New Issue> 

is equal to Yes only for issues that have never been saved.  
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DEFINING RULES  

Defining a rule involves filling in the template with specific values.  

Note that while you edit rules, you can edit the values, but you cannot add or remove fields. To add or 

remove fields you must edit the rule template.  

To define a rule:  

1   Log on to VIZOR Web Admin. Click the Workflow tab. 

2   In the Project list, click a project, then click a rule template. 

3   Click Rule and then click Add. 

4   Under Conditions, specify the values to test. For each field, click the Value box three times and then 

click the field value you want to test for. 

5   If you are defining a Dependent Values rule, then under Dependent Values, for each field, click the 

value you want to set. To use the value of another field, double-click the <Values of Field???> macro. 

If you are defining a Possible Values rule, then under Possible Values, for each field, select the check boxes 

for each possible value.  

If you are defining a Hidden Fields rule, then under Hidden Fields, for each field, select the check boxes for 

each field you wish to hide. 

If you are defining a Required Fields rule, then under Required Fields, for each field, select the check boxes 

for each field you wish to make required. 

If you are defining a Disabled Fields rule, then under Disabled Fields, for each field, select the check boxes for 

each field you wish to disable. 

If you are defining a Hidden Tabs rule, then under Hidden Tabs, for each field, select the check boxes for 

each tab you wish to hide. 

6   Click Apply to apply the rule to the Web views of the project. 

NOTES 

You can also copy a rule and edit it. To copy a rule, click the rule, then click Rule, click Copy, and type a 

name for the new rule. 
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DELETING RULES  

To delete a rule:  

1   In the list, click a rule. 

2   Click Rule and then click Remove. 

3   Click Apply to apply the changes to the Web views of the project. 

 

 

RENAMING RULES  

To rename a rule:  

1   In the list, click a rule. 

2   Click Rule and then click Rename. 

3   Type the new name for the rule. 

To change the default names for new rules:  

1   In the list, click a rule template. Click Template and then click Properties.  

2   In the Name rules according to box, type the new default name for rules. 

By default, rule names are based on the condition values (the values entered in the Value column). The string 

%Value0% represents the value in the first row of the condition, %Value1% represents the value in the second 

row, and so on.  

If you use a text string (such as WorkflowRule) as the default rule name, rule names are formed by 

appending a number to the string.  
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USING MACROS IN RULES  

<Any>  

Use the <Any> macro in conditions to define a rule that applies to any value of a field, including 

<Empty>. For example, in the default workflow, the Admins-<Any> rule allows members of the Admins 

group to set any value in the Status field.  

<Empty>  

Use the <Empty> macro in conditions to define a rule that applies when a field is empty.  

<User>  

<User> represents the current user (the user currently logged on to the Web view). You can use <User> 

in conditions, as a possible value, and as a dependent value.  

<New Issue> 

<New Issue> is used to create rules that apply only when an issue is created.  

For example, to ensure all issues submitted by managers have high priority by default, a rule like this can 

be created: 

Condition Dependent Values 

<New Issue> = Yes Priority=High 

<User in Group> =  Managers  

If the <New Issue> condition is not included, the manager would not be able to change the priority 

because the rule would reset the value to High when the issue is saved. 

<Value of Field???>  

This macro allows you to define a Dependent Values rule that assigns the value of a field to another field. 

For example, when an issue is fixed, a workflow rule could set the value of the Fixed By field to <Value of 

Owner>.  
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When you add a dependent values rule, you’ll see the <Value of Field???> macro in the Values column of 

the Dependent Values table. Double-click <Value of Field???> and then select the field whose value you 

want to use.  

By default, the Submitter field is not enabled. To use the field in the <Value of Field ???> macro, you must 

enable it using the Field Editor in VIZOR Admin. 
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SETTING POSSIBLE VALUES  

When you set the possible values of a field, you don't have to include the current value of the field in the 

list. For example, given this rule:  

When: 

<User in Group> = Employees AND 

Status = Waiting  

The possible values are:  

Status = Dropped 

Status = In Progress 

Status = Resolved  

When Status is set to Waiting, the Status list contains Dropped, In Progress, Resolved, and Waiting. 

When: 

<User in Group> = Developers AND 

Substate = Assigned 

The possible values are:  

Substate = To Be Verified 

When Substate is set to Assigned, the Substate list contains Assigned and To Be Verified.  

 

 

CHANGING WHEN RULES ARE EVALUATED  

By default, Business & Workflow rules are evaluated when an issue is loaded and when issues are created.  

However, you can force rules to be evaluated when a user changes the value of one of the fields specified 

in the condition. Keep in mind that evaluating rules on field changes can have a potentially higher 

performance cost.  

To evaluate rules on field changes:  

1   In the list, click a template. 

2   Click Template and then click Properties. 



  Page 513 

 

3   Select the Evaluate rules when users change field values check box. 

4   In the Template Properties dialog, click OK. 

5   Click Apply to apply the change to the Web views of the project. 

 

 

CHANGING THE ORDER OF EVALUATION  

Rules are evaluated in the order they are listed in the Workflow Editor. You cannot change the order of 

rules in a template (except by creating them in the desired order), but you can change the order of the 

rule templates.  

To change the order of evaluation of rule templates:  

1   In the Templates list, click a template. 

2   Click  or  to move the template up or down in the list. 

3   Click Apply to apply the change to the Web views of the project. 

 

 

APPLYING BUSINESS & WORKFLOW RULES  

When you edit a rule, define a new rule, define a new group of rules, or change the group options, you 

must apply the changes. Apply automatically enables the group of rules. If you enable the rules, but don’t 

apply them, nothing happens.  

To apply Business & Workflow rules:  

1   In the list, click a template. 

2   Click Apply. 
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NOTES 

Web view users must log out and then log back on before the changes take effect. 

 

 

DISABLING BUSINESS & WORKFLOW RULES  

You can disable all the rules based on a given template.  

To disable Business & Workflow rules:  

1   In the list, click a template. 

2   Click Template and then click Properties. 

3   Clear the Enable in all Web views of the project check box, and click OK in the message box that 

appears. 

4   In the Template Properties dialog, click OK. 

5   Click Apply to apply the change to the Web views of the project. 

 

 

 

 

 

 



  Page 515 

 

 

CHAPTER 32 - DEFINING SERVICE 

LEVEL AGREEMENTS 

ABOUT SERVICE LEVEL AGREEMENTS  

A service agreement is an agreement between the help desk and users. It defines a required level of 

service for the users.  

A service agreements can be with individual users (contacts), with all users in a department, or all users in 

a company.  

A service level is a guarantee of a certain level of service. For example, a basic service level may provide 9-

to-5 service during the regular working week, while a more comprehensive service level might provide 24 

hour service, 7 days a week.  

Each service level has its own hours of service, target response and closure times for issues, and escalation 

rules.  

A Web view used by help desk analysts has an SLA tab. This tab contains information about the service 

level agreement that applies to the issue.  

For example, when employee submits new issue, the Escalation State is automatically set to On, and the 

Problem Area is set based on the Service Type selected by the employee. Based on the service type, 

priority, and the employee’s contact information (name, department, and company), VIZOR sets the 

Target Initial Response Time, Target Closing Time and Associated SLA fields.  
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SETTING UP SERVICE AGREEMENTS 

1   Define companies and departments, so you can create service level agreements with groups of users. 

When you create an agreement, it can be either with a specific user or with all users in a department or in 

a company. 

2   Define the escalation levels. 

3   Define the service types. 

4   Define service levels. Each service level is defined by the following: 

 Target times 

 Escalation Rules 

 Operational Hours 

5   Define service agreements. 

6   Optionally, define Business & Workflow rules. VIZOR includes default Business & Workflow rules for 

the Service Type and Escalation State fields in Web views. 
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TARGET TIMES  

A service level defines target response and closure (resolution) times for each possible priority value.  

Target Initial Response Time The time it takes to initially respond to a new issue. When a help desk 

analyst responds to an issue, the analyst has to enter the response date and time on the SLA tab of the 

Web view.  

Target Closure Time The time it takes to resolve the issue, either by fixing the problem or providing an 

acceptable workaround. When an issue is resolved, VIZOR automatically enters the date and time into the 

issue.  

When you create a service level, the level gets the default target times.  

To edit the target times:  

1   In the Service Level list, click a service level. 

2   On the Target Times tab, click a row (for example, to edit the target times for the Highest priority, 

click that row). 

3   Click Edit. 

4   In the Edit Target Times dialog, type the target times in the Initial Response Time and Closure Time 

boxes. 

The target times must be integer values, such as 2, 7, or 10. You cannot enter decimal  values, such as 2.5.  

You can change the time units between minutes, hours, and days. For example, to change from hours to 

minutes, click hour(s) and then click minute(s) in the pop-up list.  

 



  Page 518 

 

ESCALATION LEVELS  

Escalation levels allow the help desk to better identify, query, report, and monitor priorities and urgent 

issues. By default, VIZOR defines five escalation levels. Level 1 is the lowest level; Level 5 is the highest.  

Time-based escalation rules are used to define a sequence of escalation levels. For example, when a new 

issue is first submitted to the help desk, the issue is at Level 1. If the help desk does not respond to the 

issue within the target initial response time, the issue is escalated to Level 2. As more time goes by 

without either a response or a resolution, the escalation level of the issue is raised, until it reaches the 

highest escalation level.  

Escalation rules and SLAs are enforced only for issues where the Escalation State is set to On. Escalation 

State is a field on the SLA tab of a Web view. By default, escalation is on, but help desk analysts can 

pause or disable escalation.  

To edit the escalation levels:  

1   In VIZOR Web Admin, click the Choices tab. 

2   In the Project list, click a project. 

3   In the Choice List list, click Escalation Level. 

4   Edit the escalation levels: 

 To edit an escalation level, click the escalation level and then click .  

 Click  to create a new escalation level. 

 To delete an escalation level, click the escalation level and then click . 

 To reorder the list, click an escalation level and then use  and  to move it. 
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ABOUT ESCALATION RULES  

Escalation rules change the escalation level of an issue. Each service level has its own escalation rules.  

An escalation rule consists of conditions and actions. If all the conditions are true, then all the actions are 

executed.  

To define an escalation rule:  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the Project list, click a project. 

3   Click Service Levels. 

4   Click the Escalation Rules tab. 

5   Click Add, or click an existing rule and then click Copy. 

6   In the Escalation Rule Name box, type a name for the rule. 

7   Define the condition that triggers the rule. 

8   Define an action that changes the escalation level when the condition is met. 

9   Click the check box to enable the condition. 
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ORDER OF EVALUATION  

Escalation rules are evaluated in the order they are listed on the Evaluation Rules tab. The first (top) rule 

is evaluated first, then the next rule below it, and so on.  

You can change the order of evaluation by using the Up and Down buttons.  
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CONDITIONS  

You can define multiple conditions. When you have multiple conditions, all conditions must be satisfied 

before the corresponding actions are executed. 

Note that you must select the check box adjacent to a condition; otherwise the condition is disabled.  

TARGET TIME CONDITIONS  

You can define conditions based on the target response and closure times. For example, an escalation rule 

can escalate an issue if the issue has not been assigned to a help desk analyst within the guaranteed 

response time for that service level.  

Alternatively, an escalation rule can send an e-mail reminder when an issue has not been resolved within 

the guaranteed response time.  

<FIELD> = <VALUE>  

For convenience, the Add Escalation Rule editor allows you to easily add conditions that test the values of 

up to five choice list fields.  

MEETS THE QUERY <VALUE>  

For more complex conditions, you can use queries built with the Query Editor in VIZOR Admin. Queries 

can use any number and type of field to determine whether to escalate an issue.  

For any given record, VIZOR can carry out automatic assignment or reassignment (to users or groups), can 

carry out automatic escalation using the its SLA component, and even notify concerned parties based on 

any field (Be it based on changes, a particular SLA in force, an override or even a specific value for a 

important field like Category. Escalation rules can perform the following actions:  

 Change the issue priority, owner, assigned work team, or escalation level. 
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 Send an e-mail message. 

 Run a program. 

SENDING E-MAIL MESSAGES  

To send an e-mail message  

1   Under Actions, click Send an e-mail. 

2   In the E-mail Content editor, complete the To, Subject, and Body of the message. You can also attach 

files. 

EDITING THE TO, CC, AND FROM FIELDS  

You can use the macros or you can specify users.  

To insert a macro:  

1   Click in the To, CC, or From box. 

2   Under Available Macros, click the macro you want to insert. 

The Contact is the person who reported the issue, while Submitter is the person who entered the issue into 

VIZOR. For example, if a help desk analyst takes a support call, the contact is the person who called, and the 

analyst is the submitter.  

Previous Owner is useful when you send an e-mail message because an issue is reassigned.  

To add users to the To, CC, and From lists:  

1   Beside the To, CC, or From box, click . 

2   In the Select Users and Contacts dialog box, double-click the users and contacts you want to add. 

The list of selected users and contacts is displayed under Selected Users and Contacts. You can edit this string 

of text, for example, to remove a user, or to add the e-mail address of a person who is not a user or contact. 

NOTES 
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 The text box beside the Find button allows you to display all users and 

contacts whose names start with the same letters. In the text box, type the first 

few letters of the name and then click Find.  

To display the complete list of users and contacts again, delete all text from the box and then click Find.  

 Click Advanced to search for all users and contacts whose names contain the 

same string, or to search based on e-mail addresses. 

EDITING E-MAIL CONTENT  

You can use macros to insert the issue number, the name of the project, and the values of different fields 

(such as the Summary and Description Log).  

To insert the value of a field:  

1   In either the Subject box or the Body box, click where you want to insert the field value. 

2   Under Available Macros, click Field Value. 

3   In the Field Value dialog, click the field whose value you want to insert. 

If you want to insert the issue description, insert the Description Log field, not the Description field.  

To switch to HTML format:  

 Select the HTML in Body check box. 

ATTACHING FILES  

To attach files to an e-mail message:  

1   Beside the Attachments box, click . 

2   In the E-mail Content Attachments dialog, click Browse and locate the file you want to attach. Click 

Link. 

This adds the file to the list of files linked to this e-mail message. Every time the e-mail message is sent, the 

linked files are attached to the message.  
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RUNNING PROGRAMS  

To run a program, type the location and name of the program in the Run Program box. You can include 

command-line arguments for the program.  

The default working directory for programs is the Windows system folder (for example, 

C:\Windows\system32).  

NOTES 

Programs must not have a user interface or require any user input. The programs are run silently by the 

Mq.Evaluator service. By default, the programs are run under the credentials of the same user who runs 

the Mq.Evaluator service (CensusUser by default). You can check this in the Services dialog 

(Administrative Tools > Services, open the Properties for the service, and then go to the Log On tab).  
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SPECIFYING OPERATIONAL HOURS  

The operational hours define when the service level agreement is in effect. The service level clock stops 

running outside of those hours.  

For example, if the hours of operation are from 9 to 5, Monday to Friday, then a new issue submitted at 

4:59 p.m. on Friday is not going to trigger any escalation rules during the weekend. If the service level 

specifies an initial response time of 30 minutes, then the help desk has until about 9:29 a.m. on Monday 

before any escalation rules are triggered.  

Note also that help desk analysts can stop the clock for specific issues (by setting the Escalation State to 

Paused). For example, the analyst may “hit pause” while waiting for more information from the end user.  

To set the operational hours  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the Project list, click a project. 

3   Click Service Levels. 

4   Click the Operational Hours tab. 

5   In the Start Time and End Time boxes, enter the working hours during which the service level is in 

effect. Type the times in the format 9:00 AM or 5pm. 

6   Enter the number of working hours in a day. 

7   Add holidays and other exceptions to the standard working hours. 

a Click Add. 

1 Click the day you want to add. 

2 Click OK. 
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DEFINING SERVICE LEVELS  

To define a service level:  

1   In VIZOR Web Admin, click the SLA tab. 

2   Click Service Levels. 

3   In the Project list, click a project. 

4   Beside the Service Level box, click . 

5   In the Add Service Level dialog, type a name and a description for the service level. 
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CREATING SERVICE AGREEMENTS  

A service agreement is an agreement between the help desk and users. The service agreement defines a 

required level of service for the users.  

A service agreement can be with individual users (contacts), with all users in a department, with all users in 

a company or apply to everyone (Global).  

GLOBAL SERVICE LEVEL AGREEMENTS 

If you would like to define an agreement that will be applied for all issues that don't fall under other 

agreements for users, departments or companies, select Global for who the agreement is with. To 

override the global agreement for specific scenarios, you can still define agreements for certain users, 

departments or companies. 

 

To create a service agreement:  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the project list, click a project. (Each project has its own service agreements.) 

3   Define a service type. (Each agreement covers a specific type of service, such as Network, Software, or 

Hardware service.)  

4   In the Service Agreements section, click Add. 

5   In the Add Service Agreement dialog, enter the required information: 

Agreement Name The name used to identify the agreement. 

Agreement Description Allows you add some notes or comments related to the agreement. Note that you can 

also attach documents to an agreement. 

Agreement is with a  A service agreement can be with individual users (contacts), with all users in a 

department, all users in a company or everyone (Global). 

Agreement Customer Depending on whether the agreement is with a contact, a department, or a company, 

this list includes all the possible users, departments, or companies. If the agreement is global, this list is 

disabled. 

Reporting Period Choose whether reports for this agreement are weekly, monthly, quarterly, semi-annual, or 

annual. The reports are available from the Service Agreements section of the SLA tab (click the Reports 
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button). 
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APPLYING SERVICE AGREEMENTS TO ISSUES  

You can apply a service agreement to the issues that are already in the project database. To do this, use a 

query to specify the issues to which the service agreement is applied.  

To apply a service agreement:  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the project list, click a project. 

3   In the Service Agreements section, click a service agreement. 

4   Click Apply. 

5   In the Apply Service Agreement dialog, click a query. The agreement is applied to the issues returned 

by that query. 
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DISABLING SERVICE AGREEMENTS  

To disable a service agreement:  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the project list, click a project. 

3   In the Service Agreements section, click a service agreement. 

4   Click Edit. 

5   In the Update Service Agreement dialog, clear the Service Agreement is enabled check box and then 

click OK. 
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SERVICE LEVEL REPORTING  

VIZOR includes a set of service level reports to help you monitor and measure help desk performance 

against service level objectives,  

To view a service level report:  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the project list, click a project. 

3   In the Service Agreements section, click Reports. (If the Reports button is disabled, click a service 

agreement.) 

4   In the Service Agreement Reports dialog, click the report you want to view, and then click OK, or 

double-click the report.  

5   In the toolbar of the Crystal Reports viewer, click  to print the issue. Click  to save the report as 

PDF, Word, or Excel. 
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SERVICE TYPES  

A service type identifies a type of service delivered by the help desk to help desk customers. The Service 

Type (for example, software or hardware) is set when an issue is submitted.  

VIZOR includes default Business & Workflow rules that base the Problem Area on the Service Type.  

To edit the list of service types:  

1   In VIZOR Web Admin, click the SLA tab. 

2   In the Project list, click a project. 

Each project has its own list of service types.  

3   In the Choice List list, click SLA Service Types. 

4   Edit the service types: 

 Click  to create a new service type. 

 To delete a service type, click the service type and then click . 

 To rename a service type, click the service type and then click . 

 To reorder the list, click a service type and then use  and  to move the service type. 
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CHAPTER 33 - E-MAIL NOTIFICATIONS 

ABOUT NOTIFICATIONS  

VIZOR can generate notifications as email messages in order to inform team members, customers and any 

stakeholder about important events. Notification messages are sent through the native e-mail system.  

Automation at its most basic starts with automated notifications to keep your team members up 

to date with changes to reported issues. They don't have to run queries, inspect issues, and 

review revision histories to find out about changes. Instead, they get e-mail messages whenever 

new issues are assigned to them, whenever someone edits an issue already assigned to them 

and much more. 

You should try to keep the number of notifications to a minimum. Defining too many notifications for 

field updates can overwhelm users with e-mail, resulting in users missing important notifications. Use 

notifications for changes to fields like Owner, Status, and Priority.  

 

WHAT CAN YOU DO WITH NOTIFICATIONS?  

You can send notifications to specific users or contacts, or to the current owner, the previous owner, or 

the contact (the person who reported the issue).  

To trigger notifications, use simple when conditions that test for changes to an issue:  

 Sending a notification when an issue is reassigned  

When an issue is reassigned, you can use the <Owner> and <Previous Owner> to send notifications to both 

the new and the previous owner.  

Send Notification To: 

 <Owner>;<Previous Owner> 

When: 

 Owner Update  
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The when condition in this example tests for updates to the Owner field.  

 Sending a notification when a field is updated  

You can use the Update test to send a notification when a field is updated.  

When: 

 Priority Update AND 

 Revision Number > 1  

In this when condition, the Update test checks for changes to the Priority field.  

Testing the Revision Number allows you to distinguish between new issues and existing issues that have had 

their priority changed. Without the Revision Number > 1 test, a Priority Updated notification would be 

generated each time someone sets the Priority when they submit a new issue.  

 Sending a notification when a field is set to a specific value  

You can send a notification when the priority of an issue is changed to ASAPHighest. To do this, use a when 

condition that looks like this:  

When: 

 Priority Update AND 

 Priority = ASAPHighest  

This when condition sends a notification when Priority is changed. Without the test, a notification would be 

sent every time an issue with the specified Priority is saved.  

 Sending a notification when a new issue is submitted  

Each issue has a revision number that increases by one each time it is saved. When an issue is first submitted, 

this revision number is set to 1, so you can test the revision number to find new issues. For example: 

When: 

 Revision Number = 1 AND 

 Submitted Date = <Today> AND 

 Priority = ASAP OR Priority = TodayPriority = Highest OR Priority = High  

This when condition looks for new issues submitted today with the highest priorities.  

 Sending a notification when certain users update an issue  

If employees mark the issues they reported as Dropped or Resolved, you can notify the owner of the issue 

using this test:  

Send Notification To: 
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 <Owner> 

When: 

 <User in Group> = Employees AND 

 Status Update  

The <User in Group> macro allows you to test for user group membership. When a manager changes the 

priority of an issue, you can notify the owner of the issue. 

Send Notification To: 

 <Owner> 

When: 

 <User in Group> = Employees AND 

 Status Update 

 Sending a notification when an issue is resolved  

You can use the <Contact> macro to notify the submitter when an issues is resolved, or dropped. For 

example: 

Send Notification To: 

 <Contact> 

When: 

 Status Update AND 

 ( Status = Resolved OR 

  Status = Dropped )  

To send an e-mail with a different subject for each possible case (for example, Issue resolved, and Issue 

dropped), define a separate notification for each Status value.  

 

You can configure VIZOR to automatically generate notification messages that inform users of changes to the 

databases. Notifications work by monitoring one or more fields in the database and then sending e-mail 

messages to the contact, the owner, the previous owner, or a specific user when a change occurs. 

Notifications are sent using the native e-mail system. They can be used to keep users up-to-date with changes 

to issues avoiding the need to run queries, inspect issues, and review revision histories to find out about 

changes.  

Use notifications for changes to fields like Owner, Status, and Priority.Defining too many notifications can 

overwhelm users with e-mail, and result in them missing important notifications 
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THE AUTO – CLOSE NOTIFICATION 

 

The auto close tickets notification evaluates a specific ticket condition to close it. This can be useful in many cases 
such as managing deadlines or avoiding unresolved tickets from accumulating if not attended.This is a special 
"notification" that doesn't send any emails out, but rather closes the tickets when the preset criteria is met. 

 To set up the auto close feature, follow the steps below:  

  
1. Open VIZOR Admin and select the HelpDesk project 
2. Click on the "Project" menu and select the Notification Editor 
3. In the notification Name, select the "Auto-close Tickets" 
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4. In the "When" drop down menu, click on the "…" button to open the "When Editor" 

 

  
5. Set up the conditions you want the feature to work by and click on apply 

 

EDITING NOTIFICATIONS  

VIZOR Admin provides a Notification editor for editing notifications. To open the editor, click 

Notification Editor on the Project menu. With the Notification editor, you can:  

Specify who receives the notification. Select the names of one or more users from the Send Notification 

to list.  

• Define when you want the system to send the notification. Click the When list  button to 

define the condition.  

• Specify what you want to include in the notification message. The body of a notification message 

can include information from the issue or the revision history.  

• Specify the reason for the notification. Type a one-line description in the Notification 

Description box. You can include this description in the body of the e-mail message.  
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SPECIFYING NOTIFICATION RECIPIENTS 

While you can send notifications to specific VIZOR users and contacts, it is more useful to send 

notifications to the users listed in the Owner and Contact fields of an issue. You can do this using macros. 

For example, to send a notification to the owner of an issue, click the <Owner> macro in the Send 

Notification To list.  

<Owner> The user whose name is currently entered in the Owner field.  

<Previous Owner> The user who owned the issue before it was reassigned.  

<Dev Owner> In projects based on XSupportBugTrk, <Dev Owner> is the developer assigned to an 

issue, and <Owner> and <Previous Owner> are the current and previous support owners. 

<Contact> The person whose name is currently entered in the Contact field.  

<Purchase Stakeholders>Useful for notifications for Purchase Line Items. It will send to the Stakeholders 

of the Purchase Line Item, as well as the Contact, Stakeholders and Business Owner of the Line Item’s 

related License. 

DEFINING WHEN CONDITIONS  

When conditions determine when VIZOR sends notifications. A when condition is a test. If an issue 

satisfies the test, VIZOR sends a notification for that issue. You typically use when conditions to:  

 Test for updates of a given field. For example, a when condition can generate 

a notification when issues are reassigned (by testing if the Owner field has been 

updated).  

 Test for updates by a specific user or by users in a specific group. For 

example, a when condition can generate a notification when anybody except a 

manager updates the Priority.  

To edit the when conditions for a notification, use the When editor. Like the Query editor, the When editor 

allows you to combine multiple conditions with parentheses and the And and Or operators.  

To open the When Editor:  

Click  beside the When field in the Notification editor.  
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SENDING NOTIFICATIONS OF FIELD UPDATES  

To send a notification when someone edits a field, use the Update test.  

To send Update notifications for a field, select the Maintain Revision History check box for that field (in 

the Field Editor). 

BASING NOTIFICATIONS ON USERS  

The Field Name list includes the macros <User> and <User in Group>. Use these macros together with 

= and <> to test who updated an issue. For example, the following condition sends a notification when 

any employee updates the Status of an issue.  

 

SPECIFYING NOTIFICATION CONTENTS  

In general, the contents of the email notification sent can be of two kinds: 

• Pre-defined mail contents. 

• Based on an email template. 
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A notification message can include information about the event and entity that generated the notification. 

For example, if VIZOR generates a notification when a new high priority issue is submitted, the message 

can include a brief description, such as New high priority issue.  

Notifications generated because of changes to a field can include entries from the Revision History that 

show the changes. The notifications can also include either a summary or a complete copy of the issue.  

 

PRE-DEFINED MAIL CONTENTS 

To specify the contents, you select one or more of the following from the Include list:  

 Notification Description is the text entered in the Notification Description 

box of the Notification editor.  

 Detailed is a copy of the issue.  

 Revision Record is the entry from the Revision History for the change that 

generated the notification. 

 Summary is a brief summary of the issue.  

The Notification Description, Revision Record, and Summary are included as text in the message body. 

Detailed is included as a separate attachment.  

To change the information included in the Summary section, edit the Notification - Summary report. 

For the Detailed attachment, edit the Notification - Detailed Record report.  

By default, the Detailed attachment is an HTML file. If you use Crystal Reports for listing reports, the 

Detailed attachment is an RTF file. See Viewing Reports for more information on using Crystal Reports for 

listing reports.  

The subject of an e-mail notification message is automatically generated, and has this format:  

Notification [<project>]: Record <issue number>  

<notification name>  

For example:  

Notification [VIZOR]: Record 11 Status Updated  
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BASED ON EMAIL TEMPLATES 

To specify the contents of the email, you can also select one existing email template. In the notifications 

editor, select Advanced and then the option for the list of email templates. Select the desired one from 

the list.  

The email notification will be sent out using the email template Subject, Message Body and Attachments, 

with any macros resolved automatically. 

 

THE SUBJECT OF THE EMAIL  

The subject of the email can be set controlled in different ways: 

1) By default, notifications that do not use an email template have the subject of the email set to: 

Notification [<project name>]: Issue <entity ID> < Notification Description> 

e.g.: 

“Notification [HelpDesk]: Issue 13031 Issue reassigned” 

 

Emails that contain one of the pre-defined mail contents: Notification Description, Detailed, 

Revision Record or Summary, do not use an email template by default. 

 

2) The subject of the email can be set to simply be the same as the text of the Notification 

Description entered in the Notification Editor. 

e.g.: 

“Issue reassigned” 

If this is desired, you can set the target area of the mail content Notification Description to be 1 

(subject) in the tblMailContent table. 

 

3) To have an email notification containing one or more of the default mail contents: Notification 
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Description, Detailed, Revision Record or Summary, and with the subject customized, you need 

to mix pre-defined contents + an email template. 

e.g.: 

“Custom notification for ID# 2423 – Urgent !” + Revision Record in the email body. 

 

To implement this you need to edit directly the table tblNotifications: 

 

1 Using the Web email template editor, create an email template that only has a 
Subject. Keep the email body empty.  

2 Open the Notification Editor and create a notification using the email template 
created above (Advanced > Email Template). 

3 Configure the rest of the notification as needed, setting the recipients of the email, 
the mail contents, etc. Save and close the Notification Editor. 

4 In SQL Management Studio, open the table tblNotifications in edit mode in the DEF 
database of the project in question. 

5 Look for the desired notification to change. Each email notification has one row. 

6 Add “Mail Template” to the field “tMailContent”. Separate the values with a “;”. For 
example, “Mail Template;Revision Record”.   

7 Save the changes and close the table. You can test the notification now. 

 

 

 

MANAGING WORKFLOW WITH NOTIFICATIONS  

 

The Status of an issue indicates where the issue is in your issue tracking system. As the status of an issue 

changes from New to Assigned to In Progress to To be Verified to Resolved, different team members 

become responsible for the issue. 

For example, when the issue is assigned to a help desk analyst, you can use update notifications to help 

manage your help desk workflow. To do this, define a notification that is sent to <Owner> when the issue 

is assigned and the Status field set to Assigned. 

When the help desk analyst marks the issue an In Progress, you can send a notification to the employee 

who submitted the issue. Similarly, the an Employee updates the issue (for example, by adding more 

details to the description), you can have VIZOR notify the help desk analyst of the change. Each time the 



  Page 544 

 

current owner changes the Substate and reassigns the issue, VIZOR sends a notification to the new 

owner. For example, suppose a developer fixes an issue: 

14. The developer sets the Substate to Fix To Be Reviewed and reassigns the issue to the person 

responsible for reviewing the fix (the code reviewer). 

15. The code reviewer receives a Substate update notification telling them that they need to review 

the fix. 

16. After the code review, the reviewer then sets Substate to Reviewed and reassigns the issue back 

to developer responsible for the fix. The reviewer can also add notes and comments in the Fix 

Information field of the issue record. 

17. The developer receives a Substate update notification telling them that the fix is reviewed and 

accepted. 

18. The developer then checks in the fix, sets Substate to To Be Verified, and reassigns the issue to a 

tester. 

19. The tester receives the Substate update notification and reviews the fix. After the fix is verified, the 

tester sets the Substate to Fixed and the issue is closed.Related Topics 

 

SETTING UP NOTIFICATIONS  

To set up notifications for VIZOR Web, use:  

 VIZOR Web Admin, a Web-based administration utility. 

 VIZOR Admin, a Windows-based administration tool. 

To set up notifications:  

1   Set up the notification service. 

2   In VIZOR Admin or in VIZOR Web Admin, set the Mail Server options. These options configure the mail 

server used to send notifications, and specify how often the notification services checks for new 

notifications to send. For more information, refer to Mail Settings. 

3   In VIZOR Admin, define the notifications you want to send. 

SETTING UP THE NOTIFICATION SERVICE  
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VIZOR installs a Microsoft Windows service named Mq Issue Agent. This service runs on the server where 

you installed Vizor Web, and takes care of generating and sending e-mail notifications.  

In the Windows Services, you can specify whether you want the service to start automatically whenever 

the server boots or you want to start the service manually.  

TO SET UP THE NOTIFICATION SERVICE 

1   Open the Windows Control Panel. Double-click Administrative Tools, then double-click Services. 

2   In the right pane, right-click the Mq Issue Agent service, and then click Properties.  

3   On the Log On tab, select This account to choose a user account. Type the password for the account 

in the Password and Confirm password fields.  

The account must be a valid domain user account and have permissions through the network.  

4   Click Apply. 

5   On the General tab, stop and start the service. 

 

SETTING THE MAIL SERVER OPTIONS  

You can set the outgoing e-mail server options in VIZOR Admin or in VIZOR Web Admin. 

TO SET THE MAIL SERVER OPTIONS IN VIZOR ADMIN: 

1   Click Options on the Tools menu. 

2   Set the server mail options. These options are used when sending notifications. 

3   If you use an SMTP mail system, click Test to check your settings. 

 Option Description 
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 Server Mail Sender Name of sender for SMTP e-mail. Some SMTP mail 

servers require the sender name to be a valid e-mail 

address. Note that this name does not appear in the 

From field. 

 SMTP Server Name or IP address of your SMTP mail server. You can 

test your settings by clicking Test. 

 Server SMTP Port The port for the SMTP server. 

 Server Mail Interval Specifies how often (in minutes) VIZOR generates 

notifications. 

 Send Invalid 

Notifications To 

If the Maximum Notification Retries is surpassed, the 

notification will be sent to this address. If there is no 

address specified, the notification service will continue 

trying to send to the original recipient. 

 Maximum 

Notification Retries 

 

Mail Program to use 

for Notifications 

The maximum number of retries for e-mail 

notifications. Once surpassed, the notification will be 

sent to the address specified in the Send Invalid 

Notifications To option. 

Enter 1 to use the default mail sender. Enter 2 to use 

the Chilkat mailer. 

 

To set the mail server options in Web Admin, refer to Mail Settings. 

HANDLING NOTIFICATION FAILURES  

If VIZOR is unable to send a notification, it tries to resend the notification. By default, the maximum 

number of retries is 100. When the maximum number of retries is reached, the notification is sent to the 

e-mail address specified by the Send Invalid Notifications To option. 

To change the Maximum Notification Retries option or the Send Invalid Notifications To option, click 

Tools>Options in VIZOR Admin. 
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EXAMPLES 

SENDING A NOTIFICATION WHEN A NON-OWNER UPDATES A HELPDESK ISSUE. 

1 Open the Notification Editor 

2 Click the New Notification button. 

3 As a notification name, enter Owner Issue Edited. 

4 Click OK. 

5 Click the Send Notification To dropdown, select <Owner>. 

6 Click the […] button next to the When field. 

7 Click the New When button. 

8 As the when name, write Non-owner updated the issue. 

9 Click OK. 

10 Click the Field Name cell in the first When Condition row, and 

select the value Revision Number. 

11 In the Test cell, select >. 

12 In the Value cell, type 1. 

13 In the Operator cell, select And. 

14 Click the Field Name cell in the second When Condition row, 

and select the value Owner. 

15 In the Test cell, select <>. 

16 In the Value cell, select <User>. 

17 Click Apply. 
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18 Click OK. 

19 Click the When dropdown, and select the newly created Nonowner 

updated the issue entry. 

20 Set the Include field to <All>. 

21 In the Description field, write Someone edited your issue – see 

the included revision history changes. 

22 Click Apply. 

Log in, and create a new issue in the HelpDesk system, and make yourself the 

owner. Log in with another user, and then modify your issue. An e-mail should 

be sent to the e-mail address associated with your user account shortly. 

 

SENDING A NOTIFICATION WHEN VIP ISSUES ARE UPDATED 

For this exercise, we’re going to be treating the users “Jean Manager” and “Jean Developer” as VIP users. 

1 Open the Notification Editor. 

2 Click the New Notification button. 

3 As a notification name, enter VIP Update Notification. 

4 Click OK. 

5 Click the Send Notification To dropdown, select <Owner>. 

6 Click the […] button next to the When field. 

7 Click the New When button. 

8 As the when name, write VIP user updated highest priority 

issue. 

9 Click OK. 

10 Click the Field Name cell in the first When Condition row, and 
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select the value Revision Number. 

11 In the Test cell, select >. 

12 In the Value cell, type 1. 

13 In the Operator cell, select And. 

14 Click the Field Name cell in the second When Condition row, 

and select the value Priority. 

15 In the Test cell, select =. 

16 In the Value cell, select Highest. 

17 In the Operator cell, select And. 

18 Click the Field Name cell in the third When Condition row, 

and select the value Submitter. 

19 In the Test cell, select =. 

20 In the Value cell, select Jean Manager. 

21 In the Operator cell, select Or. 

22 Click the Field Name cell in the fourth When Condition row, 

and select the value Submitter. 

23 In the Test cell, select =. 

24 In the Value cell, select Jean Developer. 

25 Select the row you created in steps 24-26 and click the Add () 

button. 

26 Click Apply. 

27 Click OK. 

28 Click the When dropdown, and select the newly created VIP 

user updated highest priority issue entry. 

29 Set the Include field is set to <All>. 

30 In the Description field, write A VIP issue has been updated! 
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31 Click Apply. 

Log in as “Jean Manager” or “Jean Developer” (no password), and create a new issue in the 

HelpDesk system. Log in as “admin”, and modify this issue to have Priority of Highest, and 

change the Owner to admin. After saving the issue, further edits should trigger the notification. 
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SENDING A NOTIFICATION BEFORE THE EXPIRATION OF A PURCHASE  

(E.G. SUBSCRIPTION) 

In this notification we mean a purchase in the generic term, although in reality the notification will be 

applied to a Purchase Line Item. This is because the End Date is a field of the line item. 

For this example we will use the PurchasesAgreements project. In this project, both a Purchase and a 

Purchase Line Item are main records of the project. This means that when notifications are evaluated, the 

conditions you specify are evaluated for each Purchase and for each Line Item inside all purchases. 

Why is End Date a field of the Line Item and not of the Purchase record? 

A purchase in VIZOR can represent a real invoice, a purchase order or a purchase requisition in your 

organization. Sometimes, a single purchase may include multiple items, potentially of different types. 

For example, you may purchase 3 subscriptions in the same "purchase": 

    Microsoft Office 365 E3 

    Microsoft Office 365 E5 

    Microsoft Exchange Online 

And it may be that each line item expires in different dates: 

    Microsoft Office 365 E3        until    23-SEP-2021 

    Microsoft Office 365 E5        until    21-SEP-2021 

    Microsoft Exchange Online    until    20-SEP-2021 

And thus the End Date is per line item. 

The condition in a notification sent 60 days before expiration would look like this: 

To create the notification: 

1 Open the Notification Editor 

2 Click the New Notification button. 

3 As a notification name, enter “60 Before the Expiration of a Purchase”. 
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4 Click OK. 

5 Click the Send Notification To dropdown, select the macros: 

<Contact> 

<Business Owner> 

<Stakeholders> 

 

For this test, ensure the users you use in the Contact, Business Owner or Stakeholders have valid 

email addresses. 

 

6 Click the […] button next to the When field. 

7 Click the New When button. 

8 As the when name, write “60 Before Expiration”. 

9 Click OK. 

10 Click the Field Name cell in the first When Condition row, and enter this condition 

 End Date = <60 Days From Now> 

Type      =     Line Item 

 

* <60 Days From Now> is one of the built-in time macros available in VIZOR.  

 

11 Click Apply. 

12 Click OK. 

13 Click the When dropdown, and select the newly created entry. 

14 Set the checkboxes “Use Advanced Options” and “Use Mail Template”. 

15 Select the desired email template from the list. 

16 Click Apply. 

17 Test the notification. 
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CHAPTER 34 - GENERATING WEB 

VIEWS 

 WHAT IS A WEB VIEW?  

Web views are different views of a VIZOR project. Each Web view of a project can display different records 

and different fields. 

 

For example, employees don't need to see all the issues in the database, just the ones they reported. Also, 

they don't need to see internal notes and other information entered by the support staff. Support staff, on 

the other hand, need access to all the information in the issue database. 

VIZOR can break down the complete record database into simpler sets based on their purpose, origin 

and/or category. This will help to better adequate or personalize your experience for more streamlined 

processes which will end up in increased efficiency for all the parties involved. 

When logging in, the user will be greeted by a homepage like this (Different companies may have 

different homepage: 

 

A project is database of records of the main data you are tracking in that project (and their revision histories). Example 

of projects and their records can be: Help Desk – Issues, Resources – Assets, Users & Contacts - Employees 



  Page 555 

 

 

• Clicking on any of the links in this part of the homepage will take us to its web view. For this 

example, we will use the “Assets” link. 

• Once we click on it we will be taken to the Assets web view: 

 

• Queries within the web view will determine what records the user is able to retrieve from the 

project database.  
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For example, if an IT manager would like to know how many assets are in process of repair, the “assets out 

for repair” query will retrieve the asset instances that are currently on repair, giving the IT manager easy 

access to the specific information needed. 

 

ABOUT THE WEB VIEW EDITOR  

Use the Web View Editor to create, edit, and generate Web views.   

To start the Web View Editor from the Start menu:  

 Click Start > Programs > Vector > VIZOR > Web View Editor. On the Start 

menu, point to Programs, click Vector VIZOR, and then click Web View Editor. 

To start the Web View Editor from VIZOR Admin:  

 On the Tools menu, click Web, then click Web View Editor. 

The Tools > Web > Web View Editor command is also available when the Web View editor is installed on the 

same computer where you are running VIZOR Admin.  
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Example Web View Editor window. 
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ADDING/REMOVING FIELDS IN A WEB VIEW 

 

Adding a field:  

While on the Web View Editor, follow the steps below:  

1. Click on the fields option in the left side of the window. 

2. Choose the view you want to add the field to in the Project/View dropdown. 

3. Choose the tab where the field will be located withing your database records (Asset, issue, 

contact, etc. depending on your project database) 

4. Select the field you want to include on your view from the “available” field list. 

5. Click on the  button move the selected field into the “Export to View” list. 

6. Click on the  button to generate your web views to update them and include the new 

field.  

 

 

Removing a field:  
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While on the Web View Editor, follow the steps below:  

1. Repeat steps 1 – 3 from the “Adding a field” section. 

2. Select the field you want to remove from the “Export to View” list.  

3. Click on the button to move the field into the “Available” field.  

4. Click on the  button to regenerate your web view.  
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CREATING WEB VIEWS  

To create a new Web view, you must run the Web View Editor on the Web server. Web View Editors 

installed on other computers can only edit and regenerate existing Web views.  

You can either create a new, blank Web view or you can copy an existing web view. Copying allows you to 

reuse all the settings in the existing Web view. For example, when you copy a Web view, all the field 

attribute settings are copied.  

To create a new, blank Web view:  

1   Run the Web View Editor on the Web server. 

2   Click New View , type the name of the Web view, and click OK. 

3   In the Project Name list, click a project. 

4   In the View Type list, click the type of view you want to generate. 

5   Set the group access permissions for the view.  

6   Set the Web view attributes.  

7   Export fields to the Web view.  

8   Export queries to the Web view. 

9   Click  to save your settings and generate the Web view. 

NOTES 

 To log on to the Web view, click . 

 Click  to save your settings without generating the Web view. 
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GENERATING WEB VIEWS  

To generate a Web view:  

1   In the Project / View list, click a Web view.  

2   Click  to generate the Web view. 

3   To log off all users before generating the Web view, click Yes. If you click No, users logged on to the 

Web view do not see the changes until they next log on. 

4   Click Yes to overwrite the existing files. 

5   After the Web view is generated, click  to log on to the Web view and test it. 

NOTES  

 Always run Web View Editor with a user with elevated permissions.  

 You can generate Web views without using the Web View Editor. On the Web 

server computer, click Programs > Vector > VIZOR > Vizor Tools > Generate 

Web Views. 

 

 

COPYING WEB VIEWS  

You can create a Web view based on an existing Web view. Note that if you copy a view and then change 

the project, all view settings are cleared.  

To copy a Web view:  

1   In the Project / View list, click a Web view.  
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2   Click Copy . 

3   Type a name for the new Web view.  

The Web View Editor creates a new Web view that is an exact copy of the selected Web view. 

 

DELETING WEB VIEWS  

To delete a Web view:  

1   In the Project / View list, click a Web view.  

2   Click Delete . 

Deleting a view deletes all the generated files and folders (used by that Web view) on your server.  

SHOULD I DELETE A DEFAULT WEB VIEW? 

You should never delete not delete default web views. If you dont want to use them, remove access to the 

user groups in web view editor, this will make the views disappear from VIZOR them disappear and 

prevent user access. 

RENAMING WEB VIEWS  

To rename a Web view:  

1   In the Project / View list, click a Web view.  

2   Click Rename . 

3 Type a new name for the Web view.  
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GRANTING ACCESS TO A VIEW 

To grant access to a specific view for members of a designated group (for example, granting access to 

the Security View for the HelpDesk-Analysts group), follow these steps: 

6. Open the Web View Editor on your desktop and log in. 

7. Navigate to Web Views and locate the project containing the desired view (e.g., Users and 

Contacts or Security View). 

8. On the view's configuration page, click the three dots next to the Groups allowed to open field. 

9. In the dialog box, select the HelpDesk-Analysts group (or the group you want to grant access to), 

and then click Apply. 

10. At the top of the Web View Editor, save the view and click the Generate View (all files) button to 

apply the changes. 

 

Now the selected group has the necessary permissions to access the view. 
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TYPES OF WEB VIEWS 

NORMAL VIEWS  

Normal views allow users to submit and update issues, to view the history and e-mail conversation of the 

issue, to view reports and summary lists, and more.  This type of Web view has more features available 

than the other types and every user session (from logon to logoff) takes up one license.  

READ-ONLY VIEWS  

Read-only views allow users to review existing issues, but not to edit them. All fields are read-only, and 

users cannot create or submit new issues.  

KNOWLEDGE BASE VIEWS  

Knowledge Base views allow users to look through Knowledge Base Articles that have already been 

published by VIZOR analysts. These views are equipped with a quick search feature, as well as the ability 

to load a specific article by ID.  

The administrator can choose whether to create a Knowlege Base view that requires a logon, or not. If the 

view will not require the user to login, one privileged user account must be associated with the view.  

For more information, refer to Knowledge Base Views. 

FREQUENTLY ASKED QUESTIONS VIEWS 

Frequently Asked Questions views provide a list of articles from the Knowledge Base, specifically, all of 

those that have Article Type set to FAQ. These views feature a quick search feature, and the ability to open 

multiple FAQs right in the search results. 
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The administrator can choose whether to create a FAQ view that requires a logon, or not. If the view will 

not require the user to login, one privileged user account must be associated with the view. 

For more information, refer to FAQ Views. 

SUBMIT-ONLY VIEWS  

Submit-only views are used to only submit new records. A submit-only view is basically just a form and a 

Submit button. Users cannot run queries or edit (or even view) existing records. A typical example is for 

submitting HelpDesk tickets, where users may only open new tickets or issues but nothing else. 

A submit-only view allows an unlimited number of users to submit issues. All you need is a single VIZOR 

user account. Users automatically log on to the view with this account (in fact, users never see the logon 

window, they go straight to the view).  

This user account must belong to a group that has permission to open the Web view, and to add and 

update contacts. The account is used to set the Submitter field.  

If you have more than one submit-only view for the same project, you may want to create separate 

accounts for each view. This allows you to distinguish between issues submitted from different views.  

The user submitting the issue is considered the contact. Users must enter their contact information (name, 

e-mail, and so on) the first time they submit an issue.  

SELF-SERVICE VIEWS 

Self-Service views are a type of Web view to be used by either internal or external VIZOR users to enter 

issues and be able to view (and possibly edit) the issues they have submitted. You can choose to allow 

them to edit certain fields in issues that they have submitted (for example, the Description field); or allow 

them to edit fields that were left empty when they submitted the issue; or simply view their submitted 

issues in a read-only format. 

For more information, refer to Self-Service Views. 

HOW LICENSES ARE USED DEPENDING ON THE TYPE OF WEB VIEW  

Each user session in a Normal Web view takes up one concurrent or floating license. 
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Submit-Only views do not take up any license. 

Unlike normal Web views, the Knowledge Base, FAQ, Self-Service and Read-Only Web views follow a 

slightly different licensing model: for each concurrent license that is available, 5 logons will be allowed.  

For example, if you have 20 concurrent licenses, and 15 licenses are already being used in Normal Web 

views, that means there are 25 logons (5 free concurrent licenses times 5) available to the Knowledge 

Base, FAQ, Self-Service or Read-Only views. These 25 logons are shared across all four Web views - which 

means you could have a scenario where all logons are used up with the Knowledge Base view using 6 

logons, the Self-Service view using 8, the Read-Only view 4, and the Submit-Only view 7.  

If you have 20 concurrent licenses and none of them are in use, there are 100 logons available to the 

Knowledge Base, FAQ, Self-Service or Read-Only views. 

Reserving Licenses 

It is possible to reserve licenses for specific users. 

For more information, refer to Reserving Licenses. 

SETTING WEB VIEW ATTRIBUTES  

To set Web view attributes:  

1   In the shortcut bar, click  Web View. 

2   Click  (beside Attributes) to open the Web View Attributes dialog: 

AUTO REFRESH SUMMARY LIST  

Frequency (in seconds) to automatically refresh the Summary List. Enter 0 to turn off auto refreshing. 

By default, the summary list will refresh every 300 seconds (5 minutes). 

If you change this attribute, you must regenerate the Web view.  

 

CONTACT TAB IN RECORD DETAILS 
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Whether the fields exported on the Contact tab should appear in the record details section (tabs section) or 

just in the user details pop-up. 

If you change this attribute, you must regenerate the Web view.  

DESCRIPTION  

Description of the Web view. Displayed in the list of Web views that appears when a user logs on. The 

default description is the Project / View name. To include the project and view names in the description, use 

the macros <ProjectName> and <ViewName>.  

If you change this attribute, you must regenerate the Web view.  

DISPLAY ALL READ-ONLY FIELDS AS TEXT  

Read-only fields can be displayed as text (Yes) or as disabled controls (No). In a read-only Web view, all 

fields are read-only. In normal and submit-only Web views, read-only fields have been disabled through the 

Field editor.  

If you change this attribute, you must regenerate the Web view.  

INCLUDE VSS 

Adds the Version Control tab to the Web view. This tab allows users to link issues to source files in a 

Microsoft Visual SourceSafe database, and to perform version control operations such as check out and 

check in directly from a Web view. 

ISSUES PER PAGE  

The number of issues to show per page in the Summary List.  

TIMEOUT  

The number of minutes of inactivity before the browser session times out and the user is logged off.  
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LOAD ISSUES NOT IN QUERY  

If Yes, users can load any issue by typing the issue number in the Issue box of a Web view. If No, users can 

load only the issues shown in the Summary List.  

WEB VIEW TEXT  

Text that will appear above the fields on the first tab of the web view. 

If you change this attribute, you must regenerate the Web view.  

WEB VIEW TEXT CSS CLASS  

CSS Class to use for the Web View Text. For more information, see Applying CSS Styles. 

If you change this attribute, you must regenerate the Web view.  

WEB VIEW THEME  

Which theme to use for the web view. Themes alter visual elements like icons, text, etc. 

This is an advanced attribute, and usually does not need to be changed. 

If you change this attribute, you must regenerate the Web view.  

  

SETTING GROUP ACCESS PERMISSIONS  

You can control access to Web views on a group-by-group basis. When users try to log on, they see only 

the Web views that they have permission to access. The Web View Editor is thus a tool which can be 

used to define security and control for who can access authorization features like the approvals 

view when only a membership to a specific group is supposed to grant such clearance. 

To set group access permissions:  
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1   In the shortcut bar, click Web View . 

2   Click  (beside Groups Allowed to Open) to open the View Permissions dialog. 

3   In the Groups box, click the groups you want to be able to access the Web view. 

If you allow the Users group to open the Web view, then all users can open the Web view.  

The Groups box lists the groups that are allowed to open the project (as specified in VIZOR Admin).  

 

HOW TO HIDE CERTAIN BUTTONS IN WEB VIEWS  

.Some buttons are not controlled by features but are visible or not based on whether the user has access 

to the Web view. Use the Web View Editor to set the group access permissions that control who can log 

on to the Web views.  

WEB VIEW BUTTON VIEW TO SET PERMISSIONS 

ASSETS Add Assets Resources / AddGrp 

 Manage Asset Types Resources / Manage 

 User Assets Users&Contacts / EmployeeAssets 

 Import Configuration / Configuration 

   

CHECK IN / CHECK OUT User Assets Users&Contacts / EmployeeAssets 

   

SOFTWARE LICENSES Software Assets Resources / SWAssets 

 Software Asset Types Resources / SWAssetTypes 
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 Software Installations Installations / Library 

   

WEB VIEW Button View to set permissions 

SOFTWARE ASSETS Add Assets Resources / AddGrp 

 Software Asset Types Resources / SWAssetTypes 

 Software LicenseManager / Licenses 

   

SOFTWARE ASSET TYPES Software Installations Catalog InventoriedSoftware / Catalog 

 Hidden Asset Types Resources / HiddenAssetTypes 

 Software LicenseManager / Licenses 

   

SOFTWARE INSTALLATIONS Software Installations Catalog InventoriedSoftware / Catalog 

 Software LicenseManager / Licenses 

   

SOFTWARE INSTALLATIONS 

CATALOG 

Software Installations Installations / Library 

   

HIDDEN ASSET TYPES Manage Asset Types Resources / Manage 
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 Software Asset Types Resources / SWAssetTypes 

   

WEB VIEW Button View to set permissions 

ASSET TYPES Return to Asset Library Resources / Library 

 Hidden Asset Types Resources / HiddenAssetTypes 

   

USERS New User Onboard Users&Contacts / Add 

 Terminate User Accounts Users&Contacts / Batch Terminate 

 Import Configuration / Configuration 

 

 

KNOWLEDGE BASE VIEWS 

Knowledge Base views, or KB views, are a type of Web views used to openly publish specific information about certain issues. 

KB views act like Read-Only views only they are accessible by everybody. They can be designed to give customers and/or 

users such information as: 

 Solutions to known problems 

 Project-related news 



  Page 572 

 

 

 

USING KNOWLEDGE BASE VIEWS 

To use Knowledge Base views: 

In your browser, type or paste the KB view URL given to you by your VIZOR administrator. 

Type in a search word or phrase and click Go. 

Find the article (issue) in the summary list. 

Click an article in the summary list to open it and view its details. 

To integrate a Knowledge Base view to your website: 

Open the HTML file corresponding to the webpage in which you want the KB view link to appear. 

At the proper location, type <A href="URL">LINK TEXT</A>, where URL is the address specified in the 

Web View Editor, and LINK TEXT is the text you want to appear as the link. 

Browse to this webpage in your website and click on the new link to verify that it is functional. 

CREATING AND UPDATING A KNOWLEDGE BASE VIEW 

To create or update a Knowledge Base view: 
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Create a user account to be used as the KB view logon account (see Creating User Accounts). 

 

Note: 

The user specified in the Web View Editor must belong to a group who has access to the Ad-hoc Query 

feature. 

 

Use the Web View Editor to create or update KB views (see Creating Web Views). 

Set the proper username and password for the KB view account by clicking  beside the View Type list. 

Export to the view the desired fields to be displayed, including the Add To Knowledge Base field. 

To change the list of articles (issues) published to a KB view: 

Update the KB Query  to filter the issues as desired (see About Queries). 

To change the information (fields) displayed in a KB view’s summary list: 

Update the KB Layout  to include the desired fields (see About Layouts). 

Update the KB Sort to have the summary list ordered the desired way (see About Sorts). 

THE ADD TO KNOWLEGE BASE FIELD 

Knowledge Base views use their Project’s KB Query by default.  This Query controls which articles (issues) are accessible 

through the KB view.  The Add to Knowledge Base field helps define this Query and allows VIZOR analysts to easily specify if 

an issue is to be accessible as a KB article.  By default, the KB Query returns all the issues where this field is set to either 

Internal or Public. 

The Add to Knowledge Base field is found in the Resolution tab of the HelpDesk view by default. You will 

have to use the Web View Editor to export this field to other Web views if needed. Please note that this 

field must be exported to KB views when it is used in the KB Query; the Query will fail otherwise. 

Typically, you will set this field to "No" to prevent the opened issue from being published in the KB view, 

and set it to anything else to have it published. 
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SELF-SERVICE VIEWS 

Self-Service views are a type of Web view to be used by either internal or external VIZOR users to enter information and 

make minor changes to restricted records. For example, a Self-Service for HelpDesk tickets allows users to submit new 

tickets, be able to view and possibly edit the issues they have submitted. You can choose to allow them to edit certain fields 

in issues that they have submitted (for example, the Description field); or allow them to edit fields that were left empty when 

they submitted the issue; or simply view their submitted issues in a read-only format. 

USING SELF-SERVICE VIEWS 

To use Self-Service views: 

Log on to the VIZOR Web views and select the HelpDesk / Employee view. 

You will be able to create new issues and view any issues that you have submitted. 

By default, you will be able to edit the Description and Attachments fields of the issues that you have 

submitted. You will be able to edit the Computer Name field of the issues that you have submitted if there 

is no value already entered. 

CREATING AND UPDATING A SELF-SERVICE VIEW 

To create or update a Self-Service view: 

Use the Web View Editor to create or update Self-Service views. Please refer to the Generating Web Views 

section for further details on this procedure. 

To ensure the logged in user will only see the issues they submitted: 

Only export the My Reported Issues query to the Self-Service view. 

To specify which fields the user should be able to edit after the issue has been saved: 
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Click  beside the View Type box to open the Editable 

Fields dialog. 

The fields that are exported to the Web view will be available in the The user will always be able to edit 

list. 

Select the fields that the user should be able to edit after their issue is saved (up to a maximum of 2 

fields). 

Click OK and generate your Web view. 

To specify which fields the user should be able to edit if the field is empty: 

Click  beside the View Type box to open the Editable 

Fields dialog. 
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The fields that are exported to the Web view will be available in the The user will be able to edit only if 

empty list. 

Select the fields that the user should be able to edit after their issue is saved, if the field is still empty (up 

to a maximum of 10 fields). 

Click OK and generate your Web view. 
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EXPORTING FIELDS  

To export fields:  

1   In the shortcut bar, click Fields . 

2   In the Tab list, click a tab (a tab is a group of related fields). 

3   In the Available list, click a field and then click . This moves the field to the Export To View list, 

which lists the fields included in the Web view when it is generated. 

4   Use  and  to change the order of the fields in the Export to View list. The order of the fields in 

the list determines the layout of the fields in the Web view. 

NOTES 

 Click  to move all fields in the Available list to the Export To View list. 

 Required fields are exported by default. You can remove the fields—just 

ignore the warning. 

 The Field list in Ad-hoc Query editor lists exported fields only, plus the Issue 

field 

 Layouts show only exported fields. 
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EXPORTING QUERIES  

Queries control which issues a user can see in a Web view. For example, if My Submitted Issues is the 

only query available in a Web view, users can see only the issues they submitted.  

To ensure that users cannot access any issues other than the ones found by the exported queries, you 

should hide the ad hoc query editor. The Ad-hoc Query editor allows users to see any issue (for example, 

by running a query like Issue Number > 0, which returns all issues).  

In the Queries section, the Available box lists all the queries that you can export to the Web view. The 

Export to View box lists all the queries selected for export to the Web view.  

To export queries:  

1   In the shortcut bar, click Queries . 

2   In the Available list, click a query. 

3   Click  to move the query from the Available box to Export To View.  

NOTES 

 To move all queries from Available to Export To View, click . 

 To make a query the default for the web view, click Make Default. This query 

will be automatically selected when a new user first logs in; however, their 

preferences will take precedence from that point on. 

 

ADDING THE CHILD ISSUES TAB  

Web views can have a Child Issues tab that allows users to link one or more child issues to a parent issue.  

To add the Child Issues tab:  
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1   In the shortcut bar, click Fields . 

2   In the Tab list, click Child Issues. 

3   In the Available list, click the Child Issues field and then click . 

The Child Issues field is a special grid control that allows users to build a list of child issues.  

4   If you want to allow users to control whether child issues can have a different Status value than their 

parent, export the Status controlled by parent field (Details tab). 

By default, child issues have the same substate as their parent. Users can set Status controlled by parent to No 

to override this default behavior.  

5   Regenerate the Web view. 
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EDITING FIELD ATTRIBUTES  

The fields on a Web view are arranged in a two-column layout inside an HTML table. The order of the 

fields is determined by the order in which they are listed in the Export to View list.  

The appearance and layout of the fields can be customized through field attributes, which control options 

such as alignment, width, and height.  

To edit field attributes:  

1   In the shortcut bar, click Fields . 

2   In the Tab list, click a tab. In the Export to View list, click a field. 

3   Click Attributes to open the Attribute editor. 

The Attribute editor displays the attributes for the selected field.  

4   After you open the Attribute editor, you can edit the attributes for another field by clicking the field in 

the Field Name list. 
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USING FIELD VARIABLES  

Field variables allow you to insert the name, value, or id of a field into an attribute. The field variables are 

particularly useful with the Html code after control and URL attributes. 

Variable Inserts 

%fieldvalue% The current value of the field. For choice lists, 

%fieldvalue% is the ID of the choice. 

%fieldname% The name assigned to the input control (for example, 

cbo_18_cboPriority). 

%fieldid% The numeric ID of the field (this is the nID of the field in 

tblDtsFIelds). 

ADDING POP-UP EDITORS  

A Memo field such as the Detailed Description field has an Editor attribute that controls how the content 

of the field is edited. 

Value Description 

<None>  The Memo field is an editable text area 

in the Web view.  

HTML The contents of the Memo field are 

edited in a pop-up HTML editor.  

Text The contents of the Memo field are 

edited in a pop-up Text editor.  

 

  



  Page 582 

 

ALIGNING FIELDS  

Alignment  

Aligns a field (both the caption and the input control). Possible values are Left, Right, or Center. By 

default, all fields are left-aligned.  

 

Vertical Alignment  

Sets the vertical positioning of a field (both the caption and the input control). Possible values are: Top, 

Middle, and Bottom. The default is Top.  

 

AUTOMATICALLY UPDATING CHOICE LISTS  

Automatically Update List  

If Yes, the choice list is updated each time a user logs on to the Web view. To turn on the automatic 

update of choice lists, you must regenerate the view.  

If No, the choice list is updated only when the Web view is regenerated.  

NOTES 

Automatically updating a large number of choice lists may affect performance. You should automatically 

update only the choice lists that change frequently. 
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CHANGING FIELD CAPTIONS  

The Caption attribute specifies a text label for a field. Note that reports and the Field list in the Ad-hoc 

Query editor still use the original field name, not the value of the Caption attribute.  
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SPANNING COLUMNS  

FIELDS 

Set Column Span to 1 to have the field span a single column, or 2 to have the field span the entire width 

of the page.  

To make a field span 2 columns, you must also set the CSS Class to MemoFieldWidth. Use the 

SpanTwoWidthOne class if you want a field to span two columns but still be one column wide (that is, be 

alone on a line).  

For example, in the default VIZOR Web view, the Priority field uses the SpanTwoWidthOne class. For 

example, in the default BugTrk / Customer view, the How Found field on the Detail tab uses the 

SpanTwoWidthOne class. 

CAPTIONS 

Set Caption Span to 1 to have the caption span a single column, or 2 to have the caption span the entire 

width of the page.  

APPLYING CSS STYLES  

CSS Class  

Name of a style class defined in the cascading style sheet (CensusMain.css) used by the Web view. This 

class is applied to the controls (for example, the <input> form element for a text box). By default, fields 

use the classes ComboBoxWidth, MemoFieldWidth, and TextFieldWidth. These classes set the width 

and border of the control. ComboBoxWidth, and TextFieldWidth set the width to one column, and 

MemoFieldWidth sets the width to two columns.  

The CSS Class attribute does not apply to read-only/disabled fields. These fields use the readOnlyStyle 

class.  
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DISPLAYING READ-ONLY FIELDS  

You can display read-only fields as either text or as disabled controls.  

Read-only field displayed as text  

 

Read-only field displayed as a disabled control  

 

In a read-only Web view, all fields are read-only. In normal and submit-only Web views, read-only fields 

are fields that have been disabled through the Field editor.  

To set the default for all read-only fields in the Web view:  

1   In the shortcut bar, click Web View . 

2   Click  (opposite Attributes) to open the Web View Attributes dialog. 

3   Set Display All Read-Only Fields As Text to Yes or No. 

By default, this setting applies to all read-only fields in the Web view. 

To override the default for a specific read-only field:  

1   In the shortcut bar, click Fields . 

2   In the Tab list, click the tab that contains the field. 

3   In the Export to View list, click the field and then click Attributes. 

4   Change Display Read-Only Field As Text to No or Yes. 

When Display Read-Only Field As Text is set to Default, the field uses the value of the Web view attribute 

Display All Read-Only Fields As Text.  

NOTES  

 If you display a read-only memo field as a disabled control, the scroll bar is 

disabled, so the user may not be able to see everything in the field. 
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 You must regenerate the Web view after you change the Web view attribute 

or the field attribute. 

WIDTH 

Width in characters of a single-line text box, or width in pixels of a list box.  

The CSS classes assigned to text boxes and list boxes override the Width attribute. These CSS classes 

(TextBoxWidth and ComboBoxWidth) specify the widths of the input controls.  

INSERTING CUSTOM HTML CODE  

Html code before/after control  

HTML inserted before and after the control in the generated HTML page. Must be a single line of text. For 

example, suppose you want to add a help icon that displays a tooltip.  

 

A simple way to implement field-level tooltips is to put this HTML in the Html code after control 

attribute:  

<img src="help.gif" title="Tooltip text goes here">  

This inserts a help icon that displays a tooltip when a user points to the icon.  

A more generic approach would be to write a javascript function in CustomCode.js that returns a string of 

HTML.  

function getHelpIcon ( tooltip ) { 

 var str;  

 str = '<img src="help.gif" title="' + tooltip + '">';  

 return str;  

}  

The Html code after control would then call this function to get the HTML:  

<script type="text/javascript" language="javascript">document.write( 

 parent.objCustomCode.getHelpIcon( 'Tooltip text') 

); 
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</script>  

You must declare your function in CustomCode.js. Look for the public declarations at the bottom of the 

file, and add this line:  

 this.getHelpIcon = getHelpIcon;  

NOTES 

In the Html code before/after control attributes, you can use the string %fieldname% to refer to the 

name of the control. (The name of a control is the value of the name attribute on the form element.) For 

example, you could pass %fieldname% into the getHelpIcon() function, which would then return the help 

for that field. 

ADDING URL BUTTONS  

URL buttons open a new browser window and load the document specified by the URL attribute. A URL 

button is associated with a field, and can use the field value as part of the URL.  

For example, suppose you wanted to record the ID number of a Microsoft KB article that explains how to 

resolve a problem.  

 

To add a URL button that opens the specified KB article in a browser window, set the URL and URL 

Button CSS attributes as follows:  

URL = http://support.microsoft.com 

 /default.aspx?scid=kb;en-us;%fieldvalue%  

URL Button CSS = URLButton  

In the URL attribute, %fieldvalue% is a placeholder for the KB article ID number entered in the field.  

If you omit the http:// prefix from the URL, VIZOR automatically adds it when you generate the Web view.  

The URL Button CSS attribute identifies the CSS classes used for the button. VIZOR includes several 

different URL button classes you can use:  

 URLButton 



  Page 588 

 

 MailToButton 

 RemoteControl 

URL buttons always open a new browser window, even when you specify a URL like 

mailto:xsupport@company.com.  
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TEXT BOXES  

Number of Characters  

Maximum number of characters per line in the text box.  

MULTI-CHOICE LISTS  

Number of Visible Items  

Number of items visible in a multi-choice list. Users can always see items that are outside the visible 

window by scrolling the list box.  

Show Selected Items In Text  

 

Shows a comma-separated list of the selected items in a text box above the multi-choice list. This helps 

users see what items are selected.  

Show Selected Items In Tooltip  

Shows a comma-separated list of the selected items in a tooltip. This helps users see what items are 

selected in a multi-choice list.  

 

 

 

CONFIGURING CHOICE LISTS 
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The tblUser table can contain a large range of entries. For example, a big organization can have several 

thousand users and contacts, whereas a smaller organization may have only a few tens of entries. Use the 

Select from dialog attribute to specify the method which support staff can use to make a selection from 

single- or multi-choice lists populated from the tblUser table. 

To specify the type of choice list control you want to use: 

1   In the Web View Editor, select the Web View that contains the fields you want to work with. 

2   Select Fields in the shortcut bar. 

3   Select a field you want to customize, and click the Attributes button. For example, to select the control 

type for the Contact field in the Console’s Overview tab, select Contact.  

4   Choose a control option: 

To display the data in a search dialog, click the Select from dialog attribute and click Yes. A browse  button 

is displayed alongside the field to enable users to open the Search dialog. (Select from dialog = Yes is used 

by default.) 

To display the data in a drop-down list, click the Select from drop-down list attribute and click No.  

We recommend you select the No option only when the field can contain fewer than 100 entries as it can 

take several minutes to populate a large drop-down list.  

5   Click Close to save your changes. 

 

LINKING USER DETAILS 

When dealing with issues, support staff often need to request more information from users or ask them to 

perform checks on their computers. To help support staff contact users, you can configure VIZOR to make 

user details available through a dialog linked to the User, Contact or Company fields.  

To link to user details: 

1   In the Web View Editor, select the Web View that contains the fields you want to work with. 

2   Select Fields in the shortcut bar. 

3   Select User and click the Attributes button.  

4   Click the Link to user details attribute and click Yes. 

5   Click Close to save your changes. 
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The contents of the field are underlined when users mouse over it in the Web View. This indicates a link to 

the contact details of the selected person. 

 

HIDING FIELDS  

Setting Visible to No hides the field in the Web view. The field is still included in reports and listed in the 

Field list of the Ad-hoc Query editor.  

 

POINTING USERS TO WEB VIEWS  

The URLs for a normal or read-only Web view are displayed in the Web View Editor. The VIZOR Logon 

URL is for users with VIZOR users accounts. The Windows Integrated Logon URL is for users whose 

Windows user accounts have been imported into VIZOR.  

 

The default page at the URL is logon.asp.  

For Submit-only and Knowledge Base views, you have to add the logon.asp file name and a query string 

to the URL displayed in the Web View Editor. For example:  

http://server/vit/logon.asp?View=VIZOR%2FReport%20Issue  

http://server/vit/logon.asp?View=VIZOR%2FKB 

http://server/census/logon.asp?View=BugTrk%2FSubmit%20Issue 
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http://server/census/logon.asp?View=BugTrk%2FKB 

The query string (the part after the question mark) specifies the project and view:  

View=<project>%2F<view>  

%2F is the escape sequence for a forward slash (/). Spaces in the view name are replaced with the escape 

sequence %20.  

 

CHANGING URLS AND DIRECTORIES  

A Web view is accessed through a URL like //server/vit, where server is the name of the Web server 

computer, and vit is the name of a virtual directory.  

On a Web site hosted by Microsoft Internet Information Services (IIS), a virtual directory is an alias (a 

short, descriptive name) that is mapped to a directory on the Web server.  

The Web View Editor includes a Web View wizard to help you:  

 Change the URL (for example, change //nan/vit to //nan/CallTracking) by 

changing the virtual directory.Change the URL (for example, change //nan/BugTrk 

to //nan/bugs) by changing the virtual directory. 

 Change the directory where the Web view is published. 

There are two ways to change the URL. You can create a new virtual directory, or you can use a existing 

virtual directory.  

To change the URL by creating a new virtual directory:  

1   In the shortcut bar, click URL . 

2   Click  to open the Web View Wizard and then click Next. 

3   Click Advanced, click Create a new URL and a new Directory, and then click Next. 

4   Type the name of your Web server and click Next. 

5   In the Web Site list, click the Web site where you want to create the virtual directory. 

6   In the Virtual Directory box, type the name of the new virtual directory. 
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7   In the Path box, select the directory where you want to put the generated Web view files. 

8   If you need to change the user account used for anonymous access to the virtual directory, select the 

Show advanced options check box. 

9   Click Next and then click Finish. 

To change the URL by using a different virtual directory:  

1   In the shortcut bar, click URL . 

2   Click  to open the Web View Wizard and then click Next. 

3   Click Use existing URL and click Next. 

4   In the Web Site list, click the Web site that contains the virtual directory you want to use. 

5   In the Virtual Directory list, click the virtual directory you want to use.  

By default, the Virtual Directory list contains only the virtual directories used by VIZOR Web views. To show 

all the available virtual directories, select the Show all virtual directories from IIS check box.  

6   Click Next and then click Finish. 

To change the directory:  

1   In the shortcut bar, click URL . 

2   Click  to open the Web View Wizard and then click Next. 

3   Click Advanced, click Update existing virtual directory, and then click Next. 

4   Click Next and then click Next again. 

This assumes you want to change just the directory, not the Web server, Web site, or virtual directory.  

5   In the Path box, select the new directory where you want to put the generated Web view files. 

6   If you need to change the user account used for anonymous access to the virtual directory, select the 

Show advanced options check box. 

7   Click Next and then click Finish. 
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CHANGING THE WINDOWS ACCOUNT  

VIZOR needs a Windows domain account to use for:  

 Anonymous access to the virtual directories on the Web server. 

Anonymous access is required to run any Web view or VIZOR Web Admin, which are all stored in virtual 

directories on the Web server.  

 Access to VIZOR databases in a distributed configuration, where the 

databases are not on the Web server. 

 Access to attachments, which may be stored on a different computer than the 

Web server. 

 Access to Vector Asset Management site databases 

By default, VIZOR uses the CensusUser account, which is created when you install VIZOR. The default 

password for the CensusUser account is nd5kvmWJ.  

The CensusUser account is a Windows domain account.  

NOTES 

If you change the password for the CensusUser account, or delete the user account and use another one, 

you must update the virtual directories in the Internet Service Manager (Windows) or Internet Services 

Manager (Windows 2003, 2000, XP). 

To change the Windows account used for anonymous access to a virtual directory:  

1   Open the Web View editor. In the shortcut bar, click URL . 

2   Click  to open the Web View Wizard and then click Next. 

3   Click Advanced, click Update existing virtual directory, and click Next. 

4   Click Next until you get to the Virtual Directory Properties dialog. 

5   Select the Show Advanced Options check box. 
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6   In the User Name box, enter the name of the user account.  

Click Browse to locate a domain user account.  

7   In the Password box, type the user account password. 

You can also use VIZOR Admin to change the Windows account.  

To change the Windows account used by VIZOR:  

1   Open VIZOR Admin. 

2   On the Tools menu, click Windows Account. 

3   Enter the name and password of the domain user account you want to use. 

This user account is used for anonymous access by all subsequent Web views you generate.  

NOTES 

When you change the user account used for anonymous access with the Web View Editor or VIZOR Web 

Admin (Notifications tab), all required permissions and rights are automatically set. 

 

SETTING DEFAULT VALUES FOR A WEB VIEW BASED ON USERS OR GROUPS 

To set default values for a Web view:  

1   Log on to the Web view. 

2   In the Web view toolbar, click Defaults . 

3   In the Default Values dialog, set the field values you want to use as defaults for new issues. 

4   Click Apply. 

This creates a file named MqDefaultValues.js in the folder 

CensusWebVD\<project>_<view>\Users\<logon-name> 

where <logon-name> is the name you used to log on to the Web view.  

5   Copy the file 
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\CensusWebVD\<project>_<view>\Users\<logon-name>\MqDefaultValues.js 

to  

\CensusWebVD\<project>_<view>\Users\Users\MqDefaultValues.js 

The folder Users\Users applies to all users that log on to the Web view.  

6   Copy Users\Users\MqDefaultValues.js to the CustomizedFiles folder. 

For example, if you want the default values to apply to all Web views of the HelpDesk project, copy 

MqDefaultValues.js to:  

CUSTOMIZEDFILES\#Project#HelpDesk\#AllWebViews#\Users\Users  

If you want the default values to apply only to the HelpDesk_HelpDesk view, copy MqDefaultValues.js to:  

CUSTOMIZEDFILES\#Project#HelpDesk\#WebView#HelpDesk_HelpDesk\Users\Users  

NOTES  

 Users can override these default values by setting their own defaults. 

 You can remove the Defaults button from Web views by disabling the Default 

Value Editor feature. 

  



  Page 597 

 

 

CHAPTER 35 - TEMPLATES AND THE 

CUSTOMIZEDFILES FOLDER  

The files that make up a Web view (such as .JS, .CSS, .HTML, and .ASP files) are generated from templates. 

If you edit the original templates, your customizations apply to all Web views. In addition, if you edit the 

generated files for a Web view, you must reapply your changes every time you generate the view.  

To customize specific Web views without editing the generated files, you put your customized files in a 

special CustomizedFiles folder. Each time you generate the view, the Web View Editor copies your 

customized files from the CustomizedFiles folder into the view. 

  

HOW ARE THE FILES IN THE CUSTOMIZEDFILES FOLDER TEMPLATE USED?  

 

1. CustomizedFiles will only contain files modified by the customer. 

• In 2.3.2.306, it has default old files. These files should not be removed. 

 

2. SPTemplates contains special template files that are part of VIZOR. Like the Templates folder, 

these are installed by the Setup program and should not be modified directly. 

 

3. All files in Templates are copied to the root of the runtime folder first (CensusWebVD). 

4. All files in the SPTemplates are copied after, ALWAYS replacing any file in the runtime folder and 

following the template folders wildcards rules. 

5. Files in the CustomizedFiles are copied after, replacing any file in the runtime folder ONLY if the 

version in CustomizedFiles is newer. The process also follows the template folders wildcards rules. 

6. All files in the Logos folder of CustomizedFiles are copied to the runtime folder. 
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The source folder is: "..\CustomizedFiles\#AllProjects#\Theme\images\logos" 

 

CHECKING CUSTOMIZATIONS BEFORE UPDATING TO A NEW VERSION 

 

If you have made customizations by adding files to the CustomizedFiles folder, they need to be reviewed 

before updating VIZOR to a new version to check if the customization needs to be updated to be 

compatible with the new version or discarded. 

To determine if there are customized files, search in the CustomizedFiles folder and look for any file 

modified/updated more recently than 1-jan-2019.  

We can ignore all the files older than this date. 

If there are files in that folder modified after this date, report and consult with our Technical Services 

before updating the VIZOR server. 

 

 

WHAT HAPPENS AFTER AN UPGRADE OF VIZOR? 

After an upgrade, it is likely that old CustomizedFiles will not be copied to the runtime folder and 

therefore not be ‘active’.  

This is by design. With the exception of logos, files in CustomizedFiles need to be analyzed and make 

compatible with the new version explicitly.  

The new version of the file needs to have a more recent modified date than the file it is replacing, once it 

has been tested for compatibility.  

  

Often customizations can be discarded if they have been incorporated into the product. The customized 

file needs to be checked by an expert of VIZOR to determine if the customization has been incorporated 

and, if not, to modify the old customization to be compatible with the new version. By default old 

customized files are not used by VIZOR. 
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CUSTOMIZING WEB VIEW FILES  

To customize Web view files:  

1   In the <ConnectServer>\CensusWeb folder, create a CustomizedFiles folder. 

<ConnectServer> represents the folder where your VIZOR Server is installed.  

2   In the CustomizedFiles folder, create a folder structure to hold the customized files. 

To customize files for all Web views of all projects, create this folder structure:  

 

To customize files for all Web views of a specific project, create a folder structure like this:  

 

 

 

 

 

and replace connect with the name of the project.  

To customize files for all Web views accessed through a given URL, create a folder structure like this:  

 

and replace CensusWeb with the last part of the URL. (For example, if the actual URL is 

http://SERVER/connect , replace CensusWeb with VIZOR).  

Use this approach if you generate Web views outside the ConnectServer folder.  

3   Copy the files you want to customize from the view into the CustomizedFiles folder.  

You must recreate the same folder structure. For example, if you want to customize files in the HTML, JS, and 

Reports folders of Web views of the VIZOR project, you must create this folder structure:  

http://server/connect
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4   Customize the files and generate the view. 

 

CUSTOMIZING SHARED WEB VIEW FILES  

You can also customize the files that are shared by Web views accessed through the same URL. These are 

the files found in the CensusWebVD folder, such as logon.asp.  

To customize the files in CensusWebVD for all Web views:  

Put the files in the folder  

CustomizedFiles\#AllProjects#  

-or- 

CustomizedFiles\<virtual directory>  

To customize files for all Web views accessed through a given URL:  

Put the files in the folder  

CustomizedFiles\<virtual directory>  

For example, if the URL is //server/vit, then put the customized files in a folder named CustomizedFiles\vit.  

Use this approach if you generate Web views outside of the ConnectServer folder.  

 

OVERRIDING CUSTOMIZATIONS  
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To override the customizations in #AllWebViews# for a given Web view, you can create a 

#WebView#<project>_<view> folder. For example:  

 

The files in #WebView#VIZOR_VIZOR override all #AllWebViews# customizations.  

You can create a #WebView#<project>_<web view> folder in any of the three customization folders 

(#AllProjects#, #Project#<project>, and CensusWeb).  

 

 

CUSTOMIZING THE WEB VIEW INTERFACE  

You can customize most of the HTML and ASP pages that make up a Web view. If you edit the templates, 

make sure to backup the original files before you begin your customization.  

CENSUSMAIN.CSS  

Style sheet for a Web view. The normalfield, requiredfield, and disabledfield classes define the 

appearance of the fields.  

TMPLCENSUSMAIN.HTM  

Defines the frame structure for the frames that make up the Web view page. You can change the size and 

position of each frame, add and remove scrollbars, and set the frame border size.  

TMPLTOOLBAR.HTM  

Defines the Web view toolbar.  
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TMPLSUMMARYLIST.HTM  

Defines the Summary List. You cannot customize this page.  

TMPLSQE.HTM  

Defines the Ad-hoc Query Editor.  

TABS.ASP  

Defines the layout of the tab navigation buttons.  

TMPLCMDBAR.HTM  

Contains the navigation controls.  

When editing these files, do not change references to file names, the <WC@ ... > tags, or any of the 

Javascript code.  
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CHAPTER 36 - SECURITY TOPICS 

 

OVERVIEW OF SECURITY TOPICS 

There are several topics around security in VIZOR. 

For example,  

- Security and access control to authorized data in VIZOR   

- Security and access control to authorized features in VIZOR   

- Authentication to log in to VIZOR 

- Secured sessions while using the VIZOR application  

- Security and access control to external resources using VIZOR   

VIZOR has many security controls in place to allow only authorized staff and users to view, open, modify, 

authorize and in general work with data based on their role.   

VIZOR security enables managing user access to data (assets, purchases, incidents, etc.) and features (be 

able to add a new asset, delete an asset, etc.).  

VIZOR’s security is based on the user groups.  

Users can be created within VIZOR or imported/synchronized with an external system, such as Active 

Directory. When the users originate in an external system, you can also define what VIZOR group the 

members of an external group are imported into in VIZOR.  

 

USER GROUPS  
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Each user is a member of one or more groups. Access to VIZOR features and projects is based on group 

membership. You can enable and disable features and projects on a group-by-group basis. A user can 

only access a feature or project if the user is a member of a group where the feature or project is enabled.  

To control access to VIZOR features, you assign users to the groups based on their roles and 

responsibilities in the process. For example, a help desk group leader or analyst who is also responsible 

for administering VIZOR must be a member of the Admins group.  

 

SECURITY AND ACCESS CONTROL TO AUTHORIZED DATA IN VIZOR 

Use the Web View Editor to set the group access permissions that control who can log on to the 

Web views of a VIZOR project.  

CONTROLLING ACCESS AND SECURITY OF A FIELD 

 

VIZOR has multiple ways to control access to your data. Since data is mostly stored in fields, controlling 

access and security of a field is paramount. 

 

Methods to control access and security of a field: 

• Visible or Hidden, in the Field Editor 

• Disabled or Read-only, in the Field Editor 

• Read-only for specific user groups, in the Field Editor 

• Visible or Hidden per Web View, in the Web View Editor 

• Read-only per Web View, in the Web View Editor 

• Visible or Hidden under custom conditions, using the Business Rule Worfklow Editor 

• Read-only under custom conditions, using the Business Rule Worfklow Editor 

• Create custom macros using scripting programming language to reflect unique or complex 

conditions. 

• Because access to Web views can be controlled per user group, and you can create any number of 

Web views, you can combine all these to defined eseentially any possible security, access or 

authorization situation. 

 

SECURITY AND ACCESS CONTROL TO AUTHORIZED FEATURES IN VIZOR   
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The main mechanism to authorize users to use features in VIZOR is via the VIZOR Features. Features allow 

users to create new assets or delete assets, for example. 

The following is an example of all the features that a user can be granted access/authorization to: 
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In VIZOR, access to the information is usually via the Web UI.  

VIZOR user accounts always belong to one or multiple User Groups, which give them different profiles or 

security roles. VIZOR Accounts can also be integrated with Windows AD domain accounts, individually per 

user or via mapping AD Security Groups or OUs to VIZOR User Groups.  

This architecture gives powerful and comprehensive control on access to the data to different users. 

VIZOR can be configured to limit access to individual users to specific computers or groups of computers, 

specific fields per device, the ability to make certain changes to the device information, etc. 

By default, VIZOR includes the following user Groups (you can think of them as roles): 

User Group 

 

Access to Views 

Software Managers Software Licenses 

Agreements & Purchases 

Employees 

My Actions 

 

IT Asset Managers 

 

Assets 

Employees 

Locations 

Agreements & Purchases 

My Actions 

Roles & Policies 

 

IT Managers Assets 

Software Licenses 

Employees 
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Locations 

Agreements & Purchases 

My Actions 

Roles & Policies 

Approve Change Requests 

Help Desk Incidents 

 

Employees  Request Assets 

Search KB 

Submit a HelpDesk Ticket 

Helpdesk Analyst Help Desk Incidents & Problems 

Change Requests 

Search KB 

 

HR Manager New Employee Onboard 

Batch Onboard 

Terminate Employees 

Employees 

Locations 

Roles & Policies 

Release Manager Release Management 
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SECURED SESSIONS WHILE USING THE VIZOR APPLICATION 

VIZOR sessions via the browser communicate to the Web Server using the HTTP/HTTPS protocol.  

By default, HTTPS is used and recommended, which ensures communication between the VIZOR Web and 

the server is secure and encrypted. 

 

SECURITY AND ACCESS CONTROL TO EXTERNAL RESOURCES USING VIZOR 

You can control access and authorization of users to a 3rd party, external system via the Request Portal 

and custom VIZOR Actions. These VIZOR Actions interact with the external system and grant or remove 

access to features depending on the configuration. 

ACTIVE DIRECTORY ACTIONS 
  

VIZOR can also control security aspects of your network or external systems via the AD connector. The 

following actions can be automated via the native AD adapter. 

• Add user to Security Group 

• Assign user to OU 

• Change user password 

• Create user account 

• Delete user account 

• Disable user account 

• Enable user account 

• Remove user from Security Group 

• Reset user password 
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SECURITY IN VECTOR DISCOVERY 

 

This section only applies to customers using the Vector Discovery, not when integrating with Microsoft 

ECM, LanSweeper, SolarWinds, etc.  

The Vector Discovery Server (a.k.a. Vector Asset Manager) communicates with regular Vector Discovery 

Clients using the HTTP protocol. The server uses IIS for both receiving and sending requests to and from 

the client. 

 

IP PORTS 

By default, this communication occurs over port 443 (for https) but it can be configured to use any port 

designated by the organization. 

 

SERVER-SIDE PROCESS  

Once the information is sent to the server (offline or caching area), the data is parsed and converted into 

information that is then added to the SQL Server database. This process is performed by the Vector 

Scheduler Windows Service, which runs under a Windows account designated during installation, which 

must have read/write permissions to the Offline Area, and SQL access to the database. 

 

 

CLIENT DEPLOYMENT 

Administrator privileges are required to install the Vector Client.  

Vector provides tools to push the client to be installed remotely, however, a number of security conditions 

need to be met in order for this to be successful (Admin$ share, local administrative permissions for the 

client push installer account, etc.).  
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For most environments, those where computers belong to an AD domain, Group Policy client installation 

and software update-based client installation methods offer a secure and simple method of installation. 

Including the Vector Client as part of the Computer OS image is also a secure way, provided you have 

access controls on the person who performs the installation/deployment of the OS. 

 

WINDOWS ACCOUNT ON CLIENTS 

By default, the Vector Discovery Client runs as a Windows Service. The service is called Vector Asset 

Management Agent and it is run using the Local System account by default. No additional Windows User 

Account is needed; however, it is possible to run the service with a different Windows user, ostensibly 

created solely for the Vector Discovery function. Keep in mind that if the user is changed, the user must 

have elevated privileges, and essentially be a local administrator, plus it needs to be valid in the 

computers where the client runs and a domain user account may not be valid for computers outside the 

LAN. 

  

INTERNET - DEPLOYMENT OUTSIDE THE ORGANIZATION’S NETWORK  

The Vector Discovery Client can be installed on a computer outside the organization’s LAN or WAN. If 

your VIZOR is in the Cloud and/or hosted by Vector Networks, then all your computers are in this case. 

When the Vector Discovery Client is outside the network, the client communicates with the server(s) via 

the Internet.  

In this environment, it is highly recommended to protect the Vector Discovery (a.k.a. Vector Asset 

Manager) Server behind a firewall and use TSL/SSL (https protocol) for the communication between the 

client and the server. The server can be in a DMZ network or the LAN. 

The firewall should be configured to use the designated port (80, 443, etc.) and it can be restricted to 

permit only inbound connections started from the outside. 

For increased security when exchanging information between the client and server, an encrypted security 

key is used which is unique to the site, and can be modified by the server. 
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In addition, you can also use public key infrastructure certificates for client communications. In this case, 

the IIS where the Vector server runs must be configured for HTTPS only and deploy the certificates to the 

clients. It is also possible to add SHA-256 signature or fingerprint. 
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CHAPTER 37 - MAINTAINING YOUR 

VIZOR SYSTEM 
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CHANGING THE DATE AND TIME FORMATS FOR WEB VIEWS  

The format of the dates and times entered and displayed in a Web view are controlled by the Regional 

Settings of the Web server, not the Regional Settings of the local computer.  

Web views use the short date format. 

SETTING UP THE CURRENCY 

Among the general languages or cultures supported by VIZOR, it may be needed to change some 

regional settings, like for the currency. 

 

If the server uses the same currency settings as the VIZOR default resources, there is no need to change 

any setting in VIZOR.  

For example, the culture for English in VIZOR is “en-US”, which uses “$” as the currency symbol. If VIZOR 

will be running in the UK and not using the dollar for currency, the Windows server, the SQL Server and 

the VIZOR resources need to be changed to use “£”. 

 

To facilitate this, you can just copy the file located in: 

\ConnectServer\CensusWeb\Templates\Project\localization\optional\uk\ResourcesCust.e

n-US.js 

 

And copy it to the customized files: 

\ConnectServer\CensusWeb\CustomizedFiles\#AllProjects#\Localization\en-US\ 

 

Then generate fully one web view (this files is shared among all Web views). Users may need to clear the 

cache of the Web browser to see the changes 
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ADMINISTERING VIZOR ON THE WEB  

VIZOR Web Admin is a Web-based administration tool that allows you to:  

 Add and edit users and contacts. 

 Define workflow rules. 

 Create new tabs. 

 Set up choice fields. 

 Enable e-mail notifications. 

 Migrate projects to SQL Server and move projects to different SQL Server 

computers. 

 Move attachments to a different computer. 

 Integrate InventoryLink VSS databases to VIZOR projects.  

LOGGING ON TO THE WEB ADMIN 

You can log on to VIZOR Web Admin directly from the Web View Editor, using the same logon account 

you used for the Web View Editor.  

To log on to VIZOR Web Admin  

Do one of the following:  

 In your Web browser, go to //server/vitadmin, where server is the name of 

your Web server. 

 In VIZOR Admin, click Tools > Web > Web Admin. 
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 At the Web server, click Start > Programs > Vector > VIZOR > Vizor Web 

Admin 

 In the Web View editor, click Admin and then click Log On. 

GENERATING VIZOR WEB ADMIN  

When you install the VIZOR Web Server, the setup program generates a copy of VIZOR Web Admin. If 

necessary, you can generate another copy of VIZOR Web Admin. For example, you may want to change 

the URL used to access VIZOR Web Admin.  

To generate VIZOR Web Admin:  

1   In the Web View editor, click Admin. 

2   If required, change the URL and directory for VIZOR Web Admin. 

3   Click OK. 

WINDOWS PERMISSIONS  

When you log on to VIZOR Web Admin, it uses your Windows credentials to run tasks if you are a 

member of the CensusAdminsGroup group or the local Administrators group on the VIZOR Server 

computer. Otherwise, VIZOR Web Admin runs tasks as CensusUser.  

Members of the CensusAdminsGroup group (or of the local Administrators group on the VIZOR Server 

computer) have the required permissions to perform any task with VIZOR Web Admin. The CensusUser 

account, on the other hand, cannot perform IIS-related tasks such as unloading virtual directories (when 

logging off users), and may not be able to relocate databases to other computers.  

During installation, the Setup program creates the CensusAdminsGroup group and adds all members of 

the domain Administrators group to the CensusAdminsGroup group. Setup also adds the 

CensusAdminsGroup to the local Administrators group on the VIZOR Server computer. The purpose of the 

CensusAdminsGroup is to control access to Web Admin.  

 

CONTROLLING THE FREQUENCY OF SERVICE TASKS  
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Settings for controlling the intervals of tasks executed from the Windows Service Mq Issue Agent: 

EXECUTE ACTIONS INTERVAL (ID 14) 

How often to execute Actions of type Provisioning and Deprovisioning. The value is in minutes. A negative 

value will turn off the task. 

 

CALCULATE LICENCES INTERVAL (ID 15)  

How often to calculate software licenses and compliance, based on software assets, installations and 

entitlements. The value is in minutes. A negative value will turn off the task. 

 

SEND EMAILS INTERVAL (ID 214) 

How often to send emails from the internal outgoing emails queue. The value is in seconds. A negative 

value will turn off the task. 

 

ASSETS VERIFICATION INTERVAL (ID 455) 

Verify and create assets from purchases. Evaluate software licenses and compliance. The value is in 

minutes. A negative value will turn off the task. 

 

EVALUATE NOTIFICATIONS INTERVAL (ID 202) 
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How often to evaluate notifications in the different projects. The value is in minutes. A negative value will 

turn off the task. 

 

RELOCATING DATABASES TO SQL SERVER  

VIZOR uses Microsoft SQL Server as the primary database backend. In addition, you can also run all or 

some databases in Jet/MSAccess. 

You can relocate (migrate) databases from Jet/MSAccess to SQL Server, or from one SQL Server to 

another.  

There are two types of databases you can relocate:  

 Global databases are the databases shared by all projects: the users database 

(users.mdb), the Web views database (censusweb.mdb), and the licenses 

databases (licenses.mdb). 

 Project databases contain issues and project definitions (such as the 

definitions of fields, queries, and reports).  

To relocate databases to SQL Server:  

1   Log on to VIZOR Web Admin: 

 In VIZOR Admin, click Tools > Relocate > Databases to log on to VIZOR Web Admin, where you can use the Relocation tab to 

relocate databases to SQL Server. 

 In your Web browser, go to //server/vitadmin, where server is the name of your Web server. 

2   On the Relocation tab, under Databases to relocate, select the databases you want to relocate. 

3   In the Relocate databases to this SQL Server list, click the computer to which you want to relocate 

the databases.In the Relocate databases to this SQL Server list, click the Web server computer. MSDE 

2000 databases must be on the same computer as  VIZOR. 

To relocate to a SQL Server instance, click Add a SQL Server to this list and then type the instance name 

using the syntax <computer name>\<instance name>.  

4   In the New location for database files box, enter the name of a folder on the Server where the 

database files (*.mdf, *.ldf) can be stored. 

The new location must be the path as seen from the Web server. If the SQL Server is in a different 

computer, enter a UNC., otherwise, enter a local path.  
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5   Click Apply to relocate the databases. 

6   During the relocation, you may be prompted for the password for the sa SQL Server login account. 

VIZOR needs the password so it can initialize the SQL Server. 

7   After the databases are relocated, regenerate your Web views. 

If you relocated the global databases, regenerate all Web views. If you relocated project databases, 

regenerate the Web views of the relocated projects.  

NOTES  

 We recommend that all databases be stored on the same SQL Server 

computer. This improves performance by reducing the amount of data sent over 

the network. 

 When relocating databases from one SQL Server to another, the locations of 

the physical data files (.mdf,.ldf) on both the source and target computers must 

be accessible from the Web server. Also, the user running VIZOR Web Admin 

must have full permission to move and create files on the locations . 

 Relocating databases logs off users and prevent users from logging on, so 

choose a time when there is little or no activity on VIZOR. 

 When you relocate a database to SQL Server, VIZOR creates a SQL Server 

database with one data file and one log file. After the database is created and is 

accessible in SQL Server, database administrators can add more files or configure 

the database as required. 

 VIZOR creates a SQL Server login account named censusapplication, which is 

used to connect to the SQL Server. 

TROUBLESHOOTING RELOCATIONS  

If VIZOR Web Admin cannot contact or initialize the SQL Server during relocation:  
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 Check the SQL Server is running. 

 Check the SQL Server is configured to use SQL Server and Windows 

authentication (Mixed Mode authentication). 

 Verify that the SQL Server login account sa exists, is not disabled, and has 

permissions to log into the master database in the SQL Server. sa must be system 

administrator in SQL Server.  

 Stop any antivirus software that is running on the SQL Server computer or the 

Web server computer. 

 Verify that the VIZOR Web Server computer and the SQL Server computer can 

communicate through the network (for example, use Ping to test connectivity). 

 Try using the IP address instead of the computer name to identify the SQL 

Server computer. 

 To relocate to a SQL Server instance, click Add a SQL Server to this list and 

then type the instance name using the syntax <computer name>\<instance 

name>. 

 Verify that both the SQL Server and the Web server are using the same 

protocol (by default, TCP/IP). To do this, use the SQL Server Server Network 

Utility on the SQL Server computer, and the SQL Server Client Network Utility on 

the Web server. 
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RELOCATING ATTACHMENTS  

When users upload attachments, the attachments are stored on the Web server. For example, the files 

attached to issue #3 in the VIZOR project are stored in the folder  

ConnectServer\vit\Data\Attachments  

For security purposes, you may want to move the attachments to a separate file server.  

To relocate attachments:  

1   In VIZOR Admin, click Tools > Relocate > Attachments. 

This logs you on to VIZOR Web Admin, where you can use the Relocation tab to move (relocate) attachments.  

2   In VIZOR Web Admin, click the Relocation tab and then click Relocate Attachments. 

3   Under Relocate the attachments for these projects, select the projects whose attachments you want 

to move. 

4   In the New location for attachments box, type or paste the name of an existing folder on another 

computer.  

 The Windows account (by default, CensusUser) must have (full) permissions on the new location.  

 The new location must be a UNC path (for example, \\sharename\Attachments) that the Web server can access. 

 The new location is the root folder where VIZOR creates folders to store the attachments. For example, if the new location is 

//fileserver/vitWeb  

then attachments to the VIZOR project are stored in 

//fileserver/VIZORWeb/vit/Data/Attachments  

If you created your own attachment field, then attachments are stored in 

//fileserver/vitWeb/vit/Data/<fieldname>  

5   Click Apply to relocate the attachments. 

6   After the attachments are relocated, regenerate the Web views of the projects whose attachments 

were relocated. 
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NOTES  

Relocating attachments logs off users and prevent them from logging on, so choose a time when there is 

little or no activity on VIZOR. 
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DELETING ISSUES, ASSETS AND OTHER RECORDS  

VIZOR allows authorized users to delete issues (helpdesk tickets), assets, software records, purchases, 

service requests or any other record from the database. 

You can delete them from two locations - the web views, and VIZOR Admin.  

To delete individual records in VIZOR (issues, helpdesk tickets, assets, software, etc.) from the web view, 

users need to be part of a group that has been given access to the feature. For more information about 

granting access to features, see Defining User Groups.  

To delete a range of issues in one operation, users must have access to VIZOR Admin. Both approaches 

come with the ability to recycle issue numbers, allowing them to be repurposed for future records. 

Unless your organization has a specific requierement to recycle the IDs for tickets, assets or purchases, 

you probably do not need to recycle them. 

 

TO DELETE RECORDS FROM WITHIN THE WEB VIEWS: 

1. In the VIZOR view locate the record you wish to delete in the summary list. You need to select a 

query that includes that record. 

2. In the summary list, click on the icon to Delete . 

 

3. Depending on the project, you may have the option to reuse the record number for a future ID.  
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TO DELETE RECORDS USING VIZOR ADMIN:  

1. In VIZOR Admin, click Delete on the Project menu. 

2. In the Issues to delete box, type the numbers you want to delete. 

You can type a specific issue number, a comma-separated list of issue numbers (for example: 1, 5, 7), or a 

range ( for example, 1-25). When specifying a range, both the start and the end numbers of the range would 

be deleted. 

3. If you want to reuse the issue numbers of deleted issues, select the Recycle Issue Numbers check 

box. 

Recycled issue numbers are assigned to new issues.  

 

DELETING MANY RECORDS 

You can delete multiple records quickly by setting the field "To_Be_Deleted" to 1. 

This can be done using a sql statement. 

Records with this value set to 1 will be delete by a backend process. In particular, this is done from the 

"Mq Issue Agent" service, in every cycle of the evaluation of notifications. 
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LOGONS EDITOR  

VIZOR Admin includes a Logons editor (on the Tools menu) that lists all users logged on to Web views, 

VIZOR Admin, VIZOR Web Admin, and the Web View Editor.  

The Logons editor displays the following information for each logon session: 

Name  

Logon name of the user.  

Date/Time  

Date and time that the user logged on.  

Workstation  

The user’s IP address or computer name.  

Project  

If the user is logged on to a Web view, the name of the project is displayed.  

Virtual Directory  

If the user is logged on to a Web view, the virtual directory is displayed. The virtual directory is the final 

part of the URL used to access the Web view. For example, if the virtual directory is named vit, then the 

URL is http://server/vit. You can use the Web View Editor to determine which views are at the specified 

URL.  

Virtual directories such as connect00, connect01, and connect02 are all accessed through the //server/vit 

URL.  

Application  

The component you want to work with. For example:  Web View, Web View Editor, Admin, or Web Admin.  
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LOGGING OFF USERS  

To log off a specific user:  

1   On the Tools menu, click Logons Editor. 

2   In the list of users, click a user. 

3   Click Log Off.  

To log off all users:  

1   On the Tools menu, click Logons Editor. 

2   Click Log Off All.  

Before logging off a user, a Web view displays a message telling the user that VIZOR is shutting down. 

You can give users a bit more time by sending an immediate message. To do this, set the Send 

immediate shutdown message project option to Yes.  
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SETTING THE MONITOR INTERVAL  

The Monitor Interval option (Tools>Options) controls how long (in seconds) VIZOR waits before:  

 Checking for messages from a Web view 

 Checking for user activity in a Web view 

 Terminating a user session when logging off users. 

The default interval is 60 seconds. If your Web server is on a slow Internet connection and you want to 

reduce network traffic, you can increase the monitor interval. Too large an interval, however, affects the 

time administrators have to wait when performing an action that involves logging off users.  



  Page 627 

 

ABOUT THE INTEGRITY EDITOR  

The Integrity editor (available from the Tools menu) allows you to remove database locks and validate the 

integrity of your databases. The integrity tasks apply to both SQL Server and Microsoft Access databases.  

REMOVE LOCKS  

LOCKS ON PROJECT DEFINITIONS  

Removes locks on project definitions, such as reports, queries, fields, and sorts.  

If the locked by another user message is displayed when you try to use VIZOR Admin, run the Remove 

Locks task to remove the locks.  

LOCKS ON USERS AND LOGON SESSIONS  

Removes locks on users and logon sessions. Users are locked while someone is editing a record in the 

users database (the users.mdb file or, in SQL Server, the USERS_MDB database).  

Sessions shown in the Logons editor can be locked. For example, you may not be able to remove a logon 

that is several weeks old because it is locked. Run Remove Locks to unlock the logon.  
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VALIDATE INTEGRITY OF FIELDS  

This task verifies that the issue database and the project definition database are synchronized and have 

the same set of fields. The task also checks primary keys and indexes.  

By running the Validate Integrity of Fields task, you can synchronize the backup issue database with the 

current project definitions database. 
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VALIDATE RELATIONSHIPS  

This task verifies that built-in related fields are set correctly in the issue database. In the VIZOR project, the 

only built-in related fields are State and Status.  

Validate Relationships does not apply to field relationships created with the Workflow editor.  
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VALIDATE INTEGRITY OF ISSUES  

This task verifies that the issue database and the revision history are in-sync, by checking the revision 

numbers stored in the different tables of the database.  

ENABLING AUTO REPAIR  

If you have problems running VIZOR Admin, use the Enable Auto Repair option on the Tools menu.  

Enable Auto Repair tries to repair VIZOR Admin by fixing broken references, linking tables, and 

recreating objects.  

To turn on auto-repair, click Enable Auto Repair in the Tools menu, then exit VIZOR Admin and log back 

on. While auto-repair is turned on, VIZOR Admin runs in repair mode, which may be slower than normal 

mode.  

To turn off auto-repair, click Enable Auto Repair again.  
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RELEASING DATABASES 

Some VIZOR administrative tasks start a shutdown process. Examples of such tasks include relocating 

databases, creating projects, applying changes in the Field Editor, generating Web views, and running 

integrity tasks.  

The shutdown process logs off users and releases databases. If you see a Still releasing databases 

message during the shutdown process, you can:  

 Click Cancel to stop trying to release the databases, and start logging off 

users. Do this only if you are sure that no one is using the databases. 

 Try to manually release the databases and then click OK. To release the 

databases: 

 Unload the virtual directories used by VIZOR. 

 Stop the Mq Issue Agent service. 

 Exit all VIZOR programs. 

 Exit any programs (such as Microsoft Access or SQL Server Enterprise Manager) that may be accessing the databases. 

Note that if you set the option Tools > Options > Always verify locked databases to No, VIZOR does 

not try to release databases during the shutdown process. In general, setting Always verify locked 

databases to No is not recommended, unless you know there is a process that regularly accesses the 

databases but does not affect VIZOR.  

UPLOADING LARGE ATTACHMENTS  

On Windows Server 2003 systems, the default size limit for uploaded files is 4096 KB. If a user tries to 

upload an attachment that exceeds this limit, the user may get "The page cannot be displayed" or 

"Cannot find server or DNS Error" error messages.  

To increase the upload limit for attachments:  

1   Using a text editor, open: 

\Program Files\Common Files\MetaQuest\Scripts\IIS\MqWVDConfig.vbs  

2   Set the constant UPLOAD_FILE_MAX_SIZE to the maximum size (in bytes) for uploaded attachments. 

For example:  
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UPLOAD_FILE_MAX_SIZE = 1048576   ' 1 MB  

UPLOAD_FILE_MAX_SIZE = 5242880   ' 5 MB  

UPLOAD_FILE_MAX_SIZE = 10485760  '10 MB  

3   Re-create the virtual directories where you want the new size limit to apply. Note that re-creating 

virtual directories logs off users. 

a   Start the Web View Editor. 

b   In the shortcut bar, click URL . 

c   Click  to open the Web View Wizard. 

d   In the Web View Wizard, click Next until you get to the last page of the wizard, then click Finish. This recreates the virtual 

directories associated with the existing URL. 

e   Click Yes each time the Wizard asks if you want to re-create a virtual directory and reset its properties. 

A URL (such as //Server/vit) has several associated virtual directories (for example, vit, connect00, 

connect01, and connect02).  

 

FIXING 404 ERRORS  

When VIZOR is installed on a Windows Server 2003 system, users may get 404 errors (File not found) 

when trying to open attachments. This is because IIS 6.0 on Windows Server 2003 only accepts requests 

for static files with extensions that it recognizes. You can prevent this problem by adding the extensions 

to MIME Types settings of the IIS server.  

To define a MIME type for a specific extension:  

1   Open Internet Information Services. 

2   In the console tree, right-click the virtual directory used for attachments, then click Properties. 

3   On the HTTP Headers tab, click MIME Types. 

4   Click New. 

5   In the Extension box, type a file name extension (for example, ini). 

6   In the MIME Type box, type the MIME type of the file (for example, text/ini). 

7   Apply your changes.  



  Page 633 

 

NOTES  

 You may need to restart the World Wide Web Publishing Service before your 

changes take effect. 

 For more information on MIME types, see MIME Types in the IIS 6.0 Manager 

Help. 

 The URLScan tool can also be configured to block processing of certain file 

name extensions. Verify these settings.  

FINDING THE CURRENT VERSION 

Keeping your VIZOR up to date is important to access to the newest features and the 

best functionality possible as new upgrades roll in, knowing your current build will help 

you determine if your VIZOR needs an update soon.  

The VIZOR version information is displayed on the logon page, located in the bottom-

right corner of the logon section. Refer to the image below for guidance. 

 

  

 

 

 

 

The version number is presented in a format like 7.7.0.319.020, where each segment 

provides specific details: 

• 7.7.0: The major release version. 

• 319: The specific build version, which indicates updates or patches applied. 
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• 020: Additional internal revision information. 

For example, in 7.7.0.319.020, the relevant version is 319, which identifies the specific 

build currently in use. 

 

CHAPTER 38 - IMPORTING DATA 

 ABOUT IMPORTING DATA  

VIZOR stores most of its issue data in the tblDts table of the issue database (<project>01.dat for 

Microsoft Access, <project>01_DAT for SQL Server). To import issue data into this table, use the Import 

Records command in the File menu of Vizor Admin. VIZOR stores most of its issue data in the tblDts and 

tblFixInformation tables of the issue database. tblFixInformation stores the information entered in the Fix 

tab (note that not all projects use the Fix tab). The Import Issues dialog shows the following information: 

Source table  

You import issues from a source table, which could be in Microsoft Access, SQL Server, a delimited text 

file, or a number of other formats.  

Source fields  

Source fields are the fields imported from the source table  

Destination fields  

Destination fields are the fields in the VIZOR database table tblDts.  

Mapped fields  

You map source fields to destination fields. When you click Start, the mapping determines how the source 

fields are copied to the destination fields.  

To import issues:  

1   Prepare your issue data and the VIZOR database.  

2   Import issue data into a source table. 
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A source table is an intermediate table that holds the issue data you want to import into tblDts and 

tblFixInformation.  

3   Map the fields in the source table to the fields in tblDts and tblFixInformation.  

4   Click Start to create new records in tblDts and tblFixInformation and to copy the imported issues from 

the source table into these new records.  
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WHAT CAN YOU IMPORT?  

The main tool to import and synchronize with external data is the VIZOR Import Manager tool. 

With it, you can import from sources like: 

• CSV files 

• Excel files 

• Active Directory (AD) If using AD logon authentication and/or synchronizing the information of 

user and employee accounts. 

• LDAP directories Similar to AD if using LDAP directories for logon authentication and/or 

synchronizing the information of users and employees. It can be in addition to AD. 

• Inventory / Asset Management / CMDB For automatically displaying hardware and software 

information of the computer experiencing the incident to the IT analyst/technician from 

HelpDesk, including the latest changes in the system.   

• Remote Control Using PC-Duo to allow IT analysts/technicians to connect remotely directly from 

HelpDesk/VIT to the employee desktop for troubleshooting. 

• Microsoft Dynamics CRM, if synchronizing the information of contacts, users and employees. It 

can be in addition to AD. 

• Microsoft Dynamics GP, for procurement, purchasing information. 

• SugarCRM, for contacts, customers and related records. 

• MailChimp, for contacts, customers and related records. 

• HR Systems, for employee information. 
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Most data integrations involve the following: 

• Create an import rule 

 

• Define the source type 

 

 

• Define the exact source 
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• Configure the import settings 

 

 

 

You can also use VIZOR Admin, which uses a Microsoft Access layer to import data. In this case, you can 

import from any of the formats and applications supported by Microsoft Access:  
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 Delimited text (values separated by commas, tabs, or other characters)  

 Fixed-width text (values arranged so that each field has a defined width)  

 Microsoft Excel (versions 2.x, 3.0, 4.0, and 5.0)  

 SQL databases, using ODBC drivers  

 Microsoft Access (databases other than the open database)  

 HTML  

With VIZOR, you can import data into any of the fields in the tblDts table. This table contains most of the 

issue data.  

You cannot use VIZOR to import data into the following tables:  

 tblUser, which contains user information such as the user's logon name, full 

name, e-mail address, and telephone number.  

 tblAttachment, which contains the names of the files attached to different 

issues.  

 Any of the tables that contain the possible values for choice lists. 

HOW RECORDS ARE CREATED  

When you click the Start button, VIZOR creates new records in tblDts and tblFixInformation, and copies 

the data from the source table into the new records.  

In general, if there is no mapping for a field or the imported data is invalid, VIZOR leaves the field blank. 

However, there are exceptions. The following summarizes how VIZOR handles fields when it creates new 

issues.  

Issue Number  

You cannot import issue numbers. VIZOR automatically assigns issue numbers to issues.  

Owner (nUserID)  
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You can import the full name of a user or the ID of the user in tblUsr.  

If there is no mapping or the user name is not found in tblUsr, the field is left blank.  

Submitter (nSubmitterID)  

You can import the full name of a user or the ID of the user in tblUsr.  

If there is no mapping or the user name is not found in tblUsr, the name of the current user is stored in 

the field.  

Contact (nOriginatorID)  

You can import the full name of a user or the ID of the user in tblUsr.  

If there is no mapping or the user name is not found in tblUsr, the name of the current user is stored in 

the field.  

Status  

You can import the ID of a choice value or the choice text. If there is no mapping for a choice list field, 

VIZOR sets the Status field to the choice with ID = 0 (by default, New).  

State  

You cannot import State values.  sets the State field based on the Status field.  

Time and Date fields  

You can import time and date values. If you do not map a date or time field, VIZOR sets the field to the 

current date or time. See the tblSubstate choice table for the mapping of Status values to State values.  

The Closed Date field value is imported only if the State is Closed.  

Imported date values should use the format yyyy/mm/dd.  

Imported time values should use the time format specified in the Regional Options of Windows Control 

Panel.  

Choice lists  

You can import either the choice ID (the nID of the choice in the VIZOR choice table) or the choice text.  

BEFORE YOU IMPORT  
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ADD FIELDS FOR IMPORTED DATA  

Compare the issue data you want to import against the fields in tblDts and tblFixInformation. If you want 

to import additional issue data for which there are no corresponding fields in these two tables, use the 

Field editor to add the required fields.  

CREATE A NUMBER FIELD TO HOLD IMPORTED IDS OR RECORD NUMBERS  

If you want to import the IDs or record numbers of your data records, create a numeric field in VIZOR. You 

can then map your record IDs to this field when you import your data.  

CREATE USERS AND CONTACTS  

Add users and contacts in VIZOR before importing data that contains user names.  

When you import user names into the Owner, Submitter, and Contact fields, the names must match the 

full names assigned to the users in VIZOR. You must use the users' full names, not their logon names.  

For example, if you import a set of issues owned by a user for whom no entry is defined, the Owner field 

is left blank.  

Note that you can import the numeric ID for a user in the tblUser table (users database).  

CUSTOMIZE VIZOR CHOICE LISTS TO MATCH THE IMPORTED DATA  

In VIZOR, customize choice lists to match the values you want to import. You could also change the values 

in the imported data to match the VIZOR choice lists. You could do this in the original issue data, or you 

could use Microsoft Access to modify the source table created when you imported the original issue data.  

IF YOU ARE IMPORTING TEXT FILES  
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If your issue data is in a text file, the first data record should contain the field names. Otherwise, VIZOR 

assigns the fields the names 1, 2, 3, and so on. This makes it harder to map the fields.  

Also, the first data record should have no blank fields. Microsoft Access uses the first data record to 

determine the data types of the fields. For example, if a date field is blank, Microsoft Access imports it as a 

text value, and you will be unable to convert the field into date format.  

BACK UP PROJECTS  

Make a backup copy of the issue database before you import any data. If you make a mistake mapping 

the fields, having a backup copy allows you to change the mapping and try again.  

LOG OFF USERS  

Make sure no one is using the project database while you import issues. Ask all users to exit VIZOR before 

you start to import issues.  

 

THE SELF SERVICE IMPORT ASSISTANT 

 

Beside the the import manager, the new VIZOR version has implemented the Self service import assistant. 

The assistant will let you import from an excel file. To import using the self service import assistant, follow 

the steps below: 
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1. On your Home Page, click on the “Users” link to access the “Users” web view:  

 

  

2. Once in the “Users” web view, click on the “Import” button to open the Self-Service 

Import assistant  
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3. The Import assistance will open, follow the instructions:  

a. Download the template from the link provided and fill in the user information to 

import.  

• The template will look like this. Update it with your user’s information  

 

• As seen on the image before, you will be asked to fill in your user’s information in 

the following fields:  

 

1. User’s First and Last name  

2. Unique ID: This is the ID of the person in the external source from 

where they were imported. For example, if the user was imported 

from an HR system, this would be the employee number  

3. Company name: The user’s company of origin  

4. Category: This includes several values as  

• Contractor 

• Consultant 

• Employee 

• Intern 

• Etc 

5. Email: The user’s email address.   

6. Fields highlighted in blue are mandatory, fields in black are 

optional.   

   

b. Click on Import files and then upload the file you want to import.  

c. If the “Enabled” slider is set to No, set it to Yes   

d. Once completed, if you aren't planning to import additional users again soon, set 

Enabled to No  
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4. Once the import is completed, the assistant will give you a rundown of the users 

imported. In this example, 424 users were processed, 423 were synchronized and 1 of 

them was a brand new addition. 

   

5. Your users should have been imported.  
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IMPORTING ISSUES INTO A SOURCE TABLE  

You don't import issues directly into the VIZOR tables. Instead, you import the issues into a source table. 

VIZOR copies the imported data into its tables after you define a mapping between the fields in the 

source table and the VIZOR fields.  

To import issues from a file:  

1  On the File menu, click Import Issues.  

2   Click New Source Table to import data from a text file, spreadsheet, or database table into a Microsoft 

Access table (the source table). 

3   In the Files of Type list, click the file format you want to import. 

To import issues from another VIZOR database (or from any other Microsoft Access database), click 

Microsoft Access.  

4   Click the file you want to import, and then click Import.  

To import issues from a VIZOR Access database, select the project01.dat file.  

5   In the Import Objects dialog, select the import options you want. 

If you are importing from a text file or spreadsheet, select the First Row Contains Field Names check box.  

If you are importing from a Microsoft Access database, select the tables you want to import.  

6   Click OK to import the data. 

VIZOR creates a source table named after the file you selected.  

7   To import another file, repeat steps 4 and 5. When you've finished importing, click Close.  

To import issues from a SQL database:  

1   On the File menu, click Import Issues.  

2   Click New Source Table. 

3   In the Files of type list, click ODBC. 

4   In the Select Data Source dialog, click the Machine Data Source tab. 

5   Find the SQL Server data source and click OK. 
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6   In the SQL Server Login dialog, type your SQL Server login ID and password. 

7   Click Options, and in the Database list, click a database. 

To import issues from a SQL Server database, click the issue database.  

8   Click OK. 

9   In the Import Objects dialog, select that tables you want to import. 

For SQL Server databases, the table to import is dbo.tblDts.  

10 Click OK. 
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COMBINING MULTIPLE SOURCE TABLES  

When you import issues into VIZOR, you work with one source table at a time. If your issue data is stored 

in two or more tables, you'll need to combine those tables into a single source table before you can map 

the source fields to the destination fields.  

First, use the Import Issues dialog to import each file into a separate source table, then use Microsoft 

Access to define a query that joins these source tables into a single table.  

IMPORTING ISSUES FROM PROJECTS  

In VIZOR projects, issue data may be split across two tables (tblDts and tblFixInformation) in the issue 

database.  

You need to merge the two tables before you can map the fields.  

To import issues from Microsoft Access .dat files:  

1   Click Add tblDts and tblFixInformation to the list of source tables. 

2   In the Source Table list, click qryMergeCensusTables. 

This query adds the combined fields from tblDts and tblFixInformation to the Source Fields list.  

3   Click Auto Map, and then click Start.  

To import issues from a SQL Server issue database:  

1   Add dbo.tblDts and dbo.tblFixInformation to the list of source tables. 

The source tables are named dbo_tblDts and dbo_tblFixInformation.  

2   Create a new query to merge dbo_tblDts and dbo_tblFixInformation.  

3   In the Source Table list, click the new query. 

This query adds the combined fields from dbo_tblDts and dbo_tblFixInformation to the Source Fields list.  

4   Click Auto Map, and then click Start.  

CREATING QUERIES TO MERGE SOURCE TABLES  
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The qryMergeCensusTables query merges two source tables named tblDts and tblFixInformation. If the 

source tables you want to merge have different names, you need to create a new query based on 

qryMergeCensusTables.  

To create a new query for merging source tables:  

1   Exit VIZOR Admin and open Program Files\Vector\ConnectTools\Admin.mdb in Microsoft Access. 

2   In the Objects list, click Queries. Click qryMergeCensusTables and click Design. 

3   In the View menu, click SQL View. 

4   In the SQL statements, replace all occurrences of tblDts and tblFixInformation with the names of the 

source tables you want to merge. 

5   In the File menu, click Save As and type a name for the new query. 

6   Close Admin.mdb. 

7   Open Program Files\Vector\ConnectTools\Admin.mde. 

8   Open the table tblImport and add a new record. In the tName column, type the name of the query. In 

the nID column, type a unique, numeric ID for the query (use the next available nID). 

9   Close Admin.mde. 

10 The new query is now available in the Source Table list of the Import Issues dialog.  
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MAPPING IMPORT FIELDS  

After you create a source table, you must define a mapping between the fields in the source table and the 

fields in tblDts and tblFixInformation. VIZOR uses this mapping to copy the imported data into the new 

records it creates in tblDts and tblFixInformation.  

To map a source field to a destination field:  

1   Click a field in the Source Fields list.  

2   Click a field in the Destination Fields list. The data in the source field is copied to this field when you 

click the Start button.  

3   Click the right arrow button to map the fields.  

To remove a mapping:  

1   In the Mapped Fields list, click a mapping. 

2   Click the left arrow button. 

MAPPING TEXT FIELDS  

Text fields, such as tBriefDescription, have a limit of 255 characters. Memo fields store large numbers of 

characters (in Access, up to 64000 characters; in SQL Server, up to maximum length of 231-1 

(2,147,483,647) characters).  

MAPPING MEMO FIELDS  

Import data into the mDetailedDescription and Activity$Log fields, not into the Description$Input and 

Activity fields. Import data into the mDetailedDescription and Notes$Log fields, not into the 

Description$Input and Notes$Input fields. 

IMPORTING CHOICE LISTS  
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Import either the choice text or the numeric ID of the choice in the choice table.  

IMPORTING USERS, SUBMITTERS, AND CONTACTS  

Import either the full name of a user, or the numeric ID for that user in the tblUser table (users database).  
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CHAPTER 39 - INTEGRATION WITH 

OTHER SYSTEMS 
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 INTEGRATIONS  

VIZOR is a very flexible and open IT platform and it has multiple integrations with external systems. 

 

Integrations are usually connecting and leveraging information that is produced or consumed by VIZOR. 

Integrations are key to having a clean and efficient IT service in an organization, avoiding duplication of 

data and assigning clear responsibilities to the data entities and processes. 

 

From the perspective of data flow, there are thre types of integrations: 

1. Data is input to VIZOR, sourced from the external system 

An example of this integration is Solarwinds, in which VIZOR imports and synchronizes 

the server information collected by Solarwinds, but Solarwinds is not modified in any way 

by the integration. 

 

2. Data is output from VIZOR and sent to the external system 

An example of this is the integration with some software deployment tools, which are 

controlled or triggered by VIZOR Actions to automated the allocation of software to 

users. 

 

3. Data is input and output to/from VIZOR and to/from the external system 

An example of this integration is with Active Directory, in which VIZOR imports and 

synchronizes the accounts from AD, but VIZOR can also modify AD, creating accounts, 

resetting passwords, etc. 

 

VIZOR offers various alternatives for integrations. You may use one or several approaches in your project, 

depending on your requirements. 

1. Via Email (simple configuration) 

2. Data Layer Integration 

3. Programming Extensions within VIZOR (intermediate) 

4. Web Browser API (advanced)  

5. Web Server API (advanced) 

6. Application Server COM AP (advanced)I 

7. Web View Settings & Configurations (advanced) 

 

 INTEGRATION VIA EMAIL 

Many systems have the ability to send or receive emails. VIZOR can take advantage of this and ‘talk’ to the 

external system to either continue a process in real time, trigger an event on the system, or send/receive 

data at the time of the event, One example is when a purchase is created in an accounting system and 

part of the information is sent in an email to a predefined email address that VIZOR monitors. VIZOR then 

converts the email and can potentially import data, create a ticket or trigger a custom workflow process.,  
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INTEGRATION VIA DATA LAYER 

VIZOR has a solid framework for integrating data with an external system, especially for data input into 

VIZOR so it is imported and maintained synchronized. 

The framework supports out-of-the-box SQL Server databases, MySQL databases, Excel worksheets, CSV 

and XML sources. You need to define the following elements when integrating with via the Data Layer: 

• Define the entity in VIZOR for which the external data should relate to (asset, software license, 

incident, user, contact, etc.) 

• Define the primary key of the external system 

• Define any fields or attributes from the external system that will be mapped to VIZOR fields. 

• Define any default values that should be added. 

• Define any unique fields that exist in the external system, relevant to the integration. 

• Define how often the integration should be executed. 

• Define any special conversions of data or adjustments needed in the mapping of fields from the 

system external into VIZOR. 

 

You will likely create a rule in the VIZOR Import Manager tool. The following tables in the USERS db will 

be relevant to define the schema and the behavior of the rule: 

• tblImport_ImpRule  

• tblDefaultValue_ImpRule 

• tblFieldMap_ImpRule 

Please contact Vector Networks support for more details about doing these integrations.  
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CHAPTER 40 - VIZOR LICENSE 

 

 

VIEWING YOUR LICENSE INFORMATION 

To check the number of available licenses, the license keys and related information, log on to VIZOR Web 

Admin and go to the Licenses tab. 

 

Evaluation licenses allow you to use VIZOR for a specified period of time. At the end of that period, you 

can no longer run VIZOR unless you provide a valid license key.  

Concurrent licenses are permanent licenses that allow a specified number of users to use  VIZOR 

simultaneously. With concurrent licensing, you only need licenses for the maximum number of 

simultaneous users. For example, if you have 30 users who need access to  VIZOR, but no more than 20 

log on at the same time, you need only 20 licenses. When all 20 licenses are in use, no additional users 

can log on until someone logs off. 

Named licenses are per-user licenses. Each license is dedicated to a specific user.  VIZOR automatically 

assigns named licenses to users as you create and disable user accounts. With named licensing, you 

cannot create more users than named licenses (for example, if you have five named licenses, then you can 

have at most five user). 

 

 

NUMBER OF LICENSES  

Shows how many users can run  VIZOR concurrently. The Access Enabled license key determines the 

number of concurrent users (to see the number of concurrent users, click Access Enabled in the Product 

list).  
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LICENSE TYPE  

Evaluation licenses are temporary licenses that have an expiration date. Concurrent licenses are 

permanent licenses that allow a specified number of users to use  VIZOR simultaneously.  

EXPIRATION DATE  

Shows the date at which the evaluation license expire and after which users will not be able to log into 

VIZOR.  

 

ENTERING LICENSE KEYS 

 

1) Login to Web Admin: http://< Server Name >/connectadmin (Different from the main VIZOR URL 

http://< Server Name >/connect) 

2) Log in with an admin account (the default admin remains valid for this) 

3) Select the Licenses & Logons tab 
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4) Click on the bottom right View / Edit licenses... button 

 

5) Paste the new key in the popup box 

 

6) Click "Add" 

7) Click “Close” 

 

 

 

RESERVING LICENSES  

VIZOR offers the ability to assign licenses to specific users. This way, the latter will always have access to 

Web views regardless of the number of users currently accessing the system. 

For example, if you have 10 licenses, and you wish to reserve 1 for a specific user (For example, 

'Employee'), this means you will only have 9 licenses left for other users to use. When 'Employee' logs in, 

VIZOR will automatically use his reserved license. If 'Employee' logs in a second time, while still using his 

reserved license, VIZOR will use one of the unreserved (floating) licenses.  
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To assign reserved licenses to a user, set a value for the Number of Reserved Licenses field. This is done via 

the Users and Contacts editor, as described in Editing User Information. 

For information on how concurrent licenses are handled, see Types of Web Views. 

To view how the licenses are distributed, or whether or not they are in use, go to the Licenses area in the 

Web Admin. 
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CHAPTER 41 - VIZOR PROJECTS 
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WHAT IS A VIZOR PROJECT?  

In  VIZOR, projects are used to keep data in separate databases. How you organize your VIZOR projects is 

up to you. You can have one project for tracking a new type of process that is unique and not similar to 

any existing database. To create and manage VIZOR projects, use Vizor Admin. 

A VIZOR project includes:  

 A database of data records or process and their revision histories, 

attachments, agreements, aprovals and e-mails. 

 A set of project-specific definitions, which include styles (queries, sorts, 

layouts, reports, and report pages), the fields, e-mail templates, choice lists and 

notification definitions. These definitions are shared by all users of a project.  

PROJECT STRUCTURE  

 

 

 

CREATING PROJECTS  

Typically, you start a new project because you want to tracking a completely different item or type of 

record or process in a new database.  
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New projects are always based on an existing project. When you create a new project, you can copy the 

data records, styles, notifications, Web views and the fields from the base project.   

To create a project:  

1   Start VIZOR Admin, and click New Project in the File menu. 

2   In the Project Name box, type the name of the new project. 

3   In the Base Project list, click the project you want to use as a template for the new project. 

4   In the Groups Allowed to Open Project, click the user groups that are allowed to access the project 

through VIZOR Admin, VIZOR Web Admin, the Web View Editor, or Web views. 

Note that access to individual  VIZOR components can be selectively disabled. For example, a group can 

have access to Web views of a project, but no access to Vizor Admin, Vizor Web Admin, and the Web 

View Editor.  

5   Under Global Styles and Notifications: 

 Click None to create a project with no queries, sorts, layouts, reports, or notifications. Only the fields are copied from the base 

project. 

 Click Copy from the Base Project to copy the definitions of fields, queries, sorts, layouts, reports, and notifications to the new 

project. 

If you are creating your first project, we recommend you use one of the sample projects that come with  

VIZOR as the base project. Copy the styles and notifications, but do not copy the issues and revision 

history. Also, read Building a Project Template before you start tracking issues.  

6   If you want to copy the issues from the base project, click the Copy issues and revision history from 

base project check box. 

7   If you don’t want to copy the Web views from the base project, clear the Copy Web views from the 

base project check box. 

Copying Web views from the base project can save time. For example, copying the Web views from VIZOR 

means you don't have to manually set up timestamping in a new Web view.  

 

 

COPYING DEFINITIONS AND STYLES  

A new project is always based on an existing project. The new project can start empty or take a copy of 

the styles, notifications, and fields in the base project. In the New Project dialog, select the option that 

corresponds to what you want to do with the new project:  
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 None  

Clear the styles and notifications so you can build your own. Copy the fields from the base project and 

use it as a starting point.  

 Copy from the Base Project  

Copy the styles, notifications, and fields from the base project and use them as a starting point, or 

template, for the new project. This is the suggested way.  

WHY COPY STYLES AND NOTIFICATIONS?  

Copying styles and notifications allows you to configure your new project faster by making changes on 

existing styles instead of creating them from scratch. For example, a new report may be very similar to a 

report that exists in the base project, with the only difference being that you need to add or replace new 

fields that only exist in the new project. In this case, it is faster to copy the styles, and therefore the 

reports, from the base project and then create the new fields and update the report in the new project.  

 

BUILDING A PROJECT TEMPLATE 

Before you start using  VIZOR to track issues, you should build a project template. A project template is a 

project that acts as the base for all new projects. The project template contains styles and definitions 

common to all projects.  

For example, a project template can define a standard set of queries, reports, and notifications. In 

addition, a project template can include a set of fields customized to match your company's process and 

terminology.  

Using a project template allows you to reuse custom styles, notifications, and fields. Each new project can 

copy the styles and definitions from the project template.  

Before you build a project template, you must evaluate your issue tracking and reporting requirements. 

For example, you should decide:  

 Which custom fields and choice lists are required. 

 Which standard queries and reports you want in each project. 
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 Which notifications are needed to the workflow in your process. 

To build the actual project template, create a new project based on the VIZOR project, then customize the 

issue fields and define the custom styles and notifications you need.  

 

DELETING PROJECTS  

TO DELETE A PROJECT:  

1   In VIZOR Admin, click a project in the Project list. 

2   On the File menu, click Delete Project. 

EDITING PROJECT PROPERTIES  

The project properties are displayed when you click a project in the Project list.  

PROJECT LOCATION  

Location of the project files, which includes the definitions database.  

DEFINITIONS DATABASE  

The name of the project definitions database. The definitions database contains the definitions of the 

fields, queries, sorts, layouts, reports, and notifications for the project.  

DATABASE ENGINE  
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Specifies whether the project uses Microsoft Access or SQL Server for the issue database.  

GROUPS ALLOWED TO OPEN PROJECT  

List of user groups that are allowed to open the project. Groups allowed to open a project can:  

 Log on to Web views of the project (if they also have permission to open the 

views). 

 Edit the project in VIZOR Admin (depending on what features are enabled for 

the group). 

 Edit views of that project in Web View Editor, or generate new views of that 

project. 

If the Users group is allowed to open the project, then all groups can open the project. The Admins group 

is always allowed to open projects.  

CURRENT USERS  

Displays the users currently logged on to Web views of the project.  

Name  

Logon name of the user.  

Date/Time  

Date and time that the user logged on.  

Workstation  

The user’s IP address or computer name.  

Project  

The user is logged on to a Web view of this project.  

Virtual Directory  



  Page 665 

 

The virtual directory is the final part of the URL used to access the Web view. For example, if the virtual 

directory is named vit, then the URL is http://server/vit.  

Virtual directories such as connect00, connect01, and connect02 are all accessed through the //server/vit 

URL.  

Application  

This is always Web View. The Logons Editor also lists the Web View Editor and Web Admin.  
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CHAPTER 42 - PLANNING AND 

DEPLOYING A CUSTOM PROJECT 

PLANNING  

Before you can set up your  VIZOR system, you need to understand your business structure and have a 

clear idea of the process you want to implement. The following sections illustrate the sort of information 

required to set up a typical  VIZOR installation. 

INFORMATION RECORDING AND TRACKING  

 What information do you want to record and track for each issue? 

 How do you categorize issues? 

 Do you want to provide different views of the issue data?  

For example, do you want a summary view optimized for logging issues and categorizing problems, and 

a detailed view for recording things such as how the issue was resolved, and how long it took?  

 Do you want to be able to link issues?  VIZOR supports parent-child 

relationships between issues.  

WORKFLOW  

 What is your help desk process? 

Can you represent the path of an issue through the process as a sequence of steps, or decisions, such as 

New, Assigned, Verified, Resolved?  

 Do you want to enforce this workflow process? 
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 Who needs permission to make decisions? Who is responsible for carrying out 

each step in the process? 

 Do you need e-mail notifications to enforce ownership and accountability? 

When issues are submitted or resolved, who needs to be alerted? 

ROLES AND RESPONSIBILITIES  

 What are the different roles and responsibilities of the people that use  

VIZOR? Can you identify different groups of users? 

 Do different groups have different requirements of the issue tracking system? 

Do you need to restrict access to the system based on group membership? 

For example, you probably want to restrict most users to the ability to submit and track issues. Support 

staff, on the other hand, require greater access to the system.  

 Do you need to manage and coordinate work teams?  VIZOR allows you to 

define work teams and the assign issues to them rather than a specific individual. 
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IMPLEMENTATION ROADMAP  

This roadmap outlines the major steps in implementing an issue tracking system. Performing the steps in 

the sequence recommended here save time and simplify the process.  

STEP 1. CREATE A PROJECT  

A project defines the fields, queries, sorts, layouts, and reports that you see in a Web view.  

1   Create a new project. 

2   Customize the fields in the project. 

3   Edit and define the queries, reports, sorts, and layouts to match the set of fields defined in the project. 

STEP 2. DEFINE USER GROUPS AND CREATE USER ACCOUNTS  

1   Define user groups and set group permissions to control access to data and administrative features. 

2   Create user accounts so people can log on. You can either import user accounts from Active Directory 

(or from a Windows domain), or create user accounts in  VIZOR. 

3   Assign users to groups. 

4   Define work teams and assign users to work teams. 

STEP 3. DEFINE AND GENERATE WEB VIEWS  

After you generate and test your Web views, you can perform more advanced customizations, such as 

defining workflow and notifications.  

STEP 4. DEFINE FIELD DEPENDENCIES (OPTIONAL)  
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Use the workflow editor in VIZOR Web Admin to make the possible values in one choice list depend on 

the choice selected from another list.  

You can apply changes made in the workflow editor without regenerating the Web view.  

STEP 5. DEFINE A WORKFLOW (OPTIONAL)  

Use the workflow editor in VIZOR Web Admin to define workflow rules to emulate your process. For 

example, you can enforce a sequence of steps by controlling the possible values of the Status field.  

You can also define rules that set the value of a field when another field changes. For example, you can 

define rules that assign an owner based on the problem area:  

When (Problem Area = Outlook), then set this value: (Owner = Resident Outlook Wiz).  

STEP 6. DEFINE SERVICE LEVEL AGREEMENTS  

A service agreement is an agreement between the help desk and users. The service agreement defines a 

required level of service for the users.  

A service agreements can be with individual users (contacts), with all users in a department, or all users in 

a company.  

A service level is a guarantee of a certain level of service. For example, a basic service level may provide 9-

to-5 service during the regular working week, while a more comprehensive service level might provide 24 

hour service, 7 days a week.  

Each service level has its own hours of service, target response and closure times for issues, and escalation 

rules.  

STEP 7. IMPORT EXISTING DATA (OPTIONAL)  

After you finalize the set of fields in a project, you can import information from existing databases.  
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STEP 8. DEFINE AND SET UP NOTIFICATIONS  

You can define and set up notifications after you generate your Web views, but you should do this before 

people start using the Web views to submit issues.  

STEP 9. GO LIVE  

Make your Web views available for general use.  

STEP 10. SYSTEM MAINTENANCE (ONGOING)  

You should regularly backup your projects, databases, Web views, and other system files.  
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CREATING A PROJECT  

A project defines everything you see in a Web view: the fields, queries, reports, sorts, and layouts.  

HOW MANY PROJECTS DO YOU NEED?  

Normally, you don’t need to create a custom VIZOR project. However, if you need to track different data, 

or design your own custom processes that are separate and in addition to Assets, HelpDesk Tickets, 

Software Licenses, Locations and People, then VIZOR is a great platform to create your own custom 

system.  

Each VIZOR project has its own database. In fact, two databases: one used for the data or process you 

want to track and another one for the schema and definitions of the VIZOR Project (fields, notifications, 

business rules, etc.)   

In most cases, it is recommended to reuse the existing VIZOR Projects. For example, you can record 

different types of issues in the same HelpDesk database by configuring Web views and queries. Separate 

projects are usually not needed, only if the requirements to customize the fields, queries, sorts, layouts, 

and reports, are significantly different from the default VIZOR projects.  

However, using separate VIZOR projects has some disadvantages:  

• It is difficult to generate reports across projects. 

• You need to maintain a new set of fields, business rules, etc. 

• You cannot create a single view that covers all projects. 

• It is difficult to link items from different projects 

• People who work with all three types of issue can find that separate projects 

are inefficient and time-consuming. 

CHOOSING A BASE PROJECT  
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A base project serves as a starting point for a new project. The new project inherits the fields defined in 

the base project, and can optionally inherit the styles (queries, reports, sorts, layouts, and notifications) 

and Web views as well.  

 VIZOR includes a default VIZOR project you can use as the base project. Before you create a new project 

based on VIZOR, you should familiarize yourself with the fields included in VIZOR, and understand what 

you can and cannot do when customizing fields.  

Designed for use in development projects, VIZOR allows you to record and track project-related tasks, 

feature and enhancement requests, user suggestions, and change notices.  

VIZOR includes over 60 fields, along with a complete set of reports, queries, sorts, layouts, and 

notifications based on those fields. Some of the default fields cannot be deleted, so even if you don’t use 

these fields, they take up extra space in your database.  

Before you delete a field, you must remove it from any report, query, sort, layout, or notification that 

references it. Deleting unused fields helps minimize the size of your database.  

CUSTOMIZING FIELDS  

You can edit and delete most fields in  VIZOR. For example, if a field is the right data type and size, but 

has the wrong caption, you can change the caption. Similarly, you can replace some or all of the entries in 

choice lists.  

Before customizing a project, you should familiarize with the fields, and determine:  

 Which of the existing fields you can use as is, or by changing the label, choice 

table, or tab 

 Which fields you need to add 

 Which the existing fields you want to delete 

You should also familiarize yourself with what you can and cannot do when editing fields.  

YOU CAN: 

 Add new fields. 

 Change field labels. 
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 Change the list of choices for a choice list and update the queries that test the 

choice values.  

If you change the Status choice list, you should either disable or update the default workflow rules 

because the default workflow is based on this list.  

 Delete most fields. 

To delete a field, you must first remove it from any queries, sorts, layouts, reports, and notification that 

use the field.  

Before you delete a field, go through the different queries, sorts, layouts, reports, and notification 

conditions and either remove the field or delete the style.  

 Create linked choice lists so that the contents of one list depends on a 

selection in another list. 

 Move fields between tabs. 

 Change tab names, and reorder the tabs. 

 Disable fields (make read-only) either for all users or for specific user groups. 

 Hide fields. Note that when you hide a field, it is hidden in all Web views. 

YOU CANNOT: 

 Change field types. 

For example, you cannot change a single choice field into a multi-choice field, or a Number field into a 

Text field.  

 Change the field size. 

For example, you cannot change the size of a text box from 20 to 30.  

 Delete certain fields. Some fields, such as Owner, State, and Status, cannot 

be deleted. 

When you generate a Web view, you can choose not to include specific fields. So even if you cannot 

delete them, you can remove them from all views. Of course, the fields  still take up space in your 
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database.  

 Use multi-choice lists in workflow rules. 

 Use multi-choice lists in formulas, charts, or cross-tabs when building custom 

reports with Crystal Reports. 

NOTES 

 If you need to change the type or the size of a field, the best thing to do is to 

copy the field and delete the original. When you copy a field, you can edit its type 

and size. Note that copying a field does not copy the stored data, and deleting a 

field destroys any stored data. 

WHAT HAPPENS TO STYLES  

Styles such as queries and reports are based on fields. For the most part, VIZOR Admin automatically 

updates styles when you customize the fields, but there are some exceptions.  

When you add a new field, you need to add it to the following reports:  

 Current Issue - Detailed 

Used to print the current issue in a Web view.  

 Notification - Detailed Record, Notification - Summary 

Used to format the contents or attachments to e-mail notification messages.  

NOTES 

 In a Web view, these reports show only the fields exported to the view. 
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WHEN YOU RENAME A FIELD  

When you change the label appearing on choice lists, VIZOR Admin automatically updates any reports 

and layouts that use the field name as a title.  

If you change just the Field Caption label, VIZOR Admin does not update any reports and layouts that use 

the field name as a title.  

If you rename a field such as the Status field, you may want to rename any sorts, queries, and layouts 

whose names are based on the name of the field.  

WHEN YOU EDIT A CHOICE LIST  

If you delete a choice from a choice table (for example, Assigned from tblSubstate, the Status choice 

table), then you have to update any queries that test the choice value. The same is true if you change the 

choice text (for example, from Assigned to Started).  

You may also have to update custom reports that use the choice list. For example, when you change the 

choice text, custom reports that use a specified sort order add the new choice to the Others category. 

You should also check the workflow rules if you edit the Status choice list.  

WHEN YOU DELETE A FIELD  

Custom reports that use the deleted field do not display properly. For example, if a custom report uses 

the field for calculations, or as a chart axis, then deleting the field invalidates the report. In many cases the 

report still works, but the data does not make sense.  
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CREATING GROUPS AND GRANTING PERMISSIONS  

Groups enable you to restrict access to Web views or administrative features. Typically,  groups match the 

different roles in a process. For example, if you have separate groups for employees, help desk staff and 

asset managers, you can prevent employees from opening the same Web views used by the help desk 

team and the asset managers.  

 VIZOR includes several built-in groups that cannot be deleted: Users and Admins. It also includes several 

sample groups that reflect basic help desk roles: Employees, HelpDesk-Analysts, and IT Managers.  

A person can be a member of two or more groups. If for example a help desk analyst is also responsible 

for administering your system, you can make this person a member of both HelpDesk-Analysts and 

Admins. As a member of Admins, the analyst has full access to all administrative features.  

If you want to restrict access to Web views or administrative features, use groups. Typically, you create 

groups that match the different roles in your business process. For example, if you have separate groups 

for sales and development staff, you can prevent the sales staff from opening the same Web views used 

by the development staff.  

You can have several different admin-type groups, with each group providing a different level of access to 

administrative capabilities. For example, a basic admin group could allow members to create new user 

accounts and update contact information, while other admin groups could:  

 Create fields, edit choice lists, rename tabs, change workflow. 

 Create reports, queries, sorts, and layouts, define notifications. 

 Create projects, delete records, perform database maintenance, set up 

notifications. 
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THE BUILT-IN GROUPS  

USERS  

All users are automatically members of the Users group. You cannot remove users from this group, or 

delete it. Permissions granted to this group apply to all users, and cannot be overridden. 

ADMINS  

Members of the Admin group have complete access to all projects, administrative features and all read 

access to record information from incidents to assets or software. You cannot disable features or projects 

for the Admins group.  

  

FEATURES  

Features allow you to control:  

 Who can use the Ad-hoc Query Editor, generate reports, update contact 

information, view revision histories, or change their password in a Web view. 

 Who can log on to VIZOR Admin, VIZOR Web Admin, and the Web View 

Editor. 

 Who can use certain tools in VIZOR Admin and VIZOR Web Admin. For 

example, who can edit workflow rules in VIZOR Web Admin, and who can create 

reports or edit fields in VIZOR Admin. 
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PROJECTS  

When you create a project, you specify which groups can open the project. Groups allowed to open a 

project can:  

 Log on to Web views of the project (if they also have permission to open the 

view). 

 Edit the project in VIZOR Admin. 

 Edit views of that project in Web View Editor, or generate new views of that 

project. 

Admins can always open a project. Instead of allowing Users to open a project, you should allow specific 

groups. That way you can grant access permissions to views on a group-by-group basis in the Web View 

Editor.  

VIEWS  

Groups allowed to open a view can log on to the view. A group must be allowed to open the project 

before it can be allowed to open a view.  

Remember that if members of the Users group are allowed to open the view, then any user can open the 

view.  

 

USER ACCOUNTS  

User accounts provide basic logon security.  VIZOR supports the following types of account:  

- VIZOR user accounts. 

- Active Directory user accounts. 
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- Azure / Microsoft user accounts. 

- Windows user accounts. 

 

The authentication method used for each user is specified in VIZOR Web Admin.  

A user account must is required to access VIZOR Admin, VIZOR Web Admin, and the Web View Editor. 

Users must also log on to access Web Views unless they use a submit-only view. 

SUBMIT-ONLY VIEWS  

A submit-only view allows an unlimited number of users to enter issues from a single user account. All 

users automatically log on to the view with this account (in fact, the users never see the logon window, 

they go straight to the view).  

This user account must belong to a group that has permission to open the Web view, and to add and 

update contacts. The account is used to set the Submitter field.  

Users submitting issues by this method are recorded as the contact. They must enter the required contact 

information (name, e-mail, and so on) the first time they submit an issue.  

IMPORTING USER ACCOUNTS FROM WINDOWS  

You can import accounts from an Active Directory domain or from a Windows domain.  VIZOR includes a 

User Account Manager wizard to help you import user accounts.  

You can also schedule imports to keep  VIZOR synchronized with Active Directory (or Windows domains).  

PREDEFINED USER ACCOUNTS  

VIZOR includes several built-in users: demo, itmanager, analyst, admin, etc. It also includes sample users 

that reflect basic roles. You can disable most of these accounts in VIZOR Web Admin. The admin account 

cannot be disabled or deleted. It is recommended that you change the default admin password.  
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GENERATING WEB VIEWS  

PARENT-CHILD RELATIONSHIPS BETWEEN ISSUES?  

You can add a Child Issues tab to a Web view to allow users to link one or more child issues to a parent 

issue. For example:  

 If you have several bugs that are all symptoms of the same problem, you can 

make those bugs the children of the main, parent bug for the problem. 

 If a task consists of a number of sub-tasks, the sub-task issues can be children 

of the main task.  

 If a bug is present in multiple branches of your code, you can create a child 

issue for each code branch. 

By default, the parent issue controls the substate of the child issues. For example, when a user changes 

the substate of the parent to Fixed, the children are also marked Fixed. If you want the substate of a child 

issue to be independent from the substate of the parent issue, you must export the Substate controlled by 

parent field.  

 

CUSTOMIZED FILES FROM THE BASE PROJECT?  

New projects automatically inherit the customized Web view files of the base project including any 

custom reports.  

When you create a new project, everything in:  

CUSTOMIZEDFILES\#Project#<base-project>\  

is copied to: 

CUSTOMIZEDFILES\#Project#<your-project>\  
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WHAT IF YOU DON’T EXPORT A FIELD?  

QUERIES  

If you don’t export a field, don’t export queries that reference the field. The query won’t work.  

For example, suppose you don’t export the Owner field, but you do export a query like My Open Issues, 

which tests the value of the Owner field. When a user tries to run the query, the user gets a message 

saying that the query could not be completed and the view is rolling back to the previous query.  

If the query is the default query for the view, users get a more informative message when they log on.  

LAYOUTS  

Layouts do not include fields that are not exported.  

SORTS  

Sorts default to sorting by issue number if a field is missing.  

LISTING REPORTS  

Listing reports (such as the Current Issue - Detailed report, which is used by the Print button) include 

only the fields exported to the view.  

CUSTOM REPORTS  



  Page 682 

 

Like listing reports, custom reports include only the fields exported to the view. However, unlike listing 

reports, custom reports do not always handle missing fields properly.  

For example, if the Owner field is not exported, then, instead of showing owner names along one axis of a 

chart, the report may show the summary descriptions or the priority values. What the report shows 

depends on the order of the fields in the report definition (if a field is missing, the next one in the 

definition is used).  

SHOULD YOU AUTOMATICALLY UPDATE CHOICE LISTS?  

If you expect to frequently update a choice list, set the Automatically Update List attribute to Yes. This 

means you won’t have to regenerate the Web view every time you update the list because the view checks 

for updates each time a user logs on.  

By default, only the Contact, Owner, and Submitter choice lists are automatically updated.  

Automatically updating a large number of choice lists may affect performance. You should automatically 

update only the choice lists that you plan to frequently change.  

CHANGING FIELD LABELS 

To change field labels, set the Caption attribute in the Web View Editor. This allows you to override the 

label specified in the project.  

The Caption attribute only changes the label in the HTML form. Everywhere else in the Web view (such as 

in reports and the Ad-hoc Query Editor), the label defined in the project is used.  

WHEN DO YOU HAVE TO REGENERATE?  

When you:  

 Add a new field or query to a project. Remember to move the new field or 

query to the Export to View list before you generate. 

 Change a choice list (for example, add a new choice, or change the text of a 

choice), unless Automatically Update List is set to Yes. 
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 When you change any of the attributes for a field (such as when you set 

Automatically Update List to Yes). 

You don’t have to regenerate when you:  

 Change the definition of a query, sort, or layout. 

 Define new sorts and layouts. All sorts and layouts are automatically exported 

to views of the project. 

 Create or edit reports. 

 Add a group to, or remove from, the list of groups allowed to open the view. 

You just have to save the view. 

 Enable or disable features. 

NOTES 

Web view users must exit and log back on to see the changes. 

HOW TO CONTROL THE LAYOUT OF FIELDS 

The order of the fields in the Export to View list determines the order in which they are laid out in the 

two columns of the HTML form. For example, here’s how the first six fields in the Export to View list 

would be arranged, if:  

 None of the first five fields are Memo fields. 

 Field 3 has Column Span = 2. 

 Field 6 is a Memo field and has Column Span = 2 and CSS Class = 

MemoFieldWidth. (Memo fields automatically have Column Span set to 2 and 

CSS Class = MemoFieldWidth.) 
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In this example, fields 1 through 5 have the CSS Class set to either ComboBoxWidth or TextBoxWidth. 

You can change the default widths by editing the CSS classes in CensusMain.css. 
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SETTING UP NOTIFICATIONS  

Notifications allow you to alert users when issues are updated. For example, you can:  

 Notify analysts and developers when issues are assigned to them. 

 Notify support staff when employees update an issue. 

 Notify employees and customers when issues are resolved. 

Use notifications to alert users to changes to critical fields such as Owner, Status, and Priority. Defining 

too many update notifications can overwhelm users with e-mail, resulting in users missing important 

notifications.  
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CHAPTER 43 - CUSTOMIZING VIZOR 
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POWER CUSTOMIZATIONS  

This section covers a variety of ways to customize VIZOR, all of which are considered power 

customizations.  

Power customizations often require directly accessing the SQL Server databases and a deeper technical 

expertise. Some customizations require writing code scripts in languages such as Javascript and Visual 

Basic, as well as other advanced techniques.  

 

ABOUT THE DATABASES  

MAIN RECORDS DATABASE  

Also refered to as the DAT database, it contains records for the main entity of the project (set of 

databases). For example, issues or tickets in HelpDesk, assets in Resources, user accounts in Users, 

purchases in Purchases&Agreements, etc. This database also includes all the history of changes.  

PROJECT DEFINITIONS DATABASE  

Stores all project-related definitions, including fields, queries, sorts, layouts, reports, and notifications.  

USERS DATABASE  

Stores user accounts, contacts, and the information entered on the Contact tab.  

Database Jet/Access SQL Server 
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Records Data <project>01.dat <project>01_DAT 

Project definitions <project>02.def  <project>02_DEF 

Users users.mdb USERS_MDB 

 

ADVANCED WEB VIEW SETTINGS 

There are many advanced settings that can be customized per Web view. To change them, you typically 

need to customize the file: 

ViewConstants.js  

 

Available Settings 

Area Setting Description 

CommandBar   

 EnableSaveOnlyLastTab If true, disables the OK (Save) button until 

the user is in the last tab. 

Used for Wizards.  

Default = false 

 EnableApplyInNewRec If true, the Apply button is visible even in 

forms for creating NEW items, such as 

“Submit Ticket” in HelpDesk. 

Default = false 
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LOGON PAGE 

 

SIMPLIFY THE URL 

If your VIZOR is hosted by Vector Networks, this has been already done for you. 

If you host your own VIZOR server and the Web server does not run other pages on the main Web site, 

you can automatically redirect users from the main Web site to the VIZOR URL: 

So, if the URL is: 

http://myVIZORServer  

if will be redirected to: 

http://myVIZORServer/connect  

 

In order to do that:  

1. Copy the file Default.aspx from the folder <Server>\CensusWeb\Templates\Project and paste it 

in the folder of the main web site, which is typically “C:\inetpub\wwwroot”. 

2. Delete or rename the existing file iisstart, so it is not the default document. 

 

IF NOT USING INTEGRATED AUTHENTICATION - SSO 

Are your users never going to log on to VIZOR with their Windows or Network/Active Directory accounts  

integrated with the Web browser? This is also refered to as SSO (Single-Sign On). 

To remove the link to log on so your users are not confused: 

1. Go to VIZOR Admin >  Tools > Options 
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2. Look for the option Show “Logon with my network account…”.  

3. Select No.  

4. Click OK on the editor. 

5. Regenerate one Web view (any in that URL). 

 

IF MOSTLY USING INTEGRATED AUTHENTICATION 

Do most of your users use Windows authentication integrated with the browser? 

Would you prefer having a logon page that favours those users? 

 

 

1. Customize the web.config file located in “ConnectServer\CensusWeb\Templates\Project” and move it 

to your CustomizedFiles. 

Change the default logon page to be “logoff.asp”. Add the following line before the entry for 

“logon.asp”: 

<add value="logoff.asp" /> 

It should look like this: 

        <defaultDocument enabled="true"> 

            <files> 

                <clear /> 

                <add value="logoff.asp" /> 

                <add value="logon.asp" /> 

2. Save the file. 

3. Regenerate one Web View (any in that URL). 

 

TOTAL EFFORT TIME  
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The Total Time or Total Effort time field is used to keep track of all the effective time the issue has taken 

from all the people involved in attending it or resolving it.  

This includes the Owner of the ticket and any other user that has assigned tasks or that works on the 

ticket, usually field engineers, technicians and other support team members. 

 

The Total Effort Time Field is characterized by: 

 Data Type: numeric = 102 

 Container Type=30 

The special characteristic in this case is the container type 30, which includes the following elements: 

- Read-only Field to display the total effort time in a dd:hh:mm format. 

- A Stop Watch for counting active working time as it occurs, adding the time to the total when 

stopped. 

- A button to add any time manually, in minutes. 

 

 

 

When a field is Type=102 and ContainerType=30, the HTML field template fld_102_30.htmpl is applied. 

 

DISPLAYING THE TOTAL EFFORT TIME IN ANOTHER TAB 

To display the field in exactly the same manner as the original, with the 3 components, simply follow the 

usual procedure to copy a field to another tab. Since the data type and the container type will be 102_30, 

the correct field template will be used and the intended UI displayed. 

To display only the amount in another tab, in read-only mode: 
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- Copy the field for another tab as usual (like the previous option) 

- Make the field read-only, so fEnabled=False. 

- Change the Container Type to 31. 

Setting the Container Type to 31 will make it use the HTML field template for TimeSpan fields 

fld_102_31.htmpl. 

The TimeSpan represents a time interval. Its two typical uses are: 

- Reflecting the time interval between two date and time values. For example, to store the time 

between the creation time and closure time. 

- Measuring elapsed time. For example, for the Stopwatch or the total effort time to reflect the time 

interval that has elapsed since the start of something an event. 
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CREATING AN ATTACHMENTS FIELD  

Attachment fields are useful when looking for a more complete collection of information. Be it as a 

primary source or as a complement to your information, check out the instructions below to set up 

attachment fields.   

Attachment fields can hold up any kind of files and the maximum size is controlled by the IIS service. The 

maximum size can also be set up by the administrator. 

TO CREATE AN ATTACHMENTS FIELD:  

In SQL Server Management Studio: 

1   Open the project definitions database. 

2   Open the tblDtsFields table. 

3   Copy the record for the Attachments field and paste it into a new record. 

4   Change the nID, tCaption, tLabelCaption, tBoundControlName and tWhere fields. 

• For the tWhere field, make sure that the correct number in the sequence is set up. This 

field will determine to which attachment field within the record the attached file will be 

linked to. 

5   If you want to put the new attachments field on a different tab, change the nDestinationTabID field. 

  tblDtsFIelds field Description 

 nID Unique ID for the field. 

   

   

 tCaption Label used in choice lists. 
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 tLabelCaption Default label for the field in a Web view. 

 tBound ControlName Internal name for the field. 

 tWhere Run the query: 

SELECT tWhere FROM tblDtsFields 

WHERE tName='tAttachments' AND 

tTableName='tblAttachments' 

ORDER BY tWhere DESC 

  

  

Add 1 to the highest number returned by the above 

query, and enter this as the tWhere. 

 

 

CUSTOMIZING URL BUTTONS  

URL buttons are implemented as A elements with background images.  

Each of the default URL buttons (URLButton , MailToButton , RemoteControl ) has four CSS 

classes, along with four associated :hover classes. The Web View Editor automatically determines which 

CSS class to use based on the field type and the field attribute settings. For example, the CSS classes used 

for URLButton are determined as follows: 

When These CSS classes are used 

Column Span=1 URLButtonState1  

URLButtonState1:hover 

Column Span=2 

CSS Class = 

MemoFieldWidth 

URLButtonSpanTwoState1 

URLButtonSpanTwoState1:hover 

Column Span=2  URLButtonTwoWidthOneState1  

URLButtonSpanTwoWidthOneSt
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CSS Class = SpanTwoWidthOne ate1:hover  

Field already has a button (for 

example, a date field). 

URLButtonSecondButtonState1 

URLButtonSecondButtonState1:

hover 

 

These CSS classes are defined in the CensusMain.css style sheet in 

CensusWeb\Views\CensusWebVD\Theme\css.  

Each different pair of CSS classes positions the button differently, by changing the value of the CSS left 

property.  

The :hover pseudo classes change the background image to give a rollover effect.  

To define your own buttons, copy the URLButton classes, change the class names, and point the 

background-image property to your button images. For example:  

.MyButtonState1  

{  

 background-image: 

  url(../images/buttons/mybutton_off.gif);  

 background-repeat:no-repeat;  

 display:block;  

 position:absolute;  

 left:80%;  

 width:24px;  

 height:24px;  

 top:0px;  

}  

For button rollovers, you’ll need two versions of your button image. Your button images should have a 

one or two pixel margin (so there’s some space between the field and the button). Alternatively, you could 

adjust the left property.  
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To use these new classes, use MyButton as the value of the URL Button CSS attribute.  
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CUSTOMIZING STANDARD HTML REPORTS  

Web views use HTML to display Listing reports. You can customize this HTML by editing the XML 

files that define the HTML page template.  

 TmplRpt_listing_<type>.xml 

HTML template for an HTML report page, including the table that contains the report data.  

 ValueCell_listing_<type>.xml 

HTML template for a table cell that displays a field value.  

 CaptionCell_listing_<type>.xml 

HTML template for a table cell that displays a field caption.  

where <type> is either tabular or multi-column (the two types of listing reports).  

You can find these files in the Reports folder of a Web view, for example:  

C:\Program Files\Vector 

 \ConnectServer\CensusWeb 

  \Views\CensusWebVD\vit_vit\Reports  

These XML files are dynamically created the first time you view a report.  

 VIZOR generates the HTML reports by transforming raw XML data into HTML using an XSL style sheet. 

The three .xml files are templates for the XSL style sheet.  
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CHANGING THE CSS STYLES  

The CSS styles used by the HTML reports are defined in the TmplRpt_listing_<type>.xml file.  

 

Notes 

Reports are used to format attachments to e-mail notifications. Using an embedded style sheet ensures 

that notification attachments are formatted. If you want to use an external style sheet, you must use an 

absolute URL to locate the style sheet. 

 

PLACEHOLDERS  

The empty elements, such as <ReportHeader/> and <TableCells/>, in TmpRpt_listing_<type>.xml are 

placeholders. When  VIZOR generates a report, it replaces these placeholders with report-specific data.  

 <ColumnHeaders/> is a placeholder for the field titles. 

The file CaptionCell_listing_<type>.xml contains the HTML template for a field title, where <CellWidth /> 

and <CaptionCell /> are the width and title from the Report Editor.  

 <TableCells/> is a placeholder for the field values.  

The file ValueCell_listing_<type>.xml contains the HTML template for a field value.  

 <ReportCaption /> is the name given to the report in the Report Editor. 

 <ReportHeader /> is the title text from the Page Editor. <ReportHeaderCSS 

/> is the formatting applied to the title text. 

 <PageHeader /> is the header text from the Page Editor. <PageHeaderCSS 

/> is the formatting applied to the header text. 

 <PageFooter /> is the footer text from the Page Editor. <PageFooterCSS /> 
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is the formatting applied to title text. 

 

NOTES 

To see the generated HTML, open a report in a Web view and then view the page source. 
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OPTIONAL BEHAVIOURS IN HELPDESK 

HelpDesk has some special behaviours or business rules that can be enabled easily. 

For example, you can: 

• Filter Owners base on selected Work Team 

• Filter Owners base on Category, so the skills of the person are matched 

• Set the Work Team base on selected Owners 

 

TIMESTAMP FIELDS 

 

Fields like Activity in HelpDesk and Software Licenses Changes to a memo field can be time-stamped. For 

example, you can time-stamp the changes, comments, notes, and follow-ups that are added to an issue 

description over time.  

Timestamping requires two memo fields, one for input and one for storing the timestamped log. When an 

issue is saved, the Web view automatically copies the contents of the input field to the log field.  

 

CUSTOMIZING TIMESTAMPING  

By default, each time a new entry is added to the timestamp log, a line that looks like this is added:  

 

December 11,2021 4:38 PM   analyst   (New)  
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You can customize the way the timestamp log is formatted and automatically stamp other values.  

Valid macros: 

{date_time} The current date and time, on the server 

{user} The username or logon name of the person 

submitting the entry 

{user_fullname} The Full Name of the user submitting the entry 

{activity_entry} The text added, that is, the actual new entry in text 

format. 

{substate} The current Status of the modified record 

 

For example: 

{date_time}                  Added By:  {user_fullname} 
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The templates can be edited in the table <Project>02_Def.dbo.tblProperty. There is one template for the 

Activity Log, which uses HTML format, and one for the simple Memo Field Timestamp, which is pure text. 

4 Memo Field Timestamp 

11 Activity Log 

 

 

 

 

ENABLING TIMESTAMPING IN NEW PROJECTS 

When you create a new project based on a default VIZOR project, the new project inherits the original 

timestamping fields and new Web views are created based on the Web views of the original project.  

When a new Web view is copied from an existing one, timestamping fields retain their behaviour. 

However, if a new, blank Web view is created by clicking New View  , then additional steps need to be 

taken to enable timestamping. 

To make timestamping work in Web views of the new project, you must update the Html code after 

control attribute of the Description, Description Log, Activity, and Activity Log fields. 

You need to set the Html code after control attribute of the timestamping fields. The required HTML is 

included below. Note that it is formatted for readability—the attribute itself takes a single line of text. 

Description  

<script type='text/javascript'> 

 document.write(  

  parent.objCustomCode.getCodeAfterField(  

   '%fieldname%',  

   'mem_29_txtDetailedDescription' ) 

) 

</script>  

Description Log  

<script type='text/javascript'> 

document.write(  
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 parent.objCustomCode.getCodeAfterField(  

  '%fieldname%',  

  '' )  

) 

</script>  

 

ACTIVITY FIELD  

<script type='text/javascript'> 

document.write(  

 parent.objCustomCode.getCodeAfterField(  

  '%fieldname%',  

  'mem_56_mem_56_ActivityLog' ) 

)  

</script>  

Activity Log  

<script type='text/javascript'> 

document.write(  

 parent.objCustomCode.getCodeAfterField(  

  '%fieldname%', 

   '' ) 

) 

</script>  
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ADDING TIMESTAMPING TO A NEW FIELD  

Changes to a memo field can be time-stamped. For example, you can time-stamp the changes, 

comments, notes, and follow-ups that are added to an issue description over time.  

Timestamping requires two memo fields, one for input and one for storing the timestamped log. When an 

issue is saved, the Web view automatically copies the contents of the input field to the log field.  

1   Use the Field Editor to create a memo field for input of new data, and a field for displaying the 

timestamped log. For the input field, clear the Show in Choice Lists and Maintain Revision History 

check boxes.  

2   Find the internal name of the timestamp log field. The internal name looks like 

mem_58_mem_58_FieldName.  

If you have Microsoft Access, you can find the internal name by opening the project definitions database 

and looking in the tblDtsFields table. The field name is composed from the values in the nID and 

tBoundControlName fields:  

mem_<nID>_<tBoundControlName>  

The tBoundControlName field includes a repeat of the mem_<nID> string. That is why the string appears 

twice in the name.  

If you don’t have a copy of Microsoft Access, generate a Web view for the project, then get the value of the 

name attribute of the text area control associated with the timestamp log field. You can find this in the 

tmplRecord.html file located in the HTML folder of the view:  

CensusWebVD\<project>_<view>\HTML  

3   Set the HTML code after control attributes:  

Before you generate a Web view, you must export the two fields and set their HTML code after control 

attributes.  

a   For the input field, enter this HTML code (as a single line of text): 

<script type='text/javascript'>document.write 

( parent.objCustomCode.getCodeAfterField( '%fieldname%', '<timestamp-log-field-

name>' ) ) </script>  

<timestamp-log-field-name> is the field name you found in the previous step. Note that the javascript is 

case sensitive. 

b   For the timestamp log field, enter this HTML code (as a single line of text): 

<script type='text/javascript'>document.write 
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(parent.objCustomCode.getCodeAfterField('%fieldname%','' ) )</script>  

 

 

 

TIMESTAMPING WITH ONE MEMO FIELD  

You can implement timestamping with just one memo field. To do this, use the HTML code before control 

attribute to insert a text area control above the timestamp log field. This text area control is not tied to 

any database field. It exists only to allow input, which is copied into the timestamp log field when you 

save the issue. The advantage to this approach is that you avoid storing an extra memo field in the issue 

database. The disadvantage is that you cannot use VIZOR Admin or the Web View Editor to customize the 

input text area (for example, to change the caption or position of the control).  

HTML CODE AFTER CONTROL:  

<script type='text/javascript'>  

document.write(parent.objCustomCode.getCodeAfterField('%fieldname%',''));  

</script>  

HTML CODE BEFORE CONTROL:  

<script type='text/javascript'>  

document.write(parent.objCustomCode.getInputMemoField('mem_desc', 

'%fieldname%'));  

</script>  

NEW FUNCTION IN CUSTOMCODE.JS:  

function getInputMemoField( inputFld, logFld )  

{  

var strOutput;  

strOutput="<textarea  class='MemoFieldWidth'  ";  

strOutput+="name='" + inputFld + "' ";  
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strOutput+="wrap=physical  rows=10 cols=73";  

strOutput+="onfocus=\"parent.MemoGotFocus('"  

+ inputFld + "')\" ";  

strOutput+="onchange=\"parent.OnMemoRecordChanged('" + inputFld + "')\" ";  

strOutput+="onkeypress=\"parent.OnMemoRecordChanged('" + inputFld 

+"')\"></textarea><br>";  

strOutput+="<script type='text/javascript'>";  

strOutput+="document.write(parent.objCustomCode.getCodeAfterField('" + inputFld + 

"','" +logFld + "'))</script>";  

strOutput+="</script>";  

return strOutput;  

}  

NEW DECLARATION IN CUSTOMCODE.JS:  

// Declaration of the public functions  

this.getInputMemoField=getInputMemoField;  
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CHANGING THE FORMAT OF EMAIL ATTACHMENTS IN AUTOMATED NOTIFICATIONS  

The Detailed choice in the Include list of the Notification Editor attaches a report to the notification 

message. This report includes most fields for an issue.  

If you do not use Crystal Reports, attachments can be HTML files or text files. If you do use Crystal 

Reports, attachments are RTF files by default. You can change this to be PDF, text, or a number of other 

formats. See Viewing Reports for more information on using Crystal Reports for listing reports.  

To change the format of a notification attachment:  

1   Open the project definitions database. 

2   In tblMailContents, change the nFormatType for the attachments. (Attachments have nType = 3 in 

tblMailContents). 

FORMAT TYPE CONSTANTS:  

NoFormat 0 Excel40 20 

CrystalReport 1 Excel50 21 

DataInterchange 2 Excel50Tabular 22 

RecordStyle 3 ODBC 23 

RichText 4 HTML32Standard 24 

Comma Separated 

Values 

5 Explorer32Extend 25 

TabSeparatedValues 6 NetScape20 26 

CharSeparated Values 7 Excel70 27 
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Text 8 Excel70Tabular 28 

TabSeparatedText 9 Excel80 29 

PaginatedText 10 Excel80Tabular 30 

Lotus123WKS 11 PortableDocFormat 31 

Lotus123WK1 12 HTML40 32 

Lotus123WK3 13 CrystalReport70 33 

WordForWindows 14 ReportDefinition 34 

Excel21 18 ExactRichText 35 

Excel30 18 XML 36 
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ATTACHING INFORMATION  

By default, the Revision Record and Summary are included in the body of the e-mail notification 

message. You can include this information as separate attachments.  

To do this, open the project definitions database and in tblMailContents change the nType to 3. nType 

determines where the content is put in the e-mail message. 

nType Description 

1 Subject 

2 Body of e-mail message 

3 Attachment 
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ADDING CUSTOM MAIL CONTENTS  

In the Notification Editor, the Include list specifies what to include in an e-mail notification message. You 

can add items to this list. The items can be used as the message subject, inserted in the message body, or 

included as attachments to the message.  

To add an item to the Include list of the Notification Editor:  

1   Define a function in the macroXX.bas file.  

This function should return the content you want to include in the e-mail message.  

macroXX.bas is located in the project sub-folder of the ConnectServer folder (for example: 

ConnectServer\vit\macro70.bas)  

2   Open the project definitions database, and in the tblMacros table, add a row for the new function. 

tName is the name of the macro.  

tFunctionName is the name of a function defined in macroXX.bas.  

nType specifies what arguments the function takes:  

1 = No Arguments  

2 = Issue Record  

3 = Revision history  

4 = Expression  

3   In the tblMailContents table, add a row for the macro, using the same tName as in tblMacros.  

nType specifies where to include the contents:  

1 = subject 

2 = body 

3 = attachment  

nFormatType specifies the format:  

4 = rtf 

8 = text 

14 = word 

31 = pdf 

32 = html40  
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When nType = 2, nFormatType must be 8 (text), otherwise the contents appears as a plain text e-mail 

message that contains RTF or PDF, which is never sent. This will hold up all your notifications.  
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MACRO REFERENCE 

The following is a list of macros along with explanations of how to interpret them. Some 

macros include comments or notes, providing additional insights into their functionality. 

 

To interpret this list, use the string value provided. For example: 

 

 

This indicates that the macro can be used either as <Group members> (without an 

argument) or as <Group members:NameofGroup> (with an argument). In this case, it is 

the latter. 

BUILT-IN MACROS  

 

Macros Code Example 

GROUP_MEMBERS 

{ 

            //Built-in macros 

            // ENSURE THEY ARE IN BOTH: 

            //      ParseFullMacro 

            //      Expand 

            // MACRO NAME HERE MUST BE ALL LOWER CASE 

            public const string GROUP_MEMBERS = "group members"; 

 

 

 

 

SUPERVISOR_OF 
            //  <Supervisor of:Contact> 

            public const string SUPERVISOR_OF = "supervisor of"; 

 

            //  <Manager of:Allocated to Person> 

            public const string MANAGER_OF = "manager of"; 

 

            //  <Vice President of:Allocated to Person> 

            public const string VICE_PRESIDENT_OF = "vice president of"; 

MANAGER_OF 

VICE_PRESIDENT_OF 

"group members" in   public const string GROUP_MEMBERS = "group members"; 



  Page 714 

 

 
 

 

JOB_TITLE 
            //  <Job Title:CEO> 

            public const string JOB_TITLE = "job title"; 

 

            //  <Teacher of:Allocated to Person> 

            public const string TEACHER_OF = "teacher of"; 

 

 

 

            //  <Parent Email of:Allocated to Person> 

            public const string PARENT_EMAIL_OF = "parent email of"; 

 

            //  <Parent Name of:Allocated to Person> 

            public const string PARENT_NAME_OF = "parent name of"; 

 

            //  <Parent 2 Email of:Allocated to Person> 

            public const string PARENT2_EMAIL_OF = "parent 2 email of"; 

 

            //  <Parent 2 Name of:Allocated to Person> 

            public const string PARENT2_NAME_OF = "parent 2 name of"; 

 

TEACHER_OF 

 

PARENT_EMAIL_OF 

PARENT_NAME_OF 

PARENT2_EMAIL_OF 

PARENT2_NAME_OF 

 

 

 

MINUTES_FROM_NOW 
            // <Minutes from now:[minutes]> 

            public const string MINUTES_FROM_NOW = "minutes from now"; 

 

            // <Minutes ago:[minutes]> 

            public const string MINUTES_AGO = "minutes ago"; 

 

            // <Hours from now:[hours]> 

            public const string HOURS_FROM_NOW = "hours from now"; 

 

            // <Hours ago:[hours]> 

            public const string HOURS_AGO = "hours ago"; 

 

            // <Days from now:[days]> 

            public const string DAYS_FROM_NOW = "days from now"; 

 

            // <Days ago:[days]> 

            public const string DAYS_AGO = "days ago"; 

 

            // <Months from now:[months]> 

            public const string MONTHS_FROM_NOW = "months from now"; 

 

            // <Months ago:[months]> 

            public const string MONTHS_AGO = "months ago"; 

MINUTES_AGO 

HOURS_FROM_NOW 

HOURS_AGO 

DAYS_FROM_NOW 

DAYS_AGO 

MONTHS_FROM_NOW 

MONTHS_AGO 
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YEARS_FROM_NOW 
            // <Years from now:[years]> 

            public const string YEARS_FROM_NOW = "years from now"; 

 

            // <Years ago:[years]> 

            public const string YEARS_AGO = "years ago"; 

 

            // <First day of month:[months ago/months from now]> 

            public const string FIRST_DAY_OF_MONTH = "first day of month"; 

 

            // <Last day of month:[months ago/months from now]> 

            public const string LAST_DAY_OF_MONTH = "last day of month"; 

 

 

YEARS_AGO 

 

FIRST_DAY_OF_MONTH 

LAST_DAY_OF_MONTH 

 

 

 

ASSET_IN_ACTION 

// Info on the Asset being provisioned by an action 

            public const string ASSET_IN_ACTION = "asset instance of this  

action"; 

 

            // 

            public const string CONNECT_AS = "connect as"; 

 

            // <Base URL:[]> 

            public const string BASE_URL = "base url"; 

CONNECT_AS 

BASE_URL 

 

 

 

VALUE_OF_DTS_FIELD 
            // Value of any field of the current Dts Record 

            public const string VALUE_OF_DTS_FIELD = "value of field"; 

 

            public const string ASSET_TYPE_ABBREV = "asset type 

abbreviation"; 

 

            public const string NEXT_ASSET_TYPE_NUMBER = "next asset 

type number"; 

 

            // argument: format like yymmdd 

            public const string FORMATTED_PURCHASE_DATE = "formatted 

purchase date"; 

 

            public const string APPROVERS_PER_COST_LEVEL = "approvers 

per cost level"; 

 

            public const string PURCHASE_STAKEHOLDERS = "purchase 

stakeholders"; 

 

ASSET_TYPE_ABBREV 

NEXT_ASSET_TYPE_NUMBER 

FORMATTED_PURCHASE_DATE 

APPROVERS_PER_COST_LEVEL 

PURCHASE_STAKEHOLDERS 

ASSIGNEE_SUPERVISOR 

            public const string ASSIGNEE_SUPERVISOR = "assignee 

supervisor"; 

 

            public const string ASSIGNEE_SUPERVISOR_LEVEL_1 = "assignee 
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ASSIGNEE_SUPERVISOR_LEVEL_1 
supervisor level 1"; 

 

            public const string ASSIGNEE_SUPERVISOR_LEVEL_2 = "assignee 

supervisor level 2"; 

 

            public const string ASSIGNEE_SUPERVISOR_NAME = "assignee 

supervisor name"; 

 

            public const string ASSIGNEE_SUPERVISOR_LEVEL_1_NAME = 

"assignee supervisor level 1 name"; 

 

            public const string ASSIGNEE_SUPERVISOR_LEVEL_2_NAME = 

"assignee supervisor level 2 name"; 

ASSIGNEE_SUPERVISOR_LEVEL_2 

ASSIGNEE_SUPERVISOR_NAME 

ASSIGNEE_SUPERVISOR_LEVEL_1_NAME 

ASSIGNEE_SUPERVISOR_LEVEL_2_NAME 

LINE_ITEM_PURCHASE_FIELD 
            public const string LINE_ITEM_PURCHASE_FIELD = "line item 

purchase field"; 

 

            public const string LINE_ITEM_LICENSE_FIELD = "line item license 

field"; 

 

 

            // Generic way to get the value of a field of the owner 

            // Other ideas: 

            // <Value of Owner Field:E-mail 2> 

            //  "Person value of field:Owner|Email 2" 

            //"value of person field:Owner|Email 2" 

            //"value of field in person field:Owner|Email 2" 

            //"attribute of person in field:Owner>>Email 2" 

 

            // "attribute of person in field:{Owner}.{Email 2}" 

            public const string ATTRIBUTE_OF_PERSON_IN_FIELD = "attribute 

of person in field"; 

 

            // "attribute of asset in ticket:{Asset}.{Special_Instructions}" 

            public const string ATTRIBUTE_OF_ASSET = "attribute of asset"; 

 

            /// <summary> 

            /// Example: 

            ///     <Attribute of related entity:{Computer}.{Serial Number}> 

            /// Get the value of an attribute/field of a record (DtsRecord) 

which is related to current record from a different project. 

            /// Example of a related entity: 

            ///     In Helpdesk: 

            ///     To get the email of the Owner of the ticket: 

            ///         {Owner}.{E-mail} 

            ///         In the Ticket record, first go to the Owner field, which 

returns a user/Person, and then get the E-mail field from that person. 

            /// 

LINE_ITEM_LICENSE_FIELD 

 

 

ATTRIBUTE_OF_PERSON_IN_FIELD 

ATTRIBUTE_OF_ASSET 
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 ATTRIBUTE_OF_RELATED_ENTITY 

            ///     To get the serial number of the computer of the ticket: 

            ///         {Computer}.{Serial Number} 

            ///         In the Ticket record, first go to the Computer field, which 

returns an asset, and then get the SN field from that asset. 

            ///          

            /// </summary>             

            public const string ATTRIBUTE_OF_RELATED_ENTITY = "attribute 

of related entity"; 

 
 

 

 REQUESTED_PEER_APPROVALS 

            //macros for change requests 

            public const string REQUESTED_PEER_APPROVALS = "requested 

peer approvals"; 

 

            public const string REQUESTED_USER_APPROVALS = "requested 

user approvals"; 

 

            public const string REQUESTED_MANAGER_APPROVALS = 

"requested manager approvals"; 

 

            public const string REQUESTED_SITE_DIRECTOR_APPROVALS = 

"requested site director approvals"; 

 

            public const string REQUESTED_OCIO_APPROVALS = "requested 

ocio approvals";  

 

            public const string LOSTOU = "lost ou"; 

 

            public const string DEFAULT_ASSET_NAME = "default asset 

name"; 

 

            // 

            // Assignment macros 

 

            /// <summary> 

            ///  <Round Robin:field caption to balance; User group for pool; 

query caption for Count Conditions> 

            ///  <Round Robin:Owner;HelpDesk-Analysts;Open Issues> 

            /// </summary> 

            public const string ASSIGN_ROUND_ROBIN = "round robin"; 

 

            public const string RECORD_NUMBER = "issue number"; 

 

            public const string WORKTEAM_MEMBERS = "work team 

members"; 

 

            public const string IS_ACCESSIBLE_ORGANIZATION = "is 

accessible organization"; 

REQUESTED_USER_APPROVALS 

REQUESTED_MANAGER_APPROVALS 

REQUESTED_SITE_DIRECTOR_APPROVALS 

REQUESTED_OCIO_APPROVALS 

LOSTOU 

DEFAULT_ASSET_NAME 

 

 

 

 

 

 

 

 

ASSIGN_ROUND_ROBIN 

RECORD_NUMBER 

WORKTEAM_MEMBERS 
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IS_ACCESSIBLE_ORGANIZATION  

            public const string IS_ACCESSIBLE_DEPARTMENT = "is accessible 

department"; 

 

            public const string IS_ACCESSIBLE_LOCATION = "is accessible 

location"; 

 

            public const string MY_ROLES = "my roles"; 

 

            public const string OWNER = "owner"; 

 

            public const string PROJECT_NAME = "project name"; 

 

            public const string CUSTOMER_SERVICE = "customer service"; 

 

        }  

IS_ACCESSIBLE_DEPARTMENT 

IS_ACCESSIBLE_LOCATION 

MY_ROLES 

OWNER 

PROJECT_NAME 

CUSTOMER_SERVICE 
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EXAMPLE MACROS  

<ASSET SUMMARY> MACRO FOR REPAIRS: 

The <Asset summary> macro provides asset details in the following format: 

<Asset Type> <Asset Name> - <Asset Tag> (<Serial Number>) 

 

For a Chromebook, it would display as: 

Chromebook Device Name - Asset Tag (Serial Number) 

If you’re unsure about the order or need adjustments, check the asset details in your 

system or contact support for assistance. 

FUNCTION TO RETURN A STRING:  

Public Function GetCustomSubject(oCensusApplication, lngDtsRecordID, oExpression, 

recRevisionHistory) 

GetCustomSubject = "Your subject goes here."  

End Function  

FUNCTION TO RETURN THE CONTENTS OF A TEXT FILE:  

Public Function GetCustomMsgBody( oCensusApplication, lngDtsRecordID, oExpression, 

recRevisionHistory )  
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Dim fsObj  

Dim txtStreamObj  

Dim emailbody  

Dim strFileName  

strFileName = "C:\Messages\msg.txt"  

Set fsObj = CreateObject(  

"Scripting.FileSystemObject")  

Set txtStreamObj = fsObj.OpenTextFile(  

strFileName, 1, False, False)  

emailbody = txtStreamObj.ReadAll  

txtStreamObj.Close  

GetCustomMsgBody = emailbody  

End Function  

FUNCTION THAT TAKES THE REVISION HISTORY AS AN ARGUMENT AND EXTRACTS 

A FIELD VALUE: 

Public Function GetSubject(oCensusApplication, lngDtsRecordID, oExpression, 

recRevisionHistory)  

Dim lngLastRevisionNumber   

Dim rstValue      

Dim variablename  
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If oCensusApplication Is Nothing Then  

Exit Function  

End If  

If recRevisionHistory Is Nothing Then  

Exit Function  

End If  

'get the last revision number  

GetRevisionNumberRange recRevisionHistory, 0, _  

lngLastRevisionNumber  

' Get the value for the field from the table  

' of the last revision in the given set.  

Set rstValue = oCensusApplication.CurrentProject._  

DataStores.Item(32). _  

GetConnection(1).Execute( _  

 "SELECT tBriefDescription FROM tblDts_History_  

WHERE nID=" & lngDtsRecordID _  

& " AND nRevisionNumber=" _  

& lngLastRevisionNumber, , 1)  

' Build subject line that looks like:  

'HELPDESK [Ticket 37]PROJECT [Issue 37] - Cannot print PDF file  

If Not rstValue.EOF Then  

If Not IsNull(rstValue.Fields(0).Value) Then  

GetSubject =  "HELPDESK [Ticket PROJECT [Issue " &_  

lngDtsRecordID & "] - " &_  

rstValue.Fields(0).Value  
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End If  

End If   

End Function  

In the SELECT statement, tBriefDescription is the internal name for the Summary field. You can find the 

internal field names in the tName column of the tblDtsFields table in the project definitions database.  

RELATED TOPICS 

Changing the Format of Attachments  

Attaching Information 

Adding Custom Mail Contents  

Adding Notification Reports  
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ADDING NOTIFICATION REPORTS  

 VIZOR can use reports to format information included in e-mail notifications. For example, the Detailed 

and Summary items are formatted by reports. You can define new reports and add them to the list of 

items that can be included in an e-mail notification message.  

To add a new report for notifications:  

1   In VIZOR Admin, use the Report Editor to define a new listing report. 

2   Save and preview the report. 

3   Exit VIZOR Admin. 

4   Open the project definitions database. 

5   Open the tblSystemCustomReports table, find the record for the report you just created, and get the 

nID value. 

6   Open the tblMailContents table and create a new record. 

 Field Description 

 nID Next available ID number for a record in the tblMailContents table.  

 tName Name displayed in the Include list of the Notification Editor. 

 nType 2 = include in message body  

3 = attachment 

 tFunction The GenerateReport function takes care of generating the report for the 

notification message. 

 tArguments <nID>.10, where <nID> is the ID of the report in 

tblSystemCustomReports.  

 nFormatType 4 = rtf 

8 = text 

14 = word 

31 = pdf 
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32 = html40  

See Changing the Format of Attachments for more format type values.  

When nType = 2, nFormatType must be 8 (text).   

 

The report is now available in the Include list of the Notifications Editor.  

If you’re using Crystal Reports for your listing reports, you’ll have to create a Crystal Report report file 

(.rpt) for the new notification report.  

TO CREATE AN .RPT FILE FOR YOUR NOTIFICATION REPORT:  

1   View the report in a Web view. 

This creates an .rpt file in the CensusWebVD\<project>_<view>\Reports folder. For example:  

\Program 

Files\Vector\ConnectServer\CensusWeb\Views\CensusWebVD\HelpDesk_HelpDesk\Rep

orts  

2   Copy the .rpt file to the ConnectServer\<project>\Reports folder. For example: 

\Program Files\Vector\ConnectServer\HelpDesk\Reports  

3   Rename the file by removing portrait (or landscape) from the .rpt file name. 
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SUBMIT-ONLY VIEWS WITHOUT PERSISTENT COOKIES  

Submit-only views use persistent cookies to store contact information, such as the user's name and e-mail 

address. You can set up submit-only views so that submitters do not have to enter their contact 

information. Consequently, the submit-only views use session cookies only.  

To do this, you enter the contact information into  VIZOR yourself, and then provide each user with their 

own specific URL.  

To set up submit-only views that do not use persistent cookies:  

1   Use VIZOR Web Admin to create contacts if the submit-only view is intended to allow people without  

VIZOR￼VIZORIZOR. 

2   Send a personal URL for the submit-only view to each person who needs to submit issues. 

The personal URL for a contact looks something like this:  

http://server/vit/logon.asp? 

View=VIZOR%2FReport%20Issue&CookieInfo13=14;Emilyhttp://server/census/logon.asp 

?View=BugTrk%2FSubmit%20Issue&CookieInfo13=14;Emily 

The first part of the URL is the URL for the  VIZOR logon page. The second part of the URL (in bold) is the 

query string. The View= part of the query string specifies the project and view:  

View=<project>%2F<view>  

where: 

%2F is the escape sequence for a forward slash (/).  

CookieInfo13= specifies the user’s contact information:  

CookieInfo13=<User ID>;<Personal Name>  

<User ID> is the numeric ID assigned to the contact or user. You can find this value in the tblUser table of 

the Users database. <Personal Name> is the name of the contact or user.  

Spaces in the project, view, and personal name must be replaced with the escape sequence %20.  
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You can customize the look of a Web view by editing the CensusMain.css style sheet in 

CensusWeb\Views\CensusWebVD\Theme\css.  

Put a copy of your customized style sheet in the CUSTOMIZEDFILES folder. For example, in 

#AllProjects#\Theme\css or #Project#vit\Theme\css.  

REPLACING LOGOS  

To replace the logo, edit the td.Logol and div.Logo rules in CensusMain.css. The background-image 

property specifies the logo image.  

Note that VIZOR uses two versions of the logo, logol for light backgrounds (Web view page) and logo for 

dark backgrounds (logon page).  

/* logo on a Web view page */  

td.Logol  

{  

 background-image:url(../images/logos/logol.gif);  

 background-repeat:no-repeat;  

 display:block;  

 left:27px;  

 width:200px;  

 height:60px;  

 position:absolute;  

}  

/* logo on the VIZOR logon page */  

div.Logo  

{  

 background-image:url(../images/logos/logo.gif);  

 background-repeat:no-repeat;  

 display:block;  

 left:27px;  

 width:200px;  

 height:60px;  

 position:absolute;  

 b-order:3 orange solid;  

}  



  Page 727 

 

View Toolbar  

The View toolbar is the top part of a Web view, where the logo and the Help, Log Off, and other buttons 

are displayed.  

body.TopToolbarBody sets the background color.  

td.Logol sets the logo image displayed in the toolbar.  
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SUMMARY LIST TOOLBAR  

The toolbar has three parts: the top (with the Query, Sort, and Layout lists), the middle (the Ad-hoc Query 

Editor), and the bottom (used for bottom rounded corner images).  

For the top part:  

 body.ToolbarBody sets the background color. 

This class is also used by many dialogs, such as Attach File, History, and Options.  

 ToolbarLeft, ToolbarCenter, and ToolbarRight set the background images. 

ToolbarCenter also sets the font properties for the captions. 

For the middle part:  

 body.ToolbarM sets the background color. 

 ToolbarMLeft, ToolbarMCenter, and ToolbarMRight set the background 

images. ToolbarMCenter also sets the font properties for the captions. 

For the bottom part:  

 body.ToolbarB sets the background color. 

 ToolbarBLeft, ToolbarBCenter, and ToolbarBRight set the background 

images. 
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SUMMARY LIST HEADER  

The appearance of the heading row for the Summary List is controlled by:  

 headerSummaryList 

 HeaderSummaryListCellCenter 

 HeaderSummaryListCellLeft 

 HeaderSummaryListCellRight 

headerSummaryList sets properties for the entire table. The three HeaderListSummaryCell classes are 

used to set background images. If you don’t want to use images, you can comment out the 

HeaderListSummaryCell classes and use headerSummaryList to set the background and text colors.  
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SUMMARY LIST  

body.SummaryListBody formats the page background and text.  

The appearance of links in the Summary List are controlled by body.SummaryListBody a:link and 

body.SummaryListBody a:visited.  

To change the shading of the rows in the list, edit these CSS classes. The two sets of CSS classes allow for 

rows with alternating shading.  

 SummaryList1 

 SummaryList1Hover (for Internet Explorer) 

 SummaryList1HoverN (for Netscape) 

 SummaryList2 

 SummaryList2Hover (for Internet Explorer) 

 SummaryList2HoverN (for Netscape) 
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TABS  

The appearance of the selected tab is controlled by:  

 TabsLeftCornerUp 

 TabsBackgroundUp 

 TabsRightCornerUp 

The appearance of the unselected tabs is controlled by:  

 TabsLeftCornerDown 

 TabsBackgroundDown 

 TabsRightCornerDown 

For example, you could replace the background images or use solid colors instead of images.  

To customize the font used for the text on the tabs, edit TabsBackgroundDown and TabsBackroundUp.  

The area to the right of tabs (where the next/previous page controls are located) can be styled with 

tabsBody (the background color) and tabsBorder (the bottom border), and PageNavigation (the Page X 

of Y text).  

To put a dividing border between the Summary List and the tab area, use border-top with tabsBody.  
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FORM  

Each tab in a Web view is a form that contains a table. The HTML looks like this:  

<body class="RecordBody" > 

 <form name="Record"> 

  <table class="RecordTab" >  

So, for example, to change the background color of the tabs, edit the body.RecordBody class in 

CensusMain.css.  

To apply styles to the form element, you can use this selector in the style sheet:  

body.RecordBody form { ... }  
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FIELD CAPTIONS  

Field captions in a Web view are formatted with the CSS classes normalfield, requiredfield, and 

disabledfield.  



  Page 734 

 

FORM ELEMENTS  

The CSS class applied to a form element is specified by the CSS Class field attribute in the Web View 

Editor. You can customize the default CSS classes or define your own and apply them to fields through 

the Attribute Editor.  

The default CSS classes for form elements are TextBoxWidth, ComboBoxWidth, and MemoFieldWidth, 

InputAttachment (for the Attachments box), and InputCalendar (for date fields).  
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COMMAND BAR  

The command bar is the bar at the bottom of the page that contains the Issue box and the New, Save, 

Cancel, and Print buttons.  

body.CommandBarBody sets the background color for the command bar. You can set the text color 

here (except for the text in the message area).  

CommandBarBLeft, CommandBarBCenter, and CommandBarBRight specify the background images 

for the command bar.  

CommandBarMsgLeft, CommandBarMsgCenter, and CommandBarMsgRight specify the background 

images for the message area (For example: Ready. Click New to create a new issue.) of the command bar.  

ControlsCaptionDark sets the style for the Current Issue label.  

CurrentRecord and CurrentRecordHover set the style for the Current Issue text box.  
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ABOUT BRANDING DIALOGS  

Dialogs are pages that users open by clicking a button. This includes the Attachments, Reports, Revision 

History, Password, Options, and Contacts dialogs.  

Most of the dialogs use the same style sheet as the Web view. However, the Contacts and Password 

dialogs use the CensusMain.css style sheet found in CensusWebVD\Admin\THEME\css.  
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COMMON STYLES FOR ALL DIALOGS  

body.toolbarBody sets the background color for the dialog pages (except for the Reports dialog, which 

uses body.ReportsBody).  

The box with rounded corners is a set of background images specified by these classes:  

 BoxTLeft, BoxTCenter, and BoxTRight 

 BoxMLeft, BoxMCenter, and BoxMRight 

 BoxBLeft, BoxBCenter, and BoxBRight 
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ATTACHMENTS DIALOG  

body.toolbarBody sets the background color for the page.  

DialogLabel formats the captions.  

InputFile and InputFileHover format the text boxes.  

The list of attached files is displayed in a table. HeaderSummaryListCellCenter formats the heading row 

(where the File Name and Remove captions are displayed).  

SummaryList1 and SummaryList2 format the list of files.  

DialogLabel formats the file names.  
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REPORTS DIALOG  

body.ReportsBody sets the background color for the page.  

The appearance of the tabs is controlled by the same CSS classes that apply to the tabs in a Web view 

(see Tabs).  

The Report Name caption uses the normalfield class.  

The <select> element that lists the available reports uses the ReportList class.  

The Layout: and Viewer Type: captions use the AdminNormalTextDarkBG class. The corresponding 

<select> elements do not use a CSS class, but you can use their IDs (LayoutType and ViewerType) with ID 

selectors in the CSS file.  
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REVISION HISTORY DIALOG  

This dialog uses only the common styles.  
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OPTIONS DIALOG  

body.toolbarBody sets the background color for the page.  

Captions use the normalfield class.  

Form elements (such as <input>) are in a <TD> that uses the normalfield class, but the form elements 

themselves have no class.  
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CONTACTS DIALOG  

This dialog uses the CensusMain.css style sheet in CensusWebVD\Admin\THEME\css.  

body.RecordBody sets the background color for the page.  

The caption for the Display list uses the DialogLabel class, and the <select> element uses 

AdminComboBoxWidth.  

On the input form for contact information, the captions use requiredfield and DialogLabel. The form 

elements all use AdminComboBoxWidth.  
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PASSWORD DIALOG  

This dialog uses the CensusMain.css style sheet in CensusWebVD\Admin\THEME\css.  

body.toolbarBody sets the background color for the page.  

normalfield formats the captions Old Password, Password, and Confirm Password.  

AdminTextBoxWidth and AdminTextBoxWidthHover format the text boxes.  

AdminNormalTextDarkBG formats the Password can contain a maximum of 14 characters message.  
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ABOUT BRANDING THE LOGON PAGE  

The heights of some of the table cells are hard-coded in CensusWebVD\logon.asp.  

LogonBody sets the background color for the page.  

The images and background colors for the box with rounded corners are set by these classes:  

 Logon-t-left, td.Logon-t-center, div.Logon-t-right 

 Logon-m-left, div.Logon-m-center, td.Logon-m-right 

 Logon-b-left, td.Logon-b-center, div.Logon-b-right 

Note the mix of div and td elements. If you want to replace the images with colors and borders, set the 

left and right classes to the background color and use the center classes to define your border.  

div.Logo inserts the VIZOR logo.  

div.Logon-decor-img inserts the keyboard image with the orange border  

LogonForm positions the logon form (the Logon Name and Password text boxes).  

div.LogonField and div.PwdField position the form elements.  

div.LogonCaption formats the Logon Name and Password labels.  

input.LogonInput and input.LogonInputHover format the text boxes.  

a.LogonState1 and a.LogonState1:hover set the images used for the Logon button.  

HelpState1 and HelpState1:hover set the images used for the Help button. 



  Page 745 

 

VALIDATE LOGON PAGE  

The ValidateLogon page displays the available views. With a few exceptions (documented below), this 

page uses the same styles as the Logon page.  

The heights of some of the table cells are hard-coded in CensusWebVD\validatelogon.asp.  

ExitState1 and ExitState1:hover specify the images used for the Log Off button.  

div.ViewList-m-center is used instead of div.Logon-m-center.  

div.ViewList-decor-img is used instead of div.Logon-decor-img to display the keyboard image with the 

orange border  

div.ViewLinks positions and sizes the area used to display the list of available views. This class also adds 

the vertical orange bar.  

div.LogonCaption formats the Click the view you want to open string.  

ViewListCaption formats the DIVs that contain the project names.  

ViewList-Link, ViewList-Link:link, ViewList-Link:visited, and ViewList-Link:hover format the view 

names, which are hyperlinks.  
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ADDING ROWS  

By default, the timesheet project allows users to track weekly time spent for up to four different projects. 

If you need to track time for more than four different projects or tasks, you can add more rows to the 

timesheet.  

Step 1: Create fields in the Field Editor  

1   Create a new choice list for selecting projects. Copy the Project1 field and name it Project5. 

2   Create the input fields for the days of the week. 

a   Copy the P1HRsMon field and name it P5HrsMon.  

b   Copy P5HrsMon and name it P5HrsTue. 

c   Copy P5HrsTue and name it P5HrsWed. 

d   Continue until you have input fields for all seven days of the week. 

3   Create a field to hold the weekly total. Copy Proj1TotalWkHrs and name it Proj5TotalWkHrs.  

4   Click Apply to add the fields to the project. 

Step 2: Export the new fields to the view  

1   In the Web View Editor, click the timesheet view in the Project / View list. 

2   Under Fields, click the last field (Product4) in the Export to View list. Click Attributes, and delete the 

value of the Html code after control attribute. 

3   Move the new fields from the Available list to the Export to View list. 

The new fields are added to the end of the Export to View list. The order of the fields does not matter.  

4   Click the last field in the Export to View list. Click Attributes, and set the value of the Html code after 

control attribute to “-->”. 

Step 3: Edit timesheet.js  

1   Open timesheet.js in your favorite text editor. You can find this file in the folder: 

CensusServer\CensusWeb\CUSTOMIZEDFILES\#Project#Timesheet\#AllWebViews#\Js  

This is the file to edit if you want to add a row to all Web views of your timesheet project. If you want to add 

rows to only certain Web views, you’ll need to create a new folder. For example: 

CensusServer\CensusWeb\CUSTOMIZEDFILES 
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 \#Project#Timesheet\#WebViews#Timesheets_MyTimesheets\Js  

2   At the top of the file, declare and initialize a variable that holds the ID of the new row: 

var PROJ_FIVE_ID=4;  

3   In the WriteTimesheetGrid() function, create a new array that holds the row information, and store 

this new array in m_arrTimesheet: 

m_arrTimesheet[PROJ_FIVE_ID]=new Array(  

"cbo_97_cbo_97_Project5"   

+ INNER_ARRAY_SPLITTER + INNER_ARRAY_SPLITTER+ strProjComboOptions,  

"nbr_98_nbr_98_P5HrsMon",  

"nbr_99_nbr_99_P5HrsTue",  

"nbr_100_nbr_100_P5HrsWed",  

"nbr_101_nbr_101_P5HrsThu",  

"nbr_102_nbr_102_P5HrsFri",  

"nbr_103_nbr_103_P5HrsSat",  

"nbr_104_nbr_104_P5HrsSun",  

"nbr_105_nbr_105_Proj5TotalWkHrs"   

+ INNER_ARRAY_SPLITTER + CONTROL_TYPE_TOTAL);  

4   Use the ID of the new row (PROJ_FIVE_ID) as an index into the m_arrTimesheet array.  

In the new array, specify the names assigned to form controls in the generated HTML. These names are 

based on the tBoundControlName, which you can find in the tblDtsFields table of the project definitions 

database. For example, if the tBoundControlName is cbo_97_Project5, then the form control name is 

cbo_97_cbo_97_Project5.  

Add a call to GetTimesheetProjRow() for the new row. Put this call before the call to 

GetTimesheetDayTotalRow(). 

// Calls to GetTimesheetProjRow() for previous rows  

strHTML+=m_oTimesheet.GetTimesheetProjRow(  

m_arrTimesheet[PROJ_FIVE_ID]  

);  

// call to GetTimesheetDayTotalRow()  
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Step 4: Update layouts, queries, sorts, and reports  

Any layouts, queries, sorts, or reports that use values from the rows in a timesheet must be updated.  

For example, the Current Issue - Detailed report is used to print the current timesheet. If you don’t update 

this report, it won’t show the rows you added.  

Step 5: Regenerate the Web views  

If you get javascript errors when you try to open the Web view, log off and fix timesheet.js. You don’t 

need to regenerate the Web view, but you must copy timesheet.js from the CUSTOMIZEDFILES folder to 

the Web view folder.  
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CHANGING THE TIMESHEET STARTING DAY  

The weekly timesheets can start on any day of the week. By default, the weekly timesheets start on 

Monday.  

To change the timesheet starting day: 

1   In the Web View Editor, click the timesheet view in the Project / View list. 

2   Under Fields, click the last field before the fields that make up the actual timesheet. By default, this is 

the Weekly Total Hours field. 

3   Click Attributes and then click the attribute value of the Html code after control attribute. This should 

take you to the end of the line of text, where you’ll see the START_MONDAY constant as the last 

argument to a function. 

4   Change this to the new starting day. Use one of these constants: 

START_MONDAY  

START_TUESDAY  

START_WEDNESDAY  

START_THURSDAY  

START_FRIDAY  

START_SATURDAY  

START_SUNDAY  
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CREATING A TIMESHEET  

When you create a new project based on the Timesheet project, you must add the timesheet to a Web 

view of the new project. After that, you can copy the Web view to create more views of the new project.  

 

To add a timesheet to a Web view: 

1   Export the fields displayed above the timesheet (by default: Employee, Weekly Start Date, and 

Weekly Total Hours). 

2   Enter the following HTML into the HTML code after control attribute of the last field currently in the 

Export to View list.  

Instead of typing in this HTML, you can copy the HTML code after control value from the Weekly Total Hours 

field in the original Timesheet / Timesheet Web view.  

<script type="text/javascript" src="../js/Timesheet.js"></script> 

<select name="TS_cbo_vals" class="HiddenObject"><WC@53></WC@53> 

</select><script>WriteTimesheetGrid(escape 

(document.Record.TS_cbo_vals.innerHTML),START_MONDAY);</script><!--  

3   Export the timesheet fields. The order does not matter. 

DailyTotalMon, ..., DailyTotalSun (7 fields) 

P1HrsMon, ..., P1HrsSun (7 fields) 

P2HrsMon, ..., P2HrsSun (7 fields) 

P3HrsMon, ..., P3HrsSun (7 fields) 

P4HrsMon, ..., P4HrsSun (7 fields) 

Proj1TotalWkHrs, ..., Proj4TotalWkHrs (4 fields) 

Project1, ..., Project4 (4 fields) 
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4   Enter the string “-->” (without the quotation marks) into the HTML code after control attribute of the 

last field in the Export to View list.  
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CHAPTER 44 - DATABASES 
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OVERVIEW  

VIZOR supports databases in multiple versions of SQL Server.  

By default, SQL Server databases are located on the SQL Server computer in the DATA folder or the 

default  folder specified by the SQL Server administrator. By default, Jet/Access databases are stored in 

the ConnectServer folder (for example, C:\Program Files\Vector\ConnectServer) 

Project databases  

A project includes two main databases:  

 A database of records of the main entity stored in that project (assets, tickets, 

people, etc.) and their revision histories.  

 A database of definitions, which contains defined business rules, queries, 

sorts, layouts, reports, notifications, fields, and tabs available in the project. 

Users database  

In addition to the project databases, there is a database of users, contacts, employees and companies. The 

users database is shared by all projects.  
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DAT DATABASE  

SQL Server  

Issues are stored in the <project>01_Dat database, where <project> is the name of the VIZOR project. 

The database consists of:  

 <project>01_Dat.mdf 

The master data file (MDF) of the database.  

 <project>01_Dat_log.LDF 

Log file that holds the log information used to recover the database. There must be at least one log file 

for each database, although there can be more than one.  

 

Microsoft Access  

Issues are stored in the file <project>01.dat, where <project> is the name of the VIZOR project.  

 

MAIN TABLES  

tblDts  

Stores most of the information entered for an issue. This includes most of the fields on the Overview, 

Description, and Detail tabs, as well as the information entered on any custom tabs added to the project.  

tblFixInformation  

In previous releases of VIZOR, new fields added to the Resolution tab were stored in tblFixInformation. 

The default fields are stored in tblDts. 

 

Any new fields added to the Resolution tab are stored in tblDts. Stores fix-related information entered 

on the Fix tab. 
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tblAttachments  

Stores any files attached to an issue.  

tblRevisionHistory  

Stores the revision history for issues.  
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DEFINITIONS DATABASE  

SQL Server  

The project definitions database is named <project>02_DEF, and consists of these files:  

 <project>02_DEF.mdf 

 <project>02_DEF_log.LDF 

 

Microsoft Access  

The project definitions database is named <project>02.def, where <project> is the name of the VIZOR 

project.  

 

 

MAIN TABLES  

tblDtsFields  

Defines the fields available in a VIZOR project. The Field Editor in Vizor Admin provides a user interface for 

editing most of the columns in this table.  

In tblDtsFields, the tWhere column specifies a Where clause that controls the contents of a choice list. 

The VIZOR project uses the Where clause to build the Contact, Owner, and Submitter choice lists.  

For example, this Where clause removes macros (such as <User>) and contacts from the Owner list:  

Where (([nID] >= 0 And  [tName]  <> '')Or 

[tName]  = '<User>') And fOriginator = 0  
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 The [nID] >= 0 condition removes the macros defined in tblUser: 

User ID User Name 

-4 <Contact> 

-3 <User> 

-2 <Previous Owner> 

-1 <Owner> 

The user with nID = 0 is the <None> macro.  

 The fOriginator = 0 condition removes contacts, so that the list contains 

users only. 

 tName is the name of the user.  

tblState  

Specifies the list of choices for the State field. The State field is a read-only field that is set based on the 

Status field.  

tblSubState  

Specifies the list of choices for the Status field. Each possible substate corresponds to a possible State 

value (Open or Closed).  

Choice List Tables  

A choice table specifies the possible values for a choice list field. Each row in a choice table includes an 

nID, a tName (the choice text), and optionally, an nChoiceID (for non-alphabetical choice lists).  

In the issue database, multi-choice fields store a semi-colon separated list of the tName values (the 

choice text strings), not the nID values.  
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USERS DATABASE  

All VIZOR projects share the same database of users. The users database also stores global choice lists.  

Microsoft Access  

The user database is named users.mdb.  

SQL Server  

The user database is named USERS_MDB, and consists of these files:  

 USERS_MDB.mdf 

 USERS_MDB_log.LDF 

MAIN TABLES  

tblUser  

Lists the users and contacts. Users have logon names and passwords. Contacts are people who report 

issues, but do not have a logon account.  

If you add a field to the Origin tab, the field is added to tblUser, not tblDts. The Origin tab is a read-only 

tab that displays user and contact information. The user and contact information is actually entered in 

VIZOR Web Admin (Security tab). This allows user and contact information to be entered once for all 

issues, instead every time for each issue.  
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GLOBAL DATABASES  

These databases are shared by all projects:  

 CensusWeb  

 CENSUSWEB_MDB in SQL Server 

 Stores Web view definitions. Used by the Web View Editor. 

 Licenses  

 LICENSES_MDB in SQL Server 

 Stores system information, list of projects, features, licenses. 

 

Advanced Topic 

 

DATASTORES 

DataStores are databases and other sources of data such as XML files. 

Some advanced customizations require working with datastore or database IDs. These are usually entered 

in tables and scripts.  

Global Datastores are defined in the censession.xml file. 

Project DataStores are defined in tblProjectDS [Licenses_mdb]. 

The following is a list of data store types: 

DataStore Type ID Notes 

    ClientDB  1 Internal use 
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    Admin  2 Admin Tool database 

    Library  4 Admin Tool Library (AdminLib) 

database 

    Licenses  8 Licenses_mdb 

    Users  16 Users_mdb 

    Dat  32 Project DAT database of the 

project in context 

    Def  64 Project DEF database of the 

project in context 

    Usr  128 Project USR database of the 

project in context 

    Web  256 Census_Web database of the 

project in context 

    SystemDB  512 Security databases for JET logons 

Censys.mdw 

    InventoryDB  1024 Integration with Inventory 

    SecuredDB  65536 Internal use 

    CenAuth  131072 Reserved authentication use 
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CHAPTER 45 - ARCHIVES & BACKUPS 
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ARCHIVING DATA 

 

In VIZOR, you can easily archive old records for any of the VIZOR projects (databases). 

Over time, your VIZOR system will accumulate data and, depending on the activity and the needs of the 

organization, the data can be significant. 

You may want to archive specific records for: 

- Reduce ‘noise’, if you think having these records ‘active’ do not add much value to the operations. 

- Improve performance. Any database performs better with less data. Running queries, reports, 

saving records and applying business rules execute faster with less records. 

- Regulatory Compliance. Your organization may need to archive records after specific time, or after 

specific events. 

 

Archiving involves a target VIZOR Project, which database will receive the records.  

To archive records, go to Web Admin > Options. 

Select the VIZOR project you want to archive (the source). 

 Click on Archive Project Data. 
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Select a target project to archive the records into. VIZOR only allows you to select a valid project. Valid 

projects are projects that were created from the source project. You can use the default project/databases 

IncidentsArchive, ProblemsArchive, AssetsArchive, etc.  

 

DETERMINING WHAT RECORDS TO ARCHIVE 

Select a named query to determine what records to archive. The records results of the query will be 

archived, and, if selected, deleted from the source project.  

You may use some default queries created specifically for this purpose, such as “Incidents to Archive” and 

“Problems to Archive”. By default, these queries archive records that are 2 years or older but you can 

change the exact conditions by changing this query in the Admin > Project > Query Editor.   
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BACK UPS  

You should regularly back up your VIZOR databases. Besides backing up all the issue data entered into 

the system, you should also (though perhaps less frequently) back up the files and databases that define 

your projects and Web views. Backups are part of a contingency/disaster recovery plan; this document 

does not cover the contingency or disaster recovery plan as it is particular to each organization policies 

and recovery needs. 

 

 

WHAT AND WHEN TO BACK UP 

Back up frequency depends mainly on the type of data. First of all we have to distinguish two different types of data:  

1. Records Data, like assets, tickets, licenses, Users/Contacts, etc. 

2. System Data ( information, schema, definitions) 

 

BACKING UP RECORDS DATA 

This information is dynamic, since it changes every time a VIZOR user adds, updates, or deletes a record. The 

frequency of your backups and types of backups performed is determined largely by the needs of your organization.  

 

You should tailor your backup strategy to the needs of your organization. For example, consider how much data and 

how quickly it should be recovered in the event of a disk failure.  

Daily backups may be enough, but you may need to perform more frequent differential backups if you need to 

recover up to the last hour for any disaster event. 

 



  Page 765 

 

BACKING UP SYSTEM DATA 

System Data, also known as the System Definitions, are the information that define the structure of data, business 

rules, reports, notifications, etc. This information is normally hidden from the user but allows the VIZOR system to 

function. Examples of system data are: 

• List of Fields used in a VIZOR project. 

• List of Fields available in each Web View UI, with permissions per user. 

• Template and conditions of Email Notifications. What to send and when. 

• Reports (with no data; templates). 

• Workflows and Business Rules. 

• List of VIZOR projects are available in a VIZOR Server. 

• Location of the databases used by a VIZOR project. 

This information is usually changed through VIZOR Administrator Tools, like VIZOR Admin and the Web View Editor. 

This information is usually static, since once the VIZOR project is set up it rarely changes. 

Power Customizations (customizations not done using the administrator editors) are usually static, too. Changes 

made to the Web files and scripts do not change often. These files are typically located under the CustomizedFiles 

folder (please refer to the documentation for more details about this). 

 

 

HOW TO BACK UP VIZOR DATABASES (DATABASES IN SQL SERVER)  

 

In Vizor, Records and System Data are in the SQL Server and some System data is in other type of files, like xml 

files. You can do a hot backup, which can be done while the system is being used, and a cold backup that requires all 

users to be logged off.  
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1. Live or hot backup using SQL Server tools 

A live backup is done even if the files to be backed up are in use. This is ideal for 24 hour a day operations. In this 

scenario, the VIZOR Administrator has to use some database specific tools for backing up. 

Back up SQL Server Databases: 

In this scenario, Issues, Users/Contacts and System Data are in SQL Server databases. Use the SQL Server built-in 

back up utility. Select the VIZOR databases like  

Project01_dat 

Project02_def 

Users_mdb 

Licenses_mdb 

CensusWeb_mdb, etc.  

Please refer to Microsoft SQL Server’s documentation for more information. 

 

2. Cold backup not using SQL Server tools 

A cold backup is a backup that works with the databases as files. This process is limited and not recommended as 

the only backup, if implemented. It involves copying the files to a disk or tape that is considered safe and secure to 

be an offline backup media.  

In this scenario, the VIZOR administrator has to ensure the files and databases are not being used before the 

backup process starts because, as with any other application, files in use are not backed up. 

SQL Server databases are not backed up as such, but as regular files, backing up the *.mdf and *.ldf files, which are 

the physical files of SQL Server databases. 

In order to be able to copy these files, SQL Server has to be not using the files. That is, either the SQL Server Service 

is stopped or the database is temporarily detached from the SQL Server (while the backup is in done). 

 

 

BACK UP A COMPLETE VIZOR SERVER INSTALLATION 
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In some cases, you may want to keep a complete copy of the VIZOR Server and not only the databases (typically 

contained in SQL Server databases). This complete backup of the system could be used for cloning a server or for 

disaster recovery, particularly useful if a system has power customizations.  

 

In order to do a complete backup of the system: 

Note: In the following paths, use “Program Files” for 32 bit operating systems and 

use “Program Files (x64)” for 64 bit operating systems. 

1. Back up the SQL Server databases 

As described previously. 

 

2. Back up System Data not in SQL Server databases (regular files): 

You do not need to do this type of backup frequently as these files rarely change.  

1. Ensure the files are not in use: 

i. Unload the VIZOR Web virtual directories from the Internet Services Manager 

- or - 

If there are no other applications affected, stop the World Wide Web service from the Services Manager. 

ii. Stop the MQ Issue Agent service from the Services Manager. 

iii. Close any running instances of VIZOR Admin and the Web View Editor.   

TIP: you can log off users through the Logons Editor in VIZOR Web Admin. 

 

iv. Backup the VIZOR Server folder and all the files inside with the exception of: 

• the AccessRT folder, which contains the setup program for the Microsoft Access Runtime 

• *.mdf and *.ldf files, which are the physical files of SQL Server databases and should be backed up or 

synchronized as mentioned in the previous section 

You can do this task by using any standard backup tool in the market, such as Backup Exec, Backup NOW!, 

or some Computer Associates tools. 

Note: If you have any VIZOR projects in folders outside the Vizor Server folder, remember to back up those 

files as well. 

 

 



  Page 768 

 

3. Back up the MetaQuest Common Files: 

You do not need to do this type of backup frequently as these files rarely change.  

Back up the complete folder: 

 <SystemDrive>:\Program Files\Common Files\Metaquest 

This folder contains dlls and binary files needed to run the VIZOR Server. 

 

4. Back up the VIZOR Tools: 

You do not need to do this type of backup frequently as these files rarely change.  

Back up the complete IssueTrackerTools folder, which is located by default in: 

 <SystemDrive>:\Program Files\ConnectTools 

This folder contains customized files needed to run administrator tools and programs like the IssueTracker Admin 

and the Web view Editor. 

 

5. Back up the VIZOR Server: 

You do not need to do this type of backup frequently as these files rarely change.  

Back up the complete ConnectServer folder, which is located by default in: 

 <SystemDrive>:\Program Files\ConnectServer 

This folder contains customized files, attachments, and power customizations. 

 

HOW TO BACK UP ATTACHMENTS 

Back up all the files inside the project folder. There is one folder per project and it uses the same name as the 
project. The project folder is located inside the ConnectServer folder, for example: 

 C:\Program Files\Vector\ConnectServer\Actions 

where Actions is the name of the Vector VIZOR project. 
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Inside the HelpDesk folder, you will find at least some of the following files and folders: 

I. CustomMacro.bas (File) 

II. Macro7x.bas (File) 

III. MailQueue (Folder, only if Mail Integration is turned on) 

IV. Data (Root folder for all attachments) 

1. Attachments (Folder, ticket attachments) 

2. Mail Integration Attachments (Folder) 

3. Mail Template Attachments (Folder) 

 

  

LOCATING DATABASES  

By default, all databases are stored in the ConnectServer folder on your Web server. However, the 

databases can be relocated to different folders on different computers. For example, the databases may 

be relocated to a separate SQL Server computer.  

To locate the databases, log on to VIZOR Web Admin and go to the Relocation tab.  

LOCATING ATTACHMENT FILES 

By default, attachments are stored on the Web server. For example, the files attached to issue #3 in the  

project are stored in the folder  

ConnectServer\vit\Data\Attachments\3  

Attachments may be relocated to a separate file server. To check the location of the attachments, log on 

to VIZOR Web Admin, go to the Relocation tab, and click Relocate Attachments.  

WEB VIEWS  

By default, the runtime files of Web views (the application UI) are stored on the Web server in the 

ConnectServer folder:  
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ConnectServer\CensusWeb\Views\CensusWebVD\  

To check the location of your Web views, log on to the Web View Editor and in the shortcut bar click URL.  

BACKING UP THE MAIN RECORDS  

To back up the records data stored in a project, you need to back up:  

 The man data records database, which stores all the information you entered 

(Incidents, Problems, Changes, Assets, Users, etc). 

 The files attached to issues. These files are stored outside of the issue 

database, in the file system. 

WHAT TO BACKUP  

All issue information (except for attached files) is stored in the issue database.  

Database engine Database 

SQL Server <project>01_DAT 

 

By default, attachments are stored in the project folder (for example, C:\Program 

Files\Vector\ConnectServer\vit\Data\Attachments). Note that the attachments may be stored in a different 

folder or on a different computer.  

 

 

 

 

 

 

Notes 
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 To check the location of the databases, log on to VIZOR Web Admin and click 

the Relocation tab. 

 To check the location of the attachments, log on to VIZOR Web Admin, click 

the Relocation tab, and click Relocate Attachments. 

 You can use VIZOR Admin to verify the location of the issue database. In the 

Project list, click the project to display the Project Properties. The Project 

Location specifies the location of the issue database. 
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BACKING UP PROJECTS  

Projects include the definitions of fields, queries, sorts, layouts, reports, and notifications.  

WHAT TO BACKUP  

Project definitions are stored in the definitions database.  

Database engine Database 

SQL Server <project>02_DEF database 

 

In addition to the definitions database, there are several related files you should also back up.  

Project File Description 

<project>.cen Used for project initialization 

and versioning 

 

Note that VIZOR automatically backs up the tblDtsFields table in the definitions database. This table 

contains the definitions of the fields in the project. The backup copies of the table are stored in the 

definitions database.  



  Page 773 

 

BACKING UP THE USERS DATABASE  

The users database contains all user and contact information, and is shared by all projects.  

WHAT TO BACKUP  

If at least one project uses SQL Server, the user data is stored in a SQL Server database. Otherwise, the 

user data is stored in a Microsoft Access .mdb file. The users database is located in the ConnectServer 

folder (for example, C:\Program Files\Vector\ConnectServer).  

 

Database engine Database 

SQL Server USERS_MDB 
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BACKING UP SYSTEM FILES  

We recommend you do a general backup of the files in the ConnectServer folder.  

WHAT FILES TO BACKUP  

You should backup these files:  

 Censys.mdw (security database that contains users, groups, and passwords). 

 The license database. 

 Database engine Database 

 SQL Server LICENSES_MDB 

 CenSession.xml 

 CenInfoSession.xml  

VIZOR automatically creates backup copies of CenSys.mdw and CenSession.xml in the ConnectServer 

folder when the files change. A mirror of CenSys.mdw is also available (the mirror file is named 

CenSys_mir.mdw).  
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BACKING UP WEB VIEWS  

WHAT TO BACKUP  

You should backup these databases, files, and folders:  

 The database of Web view definitions and settings. 

 Database engine Database 

 SQL Server CENSUSWEB_MDB 

 The CUSTOMIZEDFILES folder. This folder contains all the customized Web view files 

(for example, custom reports). 

 The generated Web view files. Each Web view has its own folder. For example: 

C:\Program Files\Vector\ConnectServer 

\CensusWeb\Views\CensusWebVD\HelpDesk_HelpDesk C:\Program 

Files\Vector\ConnectServer 

\CensusWeb\Views\CensusWebVD\HelpDesk_HelpDesk 

 The project folders. Each project has its own folder. For example: 

C:\Program Files\Vector\ConnectServer\HelpDesk  

The project folder stores attachments, the reports used to format notifications, the macro70.bas file, 

and the queue of notification messages. 

Note that the attachments may be stored on a different computer. To check the location of the attachments, 

log on to VIZOR Web Admin, click the Relocation tab, and click Relocate Attachments. 
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AUTOMATIC BACKUPS  

VIZOR automatically backs up:  

 The tblDtsFields table in the project definitions database. This table contains 

the definitions of the fields in the project. 

 CenSession.xml 

 CenSys.mdw 

You can disable these automatic backups by setting the Enable Backups option to No (in the Tools 

menu, click Options).  
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PERFORMING HOT BACKUPS  

Hot backups are backups performed while the VIZOR system is in use. Hot backups are ideal for 

continuous operations.  

To perform hot backups, the VIZOR administrator has to use database-specific tools:  

 To back up data in a SQL Server database, use the built-in SQL Server backup 

utility. 

 If SQL Client Tools are installed, you can use SQL Enterprise Manager to back 

up an MSDE database.  

 To back up Jet/MSAccess databases, use a third-party tool like FMS Total 

Visual Agent. 
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RESTORING BACKUPS  

After restoring backups of the issue database and the project definitions database, use the Integrity editor 

to validate the integrity of fields, relationships, and the issue database.  

 

CHAPTER 46 - RELOCATING A VIZOR 

INSTALLATION 
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ABOUT THE RELOCATION WIZARD  

VIZOR includes a Relocation Wizard for moving its installations from one computer to another.  

When you relocate VIZOR, the Relocation Wizard:  

 Logs off all users. 

 Unloads the virtual directories used by VIZOR. 

 Stops the Mq Issue Agent service. 

 Detaches local SQL Server databases. 

 Backs up the ConnectServer and ConnectTools folders before relocating them. 

 Copies VIZOR to another computer and disables the original installation. 

 Regenerates all your Web views after VIZOR is relocated. The Web views are 

all regenerated in the default CensusWeb/Views/CensusWebVD folder.  

The Relocation Wizard relocates SQL Server databases if:  

 The SQL Server databases are local to the source computer. 

 The version of SQL Server on the target computer is greater than or equal to 

the version of SQL Server on the source computer. 

RELATED TOPICS 

Before You Relocate 

Relocating VIZOR 

If Something Goes Wrong 
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Updating Client Programs 

Enabling VIZOR after Relocation 
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BEFORE YOU RELOCATE  

CHECK PERMISSIONS  

You must run the Relocation Wizard with a user account that has Full Control permission for the 

ConnectServer folders on all computers (current location and new location).  

CLOSE ALL COPIES OF VIZOR ADMIN AND THE WEB VIEW EDITOR  

This includes all copies of the programs, not just those installed on the Web server.  

RELOCATE PROJECTS  

If you have any projects located outside of the ConnectServer folder, use VIZOR Admin to move the 

projects into the ConnectServer folder. After you relocate VIZOR￼, you can use VIZOR Admin to move 

the projects back outside of the ConnectServer folder.  

BACK UP  

The Relocation Wizard backs up your ConnectServer and ConnectTools folders, but you may want to 

create your own backups.  

LOG OFF USERS  

The Relocation Wizard logs off users, but you may want to inform users that VIZOR will not be available.  
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RELATED TOPICS 

Relocating VIZOR 

Updating Client Programs 

Enabling VIZOR after Relocation 
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RELOCATING VIZOR 

In VIZOR, all components are typically installed on one computer: the Web server. The Relocation Wizard 

allows you to move VIZOR to a different computer. 

To relocate VIZOR: 

1   Close all copies of VIZOR Admin, VIZOR Web Admin, and the Web View Editor. 

2   On the target computer, perform a clean install of VIZOR. 

3   On the target computer, run the Relocation Wizard, called MqRelocateTool.exe, located in 

ConnectTools\Support\Relocation. 

4   In the Logon Name and Password boxes, enter a VIZOR user account that belongs to a group with 

Admins permissions. 

5   In the Relocate From section, enter the location of the current VIZOR Server as a UNC path (for 

example, "\\NANP\ConnectServer").  

Make sure the Computer Name box contains the name of the computer where the current VIZOR Server is 

located, and the Local Path box contains the location of the current VIZOR Server relative to a root directory 

(for example, “C:\Program Files\Vector\ConnectServer”). 

6   In Relocate To section, make sure the VIZOR Server box contains the installation location of the 

VIZOR Server on the target computer, and the VIZOR Tools box contains the location of VIZOR Admin 

and the Web View Editor on the new computer. 

7    Select the Show Advanced Options check box to show the name of the target computer. If the name 

isincorrect or missing, enter the name. 

8   Click OK to start the relocation.  

When the relocation is complete, the Wizard regenerates all the Web views. 

9   Update any remote installations of VIZOR Admin and Web View Editor to reference the new 

ConnectServer share. 

Check you can open the relocated projects and Web views, and you can run VIZOR Admin, VIZOR Web 

Admin, and the Web View Editor. 

You can now uninstall the old copy of VIZOR. 
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IF SOMETHING GOES WRONG  

If something goes wrong when you relocate VIZOR:  

 Check the error log. The Relocation Wizard creates an error log in the 

ConnectServer\Relocation folder of the computer where you run the wizard. 

 The folder name includes the date and time, so the path to the error log looks 

something like this:  

ConnectServer 

 \Relocation_02-20-2003_10.44.50 

  \RelocationErrorLog.txt   

 Check  there is enough free disk space on the new server. Typically, the 

amount of disk space required is at least twice the size of the current 

ConnectServer folder. 

 If you are relocating SQL projects, reattach the databases to the SQL Server 

before trying again.  
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UPDATING CLIENT PROGRAMS  

After you relocate VIZOR, you must update any client programs. Client programs are copies of Vizor 

Admin and the Web View Editor installed on computers other than the Web server.  

To update the client programs on a computer, you run the MqRelocateClients.exe program on that 

computer.  

When the Relocation Wizard finishes, it puts a copy of the MqRelocateClients.exe program in the 

ConnectServer\Relocation_<timestamp> folder.  

If you send the MqRelocateClients.exe program to users to run, you must also send the INI file located in 

the same folder as MqRelocateClients.exe.  
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ENABLING VIZOR AFTER RELOCATION  

When the Relocation Wizard copies a VIZOR installation to a different computer, it automatically disables 

the original installation. However, you can re-enable the original installation if you want to continue using 

it, for example, when you to test an upgrade with live data, while continuing to use the original 

installation.  

To enable VIZOR after a relocation:  

Apply the following steps to the original VIZOR installation.  

1   Reattach all SQL Server databases. 

To prevent users from using old databases, the Relocation Wizard detaches all  SQL Server databases.  

Reattach the <project>_DAT databases and the USERS_MDB database using the .mdf or .ldf files in your 

ConnectServer folder.  

2   Rename licenses.mdb. 

Locate a file in the ConnectServer folder with a name that looks like Licenses.mdb_2004-06-18_20.23.21.bak. 

If there are several files like this, use the one with the most recent date in the name.  

3   Allow users to log on. 

 In the ConnectServer folder, open the file census.ini. Find the [SessionControl] section, and if Enabled=0, change it to 

Enabled=1. 

 Start VIZOR Admin and click Tools > Integrity. Select the Remove Locks check box and click Start. 

 In the CensusWebVD folder (by default, ConnectServer\CensusWeb\Views\CensusWebVD), locate a file with a name like 

Logon.asp_bck_logoff. If this file exists, delete the Logon.asp file and rename Logon.asp_bck_logoff to Logon.asp. 

 In the CensusWebAdmin folder (by default, ConnectServer\CensusWeb\Views\CensusWebAdmin), locate a file with a name like 

Logon.htm_bck_logoff. If this file exists, delete the Logon.htm file and rename Logon.htm_bck_logoff to Logon.htm. 

4   Restart the notification service. 

If you use notifications, open Services and start the Mq Issue Agent service.  

To open Services, click Start, click Control Panel, double-click Administrative Tools, and then double-click 

Services.  
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%fieldid% variable, 429 

%fieldname% variable, 429, 434 
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.def file See project definition, 475 
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<=  less than or equal operator, 223 
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404 errors, 479 

Adding Pop -up Editors, 429 

Adding URL buttons, 435 

Ad-hoc Query Editor, 295, 425 

admin user account, 276 

Admins group, 504, 514, 518 
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Analyst user account, 276 
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Assigned Work Team field, 281 

Attachments, 467, 478 

Attachments command, 467 

Attachments field, 312, 535 
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Authentication method, 289 

Auto Repair, 477 

Automatically setting value, 395 

Automatically Update Choice List attribute, 430, 

521 

Backups, 593, 595, 597, 600, 605 

Bandwidth usage, 473 

Base projects, 504 
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Branding, 556, 573 

Byte field size, 319 

Captions, 302, 315, 431, 515, 521 

Categories, 282 

CenInfoSession.xml, 598 

CenSession.xml, 598 

CensusAdminsGroup group, 462 

CensusMain.css, 432, 448, 555, 557, 560, 563, 

566, 569, 573 

CensusUser account, 442, 462 

CensusUser user account, 462 

CensusWebVD folder, 447 

CenSys.mdw, 598 

Changing type, 515 
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Child Issues tab, 426 

Choice Editor, 302 

Choice lists, 223, 231, 280, 287, 315, 316, 324, 

325, 358, 430, 432, 436, 487, 515, 521, 585, 587 

Choice lists,Allow Choice Order Sort, 325 

Choice lists,automatically setting value, 358 

Choice lists,Automatically updating, 430 
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Choice lists,custom reports, 515 

Choice lists,database tables, 585 

Choice lists,defined, 316 

Choice lists,editing, 324, 515 
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Choice lists,importing, 487 
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436 
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Choice lists,showing selected items, 436 

Choice lists,sorting, 231, 325 

Choice lists,tooltips, 436 

Choice lists,updating in Web views, 430, 521 

Choice order sort, 223 

Client programs, 609 

Closed Date field, 326 

Closed Time field, 326 

Column Span attribute, 432, 521 

ComboBoxWidth CSS class, 432 

Contact field, 276, 521 

Contact tab, 266, 314 

contacts, 201, 266, 276, 280, 287, 415, 486, 487 

contacts,adding choice lists of, 287 

contacts,assigning to work teams, 280 

contacts,defined, 201 

contacts,importing, 486, 487 
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contacts,submit-only views, 276, 415 

Contains operator, 224 

Cookies, 554 

Copying HelpDesk, 610 

Crystal Reports, 235 

CSS classes, 432, 521, 536 

CSS style sheets, 448, 555, 557, 560, 563, 566, 

569, 573 

Currency fields, 316 

Current Issue - Detailed report, 515, 521 

Current users, 507 

CUSTOM REPORT ENGINE OPTION, 247 

Custom reports, 246, 515, 521 

Custom reports,choice list changes, 515 

Custom reports,deleted fields, 515 

Custom reports,fields not exported, 521 

Custom reports,for specific Web views, 246 

Custom reports,multi-choice lists, 515 

CustomCode.js, 434, 543, 544 

CustomizedFiles folder, 246, 445, 521, 599 

CustomizedFiles folder,backing up, 599 

CustomizedFiles folder,explained, 445 

CustomizedFiles folder,new projects, 521 

Customizing Fields, 515 

Data corruption, 474 

databases, 200, 474, 477, 478, 482, 497, 507, 535, 

583, 587, 593, 595, 596, 597, 600 

Databases command, 465 

databases,backing up, 593, 595, 597, 600 
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databases,definitions, 200 
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databases,issue, 200 

databases,locked, 478 
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databases,releasing, 478 

databases,removing locks, 474 

databases,synchronizing issues with project 

definitions, 477 

databases,users, 587 

Date fields, 222, 316, 486 

Date format, 462 

Default projects, 504 

Default values, 443 

Definitions database, 507 

Description attribute, 417 

Destination Tab, 302, 314 
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Detailed Record report, 515 

DHTML, 434 

Display All Read-Only Fields As Text attribute, 

417, 433 

Display Read-Only Field As Text attribute, 433 

DNS Error, 478 

Domain user accounts, 442 

Double field size, 319 

Editor attribute, 429 

E-mail Conversation and Queue, 347 

employee account, 276 

Employee user account, 276 

Enable Auto Repair command, 477 

Enable Backups option, 600 

Error log, 608 

Errors, 478, 479 

Errors,404 File not Found message, 479 

Errors,Cannot find server or DNS Error message, 

478 

Errors,The page cannot be displayed message, 

478 

Escalation levels, 381 

Escalation rules, 382 

Escape sequences, 438 

Features, 294, 518 

Features,described, 518 

Features,enabling and disabling, 294 

Field Editor, 302 

Fields, 302, 309, 310, 311, 312, 313, 314, 315, 

316, 319, 321, 322, 324, 358, 413, 417, 425, 

428, 429, 430, 431, 432, 433, 434, 435, 436, 

438, 443, 515, 521, 542, 543, 596 

Fields,adding to issues, 309 

Fields,Aligning attribute, 430 

Fields,Alignment attribute, 430 

Fields,attributes, 428 

Fields,automatically setting value, 358 

Fields,captions, 315, 431, 515, 521 

Fields,changing size, 515 

Fields,changing type, 515 

Fields,choice lists, 316, 430, 521 

Fields,choice lists,automatically updating, 430 

Fields,choice lists,defined, 316 

Fields,choice lists,updating in Web views, 521 
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Fields,CSS Class attribute, 432 

Fields,currency, 316 

Fields,custom reports, 521 

Fields,customizing, 515 

Fields,date, 316 

Fields,decimal numbers, 319 

Fields,default values, 443 

Fields,deleting, 321, 515 

Fields,Destination Tab, 302, 314 



  Page 791 

 

Fields,disabled, 311 

Fields,Display Read-Only Field As Text attribute, 

433 

Fields,editing, 515 

Fields,editing choice lists, 324 

Fields,Editor attribute, 429 

Fields,exporting to Web views, 425, 521 

Fields,form elements, 432 

Fields,hiding, 322, 438 

Fields,integer numbers, 319 

Fields,labels, 302, 431, 515 

Fields,layout in Web views, 521 

Fields,Layouts, 425 

Fields,Maintain Revision History, 313 

Fields,memo, 316, 433 

Fields,number, 316 

Fields,queries, 521 

Fields,read-only, 302, 311, 417, 433 

Fields,related, 358 

Fields,renaming, 515 

Fields,required, 310, 425 

Fields,security, 302, 311 

Fields,Show in Choice Lists, 312 

Fields,Show Selected Items in Text attribute, 436 

Fields,Show Selected Items In Tooltip attribute, 

436 

Fields,size, 319 

Fields,sorts, 521 

Fields,spanning columns, 432 

Fields,tabs, 314, 515 

Fields,tblDtsFields, 596 

Fields,text, 316, 434, 436 

Fields,time, 316 

Fields,timestamping, 542, 543 

Fields,types of, 316 

Fields,updating styles, 515 

Fields,URL Button CSS attribute, 435 

Fields,URL buttons, 435 

Fields,Visible attribute, 322, 438 

Fields,Width attribute, 434 

Fields,yes/no, 316 

File uploads, 478 

Form elements, 432 

Form elements,CSS classes, 432 

Global choice lists, 280, 587 

Global databases, 465 

Group leader user account, 276 

group membership, 292 

Groups, 268, 278, 290, 291, 294, 451, 504, 507, 

518 

Groups command, 290 

Groups,adding users, 291 
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Groups,Admin, 518 

Groups,creating, 290 

Groups,defined, 268, 451 

Groups,deleting, 290 

Groups,feature permissions, 294 

Groups,Guests, 518 

Groups,project access permissions, 278, 504, 

507, 518 

Groups,removing users, 291 

Groups,setting permissions, 518 

Groups,users, 518 

Groups,Web view access permissions, 518 

Guests group, 518 

HelpDesk, 604, 610 

HelpDesk Admin, 205, 324, 477 

HelpDesk project, 504 

HelpDesk Web Admin, 206, 208, 324, 462 

HelpDesk,copying to another computer, 610 

HelpDesk,moving to another computer, 604 

HelpDeskServer folder, 597 

hiding in projects, 283 

Html code after control, 434, 542, 544 

Html code after control,defined, 434 

Html code after control,timestamping, 542, 544 

Html code before control, 434, 542, 544 

Html code before control,defined, 434 

Html code before control,timestamping, 544 

Import Issues, 482, 497 

Importing users, 270 

Integer field size, 319 

Integrity command, 474, 610 

Inventory, 538 

Inventory,customizing reports list, 538 

issue database, 200, 475, 477, 482, 497, 583, 595 

issue database,backing up, 595 

issue database,DAT, 583 

issue database,described, 200 

issue database,importing, 482, 497 

issue database,synchronizing with project 

definitions, 475 

issue database,synchronizing with revision 

history, 477 

issue database,tblAttachments, 583 

issue database,tblDts, 583 

issue database,tblFixInformation, 583 

Issueagent user account, 403 

Issues, 246, 426, 469, 482, 486, 497, 515, 521 

Issues per Page attribute, 417 

Issues,deleting, 469 

Issues,importing, 482, 497 

Issues,linking, 426 

Issues,numbers, 486 
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Issues,printing, 246, 515, 521 

Issues,recycling numbers, 469 

Javascript, 434 

keyword searches, 224 

Knowledge Base views, 415, 438 

Knowledge Base views,described, 415 

Knowledge Base views,URLs, 438 

Labels, 302, 315 

Labels,changing, 315 

Labels,choice lists, 315 

Labels,Field Caption, 302, 315 

Layouts, 233, 425 

Layouts,defining, 233 

Layouts,exported fields, 425 

Licenses, 500, 598 

Licenses command, 500 

Licenses database, 598 

Like operator, 226 

Load Issues Not In Query attribute, 417 

Locks, 474, 478, 610 

Logging off users, 471, 605 

Logon accounts, 266, 276 

Logon sessions, 507 

Logon.asp, 438, 446, 554 

Logons Editor, 474 

Logons Editor command, 471 

Logos, 555, 573 

Long integer field size, 319 

Macros, 222, 281, 365, 370, 373, 398, 549 

Macros,<Any>, 373 

Macros,<Empty>, 373 

Macros,<New Issue>, 370 

Macros,<None>, 222 

Macros,<Today>, 222 

Macros,<User in Group>, 365, 370, 398 

Macros,<User>, 222, 398 

Macros,<Value of Field>, 281, 373 

Macros,defining, 549 

Mail server options, 403 

MAPI, 403 

Maximum Notification Retries option, 405 

Memo fields, 316, 429, 433, 542, 543 

Memo fields,defined, 316 

Memo fields,timestamping, 542, 543 

MemoFieldWidth CSS class, 432, 521 

MIME types, 479 

Monitor Interval, 473 

Moving attachments, 467 

Moving HelpDesk, 604 

Mq Issue Agent, 403 

Mq Issue Agent service, 478 

Mq.Evaluator service, 387 
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Multi-choice lists, 316, 515 

Network traffic, 473 

New projects, 521 

Normal Web views, 415 

Not Like operator, 226 

Notification - Detailed Record report, 515 

Notification - Summary report, 515 

Notification service, 403 

Notifications, 313, 385, 395, 398, 402, 403, 405, 

478, 504, 515, 526, 546, 549 

Notifications,attachments, 546 

Notifications,bounces, 405 

Notifications,contents, 549 

Notifications,copying to new projects, 504 

Notifications,e-mail contents, 398 

Notifications,escalation rules, 385 

Notifications,examples, 395 

Notifications,field updates, 313 

Notifications,file formats, 546 

Notifications,formatting, 515 

Notifications,Include macros, 549 

Notifications,mail server options, 403 

Notifications,maximum retries, 405 

Notifications,Mq Issue Agent service, 478 

Notifications,retries, 405 

Notifications,send failures, 405 

Notifications,setting up, 403 

Notifications,sharing between projects, 504 

Notifications,user account, 403 

Notifications,when conditions, 398 

Notifications,workflow, 402 

Number fields, 316 

Number of Characters attribute, 436 

Number of Visible Items attribute, 436 

OPTIONS, 247, 403, 405, 472, 473, 478, 526, 600 

Options,Always verify locked databases, 478 

OPTIONS,CUSTOM REPORT ENGINE, 247 

Options,Enable Backups, 600 

Options,Maximum Notification Retries, 405 

Options,Monitor Interval, 473 

Options,Send immediate shutdown message, 

472 

Options,Send Invalid Notifications To, 405 

Options,Server Mail Interval, 403 

Options,Server Mail Sender, 403 

Options,Server Mail System, 403 

Options,Server MAPI Profile, 403 

Options,SMTP Server, 403 

OPTIONS,STANDARD REPORT ENGINE, 247 

Owner field, 276, 486, 521 

Pages, 248, 417 

Pages,report, 248 
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Pages,Summary list, 417 

Passwords, 295, 403, 442 

Performance, 474, 514, 521 

Performance,number of projects, 514 

Performance,optimizing, 474 

Performance,updating choice lists, 521 

Permissions, 605 

Priority field, 223 

Problem Area field, 223 

Progress controlled by parent field, 426 

Progress field, 324, 326, 358, 426, 486, 515, 585 

Progress field,automating workflow, 358 

Progress field,child issues, 426 

Progress field,choice table, 515 

Progress field,database table, 585 

Progress field,editing, 324, 326 

Progress field,importing, 486 

Progress field,relationship with State, 326 

Progress field,renaming, 515 

Project definitions, 287, 475, 507, 515, 549, 585, 

596 

Project definitions,.def file, 585 

Project definitions,backing up, 596 

Project definitions,described, 507 

Project definitions,macros, 549 

Project definitions,Progress choice table, 515 

Project definitions,synchronizing with issue 

database, 475 

Project definitions,tables, 585 

Project definitions,tblDtsFields, 585, 596 

Project definitions,tblState, 585 

Project definitions,tblSubstate, 515, 585 

Project definitions,user choice lists, 287 

Project folder, 595 

projects, 200, 278, 283, 465, 469, 482, 497, 504, 

505, 506, 507, 514, 518, 521, 595, 599, 605 

projects,access permissions, 514 

projects,administering, 200 

projects,base projects, 514 

projects,creating, 504, 521 

projects,current users, 507 

projects,customized files, 521 

projects,database engine, 507 

projects,databases, 465 

projects,defined, 504 

projects,definitions database, 200, 507 

projects,deleting, 506 

projects,deleting issues, 469 

projects,folders, 595, 599 

projects,Groups Allowed to Open, 278, 504, 507, 

518 

projects,HelpDesk, 504 

projects,hiding users, 283 
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projects,importing issues, 482, 497 

projects,location, 507 

projects,one vs. many, 504 

projects,properties, 507 

projects,relocated, 605 

projects,styles and notifications, 505 

projects,templates, 506 

Properties of a project, 507 

Queries, 221, 222, 223, 224, 226, 281, 426, 521 

Queries,<None> macro, 224 

Queries,<Today> macro, 222 

Queries,<User> macro, 222 

Queries,Contains operator, 224 

Queries,dates, 222 

Queries,defining, 221 

Queries,exporting to Web views, 426 

Queries,keyword searches, 224 

Queries,relational operators, 223 

Queries,Revision Number field, 222 

Queries,rolling back, 521 

Queries,Web views, 521 

Queries,wildcards, 226 

Queries,work teams, 281 

Read-only fields, 311, 417, 433 

Read-Only For, 302, 311 

Read-only Web views, 415 

Regional settings, 462 

Regular expressions, 226 

Relationships between issues, 426 

Relocate, 465, 467, 604 

Relocate,attachments, 467 

Relocate,Relocate command, 465, 467 

Relocation Wizard, 604 

Removing locks, 610 

Repair and Compact command, 474 

REPORT CREATION API, 247 

Reports, 235, 246, 248, 425, 426, 515, 521 

Reports,adding fields, 515 

Reports,Current Issue - Detailed, 246, 515, 521 

Reports,customizing, 246 

Reports,Notification - Detailed Record, 515 

Reports,Notification - Summary, 515 

Reports,Pages, 248 

Reports,viewing, 235 

Required fields, 425 

Revision history, 313, 477 

Revision history,enabling/disabling, 313 

Revision history,synchronizing, 477 

Revision Number field, 222, 395 

Security, 266, 268, 278, 290, 294, 302, 311, 417, 

451, 518 

Security,fields, 302, 311 
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Security,logon accounts, 266 

Security,permissions, 278, 294, 417, 518 

Security,permissions,discussed, 518 

Security,permissions,features, 294 

Security,permissions,projects, 278 

Security,permissions,Web views, 417 

Security,user groups, 268, 278, 290, 451 

Send immediate shutdown message option, 472 

Send Invalid Notifications To option, 405 

Server Mail Interval option, 403 

Server Mail Sender option, 403 

Server Mail System option, 403 

Server MAPI Profile option, 403 

service level agreements, 378, 379, 380, 381, 382, 

387, 388, 390, 392, 393, 394 

service level agreements,creating, 390 

service level agreements,defined, 378 

service level agreements,disabling, 392 

service level agreements,escalation levels, 381 

service level agreements,operational hours, 388 

service level agreements,reporting, 390, 393 

service level agreements,running programs, 387 

service level agreements,service types, 394 

service level agreements,setting up, 379 

service level agreements,target times, 380 

Service types, 394 

Services, 387, 403, 478 

Services,Mq.Evaluator, 387 

Sessions, 471 

Show Selected Items in Text attribute, 436 

Show Selected Items In Tooltip attribute, 436 

Shutdown Process, 478 

Single choice lists, 316 

Single field size, 319 

size, 319 

SMTP Server option, 403 

sorts, 230, 231, 325, 521 

sorts,choice order, 231, 325 

sorts,defining, 230 

sorts,exported fields, 521 

spanning columns, 432 

SpanTwoWidthOne CSS class, 432 

SQL Query Analyzer, 535 

SQL Server, 595, 596, 597 

SQL Server,DEF database, 596 

SQL Server,issue database, 595 

SQL Server,USERS_MDB database, 597 

STANDARD REPORT ENGINE OPTION, 247 

State field, 326, 486 

Style sheets (CSS), 432, 555, 557, 560, 563, 566, 

569, 573 

Styles, 504, 515 
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Styles,copying to new projects, 504 

Styles,defined, 504 

Styles,editing fields, 515 

Styles,sharing between projects, 504 

Submit-only views, 276, 415, 438, 554 

Submit-only views,contacts, 276, 554 

Submit-only views,cookies, 554 

Submit-only views,described, 415 

Submit-only views,logon accounts, 276 

Submit-only views,URLs, 438, 554 

Submitter field, 276, 373, 486, 521 

Summary List, 417 

Summary report, 515 

tabs, 314, 328, 515 

tabs,adding fields, 314 

tabs,Contact, 314 

tabs,editing, 328 

tabs,moving fields, 515 

tblAttachments, 483, 535, 583 

tblDts, 482, 497, 539, 583 

tblDtsFields, 287, 585, 596 

tblFixInformation, 583 

tblRevisionHistory, 583 

tblState, 585 

tblSubstate, 515, 585 

tblUser, 358, 487, 539, 587 

templates, 506 

Text area form elements, 316 

Text fields, 316 

TextFieldWidth CSS class, 432 

Time fields, 316, 486 

Time formats, 462 

Timeout attribute, 417 

Timesheet.js, 575 

Timesheets, 575, 578, 579 

Timesheets projects, 575, 578, 579 

Timesheets,adding rows, 575 

Timesheets,adding to Web views, 579 

Timesheets,changing starting day, 578 

timestamping, 542, 543 

tmplInventoryTab.rec, 538 

tmplRecord.html, 542 

Tools, 473, 478 

Tools menu, 206, 208, 276, 290, 410, 462, 465, 

467, 471, 474, 477, 500, 600, 604 

Tools menu,Attachments command, 467 

Tools menu,Databases command, 465 

Tools menu,Enable Auto Repair command, 477 

Tools menu,Integrity Editor command, 474 

Tools menu,Licenses command, 500 

Tools menu,Logons Editor command, 471 

Tools menu,Options command, 600 
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Tools menu,Relocate command, 465, 467 

Tools menu,Repair and Compact command, 604 

Tools menu,Web > Groups command, 290 

Tools menu,Web > Users command, 276 

Tools menu,Web command, 206, 208, 410, 462 

Tools,Options, 473, 478 

traffic, 473 

Troubleshooting, 474, 477 

Troubleshooting,Admin problems, 477 

Troubleshooting,performance, 474 

Troubleshooting,removing locks, 474 

Update test, 313, 395 

Uploaded files, 478 

URL attribute, 435 

URL Button CSS, 435, 536 

URL buttons, 435 

URLs for Web Views, 438, 554 

User Categories, 282 

Users, 266, 270, 276, 280, 282, 283, 285, 286, 287, 

289, 291, 292, 403, 415, 419, 442, 471, 474, 

478, 486, 487, 510, 539, 587, 597, 605 

Users command, 276 

Users database, 587 

Users group, 419, 518 

Users,adding choice lists of, 287 

Users,adding to groups, 291 

Users,admin account, 276 

Users,analyst account, 276 

Users,anonymous access account, 442 

Users,assigning to work teams, 280 

Users,authentication, 276, 289 

Users,backing up database, 597 

Users,categories, 282 

Users,CensusUser account, 442 

Users,database, 587 

Users,defined, 266 

Users,deleting, 539 

Users,disabling, 276, 285 

Users,editing user information, 403 

Users,employee account, 276 

Users,group leader account, 276 

Users,group membership, 292 

Users,hiding in projects, 283 

Users,importing, 270, 486, 487 

Users,issueagent, 403 

Users,logging off, 471, 478, 605 

Users,logon accounts, 276 

Users,MDB database, 597 

Users,passwords, 403 

Users,removing from choice lists, 286 

Users,removing from database, 539 

Users,removing from groups, 291 
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Users,removing locks, 474 

Users,roles and responsibilities, 510 

Users,submit-only Web views, 415 

Users,Web view permissions, 419 

Users,Windows account, 442 

Users,work teams, 280 

Users.mdb, 587 

USERS_MDB database, 587 

USR database, 588 

validatelogon.asp, 574 

Vertical Alignment attribute, 430 

Virtual directories, 440, 471, 478 

Virtual directories,creating, 440 

Virtual directories,defined, 440 

Virtual directories,Logons Editor, 471 

Virtual directories,re-creating, 478 

Visible attribute, 322, 438 

Web Admin command, 206, 208, 462 

Web View Editor, 206, 410 

Web View Editor command, 206, 410 

Web views, 200, 246, 276, 281, 295, 410, 413, 

414, 415, 417, 419, 425, 426, 428, 430, 432, 

433, 434, 438, 440, 443, 445, 448, 462, 471, 

518, 521, 555, 557, 560, 563, 566, 569, 573, 

575, 578, 579, 599 

Web views,access permissions, 419, 518 

Web views,columns, 521 

Web views,copying, 413 

Web views,creating, 410 

Web views,CSS, 448 

Web views,custom reports, 246 

Web views,CustomizedFiles folder, 246, 445, 521, 

599 

Web views,CustomizedFiles folder,backing up, 

599 

Web views,CustomizedFiles folder,custom 

reports, 246 

Web views,CustomizedFiles folder,explained, 445 

Web views,CustomizedFiles folder,from base 

project, 521 

Web views,customizing, 434, 445, 555, 557, 560, 

563, 566, 569, 573 

Web views,date formats, 462 

Web views,default values, 443 

Web views,defined, 200, 410 

Web views,deleting, 414 

Web views,description, 417 

Web views,disabling features, 295 

Web views,Display All Read-Only Fields As Text 

attribute, 433 

Web views,exporting fields, 521 

Web views,exporting queries, 426 

Web views,generating, 430, 521 

Web views,groups allowed to open, 417, 518 

Web views,hiding fields, 438 
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Web views,inserting custom code, 434 

Web views,Knowledge Base, 415 

Web views,layout of fields, 428, 521 

Web views,layouts, 425 

Web views,Load Issues Not In Query, 417 

Web views,logging off users, 471 

Web views,normal, 415 

Web views,permissions, 295 

Web views,printing issues, 521 

Web views,queries, 521 

Web views,read-only, 415 

Web views,read-only fields, 433 

Web views,regenerating, 521 

Web views,renaming, 414 

Web views,style sheets, 448, 555, 557, 560, 563, 

566, 569, 573 

Web views,styling form elements, 432 

Web views,submit-only, 276, 415 

Web views,Summary List, 417 

Web views,time formats, 462 

Web views,timeouts, 417 

Web views,Timesheets, 575, 578, 579 

Web views,URLs, 438 

Web views,virtual directories, 440 

Web views,work teams, 281 

When conditions, 398 

Width attribute, 434 

Wildcards in queries, 226 

Windows account, 442 

Windows NT domains, 270 

Windows Server 2003, 478 

Work teams, 280, 281 

Work teams,assigning users, 280 

Work teams,defining, 280 

Work teams,overview, 280 

Work teams,queries, 281 

Work teams,web views, 281 

Workflow, 280, 358, 365, 366, 368, 370, 371, 372, 

373, 375, 376, 377, 402, 510 

Workflow,<New Issue> macro, 370 

Workflow,applying changes to web views, 376 

Workflow,automating, 358 

Workflow,conditions, 366 

Workflow,dependent values rules, 358 

Workflow,disabling, 377 

Workflow,example rules, 358 

Workflow,macros, 373 

Workflow,notifications, 402 

Workflow,performance costs, 365 

Workflow,planning, 510 

Workflow,possible values rule, 358 

Workflow,projects, 365 
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Workflow,related fields, 358 

Workflow,rules, 358, 366, 368, 371, 372, 375, 377 

Workflow,rules,default names, 372 

Workflow,rules,defining, 371, 372 

Workflow,rules,deleting, 372 

Workflow,rules,described, 368 

Workflow,rules,disabling, 377 

Workflow,rules,evaluating, 375 

Workflow,rules,examples, 358 

Workflow,rules,format of, 366 

Workflow,rules,renaming, 372 

Workflow,Submitter field, 373 

Workflow,templates, 368, 372, 375, 377 

Workflow,templates,creating, 368 

Workflow,templates,described, 368 

Workflow,templates,properties, 372, 375, 377 

Workflow,test operators, 366 

Workflow,user groups, 370 

Workflow,work teams, 280 

yes/no fields, 316 

 


